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Sugar Enterprise 6.7 Application Guide
The Sugar Application Guide introduces you to some basic CRM concepts and
helps you get familiar with the Sugar system. It describes how to access Sugar
through a personal computer and a web browser. It also describes how to perform
a broad range of customer relationship management tasks and related
administration tasks.

Readers are not required to have any programming or software development
knowledge, but should be generally familiar with the use of a personal computer
and a web browser such as Mozilla Firefox.

Last Modified: 01/18/2016 02:27pm

Introduction

Overview

Welcome to Sugar - a commercial, open source Customer Relationship
Management (CRM) application. Strong relationships are at the core of every
organization's success. Sugar brings ease and order to the creation, development,
and maintenance of your organization's important relationships.

Sugar consists of interrelated records in modules such as Accounts, Contacts,
Opportunities, Cases, Meetings, Emails, etc. and wraps your data in an intuitive
user interface which helps make sense of these different elements of your
business. Whatever your organization's focus - sales, marketing, support, or other
ventures - Sugar's flexible modules bend to align with your business' models and
practices. Manage your relationships from inception to fruition and beyond with
Sugar's built-in modules and relationships as well as your custom modules and
configurations available to Sugar administrators.

Core Features
Sales Force Automation

Target, Lead, and Contact management to direct and organize efforts
throughout the sales life cycle
Account management to aggregate interactions with organizations and
individuals
Opportunity management to pursue new business, share sales information,
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and track deal progress
Sales Forecasting to enable sales representatives and managers to
understand upcoming business
Quote management to prepare potential sale figures including multiple line
items, currencies, and tax codes
Product management to capture the details of your organization's goods and
services

Marketing Automation

Target, Lead, and Contact management to support the creation of new
relationships
Email marketing campaigns to present relevant email messages to groups of
recipients
Campaign management and reporting for tracking campaigns across multiple
channels and analyzing the effectiveness of marketing activities
Target List management to organize groups of recipients for ensuring
campaign message relevance
Web-to-Lead Forms to capture lead information directly from external web
input

Customer Support

Case management to track service and resolution of customer issues
Bug tracking to identify, prioritize, and resolve product issues
Contact and Account management to track support history and enable
continuity of service
Sugar Portal to provide clients with self-service capabilities support activities
Knowledge Base to manage information and share it externally

Record Keeping

Email, Task, Call, and Meeting management to facilitate day-to-day work
Note management to affix information and file attachments to other Sugar
modules
Document management to track living documents and their changes
Contract management to capture and maintain sales and service contracts
Search capabilities to quickly and easily locate your data

Collaboration

 36 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Forecasts
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Quotes
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Products
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Targets
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Leads
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Campaigns
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Campaigns
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Target_Lists
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Web_To_Lead_Forms
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Cases
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Bugs
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Accounts
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Portal_Deployment_User_Guide
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Knowledge_Base
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Tasks
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Calls
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Meetings
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Notes
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Documents
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contracts
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Search


 

Shared Email and Calendar to provide visibility across individuals and teams
Connectors and tools to leverage third-party information regarding your
prospects and clients
Project management to track the progress of multipart initiatives

Reporting

Report creation and management to gain insight into your organization's
Sugar data
Home page dashlets to display important tables and reports

Last Modified: 09/26/2015 06:25pm

Getting Started

Overview

Sugar offers users a wide range of configuration options when getting started with
the application. Your first time logging into Sugar the New User Wizard will step
through configuring some basic settings (i.e. Your Information, Your Locale, etc.).
You may skip these steps and configure these settings in your user preferences at
a later time. Please note that system administrators can also set up each user's
basic settings when creating the user in Sugar. This documentation will cover the
various options (e.g. New User Wizard, User Preferences, etc.) available when first
getting started with Sugar and accessing your account.

Accessing Sugar
Prerequisites

The following will need to be installed and configured on your local machine prior
to accessing Sugar:

A supported web browser application (e.g. Chrome, Firefox, etc.) is required
on your local machine. For more information on the various supported web
browsers, please refer to the Supported Platforms page.
The web browser must have JavaScript and cookie support enabled in order to
access Sugar.
Network access to a server running your Sugar instance is required.
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Logging In

The Sugar login screen allows you to enter login credentials (user name and
password) to access your instance. Navigate your web browser to your instance's
URL (e.g. https://example.sugarondemand.com) to access Sugar's login screen. If
you do not know your instance URL or login credentials, please reach out to your
system administrator for assistance. The New User Wizard will launch upon your
first successful log in to Sugar allowing you to configure some of your basic
personal settings.

 

Resetting Your Password

There may be occasions when users forget their Sugar password and will need to
reset it. If the system administrator has enabled the Forgot Password feature via
Admin > Password Management, user's will have the option to request a password
reset directly from Sugar's login screen. If you do not see the Forgot Password link
on your login screen, please reach out to your system administrator for further
assistance. System administrators can either enable the Forgot Password feature,
send a system-generated password to the user, or manually change the user's
password via Admin > User Management. For more information on how to set up
and manage passwords in Sugar, please refer to the Password Management
documentation. Please note that the outbound mail server for the system must be
configured via Admin > Email Settings and users will also need to have their 
personal email settings configured in their user preferences in order for the reset
password link to be emailed.For more information on setting up the system email
settings, please refer to the Email documentation in the Administration guide.

Use the following steps to reset your password:

1. Click the Forgot Password? link on the bottom right of Sugar's login dialog
box.
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2. Enter your Sugar username and primary email address; then click "Submit". If

submitted successfully, a message will appear that your request has been
submitted.

 
3. The reset password email will be sent to your primary email address. Click

the link in the email to reset your password.
4. Enter your username, new password, and new password again. Click "Log In"

to access your account with the new password.

 

Note: You may also change your password while logged in to Sugar by navigating
to the Password tab in your user preferences.

Setting Your Language

The Language dropdown list on the login dialog box allows users to select the
primary language they want displayed in Sugar. The out-of-the-box default
language is English (US), but administrators can change the default language
globally via Admin > Locale. For more information on configuring the default
language in Sugar, please refer to the User Interface section of the System
documentation. Once the default language is changed by the administrator, it will
display as the default selection on the login screen for all users.

Please note that you will need to select the specific language you want displayed
each time you log in or the default language will display in Sugar. Administrators
can also control what languages are available to select in the Language dropdown
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list via Admin > Languages. If you do not see one of the listed languages below
displayed in the Language dropdown list, please reach out to your system
administrator for assistance. For more information on managing languages in
Sugar, please refer to the Languages section of the System documentation.

 

The following languages are available for use in Sugar:

Albanian Italian
Bulgarian Japanese
Catalan Korean
Chinese Latvian
Croatian Lithuanian
Czech Norwegian
Danish Polish
Dutch Portuguese
English (UK) Romanian
English (US) Russian
French Spanish
German Slovak
Greek Swedish
Hungarian Turkish

Logging Out

When you are done working in Sugar and wish to log out of the system, simply
click your user name on the upper right of Sugar and click "Log Out". This will log
you out completely from Sugar and you must log in again in order to access your
account.
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Automatic Log Outs

While working in Sugar, a user may be automatically logged out of the system.
Currently, Sugar allows a username to be logged in under only one session, and
any additional user sessions started using the same username will log out the
previous session. This behavior is for your security as Sugar does not allow
multiple sessions for the same username from different machines or browsers. To
prevent situations like this, please do not share your login credentials (username
and password) with users in your organization.

Another situation where users are automatically logged out is when the user does
not perform any actions in Sugar for a certain period of time. The security timeout
period in Sugar is controlled by configuration settings in PHP and the web server
running your Sugar instance. Please note that the PHP session's lifetime persists
until you close your web browser and the default session timeout value is 1440
seconds (24 minutes).

In order to prevent security timeouts, users can navigate or click the page(s) in
Sugar every so often to keep the session active. If the session times out, click any
button, tab, etc. on the current page once you are ready to continue working in
Sugar, and you will be taken back to the Login screen . Another option is to
completely close your current browser and open a new browser to navigate back to
Sugar's Login page.

Please note that users can have multiple tabs of Sugar pages open within the same
web browser (e.g. Chrome) without getting logged out of the system. This is useful,
for example, for working with multiple Sugar pages or records without navigating
away from previous pages.

New User Wizard

When users first log in to Sugar, they will step through the New User Wizard to
configure some basic settings (i.e. Your Information, Your Locale, etc.). If the
system administrator already configured your basic settings when adding you as a
user to Sugar, the fields in the wizard will be populated with the provided
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information. You can update your information as you go through the New User
Wizard to make any necessary changes. Please note that you can skip the steps in
the wizard if you wish to configure the settings via your user preferences at a later
time.

Configuring Your Information

The Your Information step of the New User Wizard allows you to enter basic
information (e.g. name, email address, phone, physical address, and IM name)
about yourself to be stored in your user profile. Please note that the information
provided on this step can be updated in your user preferences at a later time if
desired. For more information on configuring your personal information, please
refer to the User Preferencessection of this documentation.

The following options are available to configure your user profile:

First Name : Enter your first name.
Last Name : Enter your last name.
Email Address : Enter your primary email address.
Office Phone : Enter your office number.
Mobile : Enter your mobile number.
IM Type : Select the instant message client (e.g. MSN, Yahoo!, AOL, None)
you use, if applicable.
IM Name : Enter your user name associated with the selected instant
message client type.
Primary Address : Enter your primary street address.
City : Enter your primary address city.
State : Enter your primary address state.
Postal Code : Enter your primary address postal code.
Country : Enter your primary address country.

Please note that all required fields are marked with a red asterisk and must be
completed prior to moving to the next step of the wizard. Once your personal
information is entered, click "Next".
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Configuring Your Locale

The Your Locale step allows you to configure the date, time, currency, and name
format you want displayed in Sugar based on your current geographical location.
Please note that the information provided on this page can be updated in your 
user preferences at a later time if desired.

The following options are available to configure your locale settings:

Time Zone : Select the time zone based on your current geographical location.
Date Format : Select the format you want the date stamps displayed in Sugar.
Time Format : Select the format you want the time stamps displayed in Sugar.
Currency : Select the default currency you want displayed in Sugar.
Currency Significant Digits : Select how many digits will appear after the
decimal symbol for currencies.
Decimal Symbol : Enter the default character used as the decimal symbol.
1000s separator : Enter the default character used to separate numeric values
in the thousands.
Name Display Format : Select the format you want the concatenated name
fields displayed in Sugar's list view and detail view.

Once your locale information is entered, click "Next".
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Configuring Your Email Account

The Your Email Account step will appear in the wizard if the system email settings
are configured via Admin > Email Settings, but the administrator has not allowed
users to use the system mail account to send their own outbound emails. Your
personal mail account information (username, password) should be entered in
order to send outbound emails from Sugar. The email provider for the default
outbound mail server will be displayed on the page. Once your mail account
information is entered, you can send a test email to confirm that the information is
correct. Click "Send Test Email", provide an email address where the test email
should be sent, then click "Send". If you do not receive the test email, double check
and re-enter the email account information to test again .For more information on
setting up your user preferences' email settings, please refer to the Email
Settings section of this documentation. Please note that you can change your
personal email setting in your user preferences at a later time if desired.

Once you click "Next", the following page will confirm that you are ready to use
Sugar and allows you to access various support resources (e.g. Documentation,
Knowledge Base, etc.) if you wish. Please note that you can click "Finish" to go
directly into your Sugar account.
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User Preferences

There is a wide range of configuration options available to users when setting up
their profile in Sugar. The User Preferences section gives users the ability to view
and update their basic information, personal email settings, themes, etc. To access
user preferences, click your user name on the upper right of Sugar and select
"Profile".

 

User Profile Tab

The User Profile tab displays basic information such as your name, email address,
phone number, etc. If the New User Wizard was completed, the information you
entered will appear under the User Profile tab. The system administrator can also
enter the user's basic information when creating the user via Admin > User
Management. For more information on creating new users, please refer to the 
User Management documentation. Your personal information on this tab are
grouped by default into the User Profile, Employee Information, and Email Settings
sections. To enter or update your information, simply enter the appropriate values
for the fields then click "Save" to preserve the changes.

User Profile

The User Profile section displays your Sugar user name, full name, status, user
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type (e.g. Regular User, System Administrator User), and profile picture (if
uploaded). Your user name, full name, status, and user type will be populated as
the system administrator must enter this information when creating a new user.
User's have the option to update their user name, full name, as well as upload a
profile picture to be displayed in the upper right of Sugar. Please note that only
system administrators have the ability to change your status and user type. For
more information on changing a user's status and user type, please refer to the 
User Management documentation.

 

Employee Information

The Employee Information section displays your employee status, title, phone
number, address, etc. If you completed the Your Information step of the New User
Wizard, the information you entered will appear in this section. You can update
your address, phone number (e.g. Work Phone, Mobile, etc.), description, IM Type
(e.g. MSN, Yahoo!, etc.), and IM Name in this section accordingly. Please note that
only system administrators can change your employee status, title, department,
and supervisor information. For more information on administrator updates to the
Employee Information section, please refer to the User Management
documentation.

If you do not wish to have your employee information displayed in the Employees
directory in Sugar, uncheck the "Display Employee Record" box. For more
information on viewing the employee directory, please refer to the Employees
documentation.
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Email Settings

The Email Settings section is where users can configure their personal email
settings. Administrator's can also set up the users email setting when adding the
user in the system. Please note that the email settings must be configured in user
preferences prior to sending outbound emails from Sugar. In addition, the
outbound mail server for the system must also be configured by the system
administrator via Admin > Email Settings. For more information on setting up the
system email settings, please refer to the Emails documentation in the
Administration guide.

Users will enter in their primary email address where password reset emails,
system-generated notifications, etc. will be sent. Multiple email addresses can be
added in email settings, but only one will be marked "Primary". The primary email
address will be displayed when sending outbound emails in Sugar and automatic
notifications from Sugar will be sent to this address as well. Users will be able to
send outbound email's automatically from Sugar if the administrator has enabled
user's to use the system mail account configured in Admin > Email Settings. If this
option is not enabled, the SMTP Username and Password fields will appear in the
Email Settings section for the user to enter their personal credentials
corresponding to their mail account on the company's defined mail server. The
user will need to enter these credentials in order to send emails using the system's
outbound mail server.

By default, outbound emails will be sent using the email client set up within the
Sugar application. However, users have the option to use an external mail client if
they would like to use an email client (e.g. Microsoft Outlook) outside of the
application .

Use the following steps to configure your personal email settings in user
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preferences:

1. Enter the primary email address in the Email Address field.
To add multiple email addresses, click the Plus sign.

 
2. The email client will be defaulted to "Sugar Email Client", but users can

choose to use an external mail client if they wish.

 
3. Enter in the SMTP Username and Password for your mail account on the

company's defined mail server.
Note: The SMTP Username and Password field will only appear if the
system administrator has not allowed users to use the system mail
account to send outbound emails.

 
4. Click "Send Test Email" and enter in an email address to send the test email.

If you do not receive the test email, double check and re-enter the email
account information to test again.

 
5. Click "Save" to preserve your email settings.

Password Tab

Users have the option to change their password in Sugar by navigating to the
Password tab in their user preferences. You can use this option to change
temporary Sugar password's, system-generated password's for password resets,
etc. Administrators also have the ability to change or reset a user's password via
Admin > User Management. For more information on how administrator's can
reset a user's password, please refer to the Resetting User Passwords section of
the User Management documentation. Please note that passwords can be changed
as often as you wish in Sugar. Updating password's in Sugar on a regular basis is
recommended for the security of your account.

To reset your password, enter your current password, new password, and

 48 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Users


 

confirmed password making sure to meet the password requirements listed on the
right. Each password requirement will be checked off in the list as the new
password meets the required conditions. Please note that the new password you
enter must meet all the restrictions in order for the password to save. System
administrators can configure the password requirements via Admin > Password
Management. They can choose the minimum and maximum lengths required for
the password, as well as indicate if any special characters are needed. Additional
requirements such as upper case, lower case letters, and numbers can also be part
of the set restriction. The password requirement set by the system administrator
determines what users will need to include when creating new passwords.
Although not recommended, administrators can choose to not set password
requirements if they wish, which will allow users to change their passwords
without any restrictions. For more information on configuring password
requirements, please refer to the Password Requirements section of the Password
Management documentation. Once you have entered the new password, click
"Save" to preserve the change.

 

Themes Tab

Users have the option to change the look and feel of Sugar's user interface by
selecting one of the themes (e.g. Eco, Amore, etc.) available in the Themes tab. By
default, the out-of-the-box theme in Sugar is " Pacific". Each theme will display
Sugar's user interface with different layouts and background colors. The location
of module tab's, Recently Viewed, and Actions menus may change as well
depending on the theme you choose. Please note that the information displayed in
Sugar will be the same regardless of the chosen theme.

Every user can have a different theme for their account based on their personal
preference and how they would like to view the data in Sugar. For example, the
Right to Left theme can be chosen for users with languages that are read from
right to left. To change your theme, simply select the desired theme in the Themes
list. Sugar provides a quick preview of each theme to the right of the list to show
users how the layout will appear before committing to it. Once you have chosen
your theme, click "Save" and your user interface will instantly display with the new
view.
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Advanced Tab

The Advanced tab shows information specific to the user's preferences in Sugar.
This information includes user settings, locale settings, PDF settings, calendar
options, and layout options. Users can set up, view, or change the information
under this tab based on their geographical location and personal preference.

User Settings

The User Settings section allows you to configure various settings for your account
such as default team(s), reminders, notify on assignment, etc. The system
administrator can configure these settings for you when adding you as a user in
Sugar, but you can change these settings accordingly based on your personal
needs and preference.

The options available to configure in the User Settings section are as follows:

Export Delimiter : Specify the character used to delimit exported data from
Sugar. By default, the comma is used to separate exported data in Sugar.
Import/Export Character Set : Select the default character set used for data
import, data export, and vCard generation. By default, UTF-8 (US or Western
Europe region) is selected as the import/export character set.

Please be sure to select the proper character set based on your locale
setting in Sugar. This will make sure that the character set between
Sugar and your local machine matches when you export data, import
data, or generate quote PDFs.

Show Full Names : Check this box if you would like your full name (e.g. John
Smith) instead of your assigned user name (e.g. jsmith) displayed in Sugar. If
enabled, your full name will appear in the My Activity Stream dashlet,
Assigned to field, and on the upper right of your Sugar account.
Offline Client Status : Select "Active" to use the Sugar Offline Client and
"Inactive" to not use it. For more information on Sugar Offline Client, please
refer to the Offline Client Guide documentation.
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Default Teams : Select the default team(s) that will be automatically assigned
to new records you create in Sugar.
Notify on Assignment : Check this box to receive an email notification when a
record is assigned to you by another user. Both the outbound mail server and 
Reminders : Mark the popup or email reminder checkbox to set default
reminders for calls and meetings. Once marked, you can select the default
reminder time (e.g. 10 minutes prior) to send reminders to invitees.
Mail Merge : Check this box to merge data (e.g. name, address) in Sugar with
mail merge templates in Word created using Sugar Plug-in for Word. Please
note that the system administrator must also enable the mail merge option in
Admin > System Settings in order for you to perform a mail merge. For more
information on enabling mail merge in system settings, please refer to the 
System documentation.
No Opportunities : Check this box if you will not be assigned opportunities in
Sugar. Please note that this setting is used for forecasting. For more
information on forecasting, please refer to the Forecasts documentation.

 

Layout Options

The Layout Options section allows users to select what modules they want
displayed or hidden in the navigation bar. You can also disable the "Filter Menu
By" feature for tab groupings and enable subpanels to be grouped into tabs in the
Detail View layout.

The options available to configure in the Layout Options section are as follows:

Module Menu Filters : This box is marked by default and allows users to view
modules in the navigation bar based on specific tab groupings (e.g. Activities,
Reports, etc.). The Filter Menu By option will appear under the More tab to
show the different tab groupings.
Select Modules for Navigation Bar : Select which modules will be displayed or
hidden in the navigation bar by using the left and right arrow to move
modules between the Display and Hide Modules column. You can also
designate the order of the modules displayed in the navigation bar by
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selecting the module in the Display Modules column and clicking the up and
down arrow.
Subpanel Tabs : Mark this checkbox to group subpanels into tabs in the
module's detail view.

 

Locale Settings

The Locale Settings section is where you can specify how you would like the data
in Sugar displayed based on your geographical location. Please note that system
administrators can set the system locale settings via Admin > Locale, which will be
the default setting for all users in Sugar. But each user has the option to change
the default locale settings for their Sugar account in their user preferences.

The options available to configure in the Locale Settings section are as follows:

Date Format : Select the format you want the date stamps displayed in Sugar.
Time Format : Select the format you want the time stamps displayed in Sugar.
Time Zone : Select the time zone based on your current geographical location.
Name Display Format : Select the format you want the concatenated name
fields displayed in Sugar's list view and detail view.
Currency : Select the default currency you want displayed in Sugar.
Show Preferred Currency : Specify if you would like currency amounts
converted to your preferred currency in list views and record views.
Currency Significant Digits : Select how many digits will appear after the
decimal symbol for currencies.
1000s Separator : Enter the default character used to separate numeric
values in the thousands.
Decimal Symbol : Enter the default character used as the decimal symbol.
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PDF Settings

The PDF Settings section allows users to set and change the default font settings
for PDF documents generated in Sugar.

The options available to configure in the PDF Settings section are as follows:

Font for Header and Body : Select the font for the header and body of PDF
documents when generated in Sugar.
Main Font Size : Enter the default font size for the PDF header when
generated in Sugar.
Font for Footer : Select the font for the footer of the PDF document when
generated in Sugar.
Data Font Size : Enter the default font size for the PDF body when generated
in Sugar.

 

Calendar Options

Sugar calendars can be shared and viewed with various iCal compatible calendar
applications such as Apple iCal, Google Calendar, Yahoo! Calendar, Mozilla
Thunderbird, etc. The calendars are viewable as read-only in the external calendar
applications and any edits to existing calendar events (e.g. meetings, calls, etc.)
can only be done in Sugar. The Calendar Options section allows users to generate
a unique publish key to sync their Sugar calendar to external calendar
application(s). The publish key is a security feature as it prevents other user's from
viewing your calendar unless they have this information. The user must have your
publish key information in order to view your Sugar calendar via the external
calendar application.
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Publish Key : The publish key is used to uniquely identify a user's calendar
and sync Sugar's calendar to external calendar applications (e.g. Google
Calendar, Apple iCal, etc.). A system-generated alphanumeric value (e.g.
948fc65a-9c89-a11f-b40c-5) is displayed by default, but users can change this
key (e.g. mysecretkey) to whatever they wish. The Publish at my location site,
Search location, and iCal integration URL all reflect the publish key within
the URL.
Publish at my location : Use this URL to sync free/busy information for
meetings from Microsoft Outlook to Sugar. This is helpful when scheduling
meetings in Sugar as you can view the user's free/busy information to avoid
scheduling conflicts.
Search location : Use this URL to sync free/busy information for meetings
from Microsoft Outlook to Sugar. This is helpful when scheduling meetings in
Sugar as you can view the user's free/busy information to avoid scheduling
conflicts.
iCal integration URL : Use this URL to integrate the external calendar
application with your Sugar calendar.
First Day of Week : Select the first day of the week that will display in Week,
Month, and Year views when viewing your Sugar calendar.

Use the following steps to integrate the external calendar application with your
Sugar calendar:

1. Navigate to the Advanced tab in your user preferences and scroll to the
Calendar Options section.

2. Enter a new publish key (e.g. mysecretkey) and Sugar will automatically
generate the iCal integration URL.

 
3. Copy and paste the iCal integration URL into your iCal compatible calendar

application.
Example: Adding the URL into Apple iCal.

1. Click "Calendar" then select "Subscribe".

 
2. Enter the iCal integration URL and click "Subscribe".
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Example: Adding the URL into Google Calendar (
https://www.google.com/calendar).

1. Click "Other Calendars" then select "Add by URL".

 
2. Enter the iCal integration URL and click "Add Calendar".

 

Use the following steps to sync the free/busy information from the Sugar calendar
to Microsoft Outlook:

1. Navigate to the Advanced tab in your user preferences and scroll to the
Calendar Options section.

2. Copy the Search location URL.
3. In Outlook, go to File > Options > Calendar > Free/Busy Options.
4. In the Internet Free/Busy section, paste the Search location URL into the

corresponding box.

Please note that the settings must be configured on each user's computer. Once
configured, the invitee shows as busy for any times currently scheduled in Sugar if
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the user's email address in Sugar matches the invitee email address in Outlook.

External Accounts Tab

The External Accounts tab allows users to connect to external applications (e.g.
Google, GoToMeeting, WebEx, etc.) from Sugar. Please note that you must have an
existing account with the external application prior to connecting in Sugar.
Connecting to your Google account enables you to upload and access documents
stored in the Google Drive™ from the Documents module. In addition, you can
upload and view Sugar documents via the Google Drive. For more information on
how to upload and view external source documents, please refer to the 
Documents documentation. If you connect to your GoToMeeting and WebEx
accounts, you will be able to schedule meetings in Sugar to be hosted by one of
these applications. Please note that you must indicate the specific meeting type
(e.g. Sugar, GoToMeeting, WebEx) when creating the meeting in Sugar. For more
information on scheduling meetings, please refer to the Meetings documentation. 

The following steps cover connecting to the Google application as an example:

1. Click the External Accounts tab in your user preferences then click "Create".

 
2. Select "Google" in the Application field then click the Connect button.

Note: If the Google option is not available to select in the Application
field, the Google connector may not have been configured properly via
Admin > Connectors. Please reach out to your Sugar administrator to
have the Google connector configured. For more information on
configuring connectors, please refer to the System documentation in the
Administration Guide.

 
3. After clicking "Connect", a pop-up window will appear. Click "Allow" to grant

permission for the connection to occur.
Google's login screen may appear inside the pop-up if you are not
already logged in to your Google account in the active browser window.
Simply enter your credentials then click "Allow" in the next window.
Note: Your browser's pop-up blocker must be disabled to ensure that the
Google account connects successfully to Sugar.
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The Google application is now connected to your Sugar account and will appear
under the External Accounts tab. Please note that for Google, GoToMeeting, and
WebEx, you can only be connected to one account per application in Sugar.

Access Tab

Users can view their access information (e.g. Access table, Roles, My Teams) via
the Access tab in the detail view of their profile. System administrators can assign
users to various teams and roles depending on what each user is allowed access to
in Sugar. You will be able to view the team(s) and role(s) assigned to you via the
Roles and My Teams section in the Access tab.

Access Table

The Access table summarizes the set of permissions assigned to the user and
allows them to view the type of access they have along with the actions (e.g. View,
Edit, Delete, etc.) they can perform in Sugar. Only system administrators have the
ability to create roles and assign them to users. Users who are assigned to the role
will only be able to perform actions defined by it. Please note that users with more
than one role assigned will have the more restrictive role setting prevail on the
access table. For example, if one role allows the user to delete records in the
Contacts module, but the other role does not allow record deletion, the user will
not be able to delete records in the Contacts module. The table will list the
modules in rows on the far left with column headers representing the type of
action (e.g. Delete, Edit, Export, etc.) users can perform in each module. For more
information on the Access table column headers, please refer to the Setting
Module-Level Permissions section in the Role Management documentation.

The following setting options are available for the Access column on the table:

Enabled :The user is allowed access to this module.
Not Set : Does not restrict or grant access to this module, defaults to having
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"Enabled" access when selected.
Disabled : The user will not be able to access this module, view any of its
records, or see any trace of its existence in Sugar.

The following setting options are available for the Access Type column on the
table:

Normal : The user will be able to perform standard functions in this module
barring restrictions from other roles or team settings. The user will not have
any type of access to the Admin menu for this module.
Not Set : Does not restrict or grant additional access to this module, defaults
to having "Normal" access when selected.
Admin :The user will supersede any team restrictions for this module and be
able to view all records.

Note: User does not get access to developer tools such as Studio and
Workflow Management.

Developer :The user will be given access to the module-specific sections of
Studio, Workflow Management, Dropdown Editor and any other necessary
menus in Admin that are specific to the module.
For more information on developer tools, please refer to the Developer Tools
documentation.
Admin & Developer :The user will be given the rights defined with the Admin
and Developer role settings.

The following setting options are available for the actions (e.g. Edit, Delete,
Export, etc.) on the table:

All : The user will be able to perform this action on any and all records that
can be accessed.
Owner : The user will only be able to perform this action where the Assigned
To field is set to be this user.
Not Set :Does not restrict or grant access to this function and actions default
to having "All" access when selected.
None : The user is not able to perform this action while using this module.
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Roles

Sugar Roles define permissions for users such as what kinds of records they can
access and what level of access they are allowed . Roles work in conjunction
withteams to form a robust security model for non-admin users in Sugar. Roles
control three different layers of access for users within Sugar: module, field, and
action-level access. Please note that only users who are assigned to the specific
role will be able to perform actions (e.g. view, edit, delete, etc.) defined by it. For
more information on the various actions and setting options for roles, please refer
to the Access Table section of this documentation. Users who are notassigned to a
role can access and perform actions in any module as long as they are assigned to
the record or a member of the team assigned to manage it. System administrators
have the ability to create various roles and assign additional roles to users via
Admin > Role Management. For more information on creating and assigning roles,
please refer to the Role Management documentation.

The Roles section displays the list of roles (if any) assigned to the user. Please note
that if you are assigned to more than one role, the more restrictive role setting
prevails. For example, if you have two roles where one role allows exporting of
records in the Leads module and the other does not, then you will not be able to
export lead records due to the more restrictive role setting.

 

My Teams

Teams consist of one or more users who are assigned to manage records in Sugar.
The defined permissions determine what records a user is and is not able to
access. Teams are used in conjunction withroles to form a robust security model
for non-admin users in Sugar. The My Teams section displays the list of teams a
user is associated with, which determines what records the user has access to in
Sugar. Please note that every record is assigned to at least one team, but can be
assigned to multiple teams as well if different users need access to it. The default
team(s) set in the User Settings section under the Advanced tabwill automatically
be assigned to new records created by the user. Users assigned to the record, as
well as system administrators can access the record regardless of team
membership. When a user is created in Sugar, they are automatically associated to
the Global team (universal team) and a Private team (users own personal team) is
created by default. System administrators can assign users to additional teams via
Admin > User Management or Admin > Team Management as necessary. For
more information on teams as well as creating and assigning teams, please refer to
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the Team Managementdocumentation.

 

Downloads Tab

The Downloads tab contains the Sugar Plug-ins for Microsoft Office (i.e. Sugar
Plug-in for Microsoft Excel, Outlook, and Word) and Sugar Plug-in for Lotus Notes.
Excel plug-in enables you to create, delete, update, or view data that is in your
Sugar application . Outlookplug-in allows you to archive emails to Sugar,
synchronize contacts, meetings, and tasks, as well as create new Sugar records.
Word p lug-in enables you to merge data, such as names and address in Sugar to
perform mail merges.These plug-ins are available with all commercial editions of
Sugar and must be installed on each Windows computer running the Microsoft
Office application where the plug-in is desired. Lotus Notes plug-in allows you to
integrate with Sugar by synchronizing meetings, tasks, and contacts, as well as
archiving emails to records in your instance. The plug-in comes with the Enterprise
or Ultimate editions of Sugar and is available for purchase a la carte for
Professional and Corporate customers.

To download the plug-in(s), click the appropriate file that correspond to your
version and bitrate of Microsoft Office Excel, Outlook, or Word. Please be sure to
check for the correct version and bitrate of your Microsoft Office application in
order to download the correct file for installation. For the Lotus Notes plug-in, the
latest version will be available for installation in the Downloads tab. For more
information on downloading and installing the Sugar plug-ins, please refer to the
appropriate Plug-ins documentation.
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User Holidays

The User Holidays subpanel appears in the detail view (e.g. User Profile tab,
Advanced tab, etc.) of the user's profile. Administrators can record the days that
users will not be working so that the time off is considered when calculating
project timelines in the Projects module. To add a holiday, click the Create button
and enter the date of the holiday along with a description and then click "Save".
Users will be able to select the scheduled holiday(s) via the Project Holidays
subpanel in Projects-related modules. For more information on creating and
managing projects, please refer to the Projects documentation.

 

Resetting a User's Preferences

Users can reset their user preferences back to the default out-of-the-box settings,
which will revert all changes made to the user preferences section (e.g. User
Profile, User Settings, Locale Settings, etc.). To reset your user preference, click
the "Reset User Preferences" button at the top of your profile in edit view or click
the Actions menu then select "Reset User Preferences" in detail view.
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From edit view:

 

From detail view:

 

Resetting a User's Home Page

Users can reset their Home page back to the default out-of-the-box layout, which
will revert all changes made to the Home page. To reset your Home page, click the
"Reset Homepage" button at the top of your profile in edit view or click the Actions
menu then select "Reset Homepage" in detail view.

From edit view:

 

From detail view:

 

Accessing Support

The SugarCRM Support page provides access to various Sugar Support resources
such as the case portal, documentation, knowledge base, training, etc. Users can
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access the support page by clicking their user name on the upper right of Sugar
andclicking "Support". To access Sugar's Support page outside of your instance, go
directly to the SugarCRM Support page (http://support.sugarcrm.com) on your
web browser.

 

The Get Started section of the Support page provides users, administrators, and
developers with the appropriate resources to get them started in configuring,
customizing, and utilizing the application. The Documentation, Training, and Find
Answers sections provide access to Sugar's self-help area where you can learn how
to use various parts of the application via online documentations, classes, videos,
knowledge base articles, etc. The Knowledge Base provides articles based on
specific topics and areas of Sugar while the Documentation goes over the entire
Sugar application in detail. The Resources section enables you to keep up-to-date
with the latest version of Sugar. It provides key information on supported versions
and platforms to ensure you are running Sugar in the best performing
environment. The Customer Center section allows support authorized contacts to
manage their Sugar subscription, view all purchased orders with Sugar, as well as
download purchased software (e.g. Sugar Plug-in for Outlook, Sugar Plug-in for
Word, etc.) for installation.
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Viewing Instance Information

Users can find information regarding their version and build of Sugar by clicking
their user name on the upper right of Sugar and selecting "About". For example,
this will be useful if you need to confirm the current version and edition of your
instance.

 

Last Modified: 03/02/2016 08:36pm

User Interface

Overview

The user interface in Sugar is essentially everything you see and can interact with
in Sugar. Knowing what buttons allow you to do what actions and how to quickly
add and edit information is critical to managing your customer information. This
documentation is divided into related sections in order to cover in detail interface
options to perform specific tasks.

Navigation Bar

All pages within Sugar display a navigation bar spanning across the top of the
page. The look and functionality of the navigation bar depends on the theme being
used. For the best functionality and aesthetics we recommend the Racer X Theme.
The navigation bar consists of the following from left to right:

Navigation Item Description
Home Displayed as the Sugar Cube and will

navigate back to the homepage. Also
includes a recently viewed menu that
spans all modules.

Module Tabs Displays the default and any customized
modules in Sugar as well as module
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specific actions, recently viewed
records, and favorites.

Global Search Search box that spans across many
modules. Can utilize classic or full text
searching.

Notifications Displays a number indicating any
system notifications. If there are none,
this section will be empty.

User Menu Displays as your user picture and name.
Clicking pulls open a menu consisting of
your Profile, Employees Module, Admin
section, Support, Help, About and
Logout.

Quick Create Displays as a plus sign where clicking
on it will allow the ability to quickly
create a record in a specific module.

 

Home

Sugar will automatically take you to your homepage when logging in. As you
navigate around in Sugar, you can return to your homepage by clicking on the
Sugar cube icon in the top left hand corner of the navigation bar.

 

You may also hover on the Sugar cube to display the Action Menu for the
homepage as well as the Recently Viewed items. The Recently Viewed menu will
display the most recent ten records viewed across all modules. Each item is a link
that can be clicked to take you directly to that record in its appropriate module.
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The only action available in the Action Menu for the homepage is "Add Page". This
action will add a new tab group to your homepage that you can add dashlets to.
For more information on how to add pages and dashlets to your homepage, please
refer to the Home documentation.

Module Tabs

Directly to the right of the Sugar cube are tabs for modules within Sugar. Click the
tab of a specific module to access the list view of that module. This is one of the
most common methods for viewing records within a module. You may also hover on
each module's tab to display the Actions, Recently Viewed, and Favorites menu for
that module. The Actions menu allows you to perform important actions within the
module. The Recently Viewed menu displays the list of records you last viewed in
the module. The Favorites menu displays the list of records you most recently
marked as favorites in the module.

 66 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Home


 

 
The amount of different module tabs you will see at once depends on your screen
resolution and the size of your browser window. If the window is too small, Sugar
will move module tabs under the More tab. Simply hover over the More tab to view
additional module tabs and their associated actions, recently viewed records, and
favorites.

 

Under the More tab, you may need to click "Show More" to view all module tabs
available.
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The module tab section of the navigation bar can be filtered by preset categories in
order to provide easy access to the most often used module tabs. The filters are
defined by default to line up with common job functions. To filter your module
tabs, hover over the More tab and then the Filter Menu By option and select the
filter you would like to apply.

 
The preset filters are defined as followed:

Filter Modules Shown
Sales Accounts

Contacts
Opportunities
Leads

Quotes
Forecasts
Contracts*
Products*

Marketing Accounts
Contacts
Leads

Campaigns
Targets
Target Lists

Support Accounts Bug Tracker
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Contacts
Cases

Knowledge Base

Activities Calendar
Calls
Meetings

Emails
Tasks
Notes

Collaboration Emails
Documents

Knowledge Base
Projects*

Reports Reports Forecasts
Sugar administrators have the ability to change the default filters and to create
new ones. For more information on how to add or modify a module menu filter,
please refer to the Developer Tools documentation in the Administration guide.
If you do not see a specific module tab in the navigation bar, please check the
following:

The module may be marked as hidden in your user preferences which will
prevent the module tab from being displayed. Navigate to your user profile
(upper right of Sugar), click the Advanced tab, and check the Layout Options
section. If you see the module in the Hide Modules list, simply move it to the
Display Modules list. For more information on hiding and displaying modules,
please refer to the Layout Options section of the Getting Started
documentation.
The administrator may have disabled the module for your entire Sugar
instance. Reach out to your Sugar administrator to have the module
displayed. Not all modules are enabled by default when installing Sugar. The
modules listed above with an asterisk (*) are hidden by default. For more
information on displaying and hiding modules throughout Sugar, please refer
to the Developer Tools documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar.

 
To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. When Full Text Search is not enabled, results starting with
your keyword will appear after clicking the magnifying glass icon or hitting your
Return/Enter key. For more information on using and configuring Global Search,
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please refer to the Global Searchsection of the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Studio documentation as well as the Search section of the
System documentation in the Administration guide.

Notifications

The notifications indicator will display for admin users only and if there are system
notifications. The notifications are typically system or configuration warnings with
links to the appropriate section in Sugar to remedy the situation. Click on the
notification number to open the notifications window. Click the "X" in the top right
of the notification window to close out the window.

 
Follow instructions and links inside the notification window to remedy the
warning.

User Menu

The user menu consists of your user picture and name. Clicking on this section
pulls open a menu of additional operations.
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The user menu allows you to perform the following operations:

Menu Item Description
Profile View your user profile, change your

password, and personalize aspects of
Sugar

Employees Navigates to the Employees module list
view to search and view Employee
records; users with administrative
privileges can also create and edit
employees
Note: Every user is listed as an
employee; however, not every employee
has to be a user in Sugar.

Admin Navigates to the Administration page to
configure and customize many aspects
of Sugar
Note: Available only if you have
administrative or developer privileges in
a specific area.

Support Opens a new window directly to
support.sugarcrm.com to access Sugar
documentation, knowledge base,
forums, and the case portal

About Navigates to the About page which
displays the current edition, version,
and build of Sugar as well as credits and
source code references

Log Out Logs the current user out of Sugar and
returns you to the login page

Quick Create
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The Quick Create menu allows you to easily create new records for various
modules from anywhere in Sugar. Simply click the quick create button on the
upper right of all Sugar pages to access the menu. Five modules are initially
displayed in the menu; click "Show More" to view any additional modules enabled
for this shortcut.

 
Up to ten modules may be enabled for the Quick Create menu at a time.
Administrators can configure which modules are enabled in the Quick Create
menu. For more information on how to add or remove modules from the Quick
Create menu or to change the order of the modules in the menu, please refer to
the Developer Tools documentation in the Administration guide.
Clicking on an item in the Quick Create menu will launch the quick create form for
the module specified. The quick create form is a shortened version of the module's
edit view and typically contains fewer fields. When using quick create to make a
record while viewing an existing record of another module where there is a
relationship between the two modules, Sugar automatically creates a relationship
between both records. For example : if you are viewing an account record (e.g.
SugarCRM Inc) and create a new contact via the quick create form, the Account
Name field in the contact record will automatically populate with "SugarCRM Inc",
thus creating the link between the two records. The quick create layout can be
configured by administrators via Admin > Studio. For more information on
configuring layouts, please re fer to the Studio documentation in the
Administration guide.
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Click "Save" to complete the quick create or to abort the process click "Cancel" or
the "X" in the top right hand corner. Alternatively you can click the Full Form
button to navigate to the module's edit form to add more details to the record
before submitting.

Footer

Sugar 6.5 introduced a collapsible footer that displays the SugarCRM logo and
links to enabled third-party integrations. Widgets or integrations created by a
third-party that used to be displayed as icons in the top navigation bar (formerly
known as the Shortcut Bar) are now automatically displayed in the footer, after
upgrading to Sugar 6.5. Icons can no longer be inserted in the top navigation bar
in Sugar.
The footer consists of the following from left to right:

Logo : An administrator can replace the SugarCRM logo with your company's
logo through Admin > System Settings. For more information on how to
change the logo in the footer, please refer to the System Settings
documentation in the Administration guide. Hover over the logo to view the
server response time for the current page load time.

 
SugarCRM Link : The middle of the Footer contains the copyright
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information. This is also a link to www.sugarcrm.com

 
Widgets : To the right of the SugarCRM link, any third-party widget icons will
appear here.
Tour : Launches the "What's new in Sugar" tour to display some recent
additions to your version of Sugar.

 
Help : This is a context-aware link to the Application Guide. For example, if
you click on the Help link in the Contacts module, you will be directed to the
Contacts section of the Application Guide.

 
Hide : The down arrow to the right of the footer will hide the entire footer
bar.

 

Separate from the footer bar, but located at the bottom of each page is a Print and
Back to Top link. Click the Print link to open a print dialog for the current page.
Click "Back to Top" to instantly return to the top of the current page.

 

List View

Each module in Sugar contains a list view to search and display records in a table
format. To access a module's list view, simply click on the module tab in the
navigation bar.

 
The list view displays all records meeting the current search criteria and to which
your user has access. By default, Sugar sorts records in descending order of their
creation date. You can view the basic details of each record within the field
columns or select the record name to view it in the detail view.
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Please note that you will only be able to see records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentations in the Administration guide.

You have the option to change what fields are displayed in each module's list view
by configuring your layout options in the Advanced Search. For more information
on configuring your list view, please refer to the Layout Options section of the
Search documentation. Users with administrator or developer access also have the
ability to change what fields are visible in the list view via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation in
the Administration guide.

Basic Search

The basic search is at the top of the list view for each module and offers a few,
commonly used fields for a simplified search experience. From the Basic Search
panel, you can click "Advanced Search" to access additional search functionality as
needed.
The following buttons and checkboxes are common across many modules' Basic
Search panel and have the following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 
When you run a search, Sugar will return records matching all (as opposed to any)
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of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a name or subject, Sugar will only return records with
a matching name or subject that are assigned to you. Once the search is complete,
the relevant results will populate in the list view below the search panel. To see all
records to which you have access within the module, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
Administrators can configure what fields appear on the Basic Search for each
module via Admin > Studio. For more information on editing layouts, please refer
to the Studiodocumentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The following buttons, checkboxes, and dropdowns are common across many
modules' Advanced Search and have the following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.
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When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a field to search, Sugar will only return records matching
that field that you have marked as favorites. When searching by a multiselect or
dropdown field (i.e. "Assigned to"), however, Sugar will return records matching
any of these selections. Once the search completes, the relevant results will
populate in the list view below the search panel. To see all records to which you
have access within the module, simply click "Clear" and then "Search" to perform a
blank search with no filters. Please note that you will only be able to see records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentations in the Administration guide.
Administrators can configure what fields appear on the Advanced Search for each
module via Admin > Studio. For more information on editing layouts, please refer
to the Studiodocumentation in the Administration guide.

Selecting Records

The list view in Sugar allows you to select a single record to view by clicking on
the name or subject of the record to open it in the detail view. You can also select
many records at once and perform certain actions on those records. Use the
following methods for selecting multiple records on module list views:

One By One : Click the checkbox next to each individual record you wish to
select.

 
Select This Page : Click the checkbox at the top of the list view to select all on
the current page. You can also click the arrow next to the checkbox and click
"Select This Page"
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Select All : Click the arrow next to the checkbox at the top of the list view and
click "Select All"

 
Note: When using Select All you can not unselect single records, but will have
to use "Deselect All"

When selecting records you can page through all of the records and Sugar will
remember which records are selected. Depending on your Sugar settings you may
see the count of records being selected or you may see a plus sign (+) to refer to
more records. Click the arrow next to the checkbox and click "Deselect All" to
remove any selected record despite how they were initially selected.
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Action Menu

Once you have selected one or more records in the list view you can perform
certain actions on those records. The module you are in determines the available
actions. To access the action menu simply click the down arrow next to the Delete
action button.

 

The actions menu provides possible actions such as Delete, Email, Mass Update,
Mail Merge, Merge, Add to Target List, and Export for one or more records. Not all
modules have all actions available. The sections below will cover the most common
actions across the modules. For more information on actions available within a
specific module, please refer to the list view section in the application guide
pertaining to that module.

Delete Records

The list view in Sugar allows you to mass delete records easily. When deleting
records in Sugar, they are not permanently deleted from the database, but are only
put into a deleted status so Sugar will not see them. These records can be
recovered by anyone with direct database access.
Use the following steps to delete one or more records via the list view:

1. Navigate to the list view by clicking the module tab in the navigation bar.
2. Use the Basic or Advanced Search to find the records you wish to delete.
3. Select the desired records individually or use the

{{web.link("#Selecting_Records","checkbox dropdown's")}}options.
4. Choose "Delete" from the Actions menu.
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5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of records. If you encounter an
error when performing this action, we recommend selecting the records in smaller
batches.
When deleting a record, any records related to that record will not be deleted. For
example: Deleting an account record will not delete any of the contacts on that
account; although, it will delete the record that associates each contact to the
account.

Mass Update Records

Mass Updating allows users to make the same change to multiple records at one
time from the list view. Users with administrator or developer level access can
control which fields are available during mass updates via Admin > Studio.
Currently, only fields with the data type of date, datetime, dropdown, multiselect,
and radio may be altered during a mass update. For more information on
configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of records. If you encounter an error when performing this action, we recommend
selecting the records in smaller batches.
Please note that your ability to mass update may be restricted by a role. For more
information on roles, please refer to the Role Management documentation in the
Administration guide. Check with your system administrator if you do not see the
Mass Update option.
Use the following steps to mass update records from the list view:

1. Navigate to the list view by clicking the module tab in the navigation bar.
2. Use the list view's Basic or Advanced Search to identify records you wish to

modify.
3. Select the desired records individually or using the

{{web.link("#Selecting_Records","checkbox dropdown's")}}options.
4. Choose "Mass Update" from the Actions menu.
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5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected records.

Merge Records

When duplicate records are identified in Sugar, you have the option to merge two
or more records into a single record. Once the merge is complete, the duplicate
record(s) will be deleted, and the primary record will remain. Please note that all
relationships belonging to the duplicate records will be merged to the primary
record meaning that any calls, meetings, cases, notes, etc. related to the duplicate
record(s) will automatically be related to the resulting, merged record.

Basic or Advanced Search may be used to identify duplicate records by, for
example, searching for records with similar names or related records. Once your
search has identified duplicate records, you can merge them directly from the list
view. Alternatively you can perform a "Find Duplicates" operation in the detail
view of a record. For more information on finding duplicate records from the detail
view, please refer to the section Find Duplicates in this documentation.
Use the following steps to merge records via the list view:
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1. Use the list view's Basic or Advanced Search to identify duplicate records.
2. Possible duplicates will be displayed in the list view. Select the duplicate

record(s) that you wish to merge.

 
3. Select "Merge" from the Actions menu to display the Merge page. The

primary record's field values are displayed on the left while other record's
values are in columns to the right. Saving the merge will preserve only the
leftmost values for each field into a single record.

 
4. The system treats the first record that you select as the primary record. To

change which record is considered the primary, click the "Set as primary"
double arrows.

5. Review the field values in each column and use the associated double arrows
to move the best value for each field to the leftmost column.

6. Click "Save Merge" once the left column contains all fields you wish to appear
on the single, merged record.

7. A pop-up message will display confirming that the duplicate record(s) should
be deleted. Click "Ok" to proceed.

Export Records

Sugar's Export option allows users to download all fields for the selected records
to their computers as a .CSV (comma-separated values) file. This may be useful
when needing to use data with other software such as Microsoft Excel or to update
existing records by exporting, making changes, then importing the altered records
back into Sugar. For more information on updating existing records via import,
please refer to the Import documentation. Due to PHP memory limitations on the
server, there may be occasions when the application times out while exporting a
large number of records. If you encounter an error when performing this action,
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we recommend selecting the records in smaller batches.
Records may be exported from the list view by selecting "Export" from the Actions
menu. Users with access to the Reports module also have the option of creating or
accessing reports containing specifically chosen fields for records and their related
record(s). Please note that only Rows and Columns-type reports have the ability to
be exported. For more information on exporting records in Sugar, please refer to
the Export documentation.

 
Please note that your ability to export from Sugar may be restricted by a role. For
more information on roles, please refer to the Role Managementdocumentation in
the Administration guide. Check with your system administrator if you do not see
the Export option.

Favoriting Records

Each Sugar user has the option to designate their own favorite records within
modules which are important or will be viewed often so that they can easily be
accessed via search or from the module tab. Once records are marked as favorites,
use the My Favorites checkbox in the Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the module tab.
Use the following steps to mark records as favorites via the list view:

1. Navigate to the list view by clicking the module tab in the navigation bar.
2. Use the Basic or Advanced Search to find the records you wish to mark as

favorites.
3. Mark the star icon on the left of each desired record's row.
4. To remove the record as a favorite, click the star again to revert it to white.

 83 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Export
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface/#Advanced_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface/#Advanced_Search


 

 

Quick Edit

The quick edit is available in most modules' list view and subpanels. You can quick
edit records via the list view by clicking the Pencil icon to the left of each record's
name or subject. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. This allows you to make quick changes to
records without navigating away from the page currently being viewed.
Use the following steps to quick edit records via the list view:

1. Navigate to the list view by clicking the module tab in the navigation bar.
2. Use the Basic or Advanced Search to find the records you wish to edit.
3. Click the Pencil icon to the left of each record's name or subject to display the

quick create form.

 
4. Update the necessary fields, then click "Save" to preserve the changes.

 84 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface/#Advanced_Search


 

 
Note: If you want to make detailed changes, click Full Form to navigate to the
edit view for that record.

5. Repeat steps 3 and 4 for the remaining records to be modified.

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.
Administrators in Sugar may configure both the edit view and quick create via
Admin > Studio. For more information on configuring layouts, please refer to the 
documentation in the Administration guide.

Sorting Records

The List view in Sugar provides the ability to sort all of the current search results
by a field column in either ascending or descending order. To sort by a field simply
click the column header noting that the fields which allow sorting will have a pair
of arrows next to it. Columns with no arrows next to them are not sortable (i.e.
Email Address).

 
Click the column header again to reverse the sort order. The list view may be
sorted by only one column at a time. You can also set a default order-by column
using the layout options in Advanced Search. For more information on setting a
default column sort, please refer to the Layout Options section of the Search
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documentation.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed.

 
The two single-arrow Next and Previous buttons can be used to scroll through the
records page-by-page.

 
The two double-arrow First Page and Last Page buttons allow you to skip to the
beginning or the end of your current results.

 

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

More Information

Many modules have a method for viewing more information about a record in the
list view. Additional details can be viewed by clicking the "i" icon to the far right of
each list view row.
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This provides users a quick view of additional information in addition to what
appears in the display column fields. The resulting pop-up window will show the
additional fields configured by default. The list of fields appearing here may only
be configured through a code-level customization. Click the "X" to close the
Additional Details window.

 

Detail View

Each module in Sugar contains a detail view to view and perform actions on a
single record within a module. To access a record's detail view, simply click on the
name or subject link from anywhere in the application including from the module's
list view.

 

The detail view displays thorough information of the record grouped by
module-specific field panels.
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You can also view the record's related records which appear in subpanels beneath
the field panels. Which subpanels show here is based on the relationships defined
for the current module and administrative settings on which subpanels to display.
You can also expand and collapse subpanels as well as reorder them. For more
information on how to change the display of subpanels, please refer to the 
Subpanels section. Users with administrator or developer access have the ability to
change the fields (i.e. Name, Assigned User, etc.) and labels of each subpanel by
configuring the layout via Admin > Studio to provide visibility to the most
important fields. For more information on modifying subpanels, please refer to the 
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Please note that you will only be able to view a record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management
documentations in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Pagination

On the upper right of the detail view, there are two buttons that allow you to page
through each contact in the list view's current search results. Clicking the Previous
button displays the previous record of the current search results while clicking the
Next button displays the next record of the current search results.

 
The text in between shows which record result you are currently viewing within
the total number of current results.
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Depending on your Sugar settings you may see the count of records being selected
or you may see a plus sign (+) to refer to more records.

 

Action Menu

The Actions menu on the top left of each detail view allows you to perform various
actions on the current record.

 

The actions menu provides possible actions such as Edit, Duplicate, Delete, View
Change Log, Find Duplicates, and many others to perform on one record. Not all
modules have all actions available and many actions are built for only a single
module (i.e. Convert Lead). The sections below will cover the most common actions
across the modules. For more information on an action not listed here, please refer
to the Detail View Action Menu section of the module's documentation in the
application guide.
Administrative users can change the action items to be displayed as separate
buttons instead of a dropdown menu via Admin > System Settings. For more
information on configuring the actions menu, please refer to the System
documentation in the Administration guide.
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Edit a Record

You can edit records via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve the changes made.

 

For more information regarding the edit view and hos to edit records in Sugar,
please refer to the Edit View section of this documentation.

Duplicate a Record

You can create a new record by duplicating an existing record from the detail view.
The duplicate option is useful if the record you are creating has similar information
to an existing record. Any related records on the source record will not be
duplicated over to the new record.
Use the following steps to create a record by duplicating an existing record:

1. Navigate to a record's detail view.
2. Click the Actions menu and select "Duplicate".
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3. The displayed edit view is pre-populated with the original records values.

Update the necessary fields, then click "Save".

Delete a Record

The detail view in Sugar allows you to delete a record. When deleting records in
Sugar, they are not permanently deleted from the database, but are only put into a
deleted status so Sugar will not see them. These records can be recovered by
anyone with direct database access.
Use the following steps to delete a record via the detail view:

1. Navigate to a record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Find Duplicates

The find duplicates action in Sugar is useful for checking a specific record for any
duplicate records that may exist in the same module. Not all modules have the find
duplicates action and the action can currently only be performed on one record at
a time. Find duplicates is available from the detail view of the Accounts, Contacts,
Opportunities, Leads, Cases, and Bug Tracker modules.
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Please note that your ability to use the Find Duplicate action may be restricted by
any role which prevents deletion. For more information on roles, please refer to
the Role Management documentation in the Administration guide. Check with your
system administrator if you do not see the Find Duplicates option.
Use the following steps to find duplicate records via the detail view:

1. Navigate to a record's detail view.
2. Select "Find Duplicates" from the Actions menu.

 
3. This step of the process allows you to select which fields will be searched on

within the module to find potential duplicate records.
4. Select any field from the Available Fields panel and click the Right arrow to

add them as a filter.

 
5. To remove a filter, simply click the "Minus" icon next to the filter.

 
6. When you are happy with the filters, click "Next Step" to proceed.

Note: Sugar will perform an "and" operator between the filter criteria. For
example : A filter for First Name: "robert" and a Last Name: "smith" will look
for records that match "robert" and "smith". So a Contact with a name of "Bob
Smith" will not be found as a duplicate.
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7. A list view will populate with any results that match your filters. Select any
records that you wish to have merged with the original record and click
"Perform Merge".

 
8. From this point you may follow the steps outlined in the Merge Records

section in this documentation to complete the merge.

Get Data

The Get Data action is only available for the Accounts module by default but can be
enabled for many other modules. Get Data will connect out, using Sugar's
connectors, to third party data providers to query and return basic information on
a company or person. By default the only data connector enabled is the Hoovers
connector.
The following connectors are available by default in Sugar:

Hoovers
Zoominfo - Company
Zoominfo - Person

Users with administrator access have the ability to enable and configure
connectors via Admin > Connectors. For more information on enabling and
configuring connectors, please refer to the Connectors section in the System
documentation in the Administration guide.
Use the following steps to find and merge Account data via the detail view:

1. Navigate to an account record's detail view.
2. Select "Get Data" from the Actions menu.
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3. The "Search and View Data" screen will appear with the current account's

name populated in the Company Name search field.

 
Note: The contents of this search field can be modified if you are not seeing
the results you are looking for. Simply type in a new value into the Company
Name field and click "Search".

4. The search results are displayed below, separated in tabs by which
connectors you have enabled. The search fields can be different for each
connector and can be configured via Admin > Connectors. For more
information on configuring connectors, please refer to the Managing
Connector Search section in the System documentation in the Administration
guide.

 
Note: You can hover over the "i" icon to get more information about the data
pulled from the connector.

5. Select the record from the data connector you wish to merge with your record
in Sugar and click "Merge".
Note : If multiple connectors are enabled, you can select one record in each
connector to merge data from multiple sources.
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6. You will now see your record data currently in Sugar on the left side of the

screen and the external data from each connector to the right hand side.

 
7. Click the double arrow at the top of a connector's column to move all data

from that connector over to Sugar.
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8. Alternatively you can select the double arrow next to each individual field to

move select data over to Sugar.

 
9. A convenient way to move data into Sugar is to use the Smart Copy feature

which will move data from the right most connector first. If a field exists in a
different connector than the right most, it will move over to Sugar from that
connector instead of leaving the field blank.

 
Note: The columns on the left side are highlighted the corresponding color of
the connector to which the data was populated from.

10. Once the data in the left hand column matches what you want the Sugar
record to contain, click "Save" to complete the merge.
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View Change Log

Changes made to each record are tracked over time, and for most modules users
are able to view the history of changes via the change log in each record's detail
view. To view the change log, navigate to a record's detail view and select "View
Change Log" from the Actions menu. Please note that only fields marked as "Audit"
in Admin > Studio will be displayed in the change log. For more information on
designating a field for audit, please refer to the Studio documentation in the
Administration guide.

 

Field Panels

Field panels are what hold the fields for a record in the detail view. Most modules
come with three panels defined by default: Overview, More Information, and
Other. Field panels can be collapse to hide unnecessary data.
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Users with administrator or developer access have the ability to change the fields
(i.e. Name, Assigned User, etc.) and labels inside the field panels as well as move,
create, and edit existing field panels via Admin > Studio to provide visibility to the
most important fields. Field panels can be collapsed by default and can also be
changed to display as tabs or to display as a combination of panels and tabs.

 

For more information on modifying field panels, please refer to the Studio
documentation in the Administration guide.

External Data Connectors

Sugar comes with many built in connectors to external data sources to enable you
to connect your Sugar data to common social media platforms. These integrations
can help to bring you closer to your customers and partners using social media.
The following are common connectors that are included by default with Sugar:
InsideView, Twitter, and LinkedIn. For more information on what connectors are
available and how to enable and configure them, please refer to the Connectors
section in the System documentation in the Administration guide.

InsideView

The InsideView subpanel, if you are an InsideView user, provides relevant
company information, news, and social media insights within your record's detail
view. The InsideView subpanel will appear by default on the detail view of the
Accounts, Contacts, Leads and Opportunity modules. Clicking the double arrow
next to "InsideView" can minimize the panel. Administrators in Sugar also have the
ability to disable InsideView for the entire instance or for specific modules so that
it is not visible to users. For more information on enabling or disabling InsideView,
please refer to the Enabling Connectors section of the System documentation in
the Administration guide.
When accessing the subpanel, InsideView performs a search based on values in the
Account name field or the Contact name and displays the results in the InsideView
panel. If InsideView finds multiple results it will provide you with the ability to
search and select the record that matches your Sugar record.

 99 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/System
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/System


 

 

From inside the subpanel you have the ability to read information on the company
or contact you are referencing. Here are some of the sections in InsideView that
you can take advantage of:

Company Information:
Overview
People
Buzz
Family Tree
Competitors

Contact Information
Current Employment
Contact Information
Recent News

For more information on the abilities of InsideView, please refer to their website at
www.insideview.com.
Note: The extent and depth of information that you can access in InsideView
depends on your InsideView subscription. For more information, see: 
http://www.insideview.com/compare-insideview-plans-free-crm-pro-and-team-sales
-intelligence

Twitter

Sugar provides two different features for Twitter integration:

Integrate your Twitter feed into the Activity Stream
View Tweets from module detail views

To integrate your Twitter feed into the Activity Stream on your homepage a Sugar
administrator will have to configure the Twitter connector from the Admin >
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Connectors page. For more information on how to integrate Twitter into user's
Activity Stream, please refer to the Connectors section of the System
documentation in the administration guide.
Use the following steps to view tweets from a company or person via the detail
view:

1. Navigate to a record's detail view for a module that has the Twitter connector
enabled.
Note: Twitter is enabled by default for the Accounts, Contacts, Leads, and
Targets modules. Sugar administrators can enable or disable modules via
Admin > Connectors.

2. Select the Twitter icon next to the record's name.

 
3. By default the Twitter connector will use the following fields to connect to a

Twitter account:

Module Field
Accounts Name
Contacts Full Name
Leads Account Name
Targets Account Name
Note: The field must match identically to a Twitter user name or the Twitter
window will not show any results. We recommend creating a new field in each
module you have Twitter enabled to store the exact Twitter user name of the
Account, Contact, Lead, or Target. A Sugar administrator will then have to
point the Twitter connector at this field to make the link. For more
information on how to configure which field is used for the Twitter connector,
please refer to the Mapping Connector Fields section of the System
documentation in the administration guide.
A popup window shows the most recent activity for the Twitter user name.
From this window you can perform the following actions in Twitter:

Reply
Retweet
Favorite
Navigate to the Twitter user's homepage

Note: You will need to have an account and be logged in to Twitter to perform
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these actions.

 

LinkedIn

The LinkedIn connector allows users in Sugar to view any connections they have to
companies or people through LinkedIn. When logged in to LinkedIn, you will see
any company matches and any connections your LinkedIn account has with any
people in that company.

Use the following steps to view LinkedIn information from a company or person via
the detail view:

1. Navigate to a record's detail view for a module that has the LinkedIn
connector enabled.
Note: LinkedIn is enabled by default for the Accounts, Contacts, Leads, and
Targets modules. Sugar administrators can enable or disable modules via
Admin > Connectors. For more information on how to enable the LinkedIn
connector for more modules please refer to the Enabling Connectors section
of the System documentation in the administration guide.

2. Select the LinkedIn icon next to the record's name.
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3. By default the LinkedIn connector will use the following fields to connect to a

LinkedIn company name:

Module Field
Accounts Name
Contacts N/A
Leads Account Name
Targets Account Name
Note: The field matches up to only a LinkedIn Company Name, not a person
name.
A popup window shows any connections to people you have at the company
located. From this window you can perform the following actions in LinkedIn:

Follow the Company
View Connections
View the Company's LinkedIn Page

Note: You will need to have an account and be logged into Twitter to perform
these actions.

 

Subpanels

The Detail View of a record displays related information in subpanels. Each module
has a subpanel that consists of rows for each related record. Each subpanel has
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some default actions to create new records in the related module or to link an
existing record. Some subpanels are different or have special actions and
behaviors.

InsideView

The InsideView subpanel, if you are an InsideView user, provides relevant
company information, news, and social media insights within your record's detail
view. The InsideView subpanel will appear by default on the detail view of the
Accounts, Contacts, Leads and Opportunity modules. The subpanel will be
collapsed by default until you expand it and agree to InsideView's Terms of use and
Privacy Policy.
For more information on InsideView, please refer to the InsideView section in the
External Data Connectors section in this documentation.

Activities and History

The Activities and History subpanels are special subpanels in Sugar that show data
from multiple modules based on certain criteria. For example: A meeting with a
status of Planned will show in the Activities subpanel. If you then change the
meeting to have a status of Held, it will move from the Activities subpanel to the
History subpanel. All related note and email records will show in the history
subpanel as there are no filters on those modules, but notes and emails will never
show in the Activities subpanel. If you customize the status field for any of the
modules the records that hold a custom status will show in the Activities subpanel,
but code level customizations would be required to have a new status show in the
History subpanels.
Please refer to this chart for the criteria both subpanels use to query data:

Subpanel Module Status Field Filter
Activities Meetings Does not Equal "Held"

Does not Equal "Not Held"
Tasks Does not Equal

"Completed"
Does not Equal "Deferred"

Calls Does not Equal "Held"
Does not Equal "Not Held"

History Meetings Equals "Held"
Equals "Not Held"

Tasks Equals "Completed"
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Equals "Deferred"
Calls Equals "Held"

Equals "Not Held"
Emails N/A
Notes N/A

Since the activities and history subpanels contain records from many different
modules, there are some differences in the actions and record display than in
normal subpanels. Each record in both subpanels will have an icon to the far left
indicating which module the record is from. For example: If the record is a call
then the icon will show as a telephone.

 
Hover over the icon to get a tooltip of what module the record belongs to.

 

Normal subpanels typically have a Create and Select option to create or link
related records. The Activities and History subpanels have multiple actions due to
the fact that there are multiple modules involved.
You have the following actions available from the Activities subpanel:
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Create Task : Creates a new task record related to the record currently being
viewed.
Schedule Meeting : Creates a new meeting record related to the record
currently being viewed.
Log Call : Creates a new call record related to the record currently being
viewed.
Compose Email : Launches the Compose Email popup while relating the new
email to the record currently being viewed as well as populating the email
address from the record in the "To".

Note: When creating a Task, Meeting, or Call from the Activities subpanel, you
have the ability to set the status field to an option that will place it in the History
subpanel.

 

You have the following actions available from the History subpanel:

Create Note or Attachment : Creates a new note record related to the record
currently being viewed.
Archive Email : Allows a received email to be entered manually on a record
for historical purposes only.
Note: This will not send an email to you or the email address on the record.
View Summary : Opens a popup window with the Subject, Status, and Detail
of all records in the History subpanel. This is useful to see a step-by-step
history of all of the records and the details of each on one page.
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Tab Groups

Sugar by default will display all associated subpanels in the detail view. Users have
the ability to filter subpanels into tab groups by selecting the predefined tabs
below the inside view panel.

 
The tab groups are defined by the module filters configured in Admin > Configure
Module Menu Filters. For more information on how to add or modify a module
menu filter, please refer to the Developer Tools documentation in the
Administration guide.
Note: The Activities and History subpanels will always appear under the "Other"
tab and the "Other" tab can not be removed.

Layout

Subpanels in Sugar can be personalized by each user to display only the relevant
subpanels in a specific order:

Collapse / Expand : Click the double arrow on the top left of each subpanel to
either collapse or expand it.

 
Rearrange Subpanels : Click and drag the subpanel's header bar to move it up
and down on the page.
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Note: Administrators can prevent users from moving subpanels to different
locations in the detail view. For more information on preventing rearranging
of subpanels, please refer to the System documentation in the Administration
guide. Check with your system administrator if you are not able to rearrange
your subpanels.

Actions

Subpanels also provide some ability to add and edit related record data:

Create a new record to be related : Click the Create button to create a new
record for the module that the subpanel belongs to. The quick create form for
the module will appear inside the subpanel and the new record created here
will be automatically related to the main record.

 
Select an existing record to be related : Click the Select button in the action
menu to launch a search popup. This will allow you to locate an existing
record in the subpanel's module to relate to the main record.

 
You may also select multiple records in the search popup to be related to the
main record.
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Edit a related record : Click the Edit button on the related record inside the
subpanel to launch the quick create for the related record's module. Change
any existing data on the record and click Save.

 
Remove a related record : Click the unlink button from the action menu on
the related record inside the subpanel to remove the relationship between the
related record and the main record.

 
Note: This will not delete the related record, but will only remove the
relationship between the two records.

Users with administrator or developer access have the ability to change the fields
(i.e. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.
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Paging

Each subpanel shows related data for the record being viewed. Subpanels have
some abilities to help view and organize the data in the subpanels:

Sort Records : Click the column header to sort by that column, clicking again
to reverse the sort direction. Sortable fields will have a pair of arrows next to
the column name and each subpanel may be sorted by only one column at a
time.

 
Record Paging : The top right of the subpanel shows which records of the
total are currently being displayed. The two single-arrow Next and Previous
buttons can be used to scroll through the records page-by-page. The two
double-arrow First Page and Last Page buttons allow you to skip to the
beginning or the end of the set.

 
Note: By default, Sugar displays 10 records per subpanel page, but
administrators can change the number of records displayed via Admin >
System Settings. For more information on changing the number of displayed
records, please refer to the System documentation in the Administration
guide.

Record Actions

Subpanels can have a variety of actions that can be performed from the record
within the subpanel. Each record has a link to view the record within it's own
module. Typically this is the name or subject field of the record in the subpanel.

 
Email addresses become a link in subpanels. Click this link to launch the compose
email popup with the email address pre-populated in the "To" field.
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Edit View

Each module in Sugar contains an edit view to change details on a single record
within a module. To access a record's edit view, simply click on the Edit button
from the detail view.

 
The edit view displays thorough information of the record grouped by module
specific field panels.

 
Please note that your ability to edit records in Sugar may be restricted by a role.
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For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.
Administrators in Sugar may configure both the edit view and quick create via
Admin > Studio. For more information on configuring layouts, please refer to the 
documentation in the Administration guide.

Pagination

On the upper right of the edit view, there are two buttons that allow you to page
through each record in the list view's current search results. Clicking the Previous
button displays the previous record of the current search results while clicking the
Next button displays the next record of the current search results while keeping
you in the edit view.

 
The text in between shows which record result you are currently editing within the
total number of current results.

 
Depending on your Sugar settings you may see the count of records being selected
or you may see a plus sign (+) to refer to more records.

 
Once any edits are complete, you may click "Save and Continue". This will save the
details in the current record and proceed to the next record in the current search
results.
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Field Panels

Field panels are what hold the fields for a record in the edit view. Most modules
come with three panels defined by default: Overview, More Information, and
Other. Field panels can be collapsed to hide unnecessary data.

 

Users with administrator or developer access have the ability to change the fields
(i.e. Name, Assigned User, etc.) and labels inside the field panels as well as move,
create, and edit existing field panels via Admin > Studio to provide visibility to the
most important fields. Field panels can be collapsed by default and can also be
changed to display as tabs or to display as a combination of panels and tabs.

 
For more information on modifying field panels, please refer to the Studio
documentation in the Administration guide.
Note: When displaying panels as tabs, required fields on a tab that is not currently
select is still required and will need to be filled in before saving.

Editing Records

The edit view's primary purpose in Sugar is to allow the editing of a record. Once
you have made the desired modifications to a record's fields, click "Save" to
preserve the changes. You can click "Cancel" at any time to return to the previous
page without editing the record.
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Administrators in Sugar may configure both the edit view via Admin > Studio. For
more information on configuring layouts, please refer to the Studio documentation
in the Administration guide.
Please note that your ability to edit records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Managementdocumentation
in the Administration guide. Check with your system administrator if you do not
have the ability to edit records.

Editing Common Fields

There are many different types of fields in Sugar, the most common of them being
text, number, dropdown, multiselect, radio, and checkbox fields.

Text : Allows any text input with the only validation options being number of
characters or required.

 
Note: If a maximum character length is placed on a text field, the input box
will not allow users to enter in more than that number of characters. This can
be misleading, as there is no visible error other than the missing characters.
The field above was limited to ten characters.
Number : Allows any number input with possible validation of a minimum and
maximum as well as required.

 
Dropdown : Provides a list of options where the user can pick only one. Blank
can be a valid option; although, the field can be set to be required to not allow
blank.

 
Multiselect : Provides a list of options where the user can pick one or more.
To select multiple, hold the Ctrl button (command on MAC) on your keyboard
and then click multiple options. Blank can be a valid option; although, the
field can be set to required to not allow blank.
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Radio : Provides a list of options where the user can pick only one. Blank can
be a valid option; although, the field can be set to be required to not allow
blank.

 
Checkbox : Provides a boolean type typically used to answer a Yes or No
question.

 

Editing Date and Time Fields

Sugar provides special date and time fields to ensure data is entered in a format
that the application can read and process.

Date : Click the calendar icon next to a date field in order to open the date
picker.

 
Click a day in the Calendar grid to enter that date into the date field.

 
Use the left and right arrows to go back and forward by one month.
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Click on the currently displayed month and year to pick a new month and year
to view the calendar.

 

 
Click on the Today button to return the view back to today's date.
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Time : Time fields in Sugar are dispalyed as three dropdown fields moving left
to right to build the time: Hours, Minutes, AM/PM.

 
Note: Minutes are selectable only in 15 minute intervals.

Editing Related Fields

Sugar contains many different relationships between different modules and a
couple of different relate fields for users to create relationships with.

Relate : Most one to many relationships in Sugar are represented by a relate
field. You will recognize relate fields by locating a field with an arrow and an
"X" button next to the field. Click the arrow to open the record selection
window:

 
Alternatively you can begin typing into a relate field and Sugar will pull up a
list of records matching your typed records for that relationship:

 
Flex Relate : Allows a dynamic module and a record from that module to be
related to the current record. This allows the user to pick which module they
want this record to be related to.
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Once a module is selected, users can then select the record from that module
by using the arrow button or by typing into the box.

 
Email Addresses : Email address fields can be linked to many different email
addresses for a single record. Click the Plus button to add an email address to
a record.

 
Each email address can be set as Opted Out or Invalid. Only one email
address can be selected as the Primary. Click the minus sign to remove an
email address from a record.

 
Teams : The team field specifies which team or teams of users have visibility
of each record. If there are multiple teams on a record, click "Show" to view
all of the teams.

 
Click the Arrow icon to open the team selector window, or click the Plus icon
to add a new row to use the type-ahead feature.
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Click the Minus icon to remove a team from the record and select only one
team to be the primary team.

 
For more information on teams, please refer to the Team Management
documentation in the Administration guide.

TinyMCE

TinyMCE is a third-party WYSIWYG tool that allows users to provide HTML
formatting in specific sections in Sugar without requiring any HTML knowledge.
TinyMCE is available when sending email, creating email templates, creating
knowledge base articles, as well as other places within Sugar.

 

The following are some descriptions of the more commonly used features in
TinyMCE:

Text Formatting : Use the folllowing buttons to format text to be bold, italics,
underlined, or stricken through.

 
Alignment : Use the following buttons to change the alignment of the text to
be left, center, right, or justified.
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Fonts : Use the following dropdowns to select special section formatting,
fonts, and sizes.

 
Layout Formatting : Use the following buttons to utilize bullet list, ordered
lists, and tables.

 
Links and Images : Use the following buttons to create a link, remove a
current link, or add an image.

 
Advanced HTML : Click the HTML button to view your content in full HTML
code. You may add and change the HTML to furthur refine your content.

 
Not all HTML is allowed to be saved in Sugar. The following are some
examples of HTML that will be removed when saved:

Anything outside of the <body></body> tags.
Any <style></style> tags.
Any <script></script> tags.
Any <form></form> tags.
Any <input> tags.Note: Inline CSS can be added to some elements (e.g.

<p>, <pre>, and <span>), but due to different email client's rendering
HTML email in unexpected ways, inline CSS is not allowed on some elements
(e.g. <div>, <img>, and <table>).

Last Modified: 09/26/2015 06:25pm

Search
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Overview

Sugar comes with the ability to search across the entire system to easily locate and
filter records in all modules. A search can be performed within the list view of a
specific module to filter for data in that module, or a search can be performed in
the global search box located on every page. The global search is a quick way to
find a specific record where the module search makes finding a set of records for a
specific module easy. This documentation will cover how to use the Classic Global
Search, Full Text Global Search, Basic Module Search, and Advanced Module
Search.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. For
information regarding searching within a single module, please refer to the 
Module Search section in this documentation.
The Global Search bar is typically located on the top right hand side of each Sugar
screen. Sugar global search can be configured to use the classic mode or can be
enabled with full text searching. Classic global search requires users to enter a
text string to perform a search where full text provides a type ahead feature that
shows results as the user types.

 
Global Search may or may not be case-sensitive depending on your database
configuration. In general, global search on Sugar installations running on MySQL
and MSSQL databases are not case-sensitive. But global search on a Sugar
installation running on Oracle is case-sensitive by default. If your instance is
hosted on SugarCRM's on-demand platform, then its global search is not case
sensitive. This allows searches for "rob" with a lowercase "r" to locate contact
records with a name of "Rob" with an uppercase "R".
When you perform a search in global search and no results are returned, you can
select "Advanced Search" to perform a more granular search or change your global
search preferences.

 
For more information on the advanced search, please refer to the Advanced
Options section in this documentation.
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Full Text Global Search (FTS)

Beginning with version 6.5.0 of Sugar, global search can be enabled with full text
searching abilities utilizing the elasticsearch engine. Full text search (FTS) allows
users to search throughout all fields and modules for an enhanced search
experience.
Note : Not all fields in Sugar are enabled by default for search, but can be enabled
by an administrator. For more information on how to enable and disable fields and
modules in FTS Global Search, please refer to the Studio documentation in the
Administration Guide.
Instances hosted on SugarCRM's On-Demand platform have FTS enabled by
default and can not be disabled through the Admin page. Enabling full text search
will improve the overall performance in global search as well as enhance the
search experience for users. For more information on how to enable and configure
FTS global search, please refer to the System documentation in the Administration
Guide.
Use the following steps to search for a contact name using the full text global
search:

1. Click into the Global Search box in Sugar and type in your search.
2. FTS has autocomplete enabled; Sugar will start searching the system once

you enter in at least three characters into the search field.

 
3. Up to ten results are shown as well as the field that met your search criteria

for each result.
4. Click on the record name in the results dropdown panel to view the record

details.
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Wildcards

Wildcards can be used to search for criteria without including the entire word in
the search. Use a wildcard character in place of characters you do not require in
your search. Use may use any number of wildcard characters in any combination
you desire. The following wildcard characters can be used in the FTS global search
in Sugar:

Character Wildcard Use
% or * Matches any number of characters,

including zero
? Matches only one character
"" Matches the entire word or group of

words within the double quotes
- Removes results matching the phrase

following the minus sign
Note: FTS global search automatically appends the wildcard character (%) to the
end of your search phrase. This allows the system to pull up all records that
include the keyword entered in the search. If performing a multiple word search,
the wildcard is only appended to the last word, not all words. If you click the
search button or hit Enter/Return the wildcard will no longer be appended and
Sugar will only search for an exact match of your search criteria.
Use the following as examples to search using wildcards in FTS global search in
Sugar:

Search Criteria Would Match Would Not Match
rob Rob, Robert, Robin Bob, Jacob, problem
%bert Albert, Bert, Robert Bart
r?b Robert, Ruby Bob, Raab
%s?i Dustin, Christi, Smith Sophie, Josephine
??it Fritz, Smith Rita, Schmitt
r?b% AND smit% Robert Smith, RobSmite Bob Smith, Robert Phillip
rob smit Rob Smith, Rob Smite Robert Smith, Robert

Smite
"smith" Smith & Sons, Smith Corp Smithson Corp
"Rob Smith" Rob Smith, The Rob Smith

Corp
Rob Smitherson, Aaron
Smith

Smith -Rob Jane Smith Rob Smith, Robert Smith
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AND vs OR

As opposed to the classic search, full text global search uses the "or" operator by
default when multiple keywords are entered in the search box. For example :
Search for "Jim Smith" will look for records that match "jim" or "smith". In this
case the Robert Smith lead and contact will be returned despite the "jim" search
not matching the record, the "smith" search did. The lead Lonny Smith will also be
returned for matching on "smith".
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Another advantage FTS has is the ability to overwrite the default "or" operator
with an "and" operator. To use an "and" operator, simply add an all caps "AND"
between the two words you are searching for. Using the example above, in order to
exclude the lead Lonny Smith from our "robert smith" search, we can search
instead for "robert AND smith". This will look for records that match "robert" and
"smith". Now the Robert Smith lead and contact will return while excluding the
Lonny Smith lead.

 
Note : If the "AND" is not in all caps, then the search will consider it a keyword to
search on and will leave the operator as an "or" between the words.

View All Results

Click the View all results link at the bottom of the results window to see all of the
results from your search. Here you will be able to see the modules and their
respective counts on the left side of the page as well as the results of the search
towards the right.
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Here you can select which modules to show results for. The results section will
show ten results at a time. If you wish to see more, select the Load More button at
the bottom of the results.

 

Filtering by Module

FTS global search gives you the option to filter the search results by module in the
all results page. The filter by list has the "Show All" option checked by default to
show results from all modules. In order to just see matching records for specific
modules, you can mark the checkbox for that module in the Filter By list.
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Alternatively you can add a special command to your search criteria to filter the
results down to a specific module. For example, we want to search all fields in the
Leads module for anyone with the name of "Cliff". You could search for cliff and
then navigate to the all results page to filter out all modules except leads. You can
also enter the following into your search criteria: Leads._all:cliff

 
This tells FTS to search the leads module and all fields for the value cliff. This can
be done with any module that has FTS enabled, including custom modules.
For more information on how to filter by module and field name, please refer to the
Filtering by Field section below.

Filtering by Field

FTS global search has the ability to add a special command to your search criteria
to filter results out by field name or by module and field name. For more
information on how to filter by module only, please refer to the section Filtering
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by Module above.
For example, we want to search for records in any module with a name that
contains "plan". Searching for "plan" in the FTS global search returns records with
plan in the account name, email address, and any other field that is enabled for
searching.

 
If instead we search for name:plan, we only see records where the field "name"
contains the criteria off "plan".

 
If we want to continue to filter this down, we can add module to the criteria by
searching Accounts.name:plan.
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Note : The search criteria must have the proper module and field names and is
case sensitive. A lowercase "a" in accounts will return no results and if you are
filtering on the shipping address city field it must be specified as
shipping_address_city. The module and field name must match to the values shown
in Admin > Studio. For more information on accessing Studio, please refer to the 
documentation in the Administration guide.

Admin Configuration

Sugar administrators have the ability to globally enable and disable modules for
the FTS global search. A globally disabled module will not be included in the
results of a FTS global search and will not be available in the list of modules for
users to enable and disable in the advanced search section.
For more information on how to enable and disable modules for FTS global search,
please refer to the Search section in the System documentation in the
Administration guide.
Administrators also have the ability to enable and disable specific fields for FTS
global search as well as setting the priority of the field in the search. To give a
field a greater weight when searching you need to adjust that field's boost level.
When a search is performed, matching records containing fields with a greater
weight will be appear higher in the search results.
For more information on how to add or remove fields from FTS global search or to
change their boost level, please refer to the Studio documentation in the
Administration guide.
Note : If changes are made to your instance's full text configuration, users on
SugarCRM Mobile must log out and back in for the corresponding fields to be
displayed as expected.
FTS global search functions off of an index created from the data in your system.
When creating and updating records, data is added and modified in the index
accordingly. Occasionally the index can become corrupt or inefficient. When this
happens a system index is required. This can be performed manually from the
Admin > Search screen or can be scheduled by creating a scheduler for the
full-text search index system job in Admin > Schedulers.
For more information on how to run a system index on FTS, please refer to the 
System documentation in the Administration guide.
For more information on automating a system re-index, please refer to the 
Schedulers documentation in the Administration guide.
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Classic Global Search

The classic global search allows users to search based on certain stock fields such
as first name, last name, email address, office phone etc. You do not have the
ability to add or remove fields from the classic global search although your
administrator can add and remove modules. For more information on how to
include or exclude a module from the classic search, please refer to the System
documentation in the Administration guide.
Use the following steps to search for a contact name using the classic global
search:

1. Click into the Global Search box in Sugar and type in your search.
2. Hit the Enter key on your keyboard or click on the magnifying glass icon.

 
3. Up to five results are shown per search-enabled module.

Your Sugar administrator can control which modules show in the results. For more
information on how to enable and disable modules for the classic global search,
please refer to the Admin Configuration section in this documentation.
If your search results return more than five records for a specific module, you will
see a link stating how many more results there are for your search in the specified
module. Click on that link to view those additional results.

 
Alternatively you can click on the "x" in the search box to clear the search and
start over.
You can perform a multiple word search in the classic global search. Sugar classic
global search assumes an "and" operator between the words being searched. For
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example : A search for "Robert Smith" will look for records that match "robert" and
"smith". In this case, the Robert Smith lead and contact will be returned. A search
for "Jim Smith" will look for records that match "jim" and "smith". In this case the
Robert Smith lead and contact will not be returned as the "jim" search would not
match these records.

 

Wildcards

Wildcards can be used to search for criteria without including the entire word in
the search. Use a wildcard character in place of characters you do not require in
your search. You may use any number of wildcard characters in any combination
you desire. The following wildcard characters can be used in the classic global
search in Sugar:

Character Wildcard Use
% Matches any number of characters,

including zero
_ Matches only one character
Note : Classic global search automatically appends the wildcard character (%) to
the end of your search phrase. This allows the system to pull up all records that
include the keyword entered in the search. If performing a multiple word search,
the wildcard is only appended to the last word, not all words.
Use the following as examples to search using wildcards in classic global search in
Sugar:

Search Criteria Would Match Would Not Match
rob Rob, Robert, Robin Bob, Jacob, problem
%bert Albert, Bert, Robert Bart
r_b Robert, Ruby Bob, Raab
%s_i Dustin, Christi, Smith Sophie, Josephine
__it Fritz, Smith Rita, Schmitt
r_b% smit% Robert Smith, RobSmite Bob Smith, Robert Phillip
rob smit Rob Smith, Rob Smite Robert Smith, Robert

Smite
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Preview

Classic global search shows you the results of your search, but only shows you the
module the record is in and the name on the record. You can select each individual
record in the results to navigate to that record for more information. Alternatively
you can use classic global search's preview feature.
Use the following steps to utilize the preview feature after performing a search in
classic global search:

1. Hover over the name of the record you want to see more details of.
2. Click on the magnifying glass icon that shows up on the left side of the link.
3. A new popup window opens with more details about the record you selected.
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4. The fields shown are the fields that were included in the search and the
matched characters will be highlighted for each field. If you are not sure why
a result is being shown, clicking the preview should show you the exact field
in the record that was matched by your criteria.
Note : The highlighting does not work with wildcard searches.

5. Click the magnifying glass icon on a different record to pull the results of that
record or alternatively click the X to close the preview.

Show All

Click the Show All link at the bottom of the results window to see all of the results
from your search. This provides a better picture of your results as well as more
fields from each result and the ability to sort the results within their modules.

 
Each module enabled for classic global search will be displayed with a subpanel of
the results from your search. If there are no results in a specific module for your
search, in place of the subpanel will be a message that says "-- No Results --". From
each module's subpanel you have the ability to:

Filter out modules via the Advanced Option. For more information on how to
filter out modules in the advanced search, please refer to the Advanced
Options section in this documentation.
Sort the records in the subpanel by clicking on the column headers
Navigate through multiple pages using the paging buttons on the top right
Navigate directly to the record being shown by clicking on the name of the
record
Launch the Quick Create form to edit the record by clicking on the pencil icon
to the left of the record name

For more information on how to utilize the features of subpanels, please refer to
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the User Interface documentation in the Application Guide. 

Admin Configuration

Sugar administrators have the ability to globally enable and disable modules for
the classic global search. A globally disabled module will not be included in the
results of a classic global search and will not be available in the list of modules for
users to enable and disable in the advanced search section.
For more information on how to enable and disable modules for classic global
search, please refer to the Enabling Modules for Global Search section in the
System Administration documentation.

Advanced Options

The Advanced Options screen is available on the all results screen of the classic
and FTS global searches. This screen gives you the ability to enable or disable
specific modules for your login.
Use the following steps to filter out modules in the all results screen of the global
search:

1. Click the Advanced link to display the modules filter.
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2. Drag any modules you wish to disable from the left panel to the right panel

and then click the Search button in classic or the Save button in FTS.

 
3. The modules in the disabled panel will no longer show in your results. To

re-enable a module simply drag it back to the enabled panel on the left and
click search.
Note : Modules in the disabled panel are disabled only for the currently
logged in user and will affect any future classic or FTS global searches until
the module is re-enabled.

Sugar administrators have the ability to globally enable and disable modules for
the global search. If the administrator globally disables a module, you will not be
able to search that module or see it in the advanced search module filters. For
more information on how to globally enable and disable modules, please refer to
the System documentation in the Administration guide.

Module Search
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Almost every module in Sugar has a list view with basic and advanced search
functionality to help you find records easily and effectively in a module specific
manner. These module-specific searches differ from global search in that you
search by specific fields in a specific module, instead of across your entire Sugar
database.
Much like global search, module search has the ability to use wildcards and
automatically appends a wildcard character (%) to the end of your search phrase.
For more information regarding using wildcards in module searches, please refer
to the Wildcards section in this documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.
The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a record name, Sugar will only return records with a
matching name that are assigned to you. Once the search is complete, the relevant
results will populate in the list view below the search panel. To see all records to
which you have access, simply click "Clear" and then "Search" to perform a blank
search with no filters. Please note that you will only be able to see records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentations in the Administration guide.
Administrators can configure what fields appear on the Basic Search via Admin >
Studio. For more information on editing layouts, please refer to the Studio
documentation in the Administration guide.
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Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. The search
fields are context-sensitive and will vary depending on the module you are
searching. From the Advanced search panel, you can click "Basic Search" for
simplified searching.
The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
this documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of this
documentation.

 
Advanced search allows users to perform ranged searches on certain date or
numeric fields. Ranged search fields include a dropdown to select the type of
predefined search including the following options:

Date Fields : Equals, Last 7 Days, Last Month, Is Between, etc.
Depending on the option selected, there will be zero (e.g. Last 7 Days, Next 7
Days, etc.), one (e.g. Equals, Not On, etc.), or two (e.g. Is Between) input
boxes to search on.
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Numeric Fields : Equals, Greater Than, Less Than, Is Between, etc.
Depending on the option selected, there will be one (e.g. Equals, Ddoes Not
Equal, etc.) or two (e.g. Is Between) input boxes to search on.

 

Fields can be enabled or disabled to allow range searches via Admin > Studio. For
more information on how to enable or disablerange searches on a field, please
refer to the Studio documentation in the administration guide.
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a record name to search, Sugar will only return records
with a matching name that you have marked as favorites. When searching by a
multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all records to
which you have access, simply click "Clear" and then "Search" to perform a blank
search with no filters. Please note that you will only be able to see records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentations in the Administration guide.

Administrators can configure what fields appear on the Advanced Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Layout Options

Sugar gives users the ability to personalize the list view of each module through
the advanced search layout options feature. Users can pick which fields are

 138 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Team_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio


 

displayed in the list view, the order they are displayed in, and which column the
records are ordered by.
Use the following steps to personalize the list view for a module using the layout
options from the advanced module search:

1. Click on the Layout Options link to expand the available options below.

 
2. Select any column name in the Display Columns panel and click the right

aligned arrow to remove the column from the list view.

 
3. Alternatively, select any column name in the Hide Columns panel and click

the left aligned arrow to add a column to the list view.

 
4. Select any column name in the Display Columns panel and click the up or

down aligned arrow to move a column left or right respectively in the list
view.
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5. In the Order By column dropdown, select a field to order your results by. Only
columns in the Display panel will be available to order by and some columns
(e.g. Email Address) are not available for sorting.

6. Select a direction you wish to order the fields by: Ascending : 1-10, A-Z;
Descending : 10 -1, Z-A

 
Note : Clicking on a column header in the list view will temporarily override
the sort selected here. In order to order by the selection made here again,
simply click the Search button.

7. Click Search to execute the search.

 

Not all columns in each module can be used in the layout options by default. If
there is a column you desire to add to your list view or order by, please contact
your Sugar administrator to enable the desired fields. For more information on
how to add or remove fields as options in the layout options section, please refer to
the Studio documentation in the Administration guide.
Note : The layout options configured here supersede the default list view settings
configured in Studio for the specified module.
Sugar remembers the last search run when you return to each module including
whether or not the Layout Options panel was exposed. After changing your layout
options, click "Layout Options" again to hide the expanded panel and click Search.
Running a search locks in place whatever options you currently have on the search
screen. Now the next time you run a search, the new options will be remembered
and the Layout Options will be hidden. Click the Clear and the Search buttons to
revert back to the default layout options.

Saved Search

Sugar gives users the ability to save any layout option changes and search criteria
for easy access to perform the same search at a later time. A common example of
this would be a manager saving a search where only his or her employees are the
Assigned Users on the record. This way, the manager can review all of their team's
records at the click of a button. You can save an unlimited number of search
results and the Saved Searches dropdown displays the last saved search at the top
of the list.
Note : Saved searches are user specific and can not be seen or shared by other
users.
Use the following steps to save a personalized search from the advanced module
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search:

1. Enter in any number of search criteria you desire.
2. Enter in a name to designate the search into the "Save search as" textbox and

click save,

Note : Any layout option changes made will also be saved with the saved

search. 
3. The search is saved and executed. You now have the ability to modify any

search criteria or layout options. After any necessary modifications are made
click the Update button next to "Modify current search".

Note : The name of the search you will be updating shows below the Update

button. 
4. There is no way to modify the name of a saved search. Alternatively you can

execute a saved search, enter a new name into the "Save search as" textbox
and click save. This will create a new saved search with the same criteria as
the original with the new name. You may then proceed to delete the old saved
search.

5. To execute a previously saved search, simply select the desired search from
the "Saved Searches" dropdown.

 
6. This immediately executes the saved search.
7. If you wish to remove a saved search, simply click the Delete button after

executing a previously saved search.

 
Note : The name of the search you will be deleting shows below the Delete
button.

AND vs OR

When searching in the Basic or Advanced module search, Sugar uses the "and"
operator, not "or". This means that if you are searching against multiple fields,
Sugar will place an "and" in between each search field returning only records
matching all of your search criteria. For example : A search performed for a record
name "sugar" and the "My Items" check box will only return records where the
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record name contains "sugar" and the assigned to field is the user currently logged
in.

 
The only time Sugar will use the "or" operator is when using the mutiselect options
in the search criteria. For example : A search performed in the Accounts module
for the industry field will allow you to select multiple options to search by.
Performing a search on the industry field with Apparel, Banking, and Chemicals
selected will return any records where industry is "Apparel" or "Banking" or
"Chemicals".

If any other field is added into the search criteria the operators between the

industry field and any other field will remain an "and" operator. 

Wildcards

Wildcards can be used to search for criteria without including the entire word in
the search. Use a wildcard character in place of characters you do not require in
your search. Use may use any number of wildcard characters in any combination
you desire. The following wildcard characters can be used in the basic and
advanced module search in Sugar:

Character Wildcard Use
% Matches any number of characters,

including zero
_ Matches only one character
Note : Module search automatically appends the wildcard character (%) to the end
of your search phrase for each text field. This allows the system to pull up all
records that include the keyword entered in the search. If performing a multiple
word search, the wildcard is only appended to the last word, not all words.
Use the following as examples to search using wildcards in module search in
Sugar:
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Search Criteria Would Match Would Not Match
rob Rob, Robert, Robin Bob, Jacob, problem
%bert Albert, Bert, Robert Bart
r_b Robert, Ruby Bob, Raab
%s_i Dustin, Christi, Smith Sophie, Josephine
__it Fritz, Smith Rita, Schmitt
r_b% smit% Robert Smith, RobSmite Bob Smith, Robert Phillip
rob smit Rob Smith, Rob Smite Robert Smith, Robert

Smite
Note : If you are doing a search on a text field your search may unintentionally be
too narrow. Sugar will try to match your text to the beginnings of your record's
field. So, if an account's name starts with an article like "A" or "The," this must be
accounted for by adding a wildcard (%) at the beginning of your text. If your
account name is "The Account," you can search for "%account" to retrieve any
record that has the word "account" in the name.

Search Memory

Sugar by default automatically saves your most recent search criteria when
leaving the module then repopulates the search fields the next time you return. For
example: Perform a search in the Accounts module for "sugar". Navigate away
from the Accounts module and then return back to the Accounts module. The
search for "sugar" will automatically be shown and the relevant results will be
shown below in the list view.
Note : This can be an unintended result if a user is unaware of this functionality.
For example: A search may have an assigned user selected that is not currently
visible in the scrolling selection box. When running a new search, best practice is
to click the Clear button before entering your search criteria.
Module search memory can be set to one of the following options:

Remember last search : This is the default behavior in Sugar
Populate only : This will populate the search criteria, but will not execute the
search.
Note : This is recommended for systems experiencing performance issues.
Do not remember last search : Search will be cleared and executed every time
the search is loaded

Note : These options are global settings and will affect all users. Please be sure to
inform users of any behavior change before making modifications.
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Admin Configuration

A Sugar administrator has many options for configuring module search. You have
the ability to add, remove, and order fields on either the basic or advanced search
layouts through Admin > Studio. For more information on how to change the basic
and advanced search layouts, please refer to the Studio documentation in the
Administration guide.
The module search results are controlled through the list view layout in Admin >
Studio. Here you can also control the possible fields a user can add to their
personalized list view. For more information on how to change the list view layout,
please refer to th e Studio documentation in the Administration guide.

Last Modified: 10/19/2015 08:39pm

Home

Overview

The Home page displays a collection of dashlets which allow users to get a quick
view of assigned records, activities, reports, etc. to help users quickly access the
information that is most critical in their daily use of Sugar. Every user in Sugar can
configure their dashlets based on the display options and filters available from
their Home page. This documentation will go over the basics of the Home page as
well as the various options available to customize the Home page to best fit your
individual needs.

Home Page Tabs

Sugar's Home page displays four Home page tabs ("My Sugar", "Sales",
"Marketing", "Support") by default. The Home page tab is where certain dashlets
are grouped together based on the information that users would like to view under
each tab. Users can modify the dashlets that appear under each Home page tab,
change the tab names, as well as add new tabs if they wish.

Default Home Page Tabs

The default Home page tabs that come out-of-the-box with Sugar are as follows:

My Sugar : This tab displays module specific dashlets such as "My Accounts",
"My Leads", "My Calls", etc. that show records assigned to the user by
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default. For more information on module dashlets, please refer to the 
Modules section of this documentation.

Sales : This tab displays pre-defined sales-related dashlets such as "My Top
Open Opportunities", "My Pipeline", etc. There will be a combination of
module and chart-type dashlets displayed under this tab providing you with
information specific to your sales opportunities in Sugar.
Marketing : This tab displays pre-defined marketing-related dashlets such as
"Leads By Lead Source", "Campaign ROI", etc. You can use this tab to group
all dashlets that would provide key marketing data for your organization.
Support : This tab displays pre-defined support-related dashlets such as "My
Open Cases", "Open Cases By Month By User", etc. The various module and
chart-type dashlets under this tab allows you to track and manage all your
open cases in Sugar.

 

Renaming Home Page Tabs

Users can change their Home page tabs to display different names if they wish.
Please note that administrators can restrict users from modifying their Home page
layouts, which will prevent renaming of Home page tabs . For more information on
how administrators can prevent Home page customizations, please refer to the 
Admin-Set Limitations section of this documentation.

The following steps cover renaming the My Sugar tab as an example:

1. Navigate to the Home page by clicking the Sugar cube icon on the upper left.
2. Double click on the My Sugar home page tab.

 
3. Enter the new name in the text field (e.g. "My Sugar Records").
4. Click outside of the Home page tab to save the change.
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Adding Home Page Tabs

Users can add new tabs to the Home page as well if they wish to group a different
set of dashlets together outside of the default tabs. Please note that administrators
can restrict users from modifying their Home page layouts, which will prevent
adding of Home page tabs. For more information on how administrators can
prevent Home page customizations, please refer to the Admin-Set Limitations
section of this documentation.

The following steps cover adding a new Home page tab called "Team" with two
columns as an example:

1. Click the Plus sign icon to the right of the default Home page tabs.

 
2. Enter in the name for the new Home page tab then select the column layout

you desire to display the dashlets.

 
3. Click "Submit" and the new Home page tab will be displayed as the last tab.

You can add dashlets to the new Home page tab to display information
you wish to view. For more information on how to add dashlets, please
refer to the Adding Dashlets section of this documentation.

 

Changing Home Page Layout

Users can change the number of columns that dashlets are displayed on the Home
page depending on how they wish to view the information. You can set the Home
page to display one dashlet at a time or up to three at once. Please note that
administrators can restrict users from modifying their Home page layouts. For
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more information on how administrators can prevent Home page customizations,
please refer to the Admin-Set Limitations section of this documentation.

The following steps cover changing the Home page layout to display three columns
as an example:

1. Navigate to the Home page by clicking the Sugar cube icon on the upper left.
2. Click "Change Layout" on the top right hand corner of the Home page.

 
3. Select the box with three columns.

 
4. The Home page will now display the dashlets across three columns.

 

Commonly Used Dashlets

By default each of the Home page tabs will display stock dashlets such as "My
Calls", "My Meetings", "My Pipeline", "My Open Cases", etc. The following sections
will go over some commonly used dashlets that can be viewed and managed on
your Home page.

Module Dashlets

There are numerous stock module dashlets that come out-of-the-box with Sugar.
Dashlets such as "My Leads", "My Accounts", "My Calls", "My Meetings" are
displayed on the Home page by default and are commonly used among Sugar
users. All of the module dashlets are displayed under the Modules tab of the Add
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Sugar Dashlets window and they show records specific to the module that are
assigned to the users by default. Please note that these module dashlets can easily
be renamed and configured to pull relevant sets of data that you wish to view. For
more information on how to configure the dashlets, please refer to the 
Configuring Dashlets section of this documentation.

 

My Activity Stream

The My Activity Stream dashlet is designed to allow team members to view each
other's activities and the actions that took place related to the Cases, Contacts,
Leads, or Opportunities module. The dashlet displays up-to-date notifications
whenever a new contact, lead, etc. is created by a team member. In addition to
record creation notifications, users can view status updates when a lead is
converted as well as when team members close a case or opportunity in Sugar.
Please note that you will only be able to view and post activity feeds for teams that
you are associated with in Sugar. The My Activity Stream dashlet is displayed by
default under the My Sugar Home page tab. 

Administrators in Sugar have the ability to disable the My Activity Stream dashlet
via Admin > Activity Streams as well as activate the feeds for all or some of the
modules (Cases, Contacts, Leads, Opportunities). For more information on activity
stream settings, please refer to the Activity Streams section of the System
documentation in the Administration guide.
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You can post status updates in the dashlet by entering it in the open text field at
the top of the My Activity Stream dashlet then clicking "Post". Click the double
arrow to the left of your name within the My Activity Stream dashlet and this will
display options to add external links, images, and YouTube videos as well as
specify the team who can view your posts. To post external links, images, or
YouTube videos, simply select one of the options (Image, Link, YouTube) in the
dropdown list and enter in the corresponding URL. Please note that these posts
will only be viewable by members of the team (e.g. West, Global, etc.) you select in
the Visible to Team field. You can reply to posts made by your team members by
clicking the Reply link to the right of each post. All of your personal posts will
display the Delete link as well allowing you to delete any unnecessary posts. Please
note that if the Show Full Names checkbox is selected in your user preferences,
your full name will be displayed on your posts instead of your assigned user name.
For more information on setting your user preferences, please refer to the Getting
Started documentation.

Administrators in Sugar have the option to disable user feeds via Admin > Activity
Streams, which will prevent users posts from being displayed on the My Activity
Stream dashlet. For more information on activity stream settings, please refer to
the Activity Streams section of the System documentation in the Administration
guide.

Example: If we post a link to the SugarCRM website along with a message for
everyone on the Global team to check it out, the message including the link will be
visible to all users on the team.
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Please note that organization's with a corporate Twitter and Facebook account can
view their feeds in the My Activity Stream dashlet. Administrators in Sugar must
configure the Facebook and Twitter connectors first via Admin > Connectors in
order for users to view the feeds on the dashlet. For more information on how to
configure the connectors, please refer to the Connectors section of the System
documentation in the Administration guide.

Adding Dashlets

Additional dashlets can be added by clicking "Add Sugar Dashlets" on the top right
hand corner of the Home page. If you would like to add the dashlet under a
specific Home page tab, select the tab ("My Sugar", "Sales", "Marketing", etc.)
prior to clicking "Add Sugar Dashlets". In the Add window, you will see the various
types of dashlets associated to the Modules, Charts, Tools, and Web tab that you
can select. To add a dashlet, simply click the specific dashlet in the Add window
and it will automatically add it to the top of the first column of your current Home
page tab. Please note that you can also add the same dashlet multiple times with
different configurations to show different records or information. By default,
fifteen is the maximum number of dashlets that users can add to any one Home
page tab. Administrators have the ability to increase or decrease the number of
dashlets allowed via Admin > System Settings. Administrators can also restrict
users from modifying their Home page layouts, which will prevent adding dashlets.
For more information on how administrators can increase the maximum number of
dashlets allowed or prevent Home page customizations, please refer to the 
Admin-Set Limitations section of this documentation.

Dashlet Types

When you click "Add Sugar Dashlets", the pop-up Add window will display the
Modules, Charts, Tools, and Web tab which house the various dashlet types. You
can also search for dashlets by entering the relevant term in the Find Sugar
Dashlet search box and clicking "Search". Please note that the search is only
performed within the specific tab ("Modules", "Charts", "Tools", "Web") you are
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currently in. The following will cover key features of dashlet-types found under
each tab that can be added to your Home page.

 

Modules

The Modules tab consists of various pre-defined module dashlets such as "My
Accounts", "My Calls", My Contacts", etc. All of the dashlets under this tab display
records that are specific to the module assigned to the user by default.

 

For example, the My Accounts dashlet will show all account records assigned to
you along with some key information (e.g. Name, Phone, etc.) on the list view
display column. You can scroll through the pages on the list view to view the set of
records by clicking the Next, Previous, First, or Last button. Each results page will
show a set number of records depending on the number of display rows (1, 3, 5,
10) you choose to show per page. Please note that you can configure the dashlets
by clicking the Edit icon to filter and display only relevant data that you wish to
view. For more information on how to configure the dashlets, please refer to the 
Configuring Dashlets section of this documentation.
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Charts

The Charts tab displays seven pre-defined report charts (e.g. "My Pipeline by Sales
Stage", "Campaign ROI", "All Opportunities by Lead Source", etc.) under "Basic
Charts". These pre-defined charts allow you to view sales and opportunities related
data for your organization. You also have the option to add custom report charts as
dashlets by selecting the saved report under "Report Charts". For more
information on how to view report charts via dashlets, please refer to the Viewing
Via Dashlet section of the Reports documentation. Please note that all report types
(Summation Report, Matrix Report, Summation with Details Report) except for
Rows and Columns-type reports have the chart option available to view as
dashlets.

You can click the Edit icon to change the title and filter the pre-defined charts
based on the available edit options. Unlike the pre-defined charts, the custom
report charts take you directly into the reports detail view to edit the report. For
more information on how to edit reports, please refer to the Reports
documentation.Once you save the edited report, you will have to refresh the
dashlet in order for the data to be updated and displayed properly on the chart.

 

The available charts under the Basic Charts option are as follows:

All Opportunities By Lead Source By Outcome : This is a horizontal stacked
bar chart that displays total opportunities for each lead source. Each colored
bar represents the different sales stage and the outcome proportions for that
particular lead source.
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All Opportunities by Lead Source : This is a pie chart that groups total sales
opportunities by each lead source.
Campaign ROI : This is a vertical bar chart that displays the return on
investment (ROI) for a campaign. If you have multiple campaigns, you will
have to click the Edit icon to select the specific campaign name to view the
campaign's ROI. You can also view this chart by clicking the "View ROI"
button in the campaigns detail view. For more information on campaign's
return on investment, please refer to the Campaign documentation.
My Closed Won Opportunities : This is a gauge chart that displays all your
closed won opportunities with the sales stage of "Closed Won". The maximum
gauge range value on the chart represents the total number of opportunities
assigned to you. The chart is automatically divided into four equal ranges
based on your total opportunity records.
My Pipeline By Sales Stage : This is a funnel chart that displays the total
dollar amounts for all your opportunities grouped by sales stage. The chart
displays only when the expected close date of the opportunity is within the
specified date range in the edit options . Please note that the funnel chart is
ordered based on the order of the Sales Stage dropdown list in the
opportunities edit view.
Outcome by Month : This is a vertical stacked bar chart in which each bar
displays the total sales pipeline by month. Each colored bar represents the
different sales stages and the outcome proportions for the opportunities in the
specific month.
Pipeline By Sales Stage : This is a funnel chart that displays the total dollar
amounts for all opportunities in Sugar grouped by sales stage. The chart
displays only when the expected close date of the opportunity is within the
specified date range in the dashlets edit options . Please note that the funnel
chart is ordered based on the order of the Sales Stage dropdown list in the
opportunities edit view.

There are various chart types (Horizontal Bar, Vertical Bar, Pie, Funnel, Gauge)
that can be displayed as a dashlet on the Home page. Each distinctively colored
area on a chart (except gauge chart) is linked to the data set that it represents. To
view the set of records that make up the colored area on the chart, simply click the
colored area to drill down to the specific group of records. You will be directed to
the modules list view to view the set of records associated to the particular colored
area.

Example: If we click the purple pie within the All Opportunities by Lead Source
chart, it will drill down to the related set of records that make up opportunities
with lead source "Public Relations". The set of opportunity records that make up
the $95,000 will be displayed in the opportunities list view for you to view the
record details.
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Tools

The Tools tab allows you to add dashlets such as "My Activity Stream", "Team
Notices", "Jot Pad", etc. and the following sections will go over the key features of
each dashlet-type.

 

Invaders : The Invaders dashlet is a game you can play directly on your Home page
if you ever need a little break. To play the game, simply use the letters "A" and "D"
on your keyboard to move the tank left-to-right then hit "S" to shoot the sugar
cubes at the alien ships.
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My Activity Stream : The My Activity Stream dashlet is designed to allow team
members to view each other's activities and the actions that took place related to
the Cases, Contacts, Leads, or Opportunities module. The dashlet displays
up-to-date notifications whenever a new contact, lead, etc. is created by a team
member. In addition to record creation notifications, users can view status updates
when a lead is converted as well as when team members close a case or
opportunity in Sugar. Users can post status updates and include external links,
images, or YouTube videos to notify and share relevant information with their team
members. Please note that the My Activity Stream dashlet is displayed by default
under the My Sugar Home page tab. For more information about the activity
stream dashlet, please refer to the My Activity Stream section of this
documentation.

 

Team Notices : The Team Notices dashlet displays team-specific announcements
posted by the administrator. These announcements display as a scrolling marquee
within the dashlet to be viewable by members of the specified team via their Home
page. Please note that only administrators have the ability to create and manage
team notices in Sugar. For more information on how to create team notices, please
refer to the Team Notices section of the Team Management documentation in the
Administration guide.
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Jot Pad : The Jot Pad dashlet displays an open text area on the Home page where
you can jot down notes, tasks, etc. that you would like to keep a reminder of in
Sugar. Double click within the text area to start typing your note. You can click the
Edit icon to change the title and height of the dashlet.

 

Sugar News : The Sugar News dashlet keeps you up-to-date with the latest news
regarding SugarCRM. The news on the dashlet feeds directly from SugarCRM's
corporate website (http://www.sugarcrm.com/crm/product/news). Please note that
the Sugar News dashlet is displayed by default under the My Sugar Home page
tab. You can click the Edit icon to change the title or the dashlet height per your
preference.

 

Web

The Web tab allows users to add external websites and news feeds to view as
dashlets on their Home page. You simply need to enter in the corresponding URL
under "Website" or "News Feed" then click the Add button beneath it. The Website
dashlet allows you to view and navigate through the corresponding URL site
directly from your Home page. You can also view RSS or Blog feeds (e.g. 
http://www.sugarcrm.com/crm/product/news) from your Home page by adding the
News Feed dashlet.
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Example: If we enter in http://sugarcrm.com under "Website" and click "Add", this
will display Sugar's website as a dashlet on the Home page. You can view the
website directly on your Home page now and can navigate through the site. You
can also click the Edit icon to change the title or dashlet height to fit your personal
preference.

 

Steps to Add a Dashlet

Occasionally users may need to add more dashlets to their Home page if they wish
to view additional information regarding their records, sales, cases, etc. Please
note that some dashlets may require you to reload the page to display the dashlet
properly.

The following steps cover adding the My Accounts dashlet under the My Sugar tab
as an example:

1. Navigate to the Home page by clicking the Sugar cube icon on the upper left.
2. Select the My Sugar tab.
3. Click "Add Sugar Dashlets" on the top right hand corner of the Home page.
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4. In the Add window, select "My Accounts".

 
5. The My Accounts dashlet will be displayed on your Home page.

To configure the dashlet, click the Edit icon at the top of the dashlet
menu bar. For information on how to configure the dashlet, please refer

to the Configuring Dashlets section of this documentation. 

Rearranging Dashlets

By default, new dashlets are automatically added to the top of the first column on
the Home page, which pushes the existing dashlets below the new one. Since this
does shift the dashlets location on the Home page, users have the option to
rearrange the dashlets to place them in different positions per their viewing
preference. Please note that administrators can restrict users from modifying their
Home page, which will prevent rearranging of dashlets. For more information on
how administrators can prevent Home page customizations, please refer to the 
Admin-Set Limitations section of this documentation.

The following steps cover moving the My Calls dashlet underneath the My
Accounts dashlet as an example:

1. Click the My Calls dashlet's menu bar.
2. Drag and drop the dashlet underneath the My Accounts dashlet.
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Configuring Dashlets

Dashlets on the Home page can easily be configured to display specific information
users want to view. Simply click the Edit icon at the top of the dashlet menu bar
and this will display the pop-up Options box with display options and filters
available to configure the dashlet. Please note that Sugar administrators have the
ability to edit the dashlet's filter and display layouts using Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Edit Options

To configure the dashlet, users will need to click the Edit icon at the top of the
dashlet menu bar, which will display the pop-up Options box with various display
options and filters to make the changes. The following sections will cover the
various options available in the Edit Options box along with the settings to
configure your dashlet.

 

General

The General section of the Options box allows you to configure how your dashlet
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will display on the Home page:

Title : Change the displayed name of the dashlet.
Display Rows : Specify how many rows or results this dashlet will display at
once. Please note that the maximum is ten rows.
Auto-Refresh : Choose a time frame to have the dashlet query automatically
refresh.
Display and Hide Columns : Use the left and right arrows to move fields
between these two lists to determine which fields will be shown in the
dashlet. Use the up and down arrows to change the left-to-right order of the
displayed columns. A maximum of six columns can be displayed within any
dashlet.

Filters

The Filters section will allow you to filter your dashlet based on fields made
available by the administrator via Studio. The fields available for filtering each
dashlet type will vary based on these Studio changes. For more information on
editing layouts, please refer to the Studio documentation in the Administration
guide.

The following will cover the most common Accounts filters as an example:

Only My Items : Select this box to only display records assigned to yourself.
Date Created : Only show records created within this time frame.
Billing Country : Enter a billing country to only show records with a matching
country name.
Multiselects : To only include records of certain Types, Industries, Teams, or
Assigned Users, choose the desired values in each category. To select
multiple desired values, hold the control or command key while clicking.
Please note that if "Only My Items" is checked, that setting will override any
attempts to select alternate values in the Assigned User field.
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Steps to Configure a Dashlet

Every user can configure their dashlet(s) to only display information they wish to
view via the display options and filters available in the Options box.

The following steps cover updating the title, display columns, status filter, and
start date filter for the My Calls dashlet as an example:

1. Click the Edit icon at the top of the dashlet menu bar.

 
2. Change the "Title" and the "Display Columns" in the General section of the

Options box.
Use the left and right arrows to move fields between the Display and
Hide columns to determine which fields will be shown in the dashlet.
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3. Update the "Status" and the "Start Date" in the Filters section of the Options

box.

 
4. Once the update is complete, click "Save" and the dashlet will reflect the

changes made.

 

Deleting Dashlets

Users can delete dashlets they no longer wish to view on their Home page by
clicking the Delete icon. Please note that deleted dashlets are not permanently
removed and can be added back by clicking "Add Sugar Dashlets" on the top right
hand corner of the Home page. For information on how to add dashlets to the
Home page, please refer to the Adding Dashlets section of this documentation.
Administrators can also restrict users from modifying their Home page layouts,
which will prevent deleting of dashlets. For more information on how
administrators can prevent Home page customizations, please refer to the 
Admin-Set Limitations section of this documentation.
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The following steps cover deleting the My Top Open Opportunities dashlet from
the Home page as an example:

1. Navigate to the Home page by clicking the Sugar cube icon on the upper left.
2. Click the Delete icon at the top of the dashlet menu bar.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Refreshing Dashlets

Dashlets in Sugar need to be refreshed in order for users to view any updated
data. There are various ways to refresh dashlets on the Home page and they are as
follows:

Users can manually refresh the dashlet by clicking the Refresh icon at the top of
the dashlet menu bar. Please note that this method allows you to refresh one
dashlet at a time.

 

Users can schedule the dashlet to automatically refresh using the Auto-Refresh
option. Click the Edit icon at the top of the dashlet menu bar and this will display
the pop-up Options box. You can select the interval for the refresh in the
Auto-Refresh dropdown list. Please note that you can schedule each of the dashlets
to refresh at different intervals.
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Users can refresh the entire Home page by clicking the Reload button at the top of
the web browser bar. This method will be beneficial if you would like to refresh all
of the dashlets at once.

 

Reset Homepage

As users make customizations to their Home page, there may be times when they
may want to revert all changes made and start fresh. Users can easily reset their
Home page back to the default out-of-the-box layout, which will allow users to
re-do all customizations. 

Use the following steps to reset the user's Home page:

1. Navigate to your user profile by choosing it from the system links in the upper
right of Sugar.

 
2. Click the Reset Homepage button to revert back to the default layout.

 

Admin-Set Limitations

Users may find that some of the options described in this documentation (e.g.
adding and moving dashlets) are not available when configuring their Home pages.
Please note that administrators in Sugar have the ability to limit how users may
modify their dashlets via Admin > System Settings. Reach out to your system
administrator if you are not able to customize your Home page or would like to
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increase the maximum number of dashlets allowed per Home page tab. Keep in
mind that the changes made in Admin > System Settings will be systemwide and
cannot be done on an individual account basis. For more information on system
settings, please refer to the System documentation in the Administration guide.

Prevent user customizable Homepage layout : Prevents users from adding or
moving dashlets. Users may still configure their dashlet filters and field
layouts.
Maximum number of Sugar Dashlets on Homepage : Sets a maximum number
of dashlets that users may add to any one Home page tab.

 

Last Modified: 09/26/2015 06:25pm

Leads

Overview

Sugar's Leads module consists of individual prospects who may be interested in a
product or service your organization provides. Once the lead is qualified as a sales
opportunity, leads can be converted into contacts, opportunities, and accounts.
There are various ways you can create leads in Sugar such as via the Leads
module, duplication, importing leads, etc. Once the lead record is created, you can
view and edit information pertaining to the lead via the Leads detail view. This
documentation will go over the basics of the Leads module as well as the various
options available in performing the actions related to the module.

Lead Fields

The Leads module contains a number of stock fields which come out of the box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged to best meet your organization's needs. Users with
administrator or developer access have the ability to alter, remove, or add fields
via Admin > Studio. For more information on adding or modifying fields, please
refer to the Studio documentation in the Administration guide.

Field Description
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Account Description A description or other information about
the lead account

Account Name The account to which the lead belongs

Note: Unlike the Contacts module, the
Account Name field is not a relate field
in the Leads module. When you convert
the lead, you will have the option to
create the account as a related record.

Assigned to The Sugar user assigned to the lead
Assistant The name of the lead's assistant within

his or her company
Assistant Phone The assistant's phone number
Birthdate The lead's date of birth
Campaign The campaign, if any, from which the

lead originated
Converted Indication that the lead has been

converted to a contact
Date Created The date the lead record was created
Date Modified The date the lead record was last

modified
Department The lead's department within their

company
Description A description or other information about

the lead
Do Not Call Indication that the lead should not be

called
Email Address The lead's email address
Fax The lead's fax number
First Name The lead's first name
Home Phone The lead's residence number
Last Name The lead's last name
Lead Source The source from which this lead

originated
Lead Source Description A description or other information about

the lead source
Mobile The lead's mobile number
Name When viewing, the lead's full name
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Office Phone The lead's office number
Opportunity Name The opportunity name associated with

the lead
Other Address The lead's alternate address (e.g.

billing, shipping)
Other Phone The lead's alternate phone number
Preferred Language The lead's preferred language when

accessing Sugar Portal
Primary Address The lead's primary address
Referred By The name of the individual or

organization that referred the lead
Salutation Standard greeting for the lead (e.g. Mr.,

Ms., Mrs., etc.)
Status The current status of the lead
Status Description A description or other information about

the lead's status
Teams The Sugar team(s) assigned to the lead

record
Title The lead's business title
Transaction Amount The expected transaction amount for the

potential business with the lead
Website The website URL associated with the

lead's organization

Leads Module Tab

The Leads module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Leads list view. You may also hover on
the tab to display the Actions, Recently Viewed, and Favorites menu. The Actions
menu allows you to perform important actions within the module. The Recently
Viewed menu displays the list of leads you last viewed in the module. The 
Favorites menu displays the list of leads you most recently marked as favorites in
the module.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Create Lead Opens the edit view layout to create a

new lead
Create Lead From vCard Imports a vCard file from your computer

to create a new lead
View Leads Opens the list view layout to search and

display leads
View Lead Reports Displays existing reports based on the

Leads module
Import Leads Opens the import wizard to create or

update leads using external data
If you do not see the Leads module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Leads module is not a member. Click the
More tab (last tab on navigation bar) then hover on "Filter Menu By" to check
how the navigation bar is grouped. For more information on tab grouping,
please refer to the User Interface documentation.
The Leads module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Leads module in the Hide Modules list, simply
move it to the Display Modules list. For more information on hiding and
displaying modules, please refer to the Layout Options section of the Getting
Started documentation.
The administrator may have disabled the Leads module for your entire Sugar
instance. Reach out to your Sugar administrator to have the Leads module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.
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Creating Leads

There are various methods for creating leads in Sugar including via the Leads
module, quick create, vCard, duplication, emails, importing leads, and web-to-lead
form. The full edit view layout opens when creating the lead directly from the
Leads menu and includes all of the relevant fields for your organization's leads.
The quick create form is a shortened version of the leads edit view and typically
contains fewer fields. Both the Edit View and Quick Create layouts can be
configured by administrators via Admin > Studio. For more information on
configuring layouts, please refer to the Studio documentation in the Administration
guide.

Creating Via Leads Module

One of the most common methods of lead creation is via the Create Lead option in
the Leads module tab. This opens up the edit view layout which allows you to enter
in all the relevant information for the lead.
Use the following steps to create a lead via the Leads module:

1. Hover on the Leads module and select "Create Lead".

 
2. Enter in the appropriate values for the fields in the edit view layout. All

required fields are marked with a red asterisk and must be completed prior to
saving.

3. Once the necessary information is entered, click "Save".

 

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
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to access the menu. You can also quick create a lead from any Leads subpanel on
related module records.
Use the following steps to create a lead via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Lead" or select "Create" on any Leads subpanel on a related module's
detail view.
From Quick Create menu:

 
From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".

 

Creating Via vCard

vCards are electronic business cards that are exchanged through applications such
as email and web browsers. In addition to allowing leads to be saved as vCards for
use in other software, you can also generate a new Sugar lead from a vCard.
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Use the following steps to create a lead in Sugar via vCard:

1. Hover on the Leads module and select "Create Lead From vCard".

 
2. Choose the vCard file from your computer and click "Import vCard".

 

Creating Via Duplication

You can also create a new lead by duplicating an existing lead record. The
duplicate option is useful if the lead you are creating has similar information to an
existing lead.

Use the following steps to create a lead by duplicating an existing record:

1. Navigate to a lead record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original lead's values.

Update the necessary fields, then click "Save".

 

Creating Via Emails
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The Emails module enables users to create new lead records from external and
imported emails using the Quick Create option. Simply click the Quick Create
button above the selected email header then select "Lead".

 

A pop-up window will open with the quick create form where you can enter
relevant values for the new lead. The name, email address, and description fields
are populated by default based on the emails subject, body, etc. All required fields
are marked with a red asterisk and must be completed prior to saving.Once the
necessary information is entered, click "Save". For more information on how to
create, send, and manage emails, please refer to the Emails documentation.

Please note that the selected email will be imported, if not already, and
automatically related to the new lead. The email record will appear within the
History subpanel of the Leads detail view.

Importing Leads

The import function allows you to push multiple lead records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.

Use the following steps to import leads via the Import Leads option:

1. Hover on the Leads module tab and select "Import Leads".

 
2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only". Click

"Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
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6. In Step 6, view the import results.
The Created Records tab will show all of the new lead records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Creating Via Web-to-Lead Form

Sugar provides a simple way to allow visitors to your website or other online
location to become leads in your Sugar instance. You can create a web-to-lead form
in Sugar and place the form on an external website. Then when a visitor to your
site completes and submits the form, their information is entered into Sugar as a
new lead record. For more information on creating and managing web-to-lead
forms, please refer to the Web-To-Lead Forms documentation.

Creating Via Portal Registration

Sugar provides administrators with an option to install and configure a self-service
portal for their customers to interact with the users. The Sugar Portal allows your
customers to file bugs, cases, and review knowledge base articles created in
Sugar. When a potential portal user visits the portal login page and completes the
registration form, their information is entered into Sugar as a new lead record. For
more information on managing the Sugar portal, please refer to the Portal
Deployment User Guide documentation.

Viewing Leads

There are various options available for viewing lead records in Sugar including via
Leads list view, Leads detail view, Leads Recently Viewed menu, dashlets, and
reports. Please note that you will only be able to see lead records as allowed by
your team membership, user access type, and assigned roles. For more information
on teams and roles, please refer to the Team Management and Role Management
documentation in the Administration guide.

Viewing Via List View

The Leads list view displays all lead records meeting the current search criteria.
To access the list view, simply click the Leads module tab. While list view shows
key lead fields, you can click the lead's name to open the record in detail view. For
more information on viewing leads via list view, please refer to the Leads List
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View section of this documentation.

Viewing Via Detail View

The Leads detail view displays thorough contact information including all lead
fields followed by subpanels of the lead's related records belonging to various
modules. The detail view can be reached by clicking a lead record's link from
anywhere in the application including from the Leads list view. For more
information on viewing lead's via detail view, please refer to the Leads Detail
Viewsection of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which leads you have recently viewed. Hover
on the Leads module tab to see a list of your most recently viewed leads and click
each name to open the lead in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view lead
information in lead-based dashlets such as "My Leads" as well as in dashlets based
on other modules such as "My Calls". Clicking a lead's name from any dashlet will
open the lead in detail view. For more information on using dashlets and viewing
lead records via dashlets, please refer to the Modules section of the Home
documentation.
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Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding leads and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the lead record's detail view by clicking the lead's name in the
report results. Please note that you can only directly access lead detail views with
Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.
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In addition to navigating to the Reports module and finding or building relevant
reports, you can use the Lead module tab's View Lead Reports option to see all
lead-based reports to which you have access.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Managementdocumentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Leads

The Leads list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Leads list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
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documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.
Open Items : Select this box to return only records with an open status (e.g.
New, Assigned, In Process).

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a lead name, Sugar will only return lead records with
a matching name that are assigned to you. Once the search is complete, the
relevant results will populate in the list view below the search panel. To see all
lead records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
lead records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Administrators can configure what fields appear on the Leads Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search
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Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a lead name to search, Sugar will only return lead records
with a matching name that you have marked as favorites. When searching by a
multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections.Once the search completes, the relevant
results will populate in the list view below the search panel. To see all lead records
to which you have access, simply click "Clear" and then "Search" to perform a
blank search with no filters. Please note that you will only be able to see lead
records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Managementdocumentation in the Administration guide.
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Administrators can configure what fields appear on the Leads Advanced Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
Search section of the System documentation in the Administration guide.

Leads List View

The Leads list view displays all lead records meeting the current search criteria to
which your user has access. You can view the basic details of each lead within the
field columns. Please note that you will only be able to see lead records as allowed
by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.
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You have the option to change what fields are displayed in list view by configuring
your layout options in the Leads Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation.Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on lead records directly from the list view by first
selecting the desired records. To select individual lead records on the Leads list
view, mark the checkbox on the left of each row. To select or deselect multiple lead
records on the list view, use the options in the checkbox dropdown menu.

Select This Page : Selects all records shown on the current page of lead
results.
Select All : Selects all records in the current search results across all pages of
lead results.
Deselect All : Deselects all records that are currently selected.
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Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more leads at a time
Email Email one or more leads at a time
Mass Update Mass update one or more leads at a time
Mail Merge Perform a mail merge on one or more

leads at a time
Note: This option only appears when
Mail Merge is enabled at the system
level and under the user's profile.

Merge Merge two or more duplicate leads
Add to Target List Add one or more leads to a target list
Export Export one or more leads to a CSV file

Favorite Designation

Users have the option to mark lead records as favorites via the list view as well as
the detail view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Leads
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module tab. In the Lead's list view, the star on the left of each lead's row is yellow
once marked to indicate a favorite lead. For more information on how to mark
records as favorites, please refer to the Favoriting Leads section of this
documentation.

 

More Information

Additional details for each lead can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional lead
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Primary Address, Mobile, Home Phone, Other Phone,
Lead Source, and Description fields by default. The list of fields appearing here
may only be configured through a code-level customization.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Leads Detail View

The Leads detail view displays thorough lead information including all lead fields
which are grouped by default into the Overview, More Information, and Other
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panels. You can also view a lead's related records (Activities, History, Campaigns)
which appear in subpanels beneath the lead fields. The detail view can be reached
by clicking a lead record's link from anywhere in the application including from the
Leads list view.

Please note that you will only be able to view a lead record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management documentation
in the Administration guide.Users with administrator or developer access have the
ability to change the detail view by configuring the layout via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation in
the Administration guide.

Actions Menu

The Actions menu on the top left of each lead's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this lead
Duplicate Duplicate this lead
Delete Delete this lead
Find Duplicates Locate potential duplicates of this lead
Get Data Search, view, and merge additional lead

data via Hoover's and/or Zoominfo
connector

Convert Lead Convert a qualified lead into a contact,
account, or opportunity
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Manage Subscriptions Manage this lead's campaign
subscriptions

View Change Log View a record of changes to this lead

Favorite Designation

Users have the option to mark lead records as a favorite via the detail view as well
as the list view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Leads
module tab. In the Leads detail view, the star on the right of the lead's name is
yellow once marked to indicate a favorite lead.For more information on how to
mark records as favorites, please refer to the Favoriting Leads section of this
documentation.

 

Next or Previous Record

On the upper right of the Leads detail view, there are two buttons that allow you to
page through each lead in the Leads list view's current search results. Clicking the
Previous button displays the previous lead of the current search results while
clicking the Next button displays the next lead of the current search results. The
text in between shows which lead result you are currently viewing within the total
number of current results .

 

Subpanels

Beneath a lead record's fields are subpanels containing related records from
various modules, campaign interaction history for this lead, and the lead's
InsideView information.
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Related Record Subpanels

Modules in Sugar display subpanels, which allow users to view related records
from other modules. Users can view the details of the related record as well as
relate new or existing records via the subpanel. Administrators can easily modify
the fields (e.g. Name, Assigned User, etc.) displayed on these subpanels as well as
the label of each subpanel through Admin > Studio so that users have visibility to
the most important fields for their organization. For more information on working
with related records subpanels, please refer to the Subpanels section of the User
Interface documentation.

Activities and History Subpanel

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the lead record. Once the activities have taken place or are completed,
they will instead appear within the History subpanel. The History subpanel also
includes notes and emails associated with the lead record. For more information
on the history and activities subpanel, please refer to the User Interface
documentation.

 

Campaigns Subpanel

The Campaigns subpanel contains historical information regarding a lead record's
interaction with all Sugar campaigns. When a mass marketing campaign is sent to
a lead (or manually marked as sent in the case of non-email campaigns), the
related campaign activity information will appear within the Campaigns subpanel.
This information mirrors the "View Status" page available from within each
individual campaign and shows activities such as when a campaign was sent, when
the lead viewed the campaign message, when the lead clicked a tracked link within
the campaign, etc. Since this subpanel contains historical campaign interactions
for the lead, it cannot be used to associate a lead with a campaign or otherwise
manage a campaign or target list. For more information on associating a lead with
a campaign, please refer to the Adding Leads to a Target List section of this
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documentation. For more information on campaigns, please refer to the 
Campaignsdocumentation.

 

InsideView Subpanel

The InsideView subpanel, if you are an InsideView user, provides relevant
company information, news, and social media insights within your lead's detail
view. The InsideView subpanel will appear by default on the detail view. The panel
can be minimized by clicking the double arrow next to "InsideView". For more
information on viewing lead information via InsideView, please refer to the User
Interface documentation. Administrators in Sugar also have the ability to disable
InsideView for the entire instance so that it is not visible to users. For more
information on disabling InsideView, please refer to the Connectors section of the
System documentation in the Administration guide.

 

Editing Leads

Leads may be edited at any time to update or add information to the record. You
can make changes to existing lead records via the Leads edit view and quick create
forms. Edit view is available within the Leads module and includes all of the Lead
fields you should need.
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Quick create is available for editing leads from outside the Leads module and
opens as a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields.

 

Please note that your ability to edit leads in Sugar may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide.Check with your system administrator if you do not see
the Edit options.

Administrators in Sugar may configure both the Leads edit view and quick create
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit leads via the detail view by clicking the Edit button on the upper left
of the page. Once the edit view layout is open, you can update the necessary fields,
then click "Save" to preserve the changes made.
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Editing Via List View

You can edit leads via the list view by clicking the Pencil icon to the left of each
lead's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.

 

Editing Via Dashlets

You can edit leads by clicking the pencil icon to the far right of any leads-based
dashlet on your Sugar home page. For example, clicking the pencil icon within the
My Leads dashlet will open a pop-up window with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes. For more information on dashlets, please refer to
the Home documentation.

 

Editing Via Reports

Sugar reports also allow you to edit a lead record by clicking on the pencil icon
next to a lead's name. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. Please note that you may only directly
edit leads from Rows and Columns-type or Summation with Details-type reports as
Summation-type and Matrix-type reports do not include the pencil icon. For more
information on reports, please refer to the Reports documentation
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Deleting Leads

If a lead record is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Leads detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once. Deleting lead records will not delete the
related records and will only remove the relationship, so you may wish to also
delete any related records to avoid orphaned records.

Please note that your ability to delete leads in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a lead record via the detail view:

1. Navigate to a lead record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more lead records via the list view:
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1. Navigate to the Leads list view by clicking the Leads module tab.
2. Use the Basic or Advanced Searchto find the Lead records you wish to delete.
3. Select the desired lead records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of lead records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Converting Leads

Sugar enables you to convert leads into contacts as you determine they qualify for
your organization's definition of a contact (e.g. after an evaluation/qualification
process or upon entering into business with the individual). When the lead is
converted, a new contact record is created in Sugar with a relationship to the
original lead record. The Convert Lead page also gives you the option to create an
account, opportunity, and activity (Calls, Meetings, Notes, Tasks) record. Please
note that administrators have the ability to alter, add, or remove fields, as well as
make modules on the Convert Lead page required via Admin > Studio. For more
information on configuring the convert layout, please refer to the Studio
documentation. If a module is set as required, the panel for the module(s) will
automatically be open on the Convert Lead page and marked with a red asterisk.
Required modules must be created or selected in order for the lead to be
converted and saved.

Administrators also have the ability to create custom fields in the Leads module to
automatically copy the field value to a field with the same name in the newly
created record. Additionally, administrators can add any custom modules that have
been installed or created in Sugar to the Convert Lead page. For more information
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on creating custom fields to copy data over to new records and adding custom
modules to the Convert Lead page, please refer to the Creating Fields section and 

Lead Conversion Options

The activities related to the lead can be copied or moved to the newly created
record(s) during lead conversion depending on the lead conversion options
selected by the administrator via Admin > System Settings. If either the copy or
move option is selected, then the associated multiselect or dropdown field will be
displayed at the bottom of the Convert Lead page.

The available lead conversion options are as follows:

Copy : This option allows you to copy the leads activities to the new record for
the module(s) selected in the multiselect field.
Move : This option allows you to move the leads activities to the new record
for the module selected in the dropdown field.
Do Nothing : The lead's activities remain with the converted lead. The copy or
move options will not be displayed on the Convert Lead page.

Please note that even if "Do Nothing" is selected, emails associated with the lead
will still show under the created contact as long as the lead and contact share the
same email address. This is because emails carry an implicit relationship with any
record containing an email address matching an address in the From, To, or CC
lines of the email record. For more information on setting lead conversion options,
please refer to the System documentation.

Steps to Convert a Lead

Once the lead has been evaluated and qualified, they are ready to be converted to
a contact in Sugar. Please note that administrators have the ability to configure
what fields appear on the convert layout via Admin > Studio. For more information
on editing layouts, please refer to the Studio documentation in the Administration
guide.

The following steps cover converting a lead to a contact and creating a new
meeting record as an example:

1. Navigate to a lead record's detail view.
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2. Select "Convert Lead" from the Actions menu.

 
3. Check the contact information in the Create Contact panel of the Convert

Lead page and make changes if necessary. The information on this panel will
be carried over to the new contact record.

 
4. Enter appropriate values for the fields in the Create Account panel.

The "Create Account" is checked off by default to allow creation of a new
account.

 
Note: You also have the option to uncheck the box to select an existing
account record instead and relate it to the lead. Please note that modules with
a one-to-one relationship or one-to-many relationship with Contacts can have
the option to select an existing record instead of creating a new record during
lead conversion. By default, the Accounts module has the select option since
there is an existing one-to-many relationship. For more information on
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configuring the selection option for modules on the Convert Lead page, please
refer to the Studio documentation.

5. Check the box for "Schedule Meeting" and enter the appropriate values in the
displayed fields.
You can also create a note, task, or log a call by checking the box associated
to the activity to open up the panel.

 
6. Once all of the necessary information is entered and the appropriate records

created, click "Save".
A confirmation page will display confirming the creation of the new
contact, account, and meeting record.

The converted lead record will display the converted contact and account name at
the top of the detail view page. You can click the record's names to view the
detail's of the converted record's.

 

If one of the lead conversion options (Copy or Move) is selected in Admin > System
Settings, the corresponding field (i.e. Copy Activities to, Move Activities to) will
appear at the bottom of the Convert Lead page. Please note that the Contacts and
Accounts module appear in the Copy Activities to and Move Activities to list by
default. A module is added to the list when you select it for creation on the Convert
Lead page. For example, if you select "Create Opportunity" on the Convert Lead
page, then the Opportunity module will appear in the list as well.

If the Copy option is selected in Admin > System Settings, then the Copy Activities
to field (multiselect) will appear on the Convert Lead page to copy the lead's
activities to the selected module record(s):
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If the Move option is selected in Admin > System Settings, then the Move
Activities to field (dropdown) will appear on the Convert Lead page to move the
lead's activities to the selected module record:

 

If you select a module to copy or move the activity during lead conversion, the
activity record(s) will show up in the Activities (open activities) and History (held
activities) subpanel of the newly created record(s). For example, if we select
"Contact" in the Copy Activities to field then all the lead's activities will be copied
and related to the new contact record.

 

Exporting Leads

Sugar's Export option allows users to download all fields for the selected leads to
their computers as a .CSV (comma-separated values) file. This may be useful when
needing to use Lead data with other software such as Microsoft Excel or to update
existing records by exporting, making changes, then importing the altered leads
back into Sugar. For more information on updating existing records via import,
please refer to the Import documentation. Due to PHP memory limitations on the
server, there may be occasions when the application times out while exporting a
large number of lead records. If you encounter an error when performing this
action, we recommend selecting the records in smaller batches.

Leads may be exported from the Leads list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for leads and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.
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Please note that your ability to export leads from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Downloading a Lead's vCard

vCards are electronic business cards that are exchanged through applications such
as email and web browsers. In addition to being able to create a lead from an
existing vCard, you can also download a vCard from Sugar in order to transfer the
lead's information to another application.

The following steps cover downloading a vCard and saving it as a contact in
Microsoft Outlook as an example:

1. Navigate to a lead record's detail view.
2. Click the vCard icon to the right of the lead's name to download the vCard

file.

 
3. Open the downloaded file in your mail or address book application. For this

example, double clicking opens the vCard in Outlook.
4. Make any necessary changes to the information, then click "Save & Close" to

save this lead in Outlook.
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Mass Updating Leads

Mass Updating allows users to make the same change to multiple lead records at
once from the Leads list view. Users with administrator or developer level access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide.Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of lead records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update leads may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Mass Update option.

Use the following steps to mass update lead records from the list view:

1. Navigate to the Leads list view by clicking the Leads module tab.
2. Use the list view's Basic or Advanced Search to identify leads you wish to

modify.
3. Select the desired leads individually or using the checkbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.
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5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected lead

records.

Finding Duplicate Leads

Between multiple users working in Sugar, importing new records, and converting
leads, it is possible for duplicate lead records to be accidentally input to the
system. Before creating a new lead record, a good practice is to first check that an
individual does not already exist in Sugar. You can locate duplicate records for
cleanup using Basic and Advanced Search from the Leads list view. Searching for
leads with similar names or other information can make search a powerful,
duplicates-finding tool. Sugar also provides a wizard for finding potential
duplicates that is available from the Leads detail view and may be used as shown
below. If duplicate lead records are detected, you can perform a merge per the 
Merging Leads section of this documentation.

Please note that your ability to use the Find Duplicate action may be restricted by
any role which prevents lead deletion. For more information on roles, please refer
to the Role Management documentation.Check with your system administrator if
you do not see the Find Duplicates option.

 197 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Leads/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Leads/#Advanced_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Leads/#Merging_Leads
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management


 

Use the following steps to locate duplicate leads using the Find Duplicates option
from the Lead detail view:

1. Navigate to a lead record's detail view.
2. Choose "Find Duplicates" from the Actions menu.

 
3. Move any fields you wish to use in identifying duplicates to the list on the

right by selecting the field and clicking the arrow.

 
4. Click "Next Step" to display a list of potential duplicate lead records which

match all of the specified filters.

 

Once you determine which leads shown in the resulting list are indeed duplicates
of your original record, select the duplicates by marking the checkboxes then click
"Perform Merge" to begin a merge with the current record. Instructions for the
merge process that follows can be found in the Merging Via Detail View section of
this documentation.

Merging Leads

When duplicate records are identified in Sugar, you have the option to merge two
or more duplicate leads into a single record. Once the merge is complete, the
duplicate lead record(s) will be deleted, and the primary record will remain. Please
note that all relationships belonging to the duplicate leads will be merged to the
primary record meaning that any calls, meetings, etc. related to the duplicate lead
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record(s) will automatically be related to the resulting, merged lead record.

Merging Via Detail View

Use the following steps to merge leads via the Leads detail view:

1. Navigate to a lead record's detail view.
2. Use the Find Duplicates option as shown in Finding Duplicate Leads to

identify duplicate leads.
3. Possible duplicates will be displayed in the results list. Select the duplicate

record(s).

 
4. Click "Perform Merge" to display the Merge Leads page. The primary record's

field values are displayed on the left while other records' values are in
columns to the right. Saving the merge will preserve only the leftmost values
for each field into a single lead record.

 
5. To change which record is considered the primary, click the "Set as primary"

double arrows.
6. Review the field values in each column and use the associated double arrows

to move the best value for each field to the leftmost column.
7. Click "Save Merge" once the left column contains all fields you wish to appear

on the single, merged record.
8. A pop-up message will display confirming that the duplicate record(s) should

be deleted. Click "Ok" to proceed.

Merging Via List View

Basic and Advanced Search may be used to identify duplicate leads by, for

 199 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Leads/#Finding_Duplicate_Leads
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Leads/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Leads/#Advanced_Search


 

example, searching for leads with similar names. Once your search has identified
duplicate leads, you can merge them directly from the Leads list view.

Use the following steps to merge leads via the list view:

1. Use the list view's Basic or Advanced Search to identify duplicate leads.
2. Possible duplicates will be displayed in the list view. Select the duplicate

record(s) that you wish to merge.

 
3. Select "Merge" from the Actions menu to display the Merge Leads page. The

primary record's field values are displayed on the left while other record's
values are in columns to the right. Saving the merge will preserve only the
leftmost values for each field into a single lead record.

 
4. To change which record is considered the primary, click the "Set as primary"

double arrows.
5. Review the field values in each column and use the associated double arrows

to move the best value for each field to the leftmost column.
6. Click "Save Merge" once the left column contains all fields you wish to appear

on the single, merged record.
7. A pop-up message will display confirming that the duplicate record(s) should

be deleted. Click "Ok" to proceed.

Favoriting Leads

Each Sugar user has the option to designate their own favorite leads which are
important or will be viewed often so that they can easily be accessed via search or
from the Leads module tab. Once records are marked as favorites, use the My
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Favorites checkbox in the Lead's Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Leads module
tab.

Favoriting Via List View

Use the following steps to mark records as favorites via the Leads list view:

1. Navigate to the Leads list view by clicking the Leads module tab.
2. Use the Basic or Advanced Searchto find the Lead records you wish to mark

as favorites.
3. Mark the star icon on the left of each desired lead's row.
4. To remove the lead as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Leads detail view:

1. Navigate to a lead record's detail view.
2. Click the star icon to the right of the lead's name in the upper left of the detail

view to designate it as a favorite.
3. To remove the lead as a favorite, click the star again to revert it to white.

 

Viewing Lead Change Logs

Changes made to each lead record are tracked over time, and users are able to
view the history of changes via the change log in each lead's detail view. To view
the change log, navigate to a lead in detail view and select "View Change Log"
from the Actions menu. Please note that only fields marked as "Audit" in Admin >
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Studio will be displayed in the change log. For more information on designating for
audit, please refer to the Studio documentation in the Administration guide.

 

Emailing Leads

Sugar allows users to compose and send outbound emails to leads. There are
various ways to send outbound mail to leads including emailing via the Emails
module, Emails quick compose, Leads module, campaigns, and workflows. Please
note that administrators in Sugar must first configure the outbound mail server for
the system via Admin > Email Settings in order for users to send outbound emails.
For more information on setting up the system email settings, please refer to the 
documentation in the Administration guide. Users will also need to have their
email settings configured in their user preferences prior to sending outbound
email from the Emails module, Emails quick compose, or Leads module. For more
information on setting up your user preferences' email settings, please refer to the 

Emailing Via the Emails Module

Use the following steps to compose and send an email to a lead via the Emails
module. For more detailed information on sending emails via the Emails module,
please refer to the Emails documentation.

1. Navigate to the Emails module by clicking the Emails module tab.
2. Click the Compose button on the upper left of the Emails module.

 
3. For the "Related To" field, select "Leads" as the module, then enter or select

the desired lead's name. The email's To field will automatically populate with
the name and email address of the selected lead record.

4. Enter a subject and body for the email message, then click "Send".
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Once the email is sent successfully, the email record will appear in the History
subpanel of the lead record.

 

Emailing Via Quick Compose

The quick compose option allows users to compose emails from various places in
Sugar without navigating away from the current page.

While viewing a lead record, you can select "Send Email" from the Quick Create
menu on the top right of any Sugar page. Quick creating an email while viewing a
lead record's detail view automatically populates the To field with the leads name
and email address as well as relating the email to the lead record.

 

Users can also use Quick Compose by clicking a lead's email address anywhere it
is displayed as a link. Clicking the email address automatically populates the To
field with the lead's name and email address as well as relating the email to the
lead record.
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Quick Compose is also available from the Activities subpanel in a lead's detail view.
Choosing "Compose Email" from the Actions menu automatically populates the To
field with the lead's name and email address as well as relating the email to the
lead record .

 

Once the email is sent successfully, the email record will appear in the History
subpanel of the lead record. For more detailed information on sending emails via
quick compose, please refer to the Emails documentation.

 

Emailing Via Leads List View

One or more leads may be emailed at a time from the Leads list view. For more
detailed information on sending emails via the Leads list view, please refer to the 
documentation.

Use the following steps to compose and send an email from the Leads list view:

1. Navigate to the Leads list view by clicking the Leads module tab.
2. Use the Basic or Advanced Search to find the Lead records you wish to

include on the email.
3. Select the desired leads individually or using the checkbox dropdown's

options.
4. Select "Email" from the Actions menu.
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5. In the Quick Compose email template, enter in the subject and body of the

email message, then click "Send".
The To field will be automatically populated with the name and email address
of the selected lead record(s).

Once the email is sent successfully, the email record will appear in the History
subpanel of the lead record(s).

 

Emailing Via Campaigns

Sugar's Campaigns module can be used to create email and newsletter campaigns
to send mass emails to a relevant set of leads. Email-type campaigns are mass
emails sent to a target list while newsletter-type campaigns are a series of mass
emails sent to a consistent or growing target list periodically or on a regular basis.
For more information on sending mass emails to leads via a campaign, please refer
to the Campaigns documentation.

Emailing Via Workflows

Sugar's Workflow module enables you to automate tasks, send email alerts, and
execute various actions. With each workflow, a set of conditions trigger a
combination of actions and email alerts potentially including alerts to lead records.
You also can create alert email templates used by workflows to insert relevent data
to the automated email notifications. For more information on workflow email
notifications, please refer to the Email Alertsection of the Workflows
documentation.

Adding Leads to a Target List
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A target list consists of a group of individuals or organizations you wish to be
included or excluded on a mass marketing campaign. These targets are typically
identified based on a set of predetermined criteria such as being a prospect or
existing customer, age group, industry, etc. There are various ways to add leads to
a target list in Sugar including using the Add to Target List option from the Lead
list view's Actions menu. For more information on target lists and other methods of
adding leads, please refer to the Target Lists documentation. Due to the PHP
memory limitations on the server, t here may be occasions when the application
times out while adding lead records to a target list.If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.

The following steps cover adding lead records to a target list via the Leads list
view as an example:

1. Navigate to the Leads list view by clicking the Leads module tab.
2. Use the Basic or Advanced Search to find the Lead records you wish to add to

a target list.
3. Select the desired lead records individually or using the checkbox

dropdown's options.
4. Choose "Add to Target List" from the Actions menu.

 
5. Locate and select the desired target list in the pop-up window or click "Create

Target List" to add to a new target list.
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In order to view the leads that have been added, you can navigate to the Target
Lists module. Click the target list's name to enter the detail view, and you will see
the lead records within the Leads subpanel.

 

Connectors

Connectors in Sugar allow the system to connect existing lead records in Sugar to
external applications such as Hoovers and Zoominfo. Users can search, view, and
merge additional lead data from the specific data source by selecting "Get Data"
from the Actions menu of the Leads detail view. For more information on utilizing
the connectors to get data, please refer to the Get Data section of the User
Interface documentation. Please note that the Hoovers and Zoominfo connectors
are not enabled by default for the Leads module. Administrators must first enable
the connectors via Admin > Connectors in order for the Get Data option to appear
in the Actions menu. For more information on enabling connectors, please refer to
the Enabling Connectors section of the System documentation in the
Administration guide.

Managing Lead Subscriptions

Leads who receive newsletter-type campaign emails from your Sugar instance are
considered subscribers to that newsletter. Users can manage these newsletter
subscriptions from the Leads detail view using the Manage Subscriptions option in
the Actions menu. Please note that you can only manage subscriptions for
newsletter-type campaigns. A newsletter campaign you have created will have one
or more default-type target lists. Leads are added to these target lists in order to
receive your newsletter. The Manage Subscriptions option allows you to add a lead
to the default-type or suppression-type target lists of your newsletter campaigns
without leaving the Leads module. For more information on newsletter
subscriptions, please refer to the Campaigns documentation.

Use the following steps to manage lead subscriptions via a lead's detail view:

1. Navigate to a lead record's detail view.
2. Select "Manage Subscriptions" from the Actions menu.
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3. To add the lead to a newsletter subscription mailing list, select the newsletter

from the Available/Newsletters Unsubscribed To list and drag it to the
Newsletters Subscribed To list. This will add the lead to the campaign's
default target list.

4. To remove the lead from the newsletter subscription mailing list, select the
newsletter from the Newsletters Subscribed To list and drag it to the
Available/Newsletters Unsubscribed To list. This will add them to the
suppression-type unsubscription target list for the newsletter campaign which
will prevent the lead from receiving the newsletter. Please note that the lead
will not be removed from the campaign's default target list.

 
5. Click "Save" to preserve your changes.

Last Modified: 09/26/2015 06:25pm

Contacts

Overview

Sugar's Contacts module consists of individual people with whom your
organization has a relationship. Contact records are typically related to an account
record, and multiple contacts may be associated to a single account. There are
various ways you can create contacts in Sugar such as via the Contacts module,
importing contacts, converting leads to contacts, etc. Once the contact record is
created, you can view and edit information pertaining to the contact via the
Contacts detail view. Each contact record may then relate to other Sugar records
such as meetings, cases, opportunities, and many others, making the contact
record a hub for viewing and continuing your interaction with the individual. This
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documentation will cover how to use the Contacts module as well as the various
actions and options available from within the module.

Contact Fields

The Contacts module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Account Name The account to which the contact

belongs
Assigned To The Sugar user assigned to the contact
Assistant The name of the contact's assistant

within his or her company
Assistant Phone The assistant's phone number
Birthdate The contact's date of birth
Campaign The campaign, if any, from which the

contact originated
Confirm Portal Password When editing, confirmation of the

contact's password for accessing Sugar
Portal

Date Created The date the contact record was created
Date Modified The date the contact record was last

modified
Department The contact's department within his or

her company
Description A description or other information about

the contact
Do Not Call Indication that the contact should not be

called
Email Address The contact's email address
Fax The contact's fax number
First Name The contact's first name
Home The contact's residence number
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Last Name The contact's last name
Lead Source The source from which the contact

originated
Mobile The contact's mobile number
Name When viewing, the contact's full name
Office Phone The contact's office number
Other Address The contact's alternate address (e.g.

billing or shipping)
Other Phone The contact's alternate phone number
Picture An image for the contact (e.g. business

card or profile picture)
Portal Active Indication that the contact is enabled to

access Sugar Portal
Portal Application The portal application name. Only used

when integrating a custom portal
solution with Sugar.

Portal Name The contact's user name for accessing
Sugar Portal

Portal Password The contact's password for accessing
Sugar Portal

Preferred Language The contact's preferred language when
accessing Sugar Portal

Primary Address The contact's primary address
Reports To The contact's manager in his or her

company
Salutation Standard greeting for the contact (e.g.

Mr., Ms., Mrs., etc.)
Sync to Outlook Indication that the contact should be

synced to Outlook when using the Sugar
Plug-in for Outlook

Note: This field must be set on a
per-user basis.

Teams The Sugar team(s) assigned to the
contact record

Title The contact's title within his or her
company
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Contacts Module Tab

The Contacts module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Contacts list view. You may also hover on
the tab to display the Actions, Recently Viewed, and Favorites menus. The Actions
menu allows you to perform important actions within the module. The Recently
Viewed menu displays the list of contacts you last viewed in the module. The 
Favorites menu displays the list of contacts you most recently marked as favorites
in the module.

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Contact Opens the edit view layout to create a

new contact
Create Contact From vCard Imports a vCard file from your computer

to create a new contact
View Contacts Opens the list view layout to search and

display contacts
View Contact Reports Displays existing reports based on the

Contacts module
Import Contacts Opens the import wizard to create or

update contacts using external data
If you do not see the Contacts module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Contacts module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Contacts module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your

 211 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Viewing_Via_Recently_Viewed
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Viewing_Via_Recently_Viewed
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Favoriting_Contacts
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Creating_Contacts
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Creating_Via_vCard
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Viewing_Contacts
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Viewing_Via_Reports
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Importing_Contacts
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface


 

user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Contacts module in the Hide Modules
list, simply move it to the Display Modules list and save. For more information
on hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Contacts module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Contacts
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Contacts

There are various methods for creating contacts in Sugar including via the
Contacts module, quick create, vCard, duplication, emails, importing contacts, and
converting leads to contacts. The full edit view layout opens when creating the
contact directly from the Contacts menu and includes all of the relevant fields for
your organization's contacts. The quick create form is a shortened version of the
contacts edit view and typically contains fewer fields. When using quick create to
make a contact while viewing an existing record of another module, Sugar
automatically creates a relationship between both records. For example, if you are
viewing an account record (e.g. ABC Company) and create a new contact via the
quick create form, the Account Name field in the contact record will automatically
populate with "ABC Company", thus creating the relationship. Both the Edit View
and Quick Create layouts can be configured by administrators via Admin > Studio.
For more information on configuring layouts, please refer to the Studio
documentation in the Administration guide.

Creating Via Contacts Module

One of the most common methods of contact creation is via the Create Contact
option in the Contacts module tab. This opens up the edit view layout which allows
you to enter in all the relevant information for the contact.
Use the following steps to create a contact via the Contacts module:

1. Hover on the Contacts module and select "Create Contact".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
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3. Once the necessary information is entered, click "Save".

 

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a contact from any Contacts
subpanel on related module records.
Use the following steps to create a contact via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Contact" or select "Create" on any Contacts subpanel on a related
module's detail view.
From Quick Create menu:

 
From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".
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Creating Via vCard

vCards are electronic business cards that are exchanged between applications
such as email and web browsers. In addition to allowing contacts to be saved as
vCards for use in other software, you can also generate a new Sugar contact from
a vCard.
Use the following steps to create a contact in Sugar via vCard:

1. Hover on the Contacts module and select "Create Contact From vCard".

 
2. Choose the vCard file from your computer and click "Import vCard".

 

Creating Via Duplication

You can also create a new contact by duplicating an existing contact record. The
duplicate option is useful if the contact you are creating has similar information to
an existing contact.
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Use the following steps to create a contact by duplicating an existing record:

1. Navigate to a contact record's detail view.
2. Select "Duplicate" from the Actions menu.

 
3. The displayed edit view is pre-populated with the original contact's values.

Update the necessary fields, then click "Save".

 

Creating Via Emails

The Emails module enables users to create new contact records from external and
imported emails using the Quick Create option. Simply click the Quick Create
button above the selected email header then select "Contact".

 

A pop-up window will open with the quick create form where you can enter
relevant values for the new contact. The name, email address, and description
fields are populated by default based on the emails subject, body, etc. All required
fields are marked with a red asterisk and must be completed prior to saving. Once
the necessary information is entered, click "Save". For more information on how to
create, send, and manage emails, please refer to the Emails documentation.

Please note that the selected email will be imported, if not already, and
automatically related to the new contact. The email record will appear within the
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History subpanel of the Contacts detail view.

Importing Contacts

The import function allows you to push multiple contact records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.

Use the following steps to import contacts via the Import Contacts option:

1. Hover on the Contacts module tab and select "Import Contacts".

 
2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only". Click

"Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. In Step 6, view the import results.

The Created Records tab will show all of the new contact records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Converting Leads to Contacts

Sugar enables you to convert lead records to contact records as you determine
that they qualify for your organization's definition of a contact (e.g. after an
evaluation/qualification process or upon entering into business with the
individual). When the lead is converted, a new contact record is created with a
relationship to the original lead record. For more information on converting leads,
please refer to the Leads documentation.

Use the following steps to convert leads into contacts:
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1. Navigate to a lead record's detail view.

 
2. Select "Convert Lead" from the Actions menu.

 
3. Complete the appropriate sections of the Convert Lead page.
4. Click "Save" to convert the lead.

 

Viewing Contacts

There are various options available for viewing contact records in Sugar including
via Contacts list view, Contacts detail view, Contacts Recently Viewed menu,
dashlets, and reports. Please note that you will only be able to see contact records
as allowed by your team membership, user access type, and assigned roles. For
more information on teams and roles, please refer to the Team Management and 
Role Managementdocumentation in the Administration guide.

Viewing Via List View

The Contacts list view displays all contact records meeting the current search
criteria. To access the list view, simply click the Contacts module tab. While list
view shows key contact fields, you can click the contact's name to open the record
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in detail view. For more information on viewing contacts via list view, please refer
to the Contacts List View section .

Viewing Via Detail View

The Contacts detail view displays thorough contact information including all
contact fields followed by subpanels of the contact's related records belonging to
various modules. The detail view can be reached by clicking a contact record's link
from anywhere in the application including from the Contacts list view. For more
information on viewing contacts via detail view, please refer to the Contacts
Detail View section.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which contacts you have recently viewed.
Hover on the Contacts module tab to see a list of your most recently viewed
contacts and click each name to open the contact in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view contact
information in contact-based dashlets such as "My Contacts" as well as in dashlets
based on other modules such as "My Calls". Clicking a contact's name from any
dashlet will open the contact in detail view. For more information on using
dashlets and viewing contact records via dashlets, please refer to the Modules
section of the Home documentation.
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Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding contacts and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the contact record's detail view by clicking the contact's name
in the report results. Please note that you can only directly access contact detail
views with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 

In addition to navigating to the Reports module and finding or building relevant
reports, you can use the Contact module tab's View Contact Reports option to see
all contact-based reports to which you have access.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Contacts

The Contacts list view includes a Basic and Advanced Search to help you locate
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records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Contacts list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a contact name, Sugar will only return contact records
with a matching name that are assigned to you. Once the search is complete, the
relevant results will populate in the list view below the search panel. To see all
contact records to which you have access, simply click "Clear" and then "Search"
to perform a blank search with no filters. Please note that you will only be able to
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see contact records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Administrators can configure what fields appear on the Contacts Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
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Favorites" and enter in a contact name to search, Sugar will only return contact
records with a matching name that you have marked as favorites. When searching
by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all contact
records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters.Please note that you will only be able to see
contact records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Administrators can configure what fields appear on the Contacts Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
Search section of the System documentation in the Administration guide.
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Contacts List View

The Contacts list view displays all contact records meeting the current search
criteria and to which your user has access. You can view the basic details of each
contact within the field columns. Please note that you will only be able to see
contact records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Contacts Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on contact records directly from the list view by
first selecting the desired records. To select individual contact records on the
Contacts list view, mark the checkbox on the left of each row. To select or deselect
multiple contact records on the list view, use the options in the checkbox
dropdown menu:
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Select This Page : Selects all records shown on the current page of contact
results.
Select All : Selects all records in the current search results across all pages of
contact results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more contacts at a time
Email Email one or more contacts at a time
Mass Update Mass update one or more contacts at a

time
Mail Merge Perform a mail merge on one or more

contacts at a time
Note: This option only appears when
Mail Merge is enabled at the system
level and under the user's profile.

Merge Merge two or more duplicate contacts
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Add to Target List Add one or more contacts to a target list
Export Export one or more contacts to a CSV

file

Favorite Designation

Users have the option to mark contact records as favorites via the list view as well
as the detail view. This allows users to designate records that are important or will
be viewed often so that they can easily be accessed via search or from the Contacts
module tab. In the Contacts list view, the star on the left of each contact's row is
yellow once marked to indicate a favorite contact. For more information on
marking records as favorites, please refer to the Favoriting Contacts section of this

documentation. 

More Information

Additional details for each contact can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional contact
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Primary Address, Mobile, Home, Other Phone, Date
Modified, and Description fields by default. The list of fields appearing here may

only be configured through a code-level customization. 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
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refer to the Layout Options section of the Search documentation. 

Contacts Detail View

The Contacts detail view displays thorough contact information including all
contact fields which are grouped by default into the Overview, More Information,
and Other panels. You can also view a contact's related records (Activities,
Opportunities, Leads, etc.) which appear in subpanels beneath the contact fields.
The detail view can be reached by clicking a contact record's link from anywhere
in the application including from the Contacts list view.

Please note that you will only be able to view a contact record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each contact's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this contact
Duplicate Duplicate this contact
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Delete Delete this contact
Find Duplicates Locate potential duplicates of this

contact
Get Data Search, view, and merge additional

contact data via Hoover's and/or
Zoominfo connector

Manage Subscriptions Manage this contact's newsletter
campaign subscriptions

View Change Log View a record of changes to this contact

Favorite Designation

Users have the option to mark contact records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often so that they can easily be accessed via search or from the
Contacts module tab. In the Contacts detail view, the star on the right of the
contact's name is yellow once marked to indicate a favorite contact. For more
information on how to mark records as favorites, please refer to the Favoriting
Contacts section of this documentation.

 

Next or Previous Record

On the upper right of the Contacts detail view, there are two buttons that allow
you to page through each contact in the Contacts list view's current search results.
Clicking the Previous button displays the previous contact of the current search
results while clicking the Next button displays the next contact of the current
search results. The text in between shows which contact result you are currently
viewing within the total number of current results.
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Subpanels

Beneath a contact record's fields are subpanels containing related records from
various modules, campaign interaction history for this contact, and the contact's
InsideView information.

Related Record Subpanels

The most common type of subpanels displayed on a contact's detail view contain
the contact's related records belonging to various modules. The relationship type
determines whether a related record will be displayed in the field listing or in a
subpanel. For example, a contact may be related to only one account but related to
multiple opportunities. This means that the related account will be displayed
amongst the contact's fields while opportunities will be displayed in a subpanel
beneath the fields.

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the contact, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the contact, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To edit the campaign's related record, choose "Edit" on the far right of the
record's row.
To delete the contact's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.
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Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

 

Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the contact record. Once the activities have taken place or are
completed, they will instead appear within the History subpanel. The History
subpanel also includes notes and emails associated with the contact record. For
more information on the history and activities subpanel, please refer to the User
Interface documentation.

 

Campaigns Subpanel

The Campaigns subpanel contains historical information regarding a contact
record's interaction with all Sugar campaigns. When a mass marketing campaign
is sent to a contact (or manually marked as sent in the case of non-email
campaigns), the related campaign activity information will appear within the
Campaigns subpanel. This information mirrors the "View Status" page available
from within each individual campaign and shows activities such as when a
campaign was sent, when the contact viewed the campaign message, when the
contact clicked a tracked link within the campaign, etc. Since this subpanel
contains historical campaign interactions for the contact, it cannot be used to
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associate a contact with a campaign or otherwise manage a campaign or target
list. For more information on associating a contact with a campaign, please refer to
the Adding Contacts to a Target List section of this documentation. For more

information on campaigns, please refer to the Campaigns documentation. 

InsideView Subpanel

The InsideView subpanel, if you are an InsideView user, provides relevant
company information, news, and social media insights within your contact's detail
view. The InsideView subpanel will appear by default on the detail view. The panel
can be minimized by clicking the double arrow next to "InsideView". For more
information on viewing contact information via InsideView, please refer to the 
User Interface documentation. Administrators in Sugar also have the ability to
disable InsideView for the entire instance so that it is not visible to users. For more
information on disabling InsideView, please refer to the Connectors section of the
System documentation in the Administration guide.

 

Editing Contacts

Contacts may be edited at any time to update or add information to the record. You
can make changes to existing contact records via the Contacts edit view and quick
create forms. Edit view is available within the Contacts module and includes all of
the Contact fields you should need.
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Quick create is available for editing contacts from outside the Contacts module and
opens as a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields.

 

Please note that your ability to edit contacts in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure both the Contacts edit view and quick
create via Admin > Studio. For more information on configuring layouts, please
refer to the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit contacts via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve your changes.
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Editing Via List View

You can edit contacts via the list view by clicking the Pencil icon to the left of each
contact's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve your changes.

 

Editing Via Dashlets

You can edit contacts by clicking the pencil icon to the far right of any
contacts-based dashlet on your Sugar home page. For example, clicking the pencil
icon within the My Contacts dashlet will open a pop-up window with the quick
create form which is a shortened version of the edit view layout. Update the
necessary fields, then click "Save" to preserve the changes. For more information
on dashlets, please refer to the Home documentation.

 

Editing Via Reports

Sugar reports also allow you to edit a contact record by clicking on the pencil icon
next to a contact's name. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. Please note that you may only directly

 232 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Contacts/#Contacts_List_View
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Home


 

edit contacts from Rows and Columns-type or Summation with Details-type reports
as Summation-type and Matrix-type reports do not include the pencil icon. For
more information on reports, please refer to the Reports documentation.

 

Deleting Contacts

If a contact record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Contacts detail view or list view.
Deleting via the detail view allows you to delete a single record while the list view
allows for mass deleting multiple records at once. Deleting contact records will not
delete the related records and will only remove the relationship, so you may wish
to also delete any related records to avoid orphaned records.

Please note that your ability to delete contacts may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Delete options.

Deleting Via Detail View

Use the following steps to delete a contact record via the detail view:

1. Navigate to a contact record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.
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Mass Deleting Via List View

Use the following steps to delete one or more contact records via the list view:

1. Navigate to the Contacts list view by clicking the Contacts module tab.
2. Use the Basic or Advanced Search to find the contact records you wish to

delete.
3. Select the desired contact records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of contact records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Contacts

Sugar's Export option allows users to download all fields for the selected contacts
to their computers as a .CSV (comma-separated values) file. This may be useful
when needing to use Contact data with other software such as Microsoft Excel or
to update existing records by exporting, making changes, then importing the
altered contacts back into Sugar. For more information on updating existing
records via import, please refer to the Import documentation. Due to PHP memory
limitations on the server, there may be occasions when the application times out
while exporting a large number of contact records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.

Contacts may be exported from the Contacts list view by selecting "Export" from
the Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for contacts and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
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please refer to the Export documentation.

 

Please note that your ability to export contacts from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Downloading a Contact's vCard

vCards are electronic business cards that are exchanged through applications such
as email and web browsers. In addition to being able to create a contact from an
existing vCard , you can also download a vCard from Sugar in order to transfer the
contact's information to another application.

The following steps cover downloading a vCard and saving it as a contact in
Microsoft Outlook as an example:

1. Navigate to a contact record's detail view.
2. Click the vCard icon to the right of the contact's name to download the vCard

file.

 
3. Open the downloaded file in your mail or address book application. For this

example, double clicking opens the vCard in Outlook.
4. Make any necessary changes to the information, then click "Save & Close" to

save this contact in Outlook.
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Mass Updating Contacts

Mass Updating allows users to make the same change to multiple contact records
at once from the Contacts list view. Users with administrator or developer access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of contact records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update contacts may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update contact records from the list view:

1. Navigate to the Contacts list view by clicking the Contacts module tab.
2. Use the list view's Basic or Advanced Search to find contacts you wish to

modify.
3. Select the desired contacts individually or using the checkbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.
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5. Scroll to the Mass Update panel and set values for the fields you wish to alter.
Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected contact

records.

Finding Duplicate Contacts

Between multiple users working in Sugar, importing new records, and converting
leads, it is possible for duplicate contact records to be accidentally input to the
system. Before creating a new contact record, a good practice is to first check that
the individual does not already exist in Sugar. You can locate duplicate records for
cleanup using Basic and Advanced Search from the Contacts list view.Searching
for contacts with similar names, related accounts, or other information can turn
search a powerful, duplicates-finding tool. Sugar also provides a wizard for finding
potential duplicates that is available from the Contacts detail view and may be
used as shown below. If duplicate contact records are detected, you can perform a
merge per the Merging Contacts section of this documentation.

Please note that your ability to use the Find Duplicate action may be restricted by
any role which prevents contact deletion. For more information on roles, please
refer to the Role Management documentation in the Administration guide.Check
with your system administrator if you do not see the Find Duplicates option.

Use the following steps to locate duplicate contacts using the Find Duplicates
option from the Contact detail view:

1. Navigate to a contact record's detail view.
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2. Choose "Find Duplicates" from the Actions menu.

 
3. Move any fields you wish to use in identifying duplicates to the list on the

right by selecting the field and clicking the arrow.

 
4. Click "Next Step" to display a list of potential duplicate contact records which

match all of the specified filters.

 

Once you determine which contacts of the resulting list are indeed duplicates of
your original record, select the duplicates by marking the checkboxes, then click
"Perform Merge" to begin a merge with the current record. Instructions for the
merge process that follows can be found in the Merging Via Detail View section of
this documentation.

Merging Contacts

When duplicate records are identified in Sugar, you have the option to merge two
or more contacts into a single record. Once the merge is complete, the duplicate
contact record(s) will be deleted, and the primary record will remain. Please note
that all relationships belonging to the duplicate contacts will be merged to the
primary record meaning that any calls, meetings, cases, etc. related to the
duplicate contact record(s) will automatically be related to the resulting, merged
contact record.
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Merging Via Detail View

Use the following steps to merge contacts via the Contacts detail view:

1. Navigate to a contact record's detail view.
2. Use the Find Duplicates option as shown in Finding Duplicate Contacts to

identify duplicate contacts.
3. Possible duplicates will be displayed in the results list. Select the duplicate

record(s).

 
4. Click "Perform Merge" to display the Merge Contacts page. The primary

record's field values are displayed on the left while other records' values are
in columns to the right. Saving the merge will preserve only the leftmost
values for each field into a single contact record.

 
5. To change which record is considered the primary, click the "Set as primary"

double arrows.
6. Review the field values in each column and use the associated double arrows

to move the best value for each field to the leftmost column.
7. Click "Save Merge" once the left column contains all fields you wish to appear

on the single, merged record.
8. A pop-up message will display confirming that the duplicate record(s) should

be deleted. Click "Ok" to proceed.

Merging Via List View

Basic and Advanced Search may be used to identify duplicate contacts by, for
example, searching for contacts with similar names or related accounts. Once your
search has identified duplicate contacts, you can merge them directly from the
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Contacts list view.

Use the following steps to merge contacts via the list view:

1. Use the list view's Basic or Advanced Search to identify duplicate contacts.
2. Possible duplicates will be displayed in the list view. Select the duplicate

record(s) that you wish to merge.

 
3. Select "Merge" from the Actions menu to display the Merge Contacts page.

The primary record's field values are displayed on the left while other
record's values are in columns to the right. Saving the merge will preserve
only the leftmost values for each field into a single contact record.

 
4. To change which record is considered the primary, click the "Set as primary"

double arrows.
5. Review the field values in each column and use the associated double arrows

to move the best value for each field to the leftmost column.
6. Click "Save Merge" once the left column contains all fields you wish to appear

on the single, merged record.
7. A pop-up message will display confirming that the duplicate record(s) should

be deleted. Click "Ok" to proceed.

Favoriting Contacts

Each Sugar user has the option to designate their own favorite contacts which are
important or will be viewed often.Once records are marked as favorites, use the
My Favorites checkbox in the Contacts Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Contacts
module tab .
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Favoriting Via List View

Use the following steps to mark records as favorites via the Contacts list view:

1. Navigate to the Contacts list view by clicking the Contacts module tab.
2. Use the Basic or Advanced Search to find the contact records you wish to

mark as favorites.
3. Click the star icon on the left of each desired contact's row.
4. To remove the contact as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Contacts detail view:

1. Navigate to a contact record's detail view.
2. Click the star icon to the right of the contact's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the contact as a favorite, click the star again to revert it to white.

 

Viewing Contact Change Logs

Changes made to each contact record are tracked over time, and users are able to
view the history of changes via the change log in each contact's detail view. To
view the change log, navigate to a contact in detail view and select "View Change
Log" from the Actions menu. Please note that only fields marked as "Audit" in
Admin > Studio will be displayed in the change log. For more information on
designating for audit, please refer to the Studio documentation in the
Administration guide.
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Emailing Contacts

Sugar allows users to compose and send outbound emails to contacts. There are
various ways to send outbound mail to contacts including emailing via the Emails
module, Emails quick compose, Contacts module, campaigns, and workflows.
Please note that administrators in Sugar must first configure the outbound mail
server for the system via Admin > Email Settings in order for users to send
outbound emails. For more information on setting up the system email settings,
please refer to the Email documentation in the Administration guide. Users will
also need to have their email settings configured in their user preferences prior to
sending outbound email from the Emails module, Emails quick compose, or
Contacts module. For more information on setting up your user preferences' email
settings, please refer to the Getting Started documentation.

Emailing Via the Emails Module

Use the following steps to compose and send an email to a contact via the Emails
module. For more detailed information on sending emails via the Emails module,
please refer to the Emails documentation.

1. Navigate to the Emails module by clicking the Emails module tab.
2. Click the Compose button on the upper left of the Emails module.

 
3. For the "Related To" field, select "Contacts" as the module then type or select

the desired contact's name. The email's To field will automatically populate
with the name and email address of the selected contact record.

4. Enter a subject and body for the email message then click "Send".
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Once the email is sent successfully, the email record will appear in the History
subpanel of the contact record.

 

Emailing Via Quick Compose

The quick compose option allows users to compose emails from various places in
Sugar without navigating away from the current page.

While viewing a contact record, you can select "Send Email" from the Quick Create
menu on the top right of any Sugar page. Quick creating an email while viewing a
contact record's detail view automatically populates the To field with the contact's
name and email address as well as relating the email to the contact record.

 

Users can also use Quick Compose by clicking a contact's email address anywhere
it is displayed as a link. Clicking the email address automatically populates the To
field with the contact's name and email address as well as relating the email to the
contact record.
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Quick Compose is also available from the Activities subpanel in a contact's detail
view. Choosing "Compose Email" from the Actions menu automatically populates
the To field with the contact's name and email address as well as relating the email
to the contact record.

 

Once the email is sent successfully, the email record will appear in the History
subpanel of the contact record. For more information on sending emails via quick
compose, please refer to the Emails documentation.

 

Emailing Via Contacts List View

One or more contacts may be emailed at a time from the Contacts list view. For
more information on sending emails via the Contacts list view, please refer to the 
documentation.

Use the following steps to compose and send an email from the Contacts list view:

1. Navigate to the Contacts list view by clicking the Contacts module tab.
2. Use the Basic or Advanced Search to find the contact records you wish to

include on the email.
3. Select the desired contacts individually or using the checkbox dropdown's

options.
4. Select "Email" from the Actions menu.
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5. In the Quick Compose email template, enter in the subject and body of the

email message, then click "Send". The To field will be automatically populated
with the name and email address of the selected contact record(s).

Once the email is sent successfully, the email record will appear in the History
subpanel of the contact record(s).

 

Emailing Via Campaigns

Sugar's Campaigns module can be used to create email and newsletter campaigns
to send mass emails to a relevant set of contacts. Email-type campaigns are mass
emails sent to a target list while newsletter-type campaigns are a series of mass
emails sent to a consistent or growing target list periodically or on a regular basis.
For more information on sending mass emails to contacts via a campaign, please
refer to the Campaigns documentation.

Emailing Via Workflows

Sugar's Workflow module enables you to automate tasks, send email alerts, and
execute various actions. With each workflow, a set of conditions trigger a
combination of actions and email alerts potentially including alerts to contact
records. You also can create alert email templates used by workflows to insert
relevent data to the automated email notifications. For more information on
workflow email notifications, please refer to the Email Alert section of the
Workflows documentation.
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Adding Contacts to a Target List

A target list consists of a group of individuals or organizations you wish to be
included or excluded on a mass marketing campaign. These targets are typically
identified based on a set of predetermined criteria such as being a prospect or
existing customer, age group, industry, etc. There are various ways to add contacts
to a target list in Sugar including using the Add to Target List option from the
Contact list view's Actions menu. For more information on target lists and other
methods of adding contacts, please refer to the Target Lists documentation. Due to
the PHP memory limitations on the server, t here may be occasions when the
application times out while adding contact records to a target list.If you encounter
an error when performing this action, we recommend selecting the records in
smaller batches.

The following steps cover adding contact records to a target list via the Contacts
list view as an example:

1. Navigate to the Contacts list view by clicking the Contacts module tab.
2. Use the Basic or Advanced Search to find the contact records you wish to add

to a target list.
3. Select the desired contact records individually or using the checkbox

dropdown's options.
4. Choose "Add to Target List" from the Actions menu.

 
5. Locate and select the desired target list in the pop-up window or click "Create

Target List" to add to a new target list.
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In order to view the contacts that have been added, you can navigate to the Target
Lists module. Click the target list's name to enter the detail view, and you will see

the contact records within the Contacts subpanel. 

Connectors

Connectors in Sugar allow the system to connect existing contact records in Sugar
to external applications such as Hoovers and Zoominfo. Users can search, view,
and merge additional data for the contact from the specific data source by
selecting "Get Data" from the Actions menu of the Contacts detail view. For more
information on utilizing the connectors to get data, please refer to the Get Data
section of the User Interface documentation. Please note that the Hoovers and
Zoominfo connectors are not enabled by default for the Contacts module.
Administrators must first enable the connectors via Admin > Connectors in order
for the Get Data option to appear in the Actions menu. For more information on
enabling connectors, please refer to the Enabling Connectors section of the System
documentation in the Administration guide.

Managing Contact Subscriptions
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Contacts who receive newsletter-type campaign emails from your Sugar instance
are considered subscribers to that newsletter. Users can manage these newsletter
subscriptions from the Contacts detail view using the Manage Subscriptions option
in the Actions menu. Please note that you can only manage subscriptions for
newsletter-type campaigns. A newsletter campaign you have created will have one
or more default-type target lists. Contacts are added to these target lists in order
to receive your newsletter. The Manage Subscriptions option allows you to add a
contact to the default-type or suppression-type target lists of your newsletter
campaigns without leaving the Contacts module. For more information on
newsletter subscriptions, please refer to the Campaigns documentation.

Use the following steps to manage contact subscriptions via a contact's detail view:

1. Navigate to a contact record's detail view.
2. Select "Manage Subscriptions" from the Actions menu.

 
3. To add the contact to a newsletter subscription mailing list, select the

newsletter from the Available/Newsletters Unsubscribed To list and drag it to
the Newsletters Subscribed To list. This will add the contact to the
campaign's default target list.

4. To remove the contact from the newsletter subscription mailing list, select the
newsletter from the Newsletters Subscribed To list and drag it to the
Available/Newsletters Unsubscribed To list. This will add them to the
suppression-type unsubscription target list for the newsletter campaign which
will prevent the contact from receiving the newsletter. Please note that the
contact will not be removed from the campaign's default target list.

 
5. Click "Save" to preserve your changes.

Last Modified: 09/26/2015 06:25pm
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Accounts

Overview

Sugar's Accounts module consists of companies with whom your organization has a
relationship and is generally seen as the hub for managing and analyzing your
business' interactions with each customer. There are various ways you can create
accounts in Sugar such as via the Accounts module, duplication, importing
accounts, etc. Once the account record is created, you can view and edit
information pertaining to the account via the Accounts detail view. Each account
record may then relate to other Sugar records such as contacts, meetings, cases,
opportunities, and many others as the customer's relationship matures. This
documentation will cover how to use the Accounts module as well as the various
actions and options available from within the module.

Account Fields

The Accounts module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Alternate Phone The account's secondary phone number
Annual Revenue The company's annual revenue
Assigned To The Sugar user assigned to the account
Billing Address The account's billing address
Campaign The campaign, if any, from which the

account originated
Copy Address From Left Select the box to copy the account's

billing address to the shipping address
field

Date Created The date the account record was
created

Date Modified The date the account record was last
modified
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Description A description or other information about
the account

Email Address The account's email address
Employees The number of employees at the

company
Fax The account's fax number
Industry The industry type to which the company

belongs
Name When viewing, the account's name
Office Phone The account's office number
Ownership Indicate if the company is privately or

publicly owned
Member Of Designate a parent-child relationship

between the account and another
account in Sugar

Rating The rating for the company compared to
other companies in Sugar

Shipping Address The account's shipping address
SIC Code The Standard Industrial Classification

(SIC) code for the account
Teams The Sugar team(s) assigned to the

account record
Ticker Symbol The stock trading symbol for the

company
Type The account type (e.g. customer,

investor, etc.)
Website The website URL associated with the

account

Accounts Module Tab

The Accounts module tab is typically located on the navigation bar at the top of
any Sugar screen. Click the tab to access the Accounts list view. You may also
hover on the tab to display the Actions, Recently Viewed, and Favorites menu. The
Actions menu allows you to perform important actions within the module. The 
Recently Viewed menu displays the list of accounts you last viewed in the module.
The Favorites menu displays the list of accounts you most recently marked as
favorites in the module.

 250 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Accounts/#Viewing_Via_Recently_Viewed
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Accounts/#Favoriting_Accounts


 

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Account Opens the edit view layout to create a

new account
View Accounts Opens the list view layout to search and

display accounts
View Account Reports Displays existing reports based on the

Accounts module
Import Accounts Opens the import wizard to create or

update accounts using external data
If you do not see the Accounts module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Accounts module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Accounts module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Accounts module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section of
the Getting Started documentation.
The administrator may have disabled the Accounts module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Accounts
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.
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Creating Accounts

There are various methods for creating accounts in Sugar including via the
Accounts module, quick create, duplication,and importing accounts. The full edit
view layout opens when creating the account directly from the Accounts menu and
includes all of the relevant fields for your organization's accounts. The quick create
form is a shortened version of the accounts edit view and typically contains fewer
fields. Both the Edit View and Quick Create layouts can be configured by
administrators via Admin > Studio. For more information on configuring layouts,
please refer to the Studio documentation in the Administration guide.

Creating Via Accounts Module

One of the most common methods of account creation is via the Create Account
option in the Accounts module tab. This opens up the edit view layout which allows
you to enter in all the relevant information for the account.
Use the following steps to create an account via the Accounts module:

1. Hover on the Accounts module and select "Create Account".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. Once the necessary information is entered, click "Save".

 

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create an account from any Accounts
subpanel on related module records.
Use the following steps to create an account via Quick Create:
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1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Account" or select "Create" on any Accounts subpanel on a related
module's detail view.
From Quick Create menu:

 
From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".

 

Creating Via Duplication

You can also create a new account by duplicating an existing account record. The
duplicate option is useful if the account you are creating has similar information to
an existing account.

Use the following steps to create an account by duplicating an existing record:
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1. Navigate to an account record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original account's values.

Update the necessary fields, then click "Save".

 

Importing Accounts

The import function allows you to push multiple account records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.

Use the following steps to import accounts via the Import Accounts option:

1. Hover on the Accounts module tab and select "Import Accounts".

 
2. In Step 1, select the import file and choose "Create new records only". Click

"Next".
3. In Step 2, confirm the import file properties. Click "Next".
4. In Step 3, confirm the field mappings for the import. Click "Next".
5. In Step 5, view the import results.

The Created Records tab will show all of the new account records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
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The Errors tab will show records that were not imported due to errors
detected during import.

Viewing Accounts

There are various options available for viewing account records in Sugar including
via Accounts list view, Accounts detail view, Accounts Recently Viewed menu,
dashlets, and reports. Please note that you will only be able to see account records
as allowed by your team membership, user access type, and assigned roles. For
more information on teams and roles, please refer to the Team Management and 
Role Management documentation in the Administration guide.

Viewing Via List View

The Accounts list view displays all account records meeting the current search
criteria. To access the list view, simply click the Accounts module tab. While list
view shows key account fields, you can click the account's name to open the record
in detail view. For more information on viewing accounts via list view, please refer
to the Accounts List View section of this documentation.

Viewing Via Detail View

The Accounts detail view displays thorough account information including all
account fields followed by subpanels of the account's related records belonging to
various modules. The detail view can be reached by clicking an account record's
link from anywhere in the application including from the Accounts list view. For
more information on viewing accounts via detail view, please refer to the 
Accounts Detail View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which accounts you have recently viewed.
Hover on the Accounts module tab to see a list of your most recently viewed
accounts and click each name to open the account in detail view.
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Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view account
information in account-based dashlets such as "My Accounts" as well as in dashlets
based on other modules such as "My Calls". Clicking an account's name from any
dashlet will open the account in detail view. For more information on using
dashlets and viewing account records via dashlets, please refer to the Modules
section of the Home documentation.

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding accounts and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the account record's detail view by clicking the account's name
in the report results. Please note that you can only directly access account detail
views with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 

In addition to navigating to the Reports module and finding or building relevant
reports, you can use the Account module tab's View Account Reports option to see
all account-based reports to which you have access.
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Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Accounts

The Accounts list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Accounts list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
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My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter an account name, Sugar will only return account
records with a matching name that are assigned to you. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all account records to which you have access, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see account records as allowed by your team membership, user access
type, and assigned roles. For more information on teams and roles, please refer to
the Team Management and Role Management documentation in the
Administration guide.

Administrators can configure what fields appear on the Accounts Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
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often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in an account name to search, Sugar will only return account
records with a matching name that you have marked as favorites. When searching
by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all account
records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
account records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Administrators can configure what fields appear on the Accounts Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
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magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
Search section of the System documentation in the Administration guide.

Accounts List View

The Accounts list view displays all account records meeting the current search
criteria and to which your user has access. You can view the basic details of each
account within the field columns. Please note that you will only be able to see
account records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Accounts Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.
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Checkbox Selection

You can perform several actions on account records directly from the list view by
first selecting the desired records. To select individual account records on the
Accounts list view, mark the checkbox on the left of each row. To select or deselect
multiple account records on the list view, use the options in the checkbox
dropdown menu:

Select This Page : Selects all records shown on the current page of account
results.
Select All : Selects all records in the current search results across all pages of
account results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more accounts at a time
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Email Email one or more accounts at a time
Mass Update Mass update one or more accounts at a

time
Mail Merge Perform a mail merge on one or more

accounts at a time
Note: This option only appears when
Mail Merge is enabled at the system
level and under the user's profile.

Merge Merge two or more duplicate accounts
Add to Target List Add one or more accounts to a target

list
Export Export one or more accounts to a CSV

file

Favorite Designation

Users have the option to mark account records as favorites via the list view as well
as the detail view. This allows users to designate records that are important or will
be viewed often so that they can easily be accessed via search or from the
Accounts module tab. In the Accounts list view, the star on the left of each
account's row is yellow once marked to indicate a favorite account. For more
information on how to mark records as favorites, please refer to the Favoriting
Accounts section of this documentation.

 

More Information

Additional details for each account can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional account
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Billing Address, Fax, Industry, and Description fields
by default. The list of fields appearing here may only be configured through a
code-level customization.
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Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Accounts Detail View

The Accounts detail view displays thorough account information including all
account fields which are grouped by default into the Overview, More Information,
and Other panels. You can also view an account's related records (Activities,
Opportunities, Leads, etc.) which appear in subpanels beneath the account fields.
The detail view can be reached by clicking an account record's link from anywhere
in the application including from the Accounts list view.

Please note that you will only be able to view an account record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each account's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this account
Duplicate Duplicate this account
Delete Delete this account
Find Duplicates Locate potential duplicates of this

account
Get Data Search, view, and merge additional

company data via Hoover's and/or
Zoominfo connector

View Change Log View a record of changes to this account

Favorite Designation

Users have the option to mark account records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often so that they can easily be accessed via search or from the
Accounts module tab. In the Accounts detail view, the star on the right of the
account's name is yellow once marked to indicate a favorite account. For more
information on how to mark records as favorites, please refer to the Favoriting
Accounts section of this documentation.

 

Copy Address
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Users also have the option to copy the account's billing or shipping address to the
related contact(s) by clicking the Copy icon in the address field. A pop-up window
will open displaying the list of all related contacts to the account. Select the
contact record(s) you wish to copy the account's address to, then choose either
"Copy to Primary Address" or "Copy to Other Address". The copied address will
appear in the primary or other address field of the related contact's detail view.

 

Next or Previous Record

On the upper right of the Accounts detail view, there are two buttons that allow
you to page through each account in the Accounts list view's current search
results. Clicking the Previous button displays the previous account of the current
search results while clicking the Next button displays the next account of the
current search results. The text in between shows which account result you are
currently viewing within the total number of current results.

 

Subpanels

Beneath an account record's fields are subpanels containing related records from
various modules, campaign interaction history for this account, and the account's
InsideView information.

Related Record Subpanels

The most common type of subpanels displayed on an account's detail view contain
the account's related records belonging to various modules. The relationship type
determines whether a related record will be displayed in the field listing or in a
subpanel. For example, an account may be related to multiple contacts, which
means that the related contacts will be displayed in a subpanel beneath the fields.
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Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the account, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the account, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To delete the account's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

 

Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the account record. Once the activities have taken place or are
completed, they will instead appear within the History subpanel. The History
subpanel also includes notes and emails associated with the account record. For
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more information on the history and activities subpanel, please refer to the User
Interface documentation.

 

Campaigns Subpanel

The Campaigns subpanel contains historical information regarding an account
record's interaction with all Sugar campaigns. When a mass marketing campaign
is sent to an account (or manually marked as sent in the case of non-email
campaigns), the related campaign activity information will appear within the
Campaigns subpanel. This information mirrors the "View Status" page available
from within each individual campaign and shows activities such as when a
campaign was sent, when the recipient viewed the campaign message, when the
recipient clicked a tracked link within the campaign, etc. Since this subpanel
contains historical campaign interactions for the account, it cannot be used to
associate an account with a campaign or otherwise manage a campaign or target
list. For more information on associating an account with a campaign, please refer
to the Adding Accounts to a Target List section of this documentation. For more
information on campaigns, please refer to the Campaigns documentation.

 

InsideView Subpanel

The InsideView subpanel, if you are an InsideView user, provides relevant
company information, news, and social media insights within your account's detail
view. The InsideView subpanel will appear by default on the detail view. The panel
can be minimized by clicking the double arrow next to "InsideView". For more
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information on viewing account information via InsideView, please refer to the 
User Interface documentation. Administrators in Sugar also have the ability to
disable InsideView for the entire instance so that it is not visible to users. For more
information on disabling InsideView, please refer to the Connectors section of the
System documentation in the Administration guide.

 

LinkedIn and Twitter Connector

The LinkedIn connector allows users in Sugar to view any connections they have to
companies through LinkedIn. The Twitter connector allows users to view, reply,
retweet, etc. to live Twitter feeds posted for the company. Users can simply click
the LinkedIn and Twitter icons to the right of the account's name to view the
account specific information if they wish. For more information on utilizing the
connectors, please refer to the Connectors section of the User Interface
documentation. Please note that the LinkedIn and Twitter connectors are enabled
by default for the Accounts module. Administrators have the ability to disable the
connectors via Admin > Connectors if they do not want it viewable by users. For
more information on disabling connectors, please refer to the Connectors section
of the System documentation in the Administration guide.

 

Editing Accounts

Accounts may be edited at any time to update or add information to the record.
You can make changes to existing account records via the Accounts edit view and
quick create forms. Edit view is available within the Accounts module and includes
all of the Account fields you should need.
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Quick create is available for editing accounts from outside the Accounts module
and opens as a pop-up without navigating away from your current page. It
generally contains fewer fields, but the Full Form button may be used to access the
full edit view should you need to edit additional fields.

 

Please note that your ability to edit accounts in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure both the Accounts edit view and quick
create via Admin > Studio. For more information on configuring layouts, please
refer to the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit accounts via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve the changes made.
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Editing Via List View

You can edit accounts via the list view by clicking the Pencil icon to the left of each
account's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.

 

Editing Via Dashlets

You can edit accounts by clicking the pencil icon to the far right of any
accounts-based dashlet on your Sugar home page. For example, clicking the pencil
icon within the My Accounts dashlet will open a pop-up window with the quick
create form which is a shortened version of the edit view layout. Update the
necessary fields, then click "Save" to preserve the changes. For more information
on dashlets, please refer to the Home documentation.

 

Editing Via Reports

Sugar reports also allow you to edit an account record by clicking on the pencil
icon next to an account's name. This opens a pop-up window with the quick create
form which is a shortened version of the edit view layout. Update the necessary
fields, then click "Save" to preserve the changes. Please note that you may only
directly edit accounts from Rows and Columns-type or Summation with
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Details-type reports as Summation-type and Matrix-type reports do not include the
pencil icon. For more information on reports, please refer to the Reports
documentation.

 

Deleting Accounts

If an account record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Accounts detail view or list view.
Deleting via the detail view allows you to delete a single record while the list view
allows for mass deleting multiple records at once. Deleting account records will
not delete the related records and will only remove the relationship, so you may
wish to also delete any related records to avoid orphaned records.

Please note that your ability to delete accounts in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete an account record via the detail view:

1. Navigate to an account record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.
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Mass Deleting Via List View

Use the following steps to delete one or more account records via the list view:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the Basicor Advanced Searchto find the Account records you wish to

delete.
3. Select the desired account records individually or using the checkbox

dropdown'soptions.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of account records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Accounts

Sugar's Export option allows users to download all fields for the selected accounts
to their computers as a .CSV (comma-separated values) file. This may be useful
when needing to use Account data with other software such as Microsoft Excel or
to update existing records by exporting, making changes, then importing the
altered accounts back into Sugar. For more information on updating existing
records via import, please refer to the Import documentation. Due to PHP memory
limitations on the server, there may be occasions when the application times out
while exporting a large number of account records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.
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Accounts may be exported from the Accounts list view by selecting "Export" from
the Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for accounts and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export accounts from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Accounts

Mass Updating allows users to make the same change to multiple account records
at once from the Accounts list view. Users with administrator or developer level
access can control which fields are available to change during mass update via
Admin > Studio. Currently, only fields with the data type of date, datetime,
dropdown, multiselect, and radio may be altered during a mass update. For more
information on configuring mass update, please refer to the Studio documentation
in the Administration guide. Due to the PHP memory limitations on the server,
there may be occasions when the application times out while mass updating a
large number of account records. If you encounter an error when performing this
action, we recommend selecting the records in smaller batches.

Please note that your ability to mass update accounts may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.
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Use the following steps to mass update account records from the list view:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the list view's Basicor Advanced Search to identify accounts you wish to

modify.
3. Select the desired accounts individually or using thecheckbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected account

records.

Finding Duplicate Accounts

Between multiple users working in Sugar, importing new records, and converting
leads, it is possible for duplicate account records to be accidentally input to the
system. Before creating a new account record, a good practice is to first check that
the account does not already exist in Sugar. You can locate duplicate records for
cleanup using Basic and Advanced Searchfrom the Accounts list view. Searching
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for accounts with similar names or other information can turn search a powerful,
duplicates-finding tool. Sugar also provides a wizard for finding potential
duplicates that is available from the Accounts detail view and may be used as
shown below. If duplicate account records are detected, you can perform a merge
per the Merging Accounts section of this documentation.

Please note that your ability to use the Find Duplicates action may be restricted by
any role which prevents account deletion. For more information on roles, please
refer to the Role Management documentation in the Administration guide.Check
with your system administrator if you do not see the Find Duplicates option.

Use the following steps to locate duplicate accounts using the Find Duplicates
option from the Account detail view:

1. Navigate to an account record's detail view.
2. Choose "Find Duplicates" from the Actions menu.

 
3. Move any fields you wish to use in identifying duplicates to the list on the

right by selecting the field and clicking the arrow.

 
4. Click "Next Step" to display a list of potential duplicate account records which

match all of the specified filters.

 

Once you determine which accounts of the resulting list are indeed duplicates of
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your original record, select the duplicates by marking the checkboxes, then click
"Perform Merge" to begin a merge with the current record. Instructions for the
merge process that follows can be found in the Merging Via Detail View section of
this documentation.

Merging Accounts

When duplicate records are identified in Sugar, you have the option to merge two
or more accounts into a single record. Once the merge is complete, the duplicate
account record(s) will be deleted, and the primary record will remain. Please note
that all relationships belonging to the duplicate accounts will be merged to the
primary record meaning that any calls, meetings, cases, etc. related to the
duplicate account record(s) will automatically be related to the resulting, merged
account record.

Merging Via Detail View

Use the following steps to merge accounts via the Accounts detail view:

1. Navigate to an account record's detail view.
2. Use the Find Duplicates option as shown in Finding Duplicate Accounts to

identify duplicate accounts.
3. Possible duplicates will be displayed in the results list. Select the duplicate

record(s).

 
4. Click "Perform Merge" to display the Merge Accounts page. The primary

record's field values are displayed on the left while other records' values are
in columns to the right. Saving the merge will preserve only the leftmost
values for each field into a single account record.
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5. To change which record is considered the primary, click the "Set as primary"

double arrows.
6. Review the field values in each column and use the associated double arrows

to move the best value for each field to the leftmost column.
7. Click "Save Merge" once the left column contains all fields you wish to appear

on the single, merged record.
8. A pop-up message will display confirming that the duplicate record(s) should

be deleted. Click "Ok" to proceed.

Merging Via List View

Basic and Advanced Search may be used to identify duplicate accounts by, for
example, searching for accounts with similar names. Once your search has
identified duplicate accounts, you can merge them directly from the Accounts list
view.

Use the following steps to merge accounts via the list view:

1. Use the list view's Basicor Advanced Search to identify duplicate accounts.
2. Possible duplicates will be displayed in the list view. Select the duplicate

record(s) that you wish to merge.

 
3. Select "Merge" from the Actions menu to display the Merge Accounts page.

The primary record's field values are displayed on the left while other
record's values are in columns to the right. Saving the merge will preserve
only the leftmost values for each field into a single account record.
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4. To change which record is considered the primary, click the "Set as primary"

double arrows.
5. Review the field values in each column and use the associated double arrows

to move the best value for each field to the leftmost column.
6. Click "Save Merge" once the left column contains all fields you wish to appear

on the single, merged record.
7. A pop-up message will display confirming that the duplicate record(s) should

be deleted. Click "Ok" to proceed.

Favoriting Accounts

Each Sugar user has the option to designate their own favorite accounts which are
important or will be viewed often so that they can easily be accessed via search or
from the Accounts module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Accounts Basicor Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Accounts
module tab .

Favoriting Via List View

Use the following steps to mark records as favorites via the Accounts list view:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the Basicor Advanced Search to find the Account records you wish to

mark as favorites.
3. Mark the star icon on the left of each desired account's row.
4. To remove the account as a favorite, click the star again to revert it to white.
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Favoriting Via Detail View

Use the following steps to mark records as favorites via the Accounts detail view:

1. Navigate to an account record's detail view.
2. Click the star icon to the right of the account's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the account as a favorite, click the star again to revert it to white.

 

Viewing Account Change Logs

Changes made to each account record are tracked over time, and users are able to
view the history of changes via the change log in each account's detail view. To
view the change log, navigate to an account in detail view and select "View Change
Log" from the Actions menu. Please note that only fields marked as "Audit" in
Admin > Studio will be displayed in the change log. For more information on
designating for audit, please refer to the Studio documentation in the
Administration guide.
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Emailing Accounts

Sugar allows users to compose and send outbound emails to accounts. There are
various ways to send outbound mail to accounts including emailing via the Emails
module, Emails quick compose, Accounts module, campaigns, and workflows.
Please note that administrators in Sugar must first configure the outbound mail
server for the system via Admin > Email Settings in order for users to send
outbound emails. For more information on setting up the system email settings,
please refer to the Emails documentation in the Administration guide. Users will
also need to have their email settings configured in their user preferences prior to
sending outbound email from the Emails module, Emails quick compose, or
Accounts module. For more information on setting up your user preferences' email
settings, please refer to the Getting Started documentation.

Emailing Via the Emails Module

Use the following steps to compose and send an email to an account via the Emails
module. For more detailed information on sending emails via the Emails module,
please refer to the Emails documentation.

1. Navigate to the Emails module by clicking the Emails module tab.
2. Click the Compose button on the upper left of the Emails module.

 
3. For the "Related To" field, select "Accounts" as the module then type or select

the desired account's name. The email's To field will automatically populate
with the name and email address of the selected account record.

4. Enter a subject and body for the email message then click "Send".
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Once the email is sent successfully, the email record will appear in the History
subpanel of the account record.

 

Emailing Via Quick Compose

The quick compose option allows users to compose emails from various places in
Sugar without navigating away from the current page.

While viewing an account record, you can select "Send Email" from the Quick
Create menu on the top right of any Sugar page. Quick creating an email while
viewing an account record's detail view automatically populates the To field with
the account's name and email address as well as relating the email to the account
record.

 

Users can also use Quick Compose by clicking an account's email address
anywhere it is displayed as a link. Clicking the email address automatically
populates the To field with the account's name and email address as well as
relating the email to the account record.

 

Quick Compose is also available from the Activities subpanel in an account's detail
view. Choosing "Compose Email" from the Actions menu automatically populates
the To field with the account's name and email address as well as relating the
email to the account record.
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Once the email is sent successfully, the email record will appear in the History
subpanel of the account record. For more information on sending emails via quick
compose, please refer to the Emails documentation.

 

Emailing Via Accounts List View

One or more accounts may be emailed at a time from the Accounts list view. For
more information on sending emails via the Accounts list view, please refer to the 
documentation.

Use the following steps to compose and send an email from the Accounts list view:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the Basicor Advanced Searchto find the Account records you wish to

include on the email.
3. Select the desired accounts individually or using thecheckbox dropdown's

options.
4. Select "Email" from the Actions menu.

 
5. In the Quick Compose email template, enter in the subject and body of the

email message, then click "Send".
The To field will be automatically populated with the name and email address
of the selected account record(s).

Once the email is sent successfully, the email record will appear in the History

 282 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Accounts/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Accounts/#Advanced_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Accounts/#Checkbox_Selection


 

subpanel of the account record(s).

 

Emailing Via Campaigns

Sugar's Campaigns module can be used to create email and newsletter campaigns
to send mass emails to a relevant set of accounts. Email-type campaigns are mass
emails sent to a target list while newsletter-type campaigns are a series of mass
emails sent to a consistent or growing target list periodically or on a regular basis.
For more information on sending mass emails to accounts via a campaign, please
refer to the Campaigns documentation.

Emailing Via Workflows

Sugar's Workflow module enables you to automate tasks, send email alerts, and
execute various actions. With each workflow, a set of conditions trigger a
combination of actions and email alerts potentially including alerts to account
records. You also can create alert email templates used by workflows to insert
relevent data to the automated email notifications. For more information on
workflow email notifications, please refer to the Email Alert section of the
Workflows documentation.

Adding Accounts to a Target List

A target list consists of a group of individuals or organizations you wish to be
included or excluded on a mass marketing campaign. These targets are typically
identified based on a set of predetermined criteria such as being a prospect or
existing customer, age group, industry, etc. There are various ways to add
accounts to a target list in Sugar including using the Add to Target List option
from the Account list view's Actions menu. For more information on target lists and
other methods of adding accounts, please refer to the Target Lists documentation.
Due to the PHP memory limitations on the server, there may be occasions when
the application times out while adding account records to a target list. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

The following steps cover adding account records to a target list via the Accounts
list view as an example:
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1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the Basicor Advanced Searchto find the Account records you wish to add

to a target list.
3. Select the desired account records individually or using the checkbox

dropdown's options.
4. Choose "Add to Target List" from the Actions menu.

 
5. Locate and select the desired target list in the pop-up window or click "Create

Target List" to add to a new target list.

 

In order to view the accounts that have been added, you can navigate to the Target
Lists module. Click the target list's name to enter the detail view, and you will see
the account records within the Accounts subpanel.
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Connectors

Connectors in Sugar allow the system to connect existing account records in Sugar
to external applications such as Hoovers and Zoominfo. Users can search, view,
and merge additional data for the account from the specific data source by
selecting "Get Data" from the Actions menu of the Accounts detail view. For more
information on utilizing the connectors to get data, please refer to the Get Data
section of the User Interface documentation. Please note that the Zoominfo
connector is not enabled by default for the Accounts module. Administrators must
first enable the connector via Admin > Connectors in order to search and view
data from Zoominfo via the Get Data option. For more information on enabling
connectors, please refer to the Enabling Connectors section of the System
documentation in the Administration guide.

Last Modified: 09/26/2015 06:25pm

Opportunities

Overview

Sugar's Opportunities module allows you to track individual sales from start to
finish. Each opportunity record represents a prospective sale and includes relevant
sale data as well as relating to other important records such as quotes, contacts,
etc. An opportunity will typically progress through several Sales Stages until it is
marked either "Closed Won" or "Closed Lost".

Opportunities can be leveraged even further by using Sugar's Forecasting module
to understand and predict sales trends as well as focus work to achieve sales
quotas. For more information on the Forecasts module, please refer to the 
Forecasts documentation.

Opportunity Fields

The Opportunities module contains a number of stock fields which come
out-of-the-box with Sugar. The following definitions are suggested meanings for
the fields, but the fields can be leveraged differently to best meet your
organization's needs. Users with administrator or developer access have the ability
to alter, add, or remove fields via Admin > Studio. For more information on
configuring fields, please refer to the Studio documentation in the Administration
guide.
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Field Description
Account Name The account to which the opportunity

belongs
Assigned to The Sugar user assigned to the

opportunity
Campaign The campaign, if any, from which the

opportunity originated

Note: This is an optional field as not all
opportunities will have a campaign.

Converted Amount The amount of the opportunity
converted to and displayed in the
system's default currency or the user's
preferred currency when the Show
Preferred Currency option is enabled on
the viewing user's profile

Note: This field is only available in the
list view. For more information on the
Converted Amount field, please see 
Transaction Amount Field Vs.
Converted Amount Field

Currency The currency used to define the
transaction amount

Date Created The date the opportunity record was
created

Date Modified The date the opportunity record was last
modified

Description A description or other information about
the opportunity

Expected Close Date The opportunity's expected or actual
close date

Lead Source The source (e.g. Trade Show) from
which the opportunity originated

Next Step The succeeding stage of the
opportunity's sales cycle

Opportunity Name The name of the opportunity
Probability (%) The opportunity's current probability of

being won

Note: This is a system-generated value
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based on the selected Sales Stage.
Sales Stage The opportunity's current sales stage

(e.g. Prospecting, Qualification, etc.)
Teams The Sugar team(s) assigned to the

opportunity record
Transaction Amount The transactional amount of the

opportunity which may use any currency
configured within Sugar

Note: For more information on the
Transaction Amount field, please see 
Transaction Amount Field Vs.
Converted Amount Field

Type The type (e.g. new business, existing
business) of opportunity

Sales Stages

A sales stage identifies the current stage (e.g. Prospecting, Qualification, etc.) that
the opportunity is in during the sales cycle. When you select a sales stage in the
opportunity record, the system automatically populates the corresponding
probability value (e.g. 10, 20, etc.) in the Probability (%) field. These probability
values are a useful tool as it helps calculate and predict your sales forecast for a
specified time period. For more information on the Forecasts module, please refer
to the Forecasts documentation. Administrators have the ability to configure the
sales stage and probability values for each sales stage via Admin > Dropdown
Editor. For more information on configuring the sales stages and probability
values, please refer to the Developer Tools documentation in the Administration
guide.

Please note that the below values are only guidelines for defining your sales stage
and you can skip one or more stages based on your organization's needs.

Sales Stage Value Probability (%) Description
Prospecting 10 Sales representative is

reviewing and qualifying
the opportunity

Note: This is the first
stage of the sales process,
which indicates that the
opportunity with this
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prospect is new.
Qualification 20 Sales representative is

interacting with the
prospect to determine if a
sales opportunity exists

Needs Analysis 25 Sales representative
understands that the
prospect is interested in
the product(s)/service(s)
and is identifying the
prospect's business
problems

Value Proposition 30 Sales representative is
mapping the company's
products and/or services
to the prospect's business
problems and describes
the value of the solution

Id. Decision Makers 40 Sales representative
identifies the decision
makers necessary to close
this opportunity after
determining there is a
match between the
prospect's business
problems and the
company's products and/or
services

Perception Analysis 50 Sales representative is
analyzing the prospect's
perceived value of the
company's solution to
prepare the appropriate
combination of products
and services for a sales
quote

Proposal/Price Quote 65 Sales representative is
delivering the proposal
(i.e. price quote) to the
prospect

Negotiation/Review 80 Sales representative is
reviewing and negotiating
the proposal with the
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prospect
Closed Won 100 Sales representative has

won this opportunity and
the client can be billed

Closed Lost 0 Sales representative has
lost this opportunity

Opportunities Module Tab

The Opportunities module tab is typically located on the navigation bar at the top
of any Sugar screen. Click the tab to access the Opportunities list view. You may
also hover on the tab to display the Actions, Recently Viewed, and Favorites
menus. The Actions menu allows you to perform important actions within the
module. The Recently Viewed menu displays the list of opportunities you last
viewed in the module. The Favorites menu displays the list of opportunities you
most recently marked as favorites in the module.

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Opportunity Opens the edit view layout to create a

new opportunity
View Opportunities Opens the list view layout to search and

display opportunities
View Opportunity Reports Displays existing reports based on the

Opportunities module
Import Opportunities Opens the import wizard to create or

update opportunities using external data
If you do not see the Opportunities module tab in Sugar, please check the
following:
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The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Opportunities module is not a member.
Click the More tab (last tab on navigation bar) then hover on "Filter Menu By"
to check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Opportunities module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Opportunities module in the Hide
Modules list, simply move it to the Display Modules list and save. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Opportunities module for your entire
Sugar instance. Reach out to your Sugar administrator to have the
Opportunities module displayed. For more information on displaying and
hiding modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration guide.

Creating Opportunities

There are various methods for creating opportunities in Sugar including via the
Opportunities module, Quotes module, quick create, duplication, emails, importing
opportunities, and lead conversion. The full edit view layout opens when creating
the opportunity directly from the Opportunities menu and includes all of the
relevant fields for your organization's opportunities. The quick create form is a
shortened version of the opportunities edit view and typically contains fewer fields.
When using quick create to make an opportunity while viewing an existing record
of another module, Sugar automatically creates a relationship between both
records. For example, if you are viewing an account record (e.g. ABC Company)
and create a new opportunity via the quick create form, the Account Name field in
the opportunity record will automatically populate with "ABC Company", thus
creating the relationship. Both the Edit View and Quick Create layouts can be
configured by administrators via Admin > Studio. For more information on
configuring layouts, please refer to the Studio documentation in the Administration
guide.

Creating Via Opportunities Module

One of the most common methods of opportunity creation is via the Create
Opportunity option in the Opportunities module tab. This opens up the edit view
layout which allows you to enter in all the relevant information for the opportunity.
Use the following steps to create an opportunity via the Opportunities module:
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1. Hover on the Opportunities module and select "Create Opportunity".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. Once the necessary information is entered, click "Save".

 

Creating Via Quotes Module

As you interact with your client and present the quote for your products and
services, you can easily create an opportunity from the Quotes detail view to better
track your sales. The displayed Opportunity detail view is pre-populated with the
original quote's values to display the opportunity name, transaction amount,
account name, and expected close date. By default, the sales stage is set to
"Proposal/Price Quote", the probability is "65%", the type is "New Business", and
the lead source is "Self Generated". You can edit the opportunity record
accordingly if you wish to change any of these default values. Please note that the
opportunity record will automatically be associated to the original quote. For more
information on creating an opportunity from a quote, please refer to the Creating
Opportunities from Quotes section of the Quotes documentation.

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create an opportunity from any
Opportunities subpanel on related module records.
Use the following steps to create an opportunity via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Opportunity" or select "Create" on any Opportunities subpanel on a
related module's detail view.
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From Quick Create menu:

 
From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".

 

Creating Via Duplication

You can also create a new opportunity by duplicating an existing opportunity
record. The duplicate option is useful if the opportunity you are creating has
similar information to an existing opportunity. Please note that existing subpanel
relationships for the original opportunity record will not carry over to the
duplicated opportunity record.

Use the following steps to create an opportunity by duplicating an existing record:

1. Navigate to an opportunity record's detail view.
2. Select "Duplicate" from the Actions menu.
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3. The displayed edit view page is pre-populated with the original opportunity's

values. Update the necessary fields, then click "Save".

 

Creating Via Emails

The Emails module enables users to create new opportunity records from external
and imported emails using the Quick Create option. Simply click the Quick Create
button above the selected email header then select "Opportunity".

 

A pop-up window will open with the quick create form where you can enter
relevant values for the new opportunity. The Opportunity Name and Description
fields are populated by default based on the emails subject and body. All required
fields are marked with a red asterisk and must be completed prior to saving. Once
the necessary information is entered, click "Save". For more information on how to
create, send, and manage emails, please refer to the Emails documentation.

Please note that the selected email will be imported, if not already, and
automatically related to the new opportunity. The email record will appear within
the History subpanel of the Opportunities detail view.

Importing Opportunities

The import function allows you to push multiple opportunity records into Sugar
using a comma (or other character) delimited file instead of creating them
one-by-one. For more information on importing, please refer to the Import
documentation.

 293 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Import


 

Use the following steps to import opportunities via the Import Opportunities
option:

1. Hover on the Opportunities module tab and select "Import Opportunities".

 
2. In Step 1, select the import file and choose "Create new records only". Click

"Next".
3. In Step 2, confirm the import file properties. Click "Next".
4. In Step 3, confirm the field mappings for the import. Click "Next".
5. In Step 5, view the import results.

The Created Records tab will show all of the new opportunity records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Creating via Lead Conversion

Sugar enables you to create a new opportunity record during the lead conversion
process. Please note that opportunities may or may not be available for creation
during lead conversion depending on the options configured by the administrator
via Admin > Studio. Administrators also have the ability to configure what fields
appear on the Create Opportunity section of the convert layout page via Admin >
Studio. For more information on configuring the convert lead layout, please refer
to the Studio documentation in the Administration guide.

Use the following steps to create an opportunity during lead conversion:

1. Navigate to a lead record's detail view.
2. Select "Convert Lead" from the Actions menu.
3. Select the Create Opportunity checkbox.
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4. Enter the relevant information for the opportunity then click "Save".

 

Viewing Opportunities

There are various options available for viewing opportunity records in Sugar
including via Opportunities list view, Opportunities detail view, Opportunities
Recently Viewed menu, d ashlets, and reports.Please note that you will only be
able to see opportunity records as allowed by your team membership, user access
type, and assigned roles. For more information on teams and roles, please refer to
the Team Management and Role Management documentation in the
Administration guide.

Viewing Via List View

The Opportunities list view displays all opportunity records meeting the current
search criteria. To access the list view, you can simply click the Opportunities
module tab or hover on the tab then select "View Opportunities". While list view
shows key opportunity fields, you can click the opportunity's name to open the
record in detail view. For more information on viewing opportunities via list view,
please refer to the Opportunities List View section.

Viewing Via Detail View

The Opportunities detail view displays thorough opportunity information including
all opportunity fields followed by subpanels of the opportunity's related records

 295 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Team_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Opportunities/#Opportunities_List_View


 

belonging to various modules. The detail view can be reached by clicking an
opportunity record's link from anywhere in the application including from the
Opportunities list view. For more information on viewing opportunities via detail
view, please refer to the Opportunities Detail View section.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which opportunities you have recently
viewed. Hover on the Opportunities module tabto see a list of your most recently
viewed opportunities and click each name to open the opportunity in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view opportunity
information in opportunity-based dashlets such as "My Top Open Opportunities" as
well as in dashlets based on other modules such as "My Calls". Clicking an
opportunity's name from any dashlet will open the opportunity in detail view. For
more information on using dashlets and viewing opportunity records via dashlets,
please refer to the Modules section of the Home documentation.

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding opportunities and their related records. In addition to
only displaying desired fields and relationships, reports can also incorporate
complex filters to only display specific subsets of your records. Once the report is
run, you will be able to view the opportunity record's detail view by clicking the
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opportunity's name in the report results. Please note that you can only directly
access opportunity detail views with Rows and Columns-type and Summation with
Details-type reports as Summation-type and Matrix-type reports do not include
hyperlinks in their display columns. For more information on using reports, please
refer to the Reports documentation.

 
In addition to navigating to the Reports module and finding or building relevant
reports, you can use the Opportunities module tab's View Opportunity Reports
option to see all opportunity-based reports to which you have access.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Viewing Via Forecasts

Sugar's Forecasts module incorporates opportunity records to build forecasting
worksheets and predict sales. Forecasts are based on the monetary value of the
opportunities in Sugar. Users can work towards sales quotas at the individual,
team, and sales organization level.Before users can access the Forecasts module to
begin building forecasting worksheets, a user with administrator access must
configure the Forecasts module with the organization's desired Time Periods,
Ranges, and Scenarios. For more information on setting up the Forecasts module,
please refer to the Forecast Configuration documentation in the Administration
Guide.

Based on the chosen filters (include, exclude, etc.), you will see all or some of your
assigned opportunities for the currently selected time period. The Forecast column
displays an automatic category indicating whether or not the opportunity's
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amounts are included in the totals for the specified time period . You can work
directly with your opportunity records by in-lineediting their probabilities and
amounts from the Forecasts module or by clicking the Name field to open a record
in the Opportunities module where you can make additional edits. For more
information on editing and managing forecasts, please refer to the Forecasts
documentation.

 

Searching Opportunities

The Opportunities list view includes a Basic and Advanced Search to help you
locate records easily and effectively in a module-specific manner. Once the search
is performed, the relevant results will be displayed in the Opportunities list view
below. Global Search allows users to search for information across their entire
Sugar database as opposed to restricting search within a specific module. Please
note that Sugar automatically appends the wildcard character (%) to the end of
your search phrase. This allows the system to retrieve all records that start with
the keyword entered in the search. If you would like to broaden the search, you
can use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:
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Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.
Open Items : Select this box to return only records with an open sales stage
(e.g. Prospecting, Proposal/Price Quote, etc.).

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter an opportunity name, Sugar will only return
opportunity records with a matching name that are assigned to you. Once the
search is complete, the relevant results will populate in the list view below the
search panel. To see all opportunity records to which you have access, simply click
"Clear" and then "Search" to perform a blank search with no filters. Please note
that you will only be able to see opportunity records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide.

Administrators can configure what fields appear on the Opportunities Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
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the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in an opportunity name to search, Sugar will only return
opportunity records with a matching name that you have marked as favorites.
When searching by a multiselect or dropdown field (e.g. "Assigned to"), however,
Sugar will return records matching any of these selections. Once the search
completes, the relevant results will populate in the list view below the search
panel. To see all opportunity records to which you have access, simply click "Clear"
and then "Search" to perform a blank search with no filters. Please note that you
will only be able to see opportunity records as allowed by your team membership,
user access type, and assigned roles. For more information on teams and roles,
please refer to the Team Management and Role Management documentation in the
Administration guide.

Administrators can configure what fields appear on the Opportunities Advanced
Search via Admin > Studio. For more information on editing layouts, please refer
to the Studio documentation in the Administration guide.

Global Search
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Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword (e.g. Opportunity Name)
into the search box. With Full Text Search enabled, pop-up results will begin
appearing once you input three or more characters. Clicking the magnifying glass
icon or hitting your Return/Enter key will cause Sugar to return exact matches for
your keyword rather than matches with words beginning with your keyword. When
Full Text Search is not enabled, results starting with your keyword will appear
after clicking the magnifying glass icon or hitting your Return/Enter key. For more
information on using and configuring Global Search, please refer to the Global
Search section of the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation.Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
Search section of the System documentation in the Administration guide.

Opportunities List View

The Opportunities list view displays all opportunity records meeting the current
search criteria and to which your user has access. You can view the basic details of
each opportunity within the field columns. Please note that you will only be able to
see opportunity records as allowed by your team membership, user access type,
and assigned roles. For more information on teams and roles, please refer to the 
Team Management and Role Management documentation in the Administration
guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Opportunities Advanced Search. For more information
on configuring your list view, please refer to the Layout Options section of the
Search documentation. Users with administrator or developer access also have the
ability to change what fields are visible in the list view via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation in
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the Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on opportunity records directly from the list view
by first selecting the desired records. To select individual opportunity records on
the Opportunities list view, mark the checkbox on the left of each row. To select or
deselect multiple opportunity records on the list view, use the options in the
checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of
opportunity results.
Select All : Selects all records in the current search results across all pages of
opportunity results.
Deselect All : Deselects all records that are currently selected.
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Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more opportunities at a

time
Mass Update Mass update two or more opportunities

at a time
Merge Merge two or more duplicate

opportunities
Export Export one or more opportunities to a

CSV file

Favorite Designation

Users have the option to mark opportunity records as favorites via the list view as
well as the detail view. This allows users to designate records that are important
or will be viewed often so that they can easily be accessed via search or from the
Opportunities module tab. In the Opportunities list view, the star on the left of
each opportunity's row is yellow once marked to indicate a favorite opportunity.
For more information on marking records as favorites, please refer to the 
Favoriting Opportunities section of this documentation.
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More Information

Additional details for each opportunity can be viewed by clicking the "i" icon to the
far right of each list view row. This provides users a quick view of additional
opportunity information in addition to what appears in the display column fields.
The resulting pop-up window will show the Lead Source, Probability, Next Step,
Type, and Description fields by default. The list of fields appearing here may only
be configured through a code-level customization.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Transaction Amount Field Vs. Converted Amount Field

The stock Opportunities list view contains two fields, Transaction Amount and
Converted Amount, that differ in functionality. When the viewing user's Show
Preferred Currency option is selected in their user profile, the Converted Amount
field will be displayed in the user's preferred currency. When it is unchecked, the
Converted Amount field will be displayed in the system default currency. For
information about setting a user's Preferred Currency and Show Preferred
Currency options, please refer to the User Profile documentation.

The primary differences between these fields and options are as follows:
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Field Name Value Displayed Sortable in List
View

Method to Update
Value

Transaction
Amount

Transactional
amount; the
currency and value
in which the
opportunity was
last saved

No; since this field
may include values
using different
currencies,
numerical sorting
would not result in
a valid ordering of
the comparative
amounts

Updated by editing
the opportunity
record

Converted Amount
(system default
currency)

Transaction
Amount converted
to the system
default currency
based on the
system-defined
conversion rate

Yes; since all
possible values use
a single currency,
sorting is allowed

Updated by a
scheduled process
when the relevant
exchange rate is
modified via Admin
> Currencies. For
more information
on how currency
changes affect the
Converted Amount
value please see 
Updating Currency
Rates

Converted Amount
(user's preferred
currency)

Transaction
Amount converted
to the viewing
user's preferred
currency as
specified in their
user profile based
on the
system-defined
conversion rate

Yes; since all
possible values use
a single currency,
sorting is allowed

Updated by
modifying the
relevant exchange
rate via Admin >
Currencies. For
more information
on how currency
changes affect the
Converted Amount
value please see 
Updating Currency
Rates

Opportunities Detail View

The Opportunities detail view displays thorough opportunity information including
all opportunity fields which are grouped by default into two separate panels. You
can also view an opportunity's related records (Activities, Contacts, Leads, etc.)
which appear in subpanels beneath the opportunity fields. The detail view can be
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reached by clicking an opportunity record's link from anywhere in the application
including from the Opportunities list view.

Please note that you will only be able to view an opportunity record according to
your team membership, user type, and role restrictions. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each opportunity's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this opportunity
Duplicate Duplicate this opportunity
Delete Delete this opportunity
Find Duplicates Locate potential duplicates of this

opportunity
View Change Log View a record of changes to this

opportunity

Favorite Designation
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Users have the option to mark opportunity records as a favorite via the detail view
as well as the list view. This allows users to designate records that are important
or will be viewed often so that they can easily be accessed via search or from the
Opportunities module tab. In the Opportunities detail view, the star on the right of
the opportunity's name is yellow once marked to indicate a favorite opportunity.
For more information on how to mark records as favorites, please refer to the 
Favoriting Opportunities section of this documentation.

 

Next or Previous Record

On the upper right of the Opportunities detail view, there are two buttons that
allow you to page through each opportunity in the Opportunities list view's current
search results. Clicking the Previous button displays the previous opportunity of
the current search results while clicking the Next button displays the next
opportunity of the current search results. The text in between shows which
opportunity result you are currently viewing within the total number of current
results.

 

Subpanels

Beneath an opportunity record's fields are subpanels containing related records
from various modules and the opportunity's InsideView information.

Related Record Subpanels

The most common type of subpanels displayed on an opportunity's detail view
contain the opportunity's related records belonging to various modules. The
relationship type determines whether a related record will be displayed in the field
listing or in a subpanel. For example, an opportunity may be related to only one
account but related to multiple contacts. This means that the related account will
be displayed amongst the opportunity's fields while contacts will be displayed in a
subpanel beneath the fields.
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Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the opportunity, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the opportunity, choose "Create" from the
subpanel's Action menu, then complete the Quick Create form and click
"Save".
To delete the opportunity's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

 

Contacts Subpanel

The Contacts subpanel for opportunities allows users to select a role (e.g. Primary
Decision Maker, Business Evaluator, etc.) for each related contact to help you
classify how each individual will ultimately factor into the buying decision. To
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select a role, simply click "Edit" on the far right of the contact record's row in the
subpanel and the role selection form will display. Please note that unlike the other
subpanels (e.g. Leads, Quotes, etc.), the edit option for contacts does not open the
actual edit view layout for the module. Select the appropriate role for the contact
then click "Save" and the chosen role will display in the Contacts subpanel of the
opportunity record.

 

Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the opportunity record. Once the activities have taken place or are
completed, they will instead appear within the History subpanel. The History
subpanel also includes notes and emails associated with the opportunity record.
For more information on the history and activities subpanel, please refer to the 
User Interface documentation.

 

InsideView Subpanel

The InsideView subpanel, if you are an InsideView user, provides relevant
company information, news, and social media insights within your opportunity's
detail view. The InsideView subpanel will appear by default on the detail view. The
panel can be minimized by clicking the double arrow next to "InsideView". For
more information on viewing opportunity information via InsideView, please refer
to the User Interface documentation. Administrators in Sugar also have the ability
to disable InsideView for the entire instance so that it is not visible to users. For
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more information on disabling InsideView, please refer to the Connectors section
of the System documentation in the Administration guide.

 

Editing Opportunities

Opportunities may be edited at any time to update or add information to the
record. You can make changes to existing opportunity records via the
Opportunities edit view and quick create forms. Edit view is available within the
Opportunities module and includes all of the Opportunities fields you should need.

 

Quick create is available for editing opportunities from outside the Opportunities
module and opens as a pop-up without navigating away from your current page. It
generally contains fewer fields, but the Full Form button may be used to access the
full edit view should you need to edit additional fields.
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Please note that your ability to edit opportunities in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure both the Opportunities edit view and quick
create via Admin > Studio. For more information on configuring layouts, please
refer to the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit opportunities via the detail view by clicking the Edit button on the
upper left of the page. Once the edit view layout is open, update the necessary
fields, then click "Save" to preserve your changes.

 

Editing Via List View

You can edit opportunities via the list view by clicking the Pencil icon to the left of
each opportunity's name. A pop-up window will open with the quick create form
which is a shortened version of the edit view layout. I f additional fields are
desired, click the Full Form button to use edit view instead. Update the necessary
fields, then click "Save" to preserve your changes.

 

Editing Via Dashlets

You can edit opportunities by clicking the pencil icon to the far right of any
opportunities-based dashlet on your Sugar home page. For example, clicking the
pencil icon within the My Top Open Opportunities dashlet will open a pop-up
window with the quick create form which is a shortened version of the edit view
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layout. If additional fields are desired, click the Full Form button to use edit view
instead. Update the necessary fields, then click "Save" to preserve the changes.
For more information on dashlets, please refer to the Home documentation.

 

Editing Via Reports

Sugar reports also allow you to edit an opportunity record by clicking on the pencil
icon next to an opportunity's name. This opens a pop-up window with the quick
create form which is a shortened version of the edit view layout. Update the
necessary fields, then click "Save" to preserve the changes. Please note that you
may only directly edit opportunities from Rows and Columns-type or Summation
with Details-type reports as Summation-type and Matrix-type reports do not
include the pencil icon. For more information on reports, please refer to the 
Reports documentation.

Please note that your ability to access and edit reports may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you cannot access the Reports module.

 

Deleting Opportunities
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If an opportunity record is invalid or should no longer appear in your
organization's Sugar instance, it may be deleted from either the Opportunities
detail view or list view. Deleting via the detail view allows you to delete a single
record while the list view allows for mass deleting multiple records at once.
Deleting opportunity records will not delete the related records and will only
remove the relationship, so you may wish to also delete any related records to
avoid orphaned records.

Please note that your ability to delete opportunities may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete an opportunity record via the detail view:

1. Navigate to an opportunity record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more opportunity records via the list view:

1. Navigate to the Opportunities list view by clicking the Opportunities module
tab.

2. Use the Basic or Advanced Search to find the opportunity records you wish to
delete.

3. Select the desired opportunity records individually or using the checkbox
dropdown's options.

4. Choose "Delete" from the Actions menu.

 313 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Opportunities/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Opportunities/#Advanced_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Opportunities/#Checkbox_Selection
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Opportunities/#Checkbox_Selection


 

 
5. A pop-up message will display asking for confirmation. Click "OK" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of opportunity records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Opportunities

Sugar's Export option allows users to download all fields for the selected
opportunities to their computers as a .CSV (comma-separated values) file. This
may be useful when needing to use Opportunity data with other software such as
Microsoft Excel or to update existing records by exporting, making changes, then
importing the altered opportunities back into Sugar. For more information on
updating existing records via import, please refer to the Import documentation.
Due to PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of opportunity records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Opportunities may be exported from the Opportunities list view by selecting
"Export" from the Actions menu. Users with access to the Reports module also
have the option of creating or accessing reports containing specifically chosen
fields for opportunities and their related record(s). Please note that only Rows and
Columns-type reports have the ability to be exported. For more information on
exporting records in Sugar, please refer to the Export documentation.
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Please note that your ability to export opportunities from Sugar may be restricted
by a role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Opportunities

Mass Updating allows users to make the same change to multiple opportunity
records at once from the Opportunities list view. Users with administrator or
developer access can control which fields are available to change during mass
update via Admin > Studio. Currently, only fields with the data type of date,
datetime, dropdown, multiselect, and radio may be altered during a mass update.
For more information on configuring mass update, please refer to the Studio
documentation in the Administration guide. Due to the PHP memory limitations on
the server, there may be occasions when the application times out while mass
updating a large number of opportunity records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.

Please note that your ability to mass update opportunities may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update opportunity records from the list view:

1. Navigate to the Opportunities list view by clicking the Opportunities module
tab.
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2. Use the list view's Basic or Advanced Search to find opportunities you wish to
modify.

3. Select the desired opportunities individually or using thecheckbox
dropdown's options.

4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected opportunity

records.

Finding Duplicate Opportunities

Between multiple users working in Sugar, importing new records, and converting
leads, it is possible for duplicate opportunity records to be accidentally input to the
system. Before creating a new opportunity record, a good practice is to first check
that the opportunity does not already exist in Sugar. You can locate duplicate
records for cleanup using Basic and Advanced Search from the Opportunities list
view.Searching for opportunities with similar names, related accounts, or other
information can turn search into a powerful, duplicates-finding tool. Sugar also
provides a wizard for finding potential duplicates that is available from the
Opportunities detail view and may be used as shown below. If duplicate
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opportunity records are detected, you can perform a merge per the Merging
Opportunities section of this documentation.

Please note that your ability to use the Find Duplicate action may be restricted by
any role which prevents opportunity deletion. For more information on roles,
please refer to the Role Management documentation in the Administration
guide.Check with your system administrator if you do not see the Find Duplicates
option.

Use the following steps to locate duplicate opportunities using the Find Duplicates
option from the Opportunity detail view:

1. Navigate to an opportunity record's detail view.
2. Choose "Find Duplicates" from the Actions menu.

 
3. Move any fields you wish to use in identifying duplicates to the list on the

right by selecting the field and clicking the arrow.

 
4. Click "Next Step" to display a list of potential duplicate opportunity records

which match all of the specified filters.

 

Once you determine which opportunities of the resulting list are indeed duplicates
of your original record, select the duplicates by marking the checkboxes, then click
"Perform Merge" to begin a merge with the current record. Instructions for the
merge process that follows can be found in the Merging Via Detail View section of
this documentation.
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Merging Opportunities

When duplicate records are identified in Sugar, you have the option to merge two
or more opportunities into a single record. Once the merge is complete, the
duplicate opportunity record(s) will be deleted, and the primary record will
remain. Please note that all relationships belonging to the duplicate opportunities
will be merged to the primary record meaning that any calls, meetings, contacts,
etc. related to the duplicate opportunity record(s) will automatically be related to
the resulting, merged opportunity record.

Merging Via Detail View

Use the following steps to merge opportunities via the Opportunities detail view:

1. Navigate to an opportunity record's detail view.
2. Use the Find Duplicates option as shown in Finding Duplicate Opportunities

to identify duplicate opportunities.
3. Possible duplicates will be displayed in the results list. Select the duplicate

record(s).

 
4. Click "Perform Merge" to display the Merge Opportunities page. The primary

record's field values are displayed on the left while other records' values are
in columns to the right. Saving the merge will preserve only the leftmost
values for each field into a single opportunity record.

 
5. To change which record is considered the primary, click the "Set as primary"

double arrows.
6. Review the field values in each column and use the associated double arrows
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to move the best value for each field to the leftmost column.
7. Click "Save Merge" once the left column contains all fields you wish to appear

on the single, merged record.
8. A pop-up message will display confirming that the duplicate record(s) should

be deleted. Click "Ok" to proceed.

Merging Via List View

Basic and Advanced Search may be used to identify duplicate opportunities by, for
example, searching for opportunities with similar names or related accounts. Once
your search has identified duplicate opportunities, you can merge them directly
from the Opportunities list view.

Use the following steps to merge opportunities via the list view:

1. Use the list view's Basic or Advanced Search to identify duplicate
opportunities.

2. Possible duplicates will be displayed in the list view. Select the duplicate
record(s) that you wish to merge.

 
3. Select "Merge" from the Actions menu to display the Merge Opportunities

page. The primary record's field values are displayed on the left while other
record's values are in columns to the right. Saving the merge will preserve
only the leftmost values for each field into a single opportunity record.

 
4. To change which record is considered the primary, click the "Set as primary"

double arrows.
5. Review the field values in each column and use the associated double arrows

to move the best value for each field to the leftmost column.
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6. Click "Save Merge" once the left column contains all fields you wish to appear
on the single, merged record.

7. A pop-up message will display confirming that the duplicate record(s) should
be deleted. Click "Ok" to proceed.

Favoriting Opportunities

Each Sugar user has the option to designate their own favorite opportunities which
are important or will be viewed often. Once records are marked as favorites, use
the My Favorites checkbox in the Opportunities Basic or Advanced Search to
retrieve your favorites or select from your most recent favorites directly from the  .

Favoriting Via List View

Use the following steps to mark records as favorites via the Opportunities list view:

1. Navigate to the Opportunities list view by clicking the Opportunities module
tab.

2. Use the Basic or Advanced Search to find the opportunity records you wish to
mark as favorites.

3. Click the star icon on the left of each desired opportunity's row.
4. To remove the opportunity as a favorite, click the star again to revert it to

white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Opportunities detail
view:

1. Navigate to an opportunity record's detail view.
2. Click the star icon to the right of the opportunity's name in the upper left of

the detail view to designate it as a favorite.
3. To remove the opportunity as a favorite, click the star again to revert it to

white.
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Viewing Opportunity Change Logs

Changes made to each opportunity record are tracked over time, and users are
able to view the history of changes via the change log in each opportunity's detail
view. To view the change log, navigate to an opportunity in detail view and select
"View Change Log" from the Actions menu. Please note that only fields marked as
"Audit" in Admin > Studio will be displayed in the change log. For more
information on designating fields for audit, please refer to the Studio
documentation in the Administration guide.

 

Updating Currency Rates

When saving an opportunity in a currency that differs from the system-defined
default currency, Sugar will store the conversion rate for that currency at the
record level. This conversion rate is used to calculate the Converted Amount when
the field is set to use the system default currency (as opposed to the user's
preferred currency which is explained below). To keep amounts historically
accurate, the conversion rate will only update on an opportunity provided the sales
stage is not set to "Closed Won" or "Closed Lost". If the opportunity is in any other
sales stage, the conversion rate will update under the following scenarios:

The opportunity undergoes a save event (e.g. mass update, manual save, etc.)
and the record's currency has a different conversion rate defined in Admin >
Currencies than is currently saved in the opportunity.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all opportunities
saved with that currency to the new rate.

When the viewing user's profile has the Show Preferred Currency option selected,
the Converted Amount field displays the Transactional Amount in the user's
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preferred currency. In this case, the conversion rate used to calculate the
Converted Amount's value is drawn directly from the conversion rate at the system
level rather than any conversion rate stored on the record. This means that the
value will always use the current conversion rate regardless of the opportunity's
sales stage. For this reason, the Converted Amount field should not be considered
historically accurate for closed opportunities when it is using the user's preferred
currency. For information about setting a user's Preferred Currency and Show
Preferred Currency options, please refer to the User Profile documentation.

For more information about currency exchange rates, please refer to the 
Currencies documentation in the Administration guide.

Last Modified: 01/14/2016 01:13pm

Forecasts

Overview

Sugar's Forecasts module incorporates opportunity records to build forecasting
worksheets and predict sales. Users can work towards sales quotas at the
individual, team, and sales organization level.

Before users can access the Forecasts module to begin building forecasting
worksheets, a user with administrator access must configure the Forecasts module
with the organization's desired Time Periods, Ranges, and Scenarios. For more
information on setting up the Forecasts module, please refer to the Forecast
Configuration documentation in the Administration Guide.

Sales representatives use the Forecasts module to work with their assigned
opportunities as the current time period progresses. These users will commit total
predictions for their personal sales based on the opportunities they expect to close.
For instructions specific to a sales representative's use of the module, please refer
to the Sales Representative section of this documentation.

Sales managers work with their own opportunity records similarly to other sales
representatives. In addition, they aggregate their reportee's committed forecast
amounts to predict their total team's sales and work towards the team's quota for
each time period. For instructions specific to a sales manager's use of the module,
please refer to the Sales Managers section of this documentation.

Additional insights are offered by the elements of the expandable Intelligence Pane
including analysis for an individual's opportunities worksheet and analysis for a
manager's team worksheets. For more information, please refer to the sales
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representative Intelligence Pane and the sales manager Intelligence Pane sections
of this documentation.

Forecast Fields

The Forecasts module contains the following fields which enable users to work
with opportunity records to forecast sales for a given time period:

Field Description
Forecast "Included", "Excluded", or "Upside"

(optional) based on the opportunity's
initial probability and the user's edits;
controls whether the opportunity is
counted in the forecast's totals and
allows for filtering; can be edited in-line
from the Forecasts module

Name The opportunity's name; can be edited
from the Opportunities module

Expected Close The opportunity's expected date of
completion; used to aggregate
opportunities to the relevant time
period; can be edited from the
Opportunities module

Stage The opportunity's current sales stage;
can be edited from the Opportunities
module

Probability The opportunity's current probability of
being won; can be edited in-line from
the Forecasts module

Likely Case The opportunity's Transaction Amount
field; can be edited in-line from the
Forecasts module

Best Case (Optional) The opportunity's most
optimistic total amount; can be edited
in-line from the Forecasts module

Worst Case (Optional) The opportunity's least
optimistic total amount; can be edited
in-line from the Forecasts module

Forecasts Module Tab
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The Forecasts module tab is typically located under the More tab on the navigation
bar at the top of any Sugar screen to the right of the home cube icon. Depending
on your settings, you may have to click "Show More" in order to see the Forecasts
module tab. Click the tab to access the Forecasts module. A user with
administrator access must first configure the Forecasts module before it can be
accessed and used. For more information on setting up the Forecasts module,
please refer to the Forecast Configuration documentation in the Administration
guide.

If you do not see the Forecasts module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (i.e.
Activities, Reports, etc.) of which the Forecasts module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Forecasts module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Forecasts module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section of
the Getting Started documentation.
The administrator may have disabled the Forecasts module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Forecasts
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Forecast Actions

Forecast actions are available at the top of the Forecasts module page and allow
users to perform the following operations:

Menu Item Description
Save Draft Saves changes to the user's

opportunities worksheet but does not
make these changes available to the
user's manager

Commit Saves changes to the current worksheet
and pushes these changes to the user's
manager's team worksheet or, in the
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case of a manager committing a
personal opportunities worksheet, to his
or her own team worksheet

Export CSV Exports the rows of the current
forecasts worksheet

Settings For users with administrator access,
opens the Forecast Configurations
wizard

Print Prints everything currently displayed on
your Forecasts page including the
worksheet and, if displayed, elements of
the Intelligence Pane

Sales Representatives

Sales representatives use the Forecasts module to work with their assigned
opportunities as the current time period progresses. These users will commit total
predictions for their personal sales based on the opportunities they expect to close.

When you access the Forecasts module as a sales representative, you will see your
name at the top left of the screen. Sales representatives who do not have any
reportees will only be able to see and work with his or her own opportunities.
Below your name, you will see a time period selection, summary and commit
history, filter, and opportunities worksheet. On the right side of each page is an
expandable Intelligence Pane which offers additional insight into your forecasting
worksheet.

Time Periods

Below your name, you will see the current time period for which you are
forecasting opportunities to meet a quota. The length and start date of this time
period depends on the Time Periods configuration set up by your administrator.
Clicking the arrow to the right of the current time period allows you to choose a
future or past time period, the availability of which is also determined by the
administrator's Time Periods configuration. Select a past or future time period to
work with opportunities and forecast for those periods.
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Summary & Commit History

To the right below the Time Period selection, you will see a summary of your
current forecasting numbers for the time period currently in view. The large
numbers are your current opportunities worksheet's Likely, Best, and Worst Case
predictions. The smaller numbers show your most recent commit's Likely, Best,
and Worst Case predictions. Any red or green arrows next to the large numbers
show whether you worksheet's current (uncommitted) numbers are higher or
lower than your most recent commit. Please note that you may or may not see a
Best Case and Worst Case depending on your administrator's Scenarios
configuration.

 

To the left of these summary numbers, you will see the date and time of your most
recent commit. There will be no date and time shown if you have not yet
committed for this time period. By clicking the arrow to the right of the latest
commit date, a dark grey panel will appear showing a history of your commits for
this time period along with the changes for each forecasting number from the
previous commit.

Filters

Below the summary and commit history, you will see a filter bar which controls
what kinds of opportunities are displayed. By default, the "Include" filter will be
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active, meaning that only the opportunities with a probability falling within the
Include range specified during the administrator's Ranges configuration will be
displayed. To add additional filters, click the arrow to the right of the Filters bar
and choose additional ranges. Please note the Upside range may or may not be
available depending on the administrator's Ranges configuration. When the Upside
range is not available, the Forecast column will display checkbox icons rather than
words with the checked box representing "Include" and the unchecked box
representing "Exclude". To remove ranges from the filter, click the "x" for each
filter name. Removing all filters will display all of your assigned opportunities.

 

Opportunities & Totals

Based on the chosen filters, you will see all or some of your assigned opportunities
for the currently selected time period listed below the Filters bar. The Forecast
column displays an automatic category indicating whether or not the opportunity's
amounts are included in the totals for this time period; this designation can be 
changed manually. You can work directly with your opportunity records by in-line 
from the Forecasts module or by clicking the Name field to open a record in the
Opportunities module where you can make additional edits.

 

At the bottom of the opportunities list, "Included Total" provides the total amounts
for all of your opportunities within this time period marked as "Include" in the
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Forecast column. The "Overall Total" shows the total amounts regardless of each
opportunity's designation in the Forecast column.

Note: If an administrator configures the Opportunities module's dropdown options
for the Sales Stage field to remove "Closed Won" and "Closed Lost", the
Forecasting module will sum all opportunities when calculating totals.

Editing Forecast Inclusion

The first time an opportunity is loaded to a opportunities worksheet, Sugar will
assign it a category of either "Include", "Exclude", or "Upside" (optional) based on
the Ranges configured by your administrator. Opportunities with a higher
probability of being won are typically assigned to the Include range while those
with a lower probability of being won are designated for the Exclude range. If your
administrator has chosen to use the Upside range, this will usually consist of
opportunities with a middle-level probability. If the administrator has chosen to not
use the Upside range, the Forecast column will display checkbox icons rather than
words with the checked box representing "Include" and the unchecked box
representing "Exclude".

You may wish to alter the category automatically assigned to your opportunities by
these adminstrator-configured ranges especially as each opportunity moves
forward in the sales process and becomes more likely to be won. To do this, simply
click on the opportunity's current category or checkbox in the Forecast column and
choose the desired category from the dropdown menu or click the checkbox to be
checked or unchecked.

 

Changing a opportunity's Forecast column to "Include" will cause its Likely, Best,
and Worst Case fields to be added to your totals while choosing "Exclude" will
remove the opportunity's numbers from your totals. Changing which opportunities
are included on your worksheet requires you to save a draft or commit in order to
preserved.

Note: Opportunities in a Closed Won stage will be included in the opportunities
worksheet and cannot have their Forecast column altered. Opportunities in a
Closed Lost stage will be excluded from the opportunities worksheet and cannot
have their Forecast column altered.
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Editing Opportunity Fields

In addition to editing the inclusion, you can make in-line changes to each
opportunity's fields including Probability, Likely Case, Best Case, and Worst Case.
To do so, simply click any field which shows a pencil icon when being hovered
over, and enter the new amount. Keep in mind that your worksheet may or may not
include "Best Case" and "Worst Case" amounts depending on your administrator's 

 

Clicking outside the text box or pressing Enter/Return will save your change to the
line and update the worksheet's totals, summary, and Intelligence Pane. Clicking
the Save Draft or Commit button will also update the opportunity records
themselves and make your changes visible when viewing the opportunity in other
places in Sugar. Saving a draft or committing is also required to preserve these
changes to your opportunities worksheet and, in the case of committing, make the
changes visible in your manager's Forecasting module.

Note: You will not be able to edit any fields for opportunities in a Closed Lost or
Closed Won stage from your worksheet, but they may be edited from the
Opportunities module.

Currency Support

If you use a currency different from your Sugar instance's default currency, your
opportunity Likely, Best, and Worst Case amounts will be displayed in the system's
default currency in the Forecasting module. Clicking to edit these amount values
will, however, display and allow for editing in your chosen currency.

Intelligence Pane

To the right of the opportunities worksheet you will find an expandable
Intelligence Pane which provides additional insights for planning and forecasting.
If the pane is hidden, click the double-arrow button to expand it. Clicking the
button again will hide it when you wish to see your worksheet at full width.

 

Projected Table

The Projected table appears in the top of the Intelligence Pane and gives a
breakdown of how your opportunities match up to your quota as well as insight
into your current pipeline. Keep in mind that your Projected table may or may not
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include "Best Case" and "Worst Case" amounts depending on your administrator's 

 

The projected table's values are calculated based on the most recent updates to
your opportunities worksheet even if the changes have not yet been saved as a
draft or committed. The values take all of your opportunities into account
regardless of any filters currently being used in your worksheet. Their meanings
are as follows:

Field Description
Quota Your personal quota for this sales time

period as assigned by your manager
Likely above/below Quota The difference between your included

opportunities' Likely Case amounts and
your quota as well as the corresponding
percentage

Best above/below Quota (Optional) The difference between your
included opportunities' Best Case
amounts and your quota as well as the
corresponding percentage

Worst above/below Quota (Optional) The difference between your
included opportunities' Worst Case
amounts and your quota as well as the
corresponding percentage

Closed The total amount of your Closed Won
opportunities

Likely above Closed The difference between your included
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opportunities' Likely Case amounts and
your Closed Won total as well as the
corresponding percentage

Best above Closed (Optional) The difference between your
included opportunities' Best Case
amounts and your Closed Won total as
well as the corresponding percentage

Worst above Closed (Optional) The difference between your
included opportunities' Worst Case
amounts and your Closed Won total as
well as the corresponding percentage

Pipeline Opportunities The number of your in-progress
included and excluded opportunities
which are not yet in a Closed Won or
Closed Lost stage

Pipeline Revenue The total Likely Case amounts of your
in-progress included and excluded
opportunities which are not yet in a
Closed Won or Closed Lost stage

Pipeline Size The ratio of your in-process
opportunities' total to your "Included"
opportunities' total; a progressive gauge
of how much more business is available
for you to bring in for this time period: a
higher number indicates many more
opportunities are available to be
pursued and included on your forecast
while a lower number indicates you are
nearing the end of your available
opportunities

Chart

The bottom of the Intelligence Pane provides a configurable chart showing
different cuts of your forecasting data over the course of the selected time period.
Each opportunity's Expected Close Date field determines in which sub-period it
appears. Only the opportunities currently appearing on your worksheet will appear
in your chart meaning that the chart is also respecting your current filters.
Throughout all chart configurations, the dotted black line represents your quota
for the given time period and can be hovered over to view the quota amount.

Click the gear icon to configure what is displayed in the chart.
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When "Likely" is chosen, each purple point represents the total Likely Case
amounts for all opportunities regardless of stage or inclusion in the forecast for
that month and any previous months falling within the time period. Choosing
"Best" or "Worst" shows the same points using the opportunities' Best Case or
Worst Case amounts instead. A purple line connects these points showing the
change in your possible cumulative opportunity amounts. Please note that you may
or may not see "Best" and "Worst" as options depending on your administrator's 
Scenarios configuration.

Choosing "Included in Forecast" in the chart configuration will show bars
representing the Likely Case amounts for your opportunities with expected close
dates in each sub-period color coded by whether the opportunities are included in
or excluded from your opportunities worksheet.

 

Choosing "Sales Stage" in the chart configuration will show bars representing the
Likely Case amounts for your opportunities with expected close dates in each
sub-period color coded by the opportunities' sales stage.
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Choosing "Probability" in the chart configuration will show bars representing the
Likely Case amounts for your opportunities with expected close dates in each
sub-period color coded by the opportunities' probabilities.

 

Note: Changes to your opportunities worksheet will need to be saved as a draft or
committed before they will be reflected in the chart, however current filters in
your worksheet will control what opportunities are included in the chart.

Sales Managers

Sales managers work with their own opportunity records similarly to other sales
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representatives. In addition, they aggregate their reportee's committed forecast
amounts to predict their total team's sales and work towards the team's quota for
the each time period.

When you access the Forecasts module as a sales manager, you will see your name
at the top left of the page along with an arrow which allows you to drill down into
your personal opportunities worksheet, your team worksheet, and your reportee's
opportunities worksheets hierarchically. While working with your personal
opportunities worksheet works similarly to how a regular sales representatives
works with their opportunities, you will also have options such as time period
selection, summary and commit history, and filters when working with your team
worksheet and your reportees' forecasting data. On the right side of each page is
an expandable intelligence pane which offers additional insight into your
forecasting worksheet.

Forecast Drilldown

Because sales managers are able to see and work with their reportee's
opportunities in addition to their own, these users will see an arrow next to their
name at the top left of the Forecasts module. This allows them to drill into team
forecasting data and individual sales representatives' opportunities. By default,
Aaron will enter the Forecasts module viewing his team worksheet which includes
the total committed amounts and quotas for each immediate reportee and himself. 

Own Opportunities

As a manager, Aaron can see and work with his own opportunities by selecting
"Opportunities (Aaron Johnson)" from the menu next to his name or from the Name
column in his team worksheet below.

 

While working with his own opportunities, he will have the same options on his
opportunities worksheet as a regular sales representative has. For more
information on working with a manager's opportunities worksheet, please refer to
the Opportunities & Totals section of this documentation. Aaron will need to
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commit his new opportunities or changes to his opportunities on his opportunities
worksheet before the amounts will be reflected on his team worksheet.

Reportee's Opportunities

Since Aaron is Ellen's manager, Aaron also has the ability to work with Ellen's
committed forecast and opportunities. He can navigate to her committed
opportunities worksheet by selecting "Ellen Smith" from the menu next to his
name or from the Name column in his team worksheet below.

 

While viewing his reportee's opportunities worksheet, Aaron will not be able to
edit any of the opportunities' amounts or probabilities. He is able to filter for
various ranges, change the time period, and view Ellen's summary and commit
history for each time period.

Team Worksheet

Aaron can return to his team worksheet by choosing his own name from the
Drilldown menu.

 

While viewing his team worksheet, he has the ability to set each team member's
quota as well as to set adjusted Likely, Best, and Worst Case amounts. Please note
that your worksheets may or may not include "Best Case" and "Worst Case"
amounts depending on your administrator's Scenarios configuration.To edit an
adjusted amount or quota, click on the number, enter a new value, and click
outside the text box or press Return/Enter. Clicking "Save Draft" will preserve
these changes in the worksheet but will not push the changes to other Sugar users.
Upon clicking "Commit", these adjusted amounts will be pushed to Aaron's
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manager thus appearing in Joy's worksheet as his committed amounts. Any
changes to quotas will also be pushed to his reportee's worksheets.

 

From the team worksheet, managers will see an "i" icon on the far right of each
row where there are newly committed changes. Clicking the "i" opens the most
recent commit history for that team member.

Note: Although it is possible for Aaron to set or alter his own personal quota, it is
recommended that intermediate managers not make changes to their personal
quota. Rather, Aaron's manager, Joy, should set the quota for his entire team from
her team worksheet.

Management Hierarchy

The ability to drill into a reportee's team worksheet and opportunities continues up
the management chain. Joy is Aaron's manager and views her own team worksheet
by default when first opening the Forecasts module. She is also able to drill into
her own opportunities by clicking "Opportunities (Joy Miller)", Aaron's team
worksheet by clicking his name, or her other reportee's team worksheet.

 

When Joy navigates to her reportee Aaron's team worksheet, Aaron's name now
appears and his team worksheet is displayed in read-only mode. Joy can further
drill down to see the opportunities worksheets of Aaron's team's members in
read-only mode. This drilling can continue recursively down through the
management chain as needed. Clicking "Parent" will move up one level of
hierarchy, bringing Joy back to her own team worksheet.
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Time Periods

Below the currently selected drilldown name, you will see the time period for
which you are forecasting to meet the time period's quota for your team. The
length and start date of this time period depends on the Time Periods
configuration set up by your administrator. At every level of drilldown, sales
managers can click the arrow to the right of the current time period and choose a
future or past time period, the availability of which is also determined by the
administrator's Time Periods configuration. Select a past or future time period to
work with opportunities and forecast for those periods.

 

Summary & Commit History

To the right below the Time Period selection, you will see a summary of the
current forecasting numbers for the time period and drilldown level currently in
view. The large numbers are the forecasting worksheet's Likely, Best, and Worst
Case predictions. The smaller numbers show the most recent commit's Likely,
Best, and Worst Case predictions. Any red or green arrows next to the large
numbers on a manager's personal opportunities worksheet or own team worksheet
show whether your worksheet's current (uncommitted) numbers are higher or
lower than the most recent commit. Please note that you may or may not see a
Best Case and Worst Case depending on your administrator's Scenarios
configuration.
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To the left of these summary numbers, you will see the date and time of the most
recent commit. On a manager's personal worksheet and own team's worksheet,
there will be no date and time shown if you have not yet committed for this time
period. By clicking the arrow to the right of the latest commit date, a dark grey
panel will appear showing a history of the commits for the worksheet currently in
view for this time period along with the changes for each forecasting number from
the previous commit.

Filters

Below the summary and commit history of each opportunities worksheet,
managers will see a filter bar which controls what kinds of opportunities are
displayed. By default, the "Include" filter will be active, meaning that only the
opportunities with a probability falling within the Include range specified during
the administrator's Ranges configuration will be displayed. To add additional
filters, click the arrow to the right of the Filters bar and choose additional ranges.
Please note the Upside range may or may not be available depending on the
administrator's Ranges configuration. When the Upside range is not available, the
Forecast column will display checkbox icons rather than words with the checked
box representing "Include" and the unchecked box representing "Exclude". To
remove ranges from the filter, click the "x" for each filter name. Removing all
filters will display all of your assigned opportunities. Please note that when
viewing your reportee's opportunity worksheets, only the opportunities they have
committed as included will be visible.

 

Intelligence Pane

To the right of the forecasting worksheet you will find an expandable Intelligence
Pane which provides additional insights for planning and forecasting. If the pane is
hidden, click the double-arrow button to expand it. Clicking the button again will
hide it when you wish to see your worksheets at full width.

 

Projected Table

The Projected table appears in the top of the Intelligence Pane and gives a
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breakdown of how the current drilldown's worksheet totals match up to that
worksheet's quota as well as insight into the pipeline relevant to that worksheet.
Keep in mind that your Projected table may or may not include "Best Case" and
"Worst Case" amounts depending on your administrator's Scenariosconfiguration.

 

When viewing your own team worksheet and own opportunities worksheet, the
Projected table's values are calculated based on the most recent updates even if
the changes have not yet been saved as a draft or committed. The exception to this
is changes to your or your reportee's quotas - these changes must be committed
prior to appearing in the Projected table. The values take all of your opportunities
into account regardless of any filters currently being used in your worksheet. Their
meanings are as follows:

Field Description
Quota The worksheet's quota for this sales

time period
Likely above/below Quota The difference between the worksheet's

included opportunities' Likely Case
amounts and the worksheet's quota as
well as the corresponding percentage

Best above/below Quota (Optional) The difference between the
worksheet's included opportunities' Best
Case amounts and the worksheet's
quota as well as the corresponding
percentage

Worst above/below Quota (Optional) The difference between the
worksheet's included opportunities'
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Worst Case amounts and the
worksheet's quota as well as the
corresponding percentage

Closed The total amount of the worksheet's
Closed Won opportunities

Likely above Closed The difference between the worksheet's
included opportunities' Likely Case
amounts and the worksheet's Closed
Won total as well as the corresponding
percentage

Best above Closed (Optional) The difference between the
worksheet's included opportunities' Best
Case amounts and the worksheet's
Closed Won total as well as the
corresponding percentage

Worst above Closed (Optional) The difference between the
worksheet's included opportunities'
Worst Case amounts and the
worksheet's Closed Won total as well as
the corresponding percentage

Pipeline Opportunities The number of the worksheet's
in-progress included and excluded
opportunities which are not yet in a
Closed Won or Closed Lost stage

Pipeline Revenue The total Likely Case amounts of the
worksheet's in-progress included and
excluded opportunities which are not
yet in a Closed Won or Closed Lost
stage

Pipeline Size The ratio of the worksheet's in-process
opportunities' total to the "Included"
opportunities' total; a progressive gauge
of how much more business is available
to be brought in for this time period: a
higher number indicates many more
opportunities are available to be
pursued and included on the forecast
while a lower number indicates nearing
the end of the available opportunities

Chart
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The bottom of the Intelligence Pane provides a configurable chart showing
different cuts of your team members' forecasting data. Throughout all chart
configurations, the dotted black line represents your quota for the given time
period and can be hovered over to view the quota amount.

While viewing your or a reportee's opportunities worksheet, the charts will display
the relevant opportunities over the course of the selected time period. In these
views, the charts function in the same way as they do for support representatives
without reportees. For more information on the meanings and configuration of the
chart while viewing your or a reportee's opportunities worksheet, please refer to
the Chartsection within the Sales Representative section of this documentation.

While viewing your or a reportee's team worksheet, the charts will display the
current worksheet's totals in bars grouped according to user. Throughout all chart
configurations, the dotted black line represents the worksheet's quota for the
given time period and can be hovered over to view the quota amount.

Click the gear icon to configure what is displayed in the chart.

 

When "Likely" is chosen, each green bar represents the total committed Likely
Case amount for each user within the current team worksheet. Each red bar
represents the total adjusted Likely Case amount for each user. The users are
ordered from left to right by their adjusted Likely Case amounts in decreasing
order. The green dots show the cumulative Likely Case total of the team built
user-by-user from left to right with the rightmost point representing the total
Likely Case amount for the entire team. The red dots do the same using the
adjusted Likely Case team total.

 341 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Forecasts/#Chart


 

 

Choosing "Best" shows similar chart elements except that the Best Case and
adjusted Best Case amounts are used. Choosing "Worst" does the same with Worst
Case and adjusted Worst Case amounts. Please note that you may or may not see
"Best" and "Worst" as options depending on your administrator's Scenarios
configuration.

Note: Changes to the forecasting worksheet will need to be saved as a draft or
committed before they will be reflected in the chart.

Saving Forecast Drafts

Whenever new information is added or changes are made to your current
forecasting worksheet, the Save Draft button will become activated. Click this
button to save your changes to the current worksheet without submitting these
changes to your manager. This provides an opportunity to work with your forecast
data before pushing more finalized amounts up the management chain. Clicking
"Save Draft" will also cause any changes to your personal opportunities' amounts
and/or probability to alter the opportunity record itself, making these new numbers
visible on the opportunity in other areas of Sugar.

 

Committing Forecasts
Whenever new information is added or changes are made to your current
forecasting worksheet, the Commit button will become activated. Click this button
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to save your changes to the current worksheet and to submit these changes to your
manager or to the team worksheet if you are a manager working on your personal
opportunities worksheet. Clicking "Commit" will also cause any changes to your
personal opportunities' amounts and/or probability to alter the opportunity record
itself, making these new numbers visible on the opportunity in other areas of
Sugar. 

For sales managers, changes to your reportees' quotas will not appear in their
Forecasts module you perform a commit. Changes to your and your reportee's
quotas will also not be reflected in the Projected table of the Intelligence Pane
until you perform a commit.

 

Exporting Forecasts

The Export option is available on every forecasting page and exports every line of
the current worksheet. Sugar will export all opportunities belonging to an
opportunities worksheet without regard to any filters currently being used to hide
opportunities. The resulting CSV file can be used in other programs such as
Microsoft Excel to view and manipulate your forecasting data. To export your
current worksheet, click "Export CSV" in the Actions menu.

 

Configuring Forecasts

Users with administrator access will have a Settings option available within the
Forecasts module. Choosing "Settings" will open the Forecast Configuration
wizard which is also available by navigating to Admin > Forecasts. For more
information on configuring the Forecasts module, please refer to the Forecast
Configuration documentation in the Administration Guide.

 

Printing Forecasts

The Print option is available on every forecasting worksheet and prints everything
currently displayed on the page. If any filters are being used in the worksheet, only
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the displayed rows will be printed. Likewise, the Projected table and Chart will
only be printed if the Intelligence Pane is currently visible. To print your current
page, select "Print" from the dropdown Actions menu.

 

Last Modified: 09/26/2015 06:25pm

Quotes

Overview

Sugar's Quotes module consists of quotes which specify the quantity and the price
per unit for products or services that your organization is selling to clients. You
can select a product directly from the product catalog or manually enter a product
that is not in the catalog during quote creation. There are various ways you can
create quotes in Sugar such as via the Quotes module and duplication. Once
created, you can generate the quote in PDF format (i.e. Quote or Invoice) and send
it to your clients. This documentation will go over the basics of the Quotes module
as well as the various options available in performing the actions related to the
module.

Quote Fields

The Quotes module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Actual Close The date the quote order shipped
Actual Close Date The date the quote is closed
Assigned To The Sugar user assigned to the quote
Billing Account Name The account to which the quote is billed
Billing Address The billing address of the account
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paying for the product or service
Billing Contact Name The contact associated with the Account

to whom the quote is billed
Copy Address From Left Select the box to copy the account's

billing address to the shipping address
field

Converted Amount The amount of the quote converted to
and displayed in the system's default
currency or the user's preferred
currency when the Show Preferred
Currency option is enabled on the
viewing user's profile

Note: This field is only available in the
list view. For more information on the
Converted Amount field, please see 
Transaction Amount Field Vs.
Converted Amount Field

Date Created The date the quote record was created
Date Modified The date the quote record was last

modified
Description A description or other information about

the quote
Discount The discounted amount (if applicable)

for the quote
Discount Total The total discount for the quote
Discounted Subtotal The discounted subtotal for the quote
Display Grand Total Indicate if the grand total should be

displayed
Display Line Numbers Indicate if the line numbers should be

displayed
Opportunity Name The opportunity name associated with

the quote
Order Stage The current order stage (e.g. Pending,

Confirmed, etc.) of the quote
Original P.O. Date The date of the original purchase order
Payment Terms The time period within which the client

must pay for the product or service
Purchase Order Num The purchase order number of the quote
Quote Number The system-generated quote number
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Quote Stage The current stage of the quote's life
cycle (e.g. Draft, Confirmed, etc.)

Quote Subject Information or detail about the product
or service for which you are creating the
quote

Quote Type The quote type
Shipping The shipping amount for the quote
Shipping Account Name The account to which the products will

be delivered
Shipping Address Address to which the products will be

delivered
Shipping Contact Name Contact associated with the Account to

whom the products will be delivered
Subtotal The subtotal for the quote
Teams The Sugar team(s) assigned to the quote

record
Tax The tax rate for the quote
Total The total amount of the quote
Transaction Amount The transactional amount of the quote

which may use any currency configured
within Sugar

Note: For more information on the
Transaction Amount field, please see 
Transaction Amount Field Vs.
Converted Amount Field

Valid Until The date until which this quote is valid

Quote Stages

The quote stage defines the current stage (e.g. Draft, Confirmed, etc.) of your
quote's life cycle. There are eight quote stages which come out-of-the-box with
Sugar and users with administrator or developer access have the ability to modify
the quote stages via Admin < Dropdown Editor. For more information on
modifying the quote stage, please refer to the Developer Tools documentation in
the Administration guide. The below definitions are suggested meanings for each
quote stage, but the stage's can be leveraged differently to best meet your
organization's needs.

Quote Stage Description
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Draft The draft version of the quote is
currently being created for the client

Negotiation Communicated with the client and
modifying the details of the quote

Delivered The updated quote is delivered to the
client

On Hold Awaiting input on quote
Confirmed The quote is approved for sale
Closed Accepted Client accepts the terms of the quote

and agrees to proceed with the sale
Closed Lost Client does not agree to the terms of the

quote and the sale is lost
Closed Dead Possible lack of communication from the

client and the sale is lost

Quotes Module Tab

The Quotes module tab is typically located under the More tab of the navigation
bar at the top of any Sugar screen. Sugar normally displays the top six modules
shown in the Display Modules list of your user preferences, so the remaining
displayed modules are grouped under the More tab. For more information on
displayed modules for the navigation bar, please refer to the Layout Options
section of the Getting Started documentation. Click the tab to access the Quotes
list view. You may also hover on the tab to display the Actions, Recently Viewed,
and Favorites menu. The Actions menu allows you to perform important actions
within the module. The Recently Viewed menu displays the list of quotes you last
viewed in the module. The Favorites Menu displays the list of quotes you most
recently marked as favorites in the module.

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Quote Opens the edit view layout to create a

new quote

 347 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Getting_Started
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Quotes/#Viewing_Via_Recently_Viewed
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Quotes/#Favoriting_Quotes
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Quotes/#Creating_Quotes


 

View Quotes Opens the list view layout to search and
display quotes

View Quote Reports Displays existing reports based on the
Quotes module

If you do not see the Quotes module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Quotes module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Quotes module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Quotes module in the Hide Modules list, simply
move it to the Display Modules list and save. For more information on hiding
and displaying modules, please refer to the Layout Options section of the
Getting Started documentation.
The administrator may have disabled the Quotes module for your entire Sugar
instance. Reach out to your Sugar administrator to have the Quotes module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Quotes

There are various methods for creating quotes in Sugar including via the Quotes
module and duplication. The full edit view layout opens when creating the quote
directly from the Quotes menu and includes all of the relevant fields for your
organization's quotes. The Edit View layout can be configured by administrators
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

Creating Via Quotes Module

One of the most common methods of quote creation is via the Create Quote option
in the Quotes module tab. This opens up the edit view layout which allows you to
enter in all the relevant information (e.g. Basic Information, Line Items, etc.) for
the quote. Once the product details are entered in the quote's line item(s), Sugar
will automatically calculate and display the subtotal, discount (if applicable), tax,
shipping, and total for each group as well as a grand total for the entire quote.
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Basic Information

The first part of creating a quote is to complete the basic information sections (e.g.
Overview, Bill to, Address Information). Enter the appropriate values for the fields

 

Adding Groups

The Line Items section allows users to add products from the product catalog and
arrange them in groups. Prior to adding the groups and products, you can define
the currency, tax rate, shipping provider, etc. if different from the default value
selected. Please note that users with administrator or developer access have the
ability to configure the Currency, Tax Rate, and Shipping Provider fields via Admin
> Currency, Admin > Tax Rates, and Admin > Shipping Providers. For more
information on configuring these fields, please refer to the System as well as the 
Products and Quotes documentations. The Display Grand Total and Display Line
Number checkbox is marked by default, but you can uncheck it if you do not wish
to have the grand total or line numbers displayed on the quote.

You can add multiple groups (e.g. chairs, tables, etc.) to your quote to arrange
similar products and/or services together for better organization. For example, you
can add a group called "Chairs" then add the different types of chairs that the
client is purchasing under this group.
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Use the following steps to add a new group to your quote:

1. Scroll to the Line Items panel and click the Add Group button.

 
2. Enter in a group name then click the Add Row button to add products to this

group.
By default, "Draft" is selected as the group stage, but you can change
this accordingly.

 
3. To delete a group, click the Delete Group button.

 

Adding Rows

Once you create a group, use the Add Row feature to add products to the group.
You have the option of selecting a product from the product catalog or manually
entering a new product, not in the catalog. When you select the product from the
catalog, the system automatically populates the manufacturer's number, tax class,
cost, list, etc. You cannot modify the line item information for selected products as
the value is pulled directly from the product catalog. Please note that system
administrators must first create and add products via Admin > Product Catalog in
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order for users to select it when adding line items. For more information on adding
and modifying products in the product catalog, please refer to the Product
Catalog section of the Product and Quotes documentation.New products entered in
the quote can have the manufacturer number, tax class, and pricing information
manually entered. Please note that products you manually enter into the quote will
not be added to the product catalog as only administrators have the ability to
create them.

The product(s) added to each quote line item will create a new record in the
Products module when the quote is saved. For more information on creating
product records, please refer to the Products documentation.

Use the following steps to add a row and select a product from the Product
Catalog:

1. Click "Add Row" in the Group section.

 
2. Click the arrow next to the Product field to select from the Product Catalog

list.

 
3. Locate and select the desired product in the pop-up window to add to your

group.
You can also use the Search panel to search for a product by name and
category.
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The selected product will be added to the group with the populated line items
(grayed out). You can modify the quantity and unit price as well as enter in a
discount (if applicable) if you wish. Please note that you can input the discount in
absolute price or mark the checkbox if you would like to indicate the discount as a
percentage of the unit price. For a description of the line item fields (e.g. Cost,
List, etc.), please refer to the Product Catalog Fields section in the Products and
Quotes documentation. Please note that any products that should not be included
in the quote can be easily removed by clicking "Remove Row" to the far right of

each product row.  

Use the following steps to add a row and manually enter a product in the group:

1. Click "Add Row" in the Group section.
2. Manually enter in the product name along with the manufacturer number, tax

class, cost, etc. to add to your group.
For a description of the line item fields (e.g. Cost, List, etc.), please refer
to the Product Catalog Fieldssection in the Products and Quotes
documentation.
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Note: Products that are manually entered into quotes will not be added to your
product catalog, but will be added as new product records in the Products module.

Adding Comments

Users have the option to enter comments for individual products as well as add
comments as a line item in the group. Please note that all comments entered will
appear on both the Quote and Invoice PDF documents.

Use the open text box below each product to enter any product-related
information.

 

To add a comment for the group, click the Add Comment button and the comment
box will be added as a line item. You can remove any group comments that are not
needed by clicking "Remove Comment" to the right of the comment box.

 

Rearranging Line Items

Users also have the ability to rearrange quote line items (e.g. rows and comments)
by placing them in different positions within the group per their personal
preference.

The following steps cover moving the Recliner line item to the Ottoman line item
location as an example:

1. Click the double vertical bar icon to the left of the Recliner line item row.
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2. Now, click the double vertical bar icon to the left of the Ottoman line item

row.

 

Once you click the second double vertical bar icon, the Recliner line item will swap
positions with the Ottoman line item and display in the second row. Please note
that you can also rearrange any comment line item rows by following the same
steps above.

 

Creating Via Duplication

You can also create a new quote by duplicating an existing quote record. The
duplicate option is useful if the quote you are creating has similar information to
an existing quote.
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Use the following steps to create a quote by duplicating an existing record:

1. Navigate to a quote record's detail view.
2. Select "Duplicate" from the Actions menu.

 
3. The displayed edit view is pre-populated with the original quote's values.

Update the necessary fields, then click "Save".

 

Viewing Quotes

There are various options available for viewing quote records in Sugar including
via Quotes list view, Quotes detail view, Quotes Recently Viewed menu, dashlets,
and reports. Please note that you will only be able to see quote records as allowed
by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

Viewing Via List View

The Quotes list view displays all quote records meeting the current search criteria.
To access the list view, simply click the Quotes module tab. While list view shows
key quote fields, you can click the quote's name to open the record in detail view.
For more information on viewing quotes via list view, please refer to the Quotes
List View section of this documentation.

Viewing Via Detail View

The Quotes detail view displays thorough quote information including all quote
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fields followed by subpanels of the quote's related records belonging to various
modules. The detail view can be reached by clicking a quote record's link from
anywhere in the application including from the Quotes list view. For more
information on viewing quotes via detail view, please refer to the Quotes Detail
Viewsection of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which quotes you have recently viewed.
Hover on the Quotes module tab to see a list of your most recently viewed quotes
and click each name to open the quote in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view quote
information in quote-based dashlets such as "My Quotes" as well as in dashlets
based on other modules such as "My Calls". Clicking a quote's name from any
dashlet will open the quote in detail view. For more information on using dashlets
and viewing quote records via dashlets, please refer to the Modulessection of the
Home documentation.

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding quotes and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
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will be able to view the quote record's detail view by clicking the quote's name in
the report results. Please note that you can only directly access quote detail views
with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide.Check with your system administrator if you cannot
access the Reports module.

Searching Quotes

The Quotes list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Quotes list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic search panel, you can click "Advanced Search" to access additional
search functionality as needed.
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The buttons and checkboxes available in the Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.
Open Items : Select this box to return only records with an open stage (e.g.
Draft, Negotiation, etc.).

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter in a quote subject to search, Sugar will only return the
quote records with a matching name that are assigned to you. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all quote records to which you have access, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see quote records as allowed by your team membership, user access type,
and assigned roles. For more information on teams and roles, please refer to the 
Team Management and Role Managementdocumentation.

Administrators can configure what fields appear on the Quotes Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
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Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Favorites" and enter in a quote subject to search, Sugar will only return
the quote records with a matching name that are marked as favorites. When
searching by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar
will return records matching any of these selections. Once the search completes,
the relevant results will populate in the list view below the search panel. To see all
quote records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
quote records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation.

Administrators can configure what fields appear on the Quotes Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
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version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
Search section of the System documentation in the Administration guide.

Quotes List View

The Quotes list view displays all quote records meeting the current search criteria
to which your user has access. You can view the basic details of each quote within
the field columns. Please note that you will only be able to see quote records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options available in Quotes Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.
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Pagination

List view displays the current search results broken into pages that you can scroll
through rather than potentially displaying thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on quote records directly from the list view by
first selecting the desired records. To select individual quote records on the
Quotes list view, mark the checkbox on the left of each row. To select or deselect
multiple quote records on the list view, use the options in the checkbox dropdown
menu.

Select This Page : Selects all records shown on the current page of quote
results.
Select All : Selects all records in the current search results across all pages of
quote results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
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various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more quotes at a time
Mass Update Mass update one or more quotes at a

time
Export Export one or more quotes to a CSV file

Favorite Designation

Users have the option to mark quote records as favorites via the list view as well as
the detail view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Quotes
module tab. In the Quotes list view, the star on the left of each quote's row is
yellow once marked to indicate a favorite quote. For more information on how to
mark records as favorites, please refer to the Favoriting Quotessection of this
documentation.

 

More Information

Additional details for each quote can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional quote
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Purchase Order Number, Original P.O. Date, Billing
Address, Shipping Address, Subtotal, Tax, Shipping, Total, and Description fields
by default. The list of fields appearing here may only be configured through a
code-level customization.
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Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Transaction Amount Field Vs. Converted Amount Field

The stock Quotes list view contains two fields, Transaction Amount and Converted
Amount, that differ in functionality. When the viewing user's Show Preferred
Currency option is selected in their user profile, the Converted Amount field will
be displayed in the user's preferred currency. When it is unchecked, the Converted
Amount field will be displayed in the system default currency. For information
about setting a user's Preferred Currency and Show Preferred Currency options,
please refer to the User Profile documentation.

The primary differences between these fields and options are as follows:

Field Name Value Displayed Sortable in List
View

Method to Update
Value

Transaction
Amount

Transactional
amount; the
currency and value
in which the quote
was last saved

No; since this field
may include values
using different
currencies,
numerical sorting
would not result in
a valid ordering of
the comparative
amounts

Updated by editing
the quote record

Converted Amount
(system default

Transaction
Amount converted

Yes; since all
possible values use

Updated by a
scheduled process
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currency) to the system
default currency
based on the
system-defined
conversion rate

a single currency,
sorting is allowed

when the relevant
exchange rate is
modified via Admin
> Currencies. For
more information
on how currency
changes affect the
Converted Amount
value please see 
Updating Currency
Rates

Converted Amount
(user's preferred
currency)

Transaction
Amount converted
to the viewing
user's preferred
currency as
specified in their
user profile based
on the
system-defined
conversion rate

Yes; since all
possible values use
a single currency,
sorting is allowed

Updated by
modifying the
relevant exchange
rate via Admin >
Currencies. For
more information
on how currency
changes affect the
Converted Amount
value please see 
Updating Currency
Rates

Quotes Detail View

The Quotes detail view displays thorough quote information including all quote
fields which are grouped by default into the Overview, Bill to, Address Information,
and Other panels. The Line Items panel displays as well to show the details of
products being purchased arranged by groups. You can also view a quote's related
records (Activities, History, Documents) which appear in subpanels beneath the
quote fields. The detail view can be reached by clicking a quote record's link from
anywhere in the application including from the Quotes list view.

Please note that you will only be able to view a quote record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu
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The Actions menu on the top left of each quote's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this quote
Duplicate Duplicate this quote
Delete Delete this quote
Create Opportunity from Quote Use this quote information to create an

opportunity record
Download PDF Download this quote in PDF format
Email PDF Email this quote as a PDF attachment
View Change Log View a record of changes to this quote

Favorite Designation

Users have the option to mark quote records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often as they can easily be accessed via search or from the Quotes
module tab. In the Quotes detail view, the star on the right of the quote's name is
yellow once marked to indicate a favorite quote. For more information on how to
mark records as favorites, please refer to the Favoriting Quotes section of this
documentation.
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Next or Previous Record

On the upper right of the Quotes detail view, there are two buttons that allow you
to page through each quote in the Quotes list view's current search results.
Clicking the Previous button displays the previous quote of the current search
results while clicking the Next button displays the next quote of the current search
results. The text in between shows which quote result you are currently viewing
within the total number of current results.

 

Subpanels

Beneath a quote record's fields are subpanels containing related records from
various modules.

Related Record Subpanels

The most common type of subpanel displayed on a quote's detail view contain the
quote's related records belonging to the Documents module. The relationship type
determines whether a related record will be displayed in the field listing or in a
subpanel. For example, multiple quotes may be related to an opportunity, which
means that the related opportunity will be displayed in a relate field in the quote's
Overview panel.

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of the subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
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subpanel to open it in detail view.
To relate an existing record to the quote, choose "Select" from the subpanel's
Action menu, then locate and select the desired record.
To relate a new record to the quote, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To delete the quote's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

 

Activities and History Subpanel

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the quote record. Once the activities have taken place or are completed,
they will instead appear within the History subpanel. The History subpanel also
includes notes and emails associated with the quote record. For more information
on the history and activities subpanel, please refer to the User Interface
documentation.

 

 367 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/System
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface


 

Editing Quotes

Quotes may be edited at any time to update or add information to the record. You
can make changes to existing quote records via the Quotes edit view and quick
create forms. Edit view is available within the Quotes module and includes all of
the Quote fields you should need.

 

Quick create is available for editing quotes from outside the Quotes module and
opens in a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields.

 

Please note that your ability to edit quotes in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
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if you do not see the Edit options.

Administrators in Sugar may configure both the Quotes edit view and quick create
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit quotes via the detail view by clicking the Edit button on the upper left
of the page. Once the edit view layout is open, you can update the necessary fields,
then click "Save" to preserve the changes made .

 

Editing Via List View

You can edit quotes via the list view by clicking the Pencil icon to the left of each
quote's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.

 

Editing Via Dashlets

You can edit quotes by clicking the pencil icon to the far right of any quotes-based
dashlet on your Sugar home page. For example, clicking the pencil icon within the
My Quotes dashlet will open a pop-up window with the quick create form which is
a shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes. For more information on dashlets, please refer to
the Home documentation.
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Editing Via Reports

Sugar reports also allow you to edit a quote record by clicking on the pencil icon
next to a quote's name. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. Please note that you may only directly
edit quotes from Rows and Columns-type or Summation with Details-type reports
as Summation-type and Matrix-type reports do not include the pencil icon. For
more information on reports, please refer to the Reports documentation.

 

Deleting Quotes

If a quote record is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Quotes detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once. Deleting quote records will not delete the
related records and will only remove the relationship, so you may wish to also
delete any related records to avoid orphaned records.

Please note that your ability to delete quotes in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View
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Use the following steps to delete a quote record via the detail view:

1. Navigate to a quote record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more quote records via the list view:

1. Navigate to the Quotes list view by clicking the Quotes module tab.
2. Use the Basic or Advanced Searchto find the Quote records you wish to

delete.
3. Select the desired quote records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of quote records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Quotes

Sugar's Export option allows users to download all fields for the selected quotes to
their computers as a .CSV (comma-separated values) file. This may be useful when
needing to use Quote data with other software such as Microsoft Excel. Due to

 371 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Quotes/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Quotes/#Advanced_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Quotes/#Checkbox_Selection
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Quotes/#Checkbox_Selection


 

PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of quote records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Quotes may be exported from the Quotes list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for quotes and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export quotes from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Quotes

Mass Updating allows users to make the same change to multiple quote records at
once from the Quotes list view. Users with administrator or developer level access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of quote records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update quotes may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Mass Update option.

Use the following steps to mass update quote records from the list view:
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1. Navigate to the Quotes list view by clicking the Quotes module tab.
2. Use the list view's Basic or Advanced Search to identify quotes you wish to

modify.
3. Select the desired quotes individually or using thecheckbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected quote

records.

Favoriting Quotes

Each Sugar user has the option to designate their own favorite quotes which are
important or will be viewed often so that they can easily be accessed via search or
from the Quotes module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Quotes Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Quotes
module tab .

Favoriting Via List View

Use the following steps to mark records as favorites via the Quotes list view:
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1. Navigate to the Quotes list view by clicking the Quotes module tab.
2. Use the Basic or Advanced Search to find the Quote records you wish to mark

as favorites.
3. Mark the star icon on the left of each desired quote's row.
4. To remove the quote as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Quotes detail view:

1. Navigate to a quote record's detail view.
2. Click the star icon to the right of the quote's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the quote as a favorite, click the star again to revert it to white.

 

Creating Opportunities from Quotes

Each opportunity record in Sugar represents a prospective sale and includes
relevant sales data as well as relating to other important records such as quotes,
contacts, etc. As you interact with your client and present the quote for your
products and services, you can create an opportunity from the Quotes detail view
to better track your sales. The displayed Opportunity detail view is pre-populated
with the original quote's values to reflect the opportunity name, opportunity
amount, account name, expected close date, best case, and worst case. Any other
fields populated will be based off the default values as they are defined in Studio
for the Opportunities module. Please note that the opportunity record will
automatically be associated to the quote .

Use the following steps to create an opportunity from a quote:
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1. Navigate to a quote record's detail view.
2. Select "Create Opportunity from Quote" from the Actions menu.

 
3. The newly created Opportunity record will be pre-populated with some of the

original quote's values and linked to the quote record.
You may update the record if you wish by clicking "Edit" then saving the
changes.

 

Downloading Quotes as PDFs

Users have the option to download the quotes as PDF's via the Quotes detail view.
The two formats available when downloading the quote to PDF is "Quote" and
"Invoice". The Download PDF option enables you to easily download the quote onto
your machine and email or mail it to your client outside of the Sugar application.
Both PDF formats list the details (e.g. quantity, product name, etc.) of the items or
services for purchase as well as the associated price (e.g. list price, unit price, tax,
total, etc.). When the quote is initially created in the system, you can download it
as a Quote PDF file and send it to the client for review. Once the client approves
the quote's terms and agrees to purchase your product or service, you can
generate an invoice for payment.

Use the following steps to download a quote as PDF:

1. Navigate to a quote record's detail view.
2. Hover on the Download PDF option in the Actions menu and choose either

"Quote" or "Invoice".
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3. Open the downloaded file and save it to your machine.

Quote:

 
Invoice:
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Emailing Quotes as PDFs

Users also have the option to email quotes to clients in PDF format (i.e. Quote or
Invoice) using Sugar's email client. The Email PDF option generates and attaches
the PDF document of the quote to be emailed to the client. Both the Quote and
Invoice formats list the details (e.g. quantity, product name, etc.) of the items or
services for purchase as well as the associated price (e.g. list price, unit price, tax,
total, etc.). Normally, the quote will be sent to the client to approve the quote's
terms then the invoice is sent once they agree to purchase your product or service.

Please note that administrators in Sugar must first configure the outbound mail
server for the system via Admin > Email Settings in order for users to send
outbound emails. For more information on setting up the system email settings,
please refer to the Emails documentation in the Administration guide. Users will
also need to have their email settings configured in their user preferences prior to
sending outbound email from the Emails module. For more information on setting
up your user preferences' email settings, please refer to the Getting Started
documentation.

Use the following steps to email a quote as PDF:
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1. Navigate to a quote record's detail view.
2. Hover on the Email PDF option in the Actions menu and choose either

"Quote" or "Invoice".

 
3. The compose email option will open in the Emails module.

The email's To field will automatically populate with the email address of
the selected account or contact (if related).
You can update the Subject field if you wish and enter a body for the
email message.
Please note that the Quote or Invoice PDF document will automatically
be attached to the email. To view the attached PDF document, click the
left arrow on the upper right corner of the Compose window.

 
4. Click "Send" to send the quote or invoice to the client.

Once the email is sent successfully, the email record will appear in the History
subpanel of the quote, account, and contact (if related) record. For more
information on sending emails from Sugar, please refer to the Emails
documentation.
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Viewing Quote Change Logs

Changes made to each quote record are tracked over time, and users are able to
view the history of changes via the change log in each quote's detail view. To view
the change log, navigate to a quote in detail view and select "View Change Log"
from the Actions menu. Please note that only fields marked as "Audit" in Admin >
Studio will be displayed in the change log. For more information on designating for
audit, please refer to the Studio documentation in the Administration guide.

 

Updating Currency Rates

When saving a quote in a currency that differs from the system-defined default
currency, Sugar will store the conversion rate for that currency at the record level.
This conversion rate is used to calculate the Converted Amount when the field is
set to use the system default currency (as opposed to the user's preferred currency
which is explained below). To keep amounts historically accurate, the conversion
rate will only update on a quote provided the quote stage is not set to "Closed
Accepted", "Closed Lost", or "Closed Dead". If the quote is in any other stage, the
conversion rate will update under the following scenarios:

The quote undergoes a save event (e.g. mass update, manual save, etc.) and
the record's currency has a different conversion rate defined in Admin >
Currencies than is currently saved in the quote.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all quotes saved
with that currency to the new rate.

When the viewing user's profile has the Show Preferred Currency option selected,
the Converted Amount field displays the Transactional Amount in the user's
preferred currency. In this case, the conversion rate used to calculate the
Converted Amount's value is drawn directly from the conversion rate at the system
level rather than any conversion rate stored on the record. This means that the
value will always use the current conversion rate regardless of the opportunity's
sales stage. For this reason, the Converted Amount field should not be considered
historically accurate for closed quotes when it is using the user's preferred
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currency. For information about setting a user's Preferred Currency and Show
Preferred Currency options, please refer to the User Profile documentation.

For more information about currency exchange rates, please refer to the 
Currencies documentation in the Administration guide.

Last Modified: 09/22/2016 06:00pm

Products

Overview

Sugar's Products module consists of all products that have already been sold or are
in the process of being sold to clients. The list of products sold by your
organization is housed in Admin > Product Catalog and administrators have the
ability to add new products as necessary. When creating products, you have the
option to either select products from the catalog or create new products via the
Products module. There are various ways you can create products in Sugar such as
via the Products module, Quotes module, duplication, importing products, etc.
Once the product record is created, you can view and edit information pertaining
to the product via the Products detail view. This documentation will cover how to
use the Products module as well as the various actions and options available from
within the module.

Product Fields

The Products module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Account Name The account to which the product

belongs
Asset Number The product's internal inventory number
Book Value The book value of the product upon

order
Book Value Date The date on which the product was
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ordered
Category The category to which the product

belongs

Note: For more information on creating
product categories, please refer to the 
documentation in the Administration
guide.

Contact Name The contact to which the product
belongs

Cost The actual cost of the product displayed
in the transactional currency

Currency The currency type (e.g. US Dollars) in
which the account will pay for the
product

Date Created The date the product record was
created

Date Modified The date the product record was last
modified

Description A description or other information about
the product

Discount in % Indication that the offered discount rate
is a percentage value

Discount Rate Discount amount offered on the product,
if applicable

Discount Total The total discount offered on the
product

List The List Price converted to and
displayed in the system's default
currency or the user's preferred
currency when the Show Preferred
Currency option is enabled on the
viewing user's profile

Note: This field is only available in the
list view. For more information about
the List field, please see About the List
and Price Fields

List Price The quoted list price of the product
displayed in the transactional currency

Manufacturer The manufacturer for the product
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Note: For more information on creating
and managing manufacturers, please
refer to the Products and Quotes
documentation in the Administration
guide.

Mft Part Number The manufacturer's part number for the
product

Modified by Name The Sugar user who last modified the
product record

Price The Unit Price converted to and
displayed in the system's default
currency or the user's preferred
currency when the Show Preferred
Currency option is enabled on the
viewing user's profile

Note: This field is only available in the
list view. For more information about
the List field, please see About the List
and Price Fields 

Pricing Factor The variable pricing factor depending
on the pricing formula

Pricing Formula The pricing formula for the product
Product URL The web address of product if available

online
Product The product's name as selected from the

product catalog list or manually entered
as new

Note: For more information on creating
and managing the product catalog,
please refer to the Products and Quotes

Purchased The actual purchase date of the product
Quantity The number of products purchased
Quote Name The quote to which the product belongs
Serial Number The serial number for the product
Status The current status of the product
Support Contact The name of user responsible for

providing product support
Support Desc Brief description or other information

regarding the support provided
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Support Expires The date when product support ends
Support Starts The date when product support starts
Support Term The term (e.g. six months, one year,

etc.) in which support will be provided
for the product

Support Title The title of the support representative
providing product support

Tax Class Tax classification (e.g. taxable,
non-taxable) for the product

Teams The Sugar team(s) assigned to the
product record

Type The specified product type

Note: For more information on creating
product types, please refer to the 
Products and Quotes documentation in
the Administration guide.

Unit Price The unit price of the product displayed
in the transactional currency

Vendor Part Number The vendor's part number for the
product

Weight The weight of the product

Products Module Tab

The Products module tab is typically located under the More tab of the navigation
bar at the top of any Sugar screen. Sugar normally displays the top six modules
shown in the Display Modules list of your user preferences, so the remaining
displayed modules are grouped under the More tab. For more information on
displayed modules for the navigation bar, please refer to the Layout Options
section of the Getting Started documentation. Click the tab to access the Products
list view. You may also hover on the tab to display the Actions, Recently Viewed,
and Favorites menu. The Actions menu allows you to perform important actions
within the module. The Recently Viewed menu displays the list of products you last
viewed in the module. The Favorites Menu displays the list of products you most
recently marked as favorites in the module.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Create Product Opens the edit view layout to create a

new product
View Products Opens the list view layout to search and

display products
Import Products Opens the import wizard to create or

update products using external data
If you do not see the Products module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Products module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Products module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Products module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section of
the Getting Started documentation.
The administrator may have disabled the Products module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Products
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Products

There are various methods for creating products in Sugar including via the
Products module, Quotes module, quick create, duplication, and importing
products. The full edit view layout opens when creating the product directly from
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the Products menu and includes all of the relevant fields for your organization's
products. Please note that administrators have the ability to create and manage
items from the product catalog, product category, product type, and manufacturer
list via Admin > Products and Quotes. For more information on how to create and
manage these product fields, please refer to the Products and Quotes
documentation in the Administration guide. The quick create form is a shortened
version of the products edit view and typically contains fewer fields. Both the Edit
View and Quick Create layouts can be configured by administrators via Admin >
Studio. For more information on configuring layouts, please refer to the Studio
documentation in the Administration guide.

Creating Via Products Module

One of the most common methods of product creation is via the Create Product
option in the Products module tab. This opens up the edit view layout which allows
you to enter in all the relevant information for the product.
Use the following steps to create a product via the Products module:

1. Hover on the Products module and select "Create Product".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
You can either select an existing product from the product catalog or
enter a new product in the Product field. Please note that new products
you create via the Products module will not be added to the product
catalog.

3. Once the necessary information is entered, click "Save".

 

Creating Via Quotes Module

The Quotes edit view layout allows you to select products from the product catalog
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to add as line items when creating the quote. You can also manually enter new
products that are not available in the product catalog to your quote. The product
added to each quote line item creates a new record in the Products module when
the quote is saved. For more information on adding products to quote line items,
please refer to the Creating Quotes section of the Quotes documentation.

 

Creating Via Quick Create

You can quick create a product from any Products subpanel on related module
records. Please note that administrators have the ability to disable subpanels for
the entire instance via Admin > Display Modules and Subpanels. Reach out to your
Sugar administrator to have the Products subpanel displayed if it is not available.
For more information on displaying and hiding subpanels throughout Sugar, please
refer to the Developer Tools documentation in the Administration guide.

Use the following steps to create a product via Quick Create:

1. Select "Create" on any Products subpanel on a related module's detail view.

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".
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Creating Via Duplication

You can also create a new product by duplicating an existing product record. The
duplicate option is useful if the product you are creating has similar information to
an existing product.

Use the following steps to create a product by duplicating an existing record:

1. Navigate to a product record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original product's values.

Update the necessary fields, then click "Save".

 

Importing Products

The import function allows you to push multiple product records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.

Use the following steps to import products via the Import Products option:

1. Hover on the Products module tab and select "Import Products".
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2. In Step 1, select the import file and choose "Create new records only". Click

"Next".
3. In Step 2, confirm the import file properties. Click "Next".
4. In Step 3, confirm the field mappings for the import. Click "Next".
5. In Step 5, view the import results.

The Created Records tab will show all of the new product records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Viewing Products

There are various options available for viewing product records in Sugar including
via Products list view, Products detail view, Products Recently Viewed menu,
dashlets, and reports. Please note that you will only be able to see product records
as allowed by your team membership, user access type, and assigned roles. For
more information on teams and roles, please refer to the Team Management and 
Role Management documentation in the Administration guide.

Viewing Via List View

The Products list view displays all product records meeting the current search
criteria. To access the list view, simply click the Products module tab. While list
view shows key product fields, you can click the product's name to open the record
in detail view. For more information on viewing products via list view, please refer
to the Products List View section of this documentation.

Viewing Via Detail View

The Products detail view displays thorough product information including all
product fields followed by subpanels of the product's related records belonging to
various modules. The detail view can be reached by clicking a product record's link
from anywhere in the application including from the Products list view. For more
information on viewing products via detail view, please refer to the Products
Detail View section of this documentation.

 388 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Team_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Products/#Products_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Products/#Products_Detail_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Products/#Products_Detail_View


 

Viewing Via Recently Viewed

As you work, Sugar will keep track of which products you have recently viewed.
Hover on the Products module tab to see a list of your most recently viewed
products and click each name to open the product in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view product
information in dashlets based on other modules such as "My Notes". Clicking a
product's name from any dashlet will open the product in detail view. For more
information on using dashlets and viewing product records via dashlets, please
refer to the Modules section of the Home documentation.

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding products and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the product record's detail view by clicking the product's name
in the report results. Please note that you can only directly access product detail
views with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.
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Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Products

The Products list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Products list view below.
Please note that Sugar automatically appends the wildcard character (%) to the
end of your search phrase. This allows the system to retrieve all records that start
with the keyword entered in the search. If you would like to broaden the search,
you can use the wildcard at the beginning of your text as well (e.g. %services). This
will pull up any record that has the word "services" in the name, regardless of how
it starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
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the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Favorites" and enter a product name, Sugar will only return product
records with a matching name that you have marked as favorites. Once the search
is complete, the relevant results will populate in the list view below the search
panel. To see all product records to which you have access, simply click "Clear"
and then "Search" to perform a blank search with no filters. Please note that you
will only be able to see product records as allowed by your team membership, user
access type, and assigned roles. For more information on teams and roles, please
refer to the Team Management and Role Management documentation in the
Administration guide.

Administrators can configure what fields appear on the Products Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
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Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a product name to search, Sugar will only return product
records with a matching name that you have marked as favorites. When searching
by a multiselect or dropdown field (e.g. "Type"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel.

To see all product records to which you have access, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see product records as allowed by your team membership, user access
type, and assigned roles. For more information on teams and roles, please refer to
the Team Management and Role Management documentation in the
Administration guide.

Administrators can configure what fields appear on the Products Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Products List View
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The Products list view displays all product records meeting the current search
criteria and to which your user has access. You can view the basic details of each
product within the field columns. Please note that you will only be able to see
product records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Products Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on product records directly from the list view by
first selecting the desired records. To select individual product records on the
Products list view, mark the checkbox on the left of each row. To select or deselect
multiple product records on the list view, use the options in the checkbox
dropdown menu:
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Select This Page : Selects all records shown on the current page of product
results.
Select All : Selects all records in the current search results across all pages of
product results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more products at a time
Mass Update Mass update one or more products at a

time
Export Export one or more products to a CSV

file

Favorite Designation

Users have the option to mark product records as favorites via the list view as well
as the detail view. This allows users to designate records that are important or will
be viewed often so that they can easily be accessed via search or from the
Products module tab. In the Products list view, the star on the left of each
product's row is yellow once marked to indicate a favorite product. For more
information on how to mark records as favorites, please refer to the Favoriting
Products section of this documentation.
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Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

About the List and Price Fields

The stock Products list view contains two fields, List and Price, that are based on
the List Price and Unit Price fields. Both List Price and Unit Price are displayed in
the transactional values of the product.

When the viewing user's Show Preferred Currency option is selected in their user
profile, the List and Price fields will convert the transactional values to the user's
preferred currency. In this situation, the List and Price field values will update
immediately to reflect the current conversion rates.

When it is unchecked, the List and Price fields will be displayed in the system
default currency. In this situation, the List and Price field values are updated
according to changes in the conversion rate by a scheduled process when the
relevant exchange rate is modified via Admin > Currencies. For information about
setting a user's Preferred Currency and Show Preferred Currency options, please
refer to the User Profile documentation.

For more information on how currency changes affect these value please see 

 395 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Search
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Getting_Started


 

Updating Currency Rates.

Products Detail View

The Products detail view displays thorough product information including all
product fields. You can also view a product's related records (e.g. Documents)
which appear in subpanels beneath the product fields. The detail view can be
reached by clicking a product record's link from anywhere in the application
including from the Products list view.

Please note that you will only be able to view a product record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each product's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this product
Duplicate Duplicate this product
Delete Delete this product
View Change Log View a record of changes to this product
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Favorite Designation

Users have the option to mark product records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often so that they can easily be accessed via search or from the
Products module tab. In the Products detail view, the star on the right of the
product's name is yellow once marked to indicate a favorite product. For more
information on how to mark records as favorites, please refer to the Favoriting
Products section of this documentation.

 

Next or Previous Record

On the upper right of the Products detail view, there are two buttons that allow
you to page through each product in the Products list view's current search
results. Clicking the Previous button displays the previous product of the current
search results while clicking the Next button displays the next product of the
current search results. The text in between shows which product result you are
currently viewing within the total number of current results.

 

Subpanels

Beneath a product record's fields are subpanels containing related records from
various modules and the product's notes.

Related Record Subpanels

The most common type of subpanel displayed on a product's detail view contain
the product's related records belonging to various modules. The relationship type
determines whether a related record will be displayed in the field listing or in a
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subpanel. For example, m ultiple documents may be related to a product, so the
documents will be displayed in a subpanel beneath the fields.

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Status, etc.) and labels of the subpanel by configuring the layout via
Admin > Studio to provide visibility to the most important fields. For more
information on modifying subpanels, please refer to the Studio documentation in
the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the product, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the product, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save". Please
note that for the Notes subpanel the full edit view layout will open to create
the note.
To delete the product's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

 

Related Products Subpanel
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The Related Products subpanel allows users to relate similar products to the
product record to keep track of it in the system. Simply click "Select" from the
subpanel's Action menu and the products pop-up window will open. You can search
and select the desired product(s) in the pop-up window to relate to the current
product record. The related product(s) will appear in the Related Products
subpanel of the product record.

 

Notes Subpanel

The Notes subpanel allows users to create new note records to relate to the
product. To create the note, simply click "Create" from the subpanel's Action menu
and the notes full edit view layout will open. Enter in all the relevant information
for the note then click "Save". The note will automatically be related to the product
and will appear in the Notes subpanel of the product record.

 

Editing Products

Products may be edited at any time to update or add information to the record. You
can make changes to existing product records via the Products edit view. Edit view
is available within the Products module and includes all of the Product fields you
should need.

 

Please note that your ability to edit products in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.
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Administrators in Sugar may configure the Products edit view via Admin > Studio.
For more information on configuring layouts, please refer to the Studio
documentation in the Administration guide.

Editing Via Detail View

You can edit products via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve the changes made.

 

Editing Via List View

You can edit products via the list view by clicking the Pencil icon to the left of each
product's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve your changes.

 

Editing Via Reports

Sugar reports also allow you to edit a product record by clicking on the pencil icon
next to a product's name. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. Please note that you may only directly
edit products from Rows and Columns-type or Summation with Details-type reports
as Summation-type and Matrix-type reports do not include the pencil icon. For
more information on reports, please refer to the Reports documentation.
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Deleting Products

If a product record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Products detail view or list view.
Deleting via the detail view allows you to delete a single record while the list view
allows for mass deleting multiple records at once. Deleting product records will
not delete the related records and will only remove the relationship, so you may
wish to also delete any related records to avoid orphaned records.

Please note that your ability to delete products in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a product record via the detail view:

1. Navigate to a product record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View
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Use the following steps to delete one or more product records via the list view:

1. Navigate to the Products list view by clicking the Products module tab.
2. Use the Basicor Advanced Searchto find the Product records you wish to

delete.
3. Select the desired product records individually or using the checkbox

dropdown'soptions.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of product records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Products

Sugar's Export option allows users to download all fields for the selected products
to their computers as a .CSV (comma-separated values) file. This may be useful
when needing to use Product data with other software such as Microsoft Excel or
to update existing records by exporting, making changes, then importing the
altered products back into Sugar. For more information on updating existing
records via import, please refer to the Import documentation. Due to PHP memory
limitations on the server, there may be occasions when the application times out
while exporting a large number of product records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.

Products may be exported from the Products list view by selecting "Export" from
the Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for products and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.
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Please note that your ability to export products from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Products

Mass Updating allows users to make the same change to multiple product records
at once from the Products list view. Users with administrator or developer level
access can control which fields are available to change during mass update via
Admin > Studio. Currently, only fields with the data type of date, datetime,
dropdown, multiselect, and radio may be altered during a mass update. For more
information on configuring mass update, please refer to the Studio documentation
in the Administration guide. Due to the PHP memory limitations on the server,
there may be occasions when the application times out while mass updating a
large number of product records. If you encounter an error when performing this
action, we recommend selecting the records in smaller batches.

Please note that your ability to mass update products may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update product records from the list view:

1. Navigate to the Products list view by clicking the Products module tab.
2. Use the list view's Basicor Advanced Search to identify products you wish to

modify. 
3. Select the desired products individually or using thecheckbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.
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5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected product

records.

Favoriting Products

Each Sugar user has the option to designate their own favorite products which are
important or will be viewed often so that they can easily be accessed via search or
from the Products module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Products Basicor Advanced Searchto retrieve your
favorites or select from your most recent favorites directly from the Products
module tab.

Favoriting Via List View

Use the following steps to mark records as favorites via the Products list view:
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1. Navigate to the Products list view by clicking the Products module tab.
2. Use the Basicor Advanced Search to find the Product records you wish to

mark as favorites.
3. Mark the star icon on the left of each desired product's row.
4. To remove the product as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Products detail view:

1. Navigate to a product record's detail view.
2. Click the star icon to the right of the product's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the product as a favorite, click the star again to revert it to white.

 

Viewing Product Change Logs

Changes made to each product record are tracked over time, and users are able to
view the history of changes via the change log in each product's detail view. To
view the change log, navigate to a product in detail view and select "View Change
Log" from the Actions menu. Please note that only fields marked as "Audit" in
Admin > Studio will be displayed in the change log. For more information on
designating for audit, please refer to the Studio documentation in the
Administration guide.

 405 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Products/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Products/#Advanced_Search
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio


 

 

Updating Currency Rates

When saving a product in a currency that differs from the system-defined default
currency, Sugar will store the conversion rate for that currency at the record level.
This conversion rate is used to calculate the Price and List fields when they are set
to use the system default currency (as opposed to the user's preferred currency
which is explained below). To keep amounts historically accurate, the conversion
rate will only update on a product provided the status is not set to "Shipped". If the
product is in any other sales stage, the conversion rate will update under the
following scenarios:

The product undergoes a save event (e.g. mass update, manual save, etc.) and
the record's currency has a different conversion rate defined in Admin >
Currencies than is currently saved in the product.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all products saved
with that currency to the new rate.

When the viewing user's profile has the Show Preferred Currency option selected,
the Price and List fields display in the user's preferred currency. In this case, the
conversion rate is drawn directly from the conversion rate at the system level
rather than any conversion rate stored on the record. This means that the value
will always use the current conversion rate regardless of the product's status. For
this reason, the Price and List fields should not be considered historically accurate
for closed business when it is using the user's preferred currency. For information
about setting a user's Preferred Currency and Show Preferred Currency options,
please refer to the User Profile documentation.

For more information about currency exchange rates, please refer to the 
Currencies documentation in the Administration guide.

Last Modified: 09/26/2015 06:25pm
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Overview

Sugar's Contracts module consists of individual business arrangements your
organization has with vendors, customers, or association. There are various ways
you can create contracts in Sugar such as via the Contracts module, importing
contracts, duplication, etc. Once the contract record is created, you can view and
edit information pertaining to the contract via the Contracts detail view. Each
contract record may then relate to other Sugar records such as opportunities,
documents, quotes, and many others. This documentation will cover how to use the
Contracts module as well as the various actions and options available from within
the module.
Note: This module is hidden by default. The administrator must display it for your
use.

Contract Fields

The Contracts module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Account Name The account to which the contract

belongs
Assigned To The Sugar user assigned to the contract
Company Signed Date Date on which your organization signed

the contract
Contract Name The name or designation of the contract
Contract Term Calculation of days between the start

and end date of the contract
Contract Value The value of the contract for the

specified currency
Currency The currency used to represent the

contract value
Customer Signed Date Date on which the account signed this

contract
Date Created The date the contract record was

created
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Date Modified The date the contract record was last
modified

Description A description or other information about
the contract

End Date Date on which this contract expires
Expiration Notice Date and time to send a reminder to the

assigned user indicating that this
contract will expire shortly
Note : Assignment notifications must be
turned on and the "Process Workflow
Tasks" scheduler must be running.

Opportunity Name The opportunity if any, from which the
contract originated or is related to

Reference Code The internal designation used to refer to
this contract

Start Date Date on which this contract takes effect
Status The current status of the contract (e.g.

Not Started, In Progress, Signed)
Teams The Sugar team(s) assigned to the

contract record
Type The type assigned to the contract

Note : Types are created in Admin >
Contract Types and come with no
options by default.

Contracts Module Tab

The Contracts module tab is typically located under the More tab on the navigation
bar at the top of any Sugar screen to the right of the home cube icon. Depending
on your settings, you may have to click "Show More" in order to see the Knowledge
Base module tab. Click the tab to access the Contracts list view. You may also
hover on the tab to display the Actions, Recently Viewed, and Favorites menus.
The Actions menu allows you to perform important actions within the module. The 

 408 / 1.013



 

 
The Actions menu allows you to perform the following operations:

Menu Item Description
Create Contract Opens the edit view layout to create a

new contract
View Contracts Opens the list view layout to search and

display contracts
Import Contracts Opens the import wizard to create or

update contracts using external data
If you do not see the Contracts module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Contracts module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Contracts module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Contracts module in the Hide Modules
list, simply move it to the Display Modules list and save. For more information
on hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Contracts module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Contracts
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Contracts

There are various methods for creating contracts in Sugar including via the
Contracts module, quick create, duplication, and importing contracts. The full edit
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view layout opens when creating the contract directly from the Contracts menu
and includes all of the relevant fields for your organization's contracts. The quick
create form is a shortened version of the contracts edit view and typically contains
fewer fields. When using quick create to make a contract while viewing an existing
record of another module, Sugar automatically creates a relationship between both
records. For example, if you are viewing an account record (e.g. ABC Company)
and create a new contract via the quick create form, the Account Name field in the
contract record will automatically populate with "ABC Company", thus creating the
relationship. Both the Edit View and Quick Create layouts can be configured by
administrators via Admin > Studio. For more information on configuring layouts,
please refer to the Studio documentation in the Administration guide.

Creating Via Contracts Module

One of the most common methods of contract creation is via the Create Contract
option in the Contracts module tab. This opens up the edit view layout which
allows you to enter in all the relevant information for the contract.

Use the following steps to create a contract via the Contracts module:

1. Hover on the Contracts module and select "Create Contract".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. Once the necessary information is entered, click "Save".
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Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a contract from any Contracts
subpanel on related module records.
Note : Quick create for the Contracts module is disabled by default, but can be
enabled through Admin > Configure Navigation Bar Quick Create. For more
information on how to enable modules to be used for Quick Create, please refer to
the Developer Tools documentation in the Administration guide.

Use the following steps to create a contract via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Contract". If you do not see the "Create Contract" option, please click
"Show More" to see more Quick Create options. You can also select "Create"
on any Contracts subpanel on a related module's detail view.
From Quick Create menu:

 
From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".
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Creating Via Duplication

You can also create a new contract by duplicating an existing contract record. The
duplicate option is useful if the contract you are creating has similar information to
an existing contract.
Use the following steps to create a contract by duplicating an existing record:

1. Navigate to a contract record's detail view.
2. Select "Duplicate" from the Actions menu.

 
3. The displayed edit view is pre-populated with the original contract's values.

Update the necessary fields, then click "Save".

 

Importing Contracts

The import function allows you to push multiple contract records into Sugar using
a comma (or other character) delimited file instead of creating them one-by-one.
For more information on importing, please refer to the Import documentation.
Use the following steps to import contracts via the Import Contracts option:

1. Hover on the Contracts module tab and select "Import Contracts".
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2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only". Click

"Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. In Step 6, view the import results.

The Created Records tab will show all of the new contract records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Viewing Contracts

There are various options available for viewing contract records in Sugar including
via Contracts list view, Contracts detail view, Contracts Recently Viewed menu,
dashlets, and reports. Please note that you will only be able to see contract records
as allowed by your team membership, user access type, and assigned roles. For
more information on teams and roles, please refer to the Team Management and 
Role Management documentations in the Administration guide.

Viewing Via List View

The Contracts list view displays all contract records meeting the current search
criteria. To access the list view, simply click the Contracts module tab. While list
view shows key contract fields, you can click the contract's name to open the
record in detail view. For more information on viewing contracts via list view,
please refer to the Contracts List View section.

Viewing Via Detail View

The Contracts detail view displays thorough contract information including all
contract fields followed by subpanels of the contract's related records belonging to
various modules. The detail view can be reached by clicking a contract record's
link from anywhere in the application including from the Contracts list view. For
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more information on viewing contracts via detail view, please refer to the 
Contracts Detail View section.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which contracts you have recently viewed.
Hover on the Contracts module tab to see a list of your most recently viewed
contracts and click each name to open the contract in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view contract
information in dashlets based on other modules such as "My Notes". Clicking a
contract's name from any dashlet will open the contract in detail view. For more
information on using dashlets and viewing contract records via dashlets, please
refer to the Dashlets section of the Home documentation.

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding contracts and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the contract record's detail view by clicking the contract's
name in the report results. Please note that you can only directly access contract
detail views with Rows and Columns-type and Summation with Details-type reports
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as Summation-type and Matrix-type reports do not include hyperlinks in their
display columns. For more information on using reports, please refer to the 
Reports documentation.

 
Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Users documentation in the
Administration guide. Check with your system administrator if you cannot access
the Reports module.

Searching Contracts

The Contracts list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Contracts list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.
For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.
The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform

 415 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Search


 

the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a contract name, Sugar will only return contract
records with a matching name that are assigned to you. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all contract records to which you have access, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see contract records as allowed by your team membership, user access
type, and assigned roles. For more information on teams and roles, please refer to
the Team Management and Role Management documentations in the
Administration guide.
Administrators can configure what fields appear on the Contracts Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.
The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
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the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a contract name to search, Sugar will only return contract
records with a matching name that you have marked as favorites. When searching
by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all contract
records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
contract records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.

Administrators can configure what fields appear on the Contracts Advanced
Search via Admin > Studio. For more information on editing layouts, please refer
to the Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 
To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
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magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.
Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Studio documentation as well as the Search section of the
System documentation in the Administration guide.

Contracts List View

The Contracts list view displays all contract records meeting the current search
criteria and to which your user has access. You can view the basic details of each
contract within the field columns. Please note that you will only be able to see
contract records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
You have the option to change what fields are displayed in list view by configuring
your layout options in the Contracts Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.
By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to t he 
System documentation in the Administration guide.
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Checkbox Selection

You can perform several actions on contract records directly from the list view by
first selecting the desired records. To select individual contract records on the
Contracts list view, mark the checkbox on the left of each row. To select or
deselect multiple contract records on the list view, use the options in the checkbox
dropdown menu:

Select This Page : Selects all records shown on the current page of contract
results.
Select All : Selects all records in the current search results across all pages of
contract results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more contracts at a time
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Mass Update Mass update one or more contracts at a
time

Export Export one or more contracts to a CSV
file

Favorite Designation

Users have the option to mark contract records as favorites via the list view as well
as the detail view. This allows users to designate records that are important or will
be viewed often so that they can easily be accessed via search or from the
Contracts module tab. In the Contracts list view, the star on the left of each
contract's row is yellow once marked to indicate a favorite contract. For more
information on marking records as favorites, please refer to the Favoriting
Contracts section of this documentation.

 

More Information

Additional details for each contract can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional contract
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Reference Code, and Description fields by default.
The list of fields appearing here may only be configured through a code-level
customization.
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Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Contracts Detail View

The Contracts detail view displays thorough contract information including all
contract fields which are grouped by default into the Overview and Other panels.
You can also view a contract's related records (Documents, Notes, Contacts, etc.)
which appear in subpanels beneath the contract fields. The detail view can be
reached by clicking a contract record's link from anywhere in the application
including from the Contracts list view.
Please note that you will only be able to view a contract record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentations in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
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Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each contract's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this contract
Duplicate Duplicate this contract
Delete Delete this contract
View Change Log View a record of changes to this

contract

Favorite Designation

Users have the option to mark contract records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often so that they can easily be accessed via search or from the
Contracts module tab. In the Contracts detail view, the star on the right of the
contract's name is yellow once marked to indicate a favorite contract. For more
information on how to mark records as favorites, please refer to the Favoriting
Contracts section of this documentation.
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Next or Previous Record

On the upper right of the Contracts detail view, there are two buttons that allow
you to page through each contract in the Contracts list view's current search
results. Clicking the Previous button displays the previous contract of the current
search results while clicking the Next button displays the next contract of the
current search results. The text in between shows which contract result you are
currently viewing within the total number of current results.

 

Related Record Subpanels

The most common type of subpanels displayed on a contract's detail view contain
the contract's related records belonging to various modules. The relationship type
determines whether a related record will be displayed in the field listing or in a
subpanel. For example, a contract may be related to only one account but related
to multiple contacts. This means that the related account will be displayed
amongst the contract's fields while contacts will be displayed in a subpanel
beneath the fields.
Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.
Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.
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To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the contract, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the contract, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To edit a related record, choose "Edit" on the far right of the record's row.
To delete the contract's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

 
Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Signing Documents

The documents subpanel gives users the ability to create and select documents to
be attached to the contract record. Template documents give users the ability to
perform additional actions on the document through the contracts module. This
feature is best used for a standard contract or agreement document that the
organization will have to sign. Once the contract is signed by the organization,
users can click "Sign" on the related document record.

 

This prompts the user to create a new document record for the signed contract,
which will be related to the template document as well as the contract record. You
will now see both documents, the original contract template and the signed
contract, in the documents subpanel of the contract record.
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Once a document related to a contract gets revised you have the option of pulling
the latest revision to be linked to the contract. Otherwise the version of the
document that existed when linked to the contract will remain linked. Click "Get
Latest" to link the most recent version of the document to the contract.

 

Editing Contracts

Contracts may be edited at any time to update or add information to the record.
You can make changes to existing contract records via the Contracts edit view and
quick create forms. Edit view is available within the Contracts module and includes
all of the Contract fields you should need.

 
Quick create is available for editing contracts from outside the Contracts module
and opens as a pop-up without navigating away from your current page. It
generally contains fewer fields, but the Full Form button may be used to access the
full edit view should you need to edit additional fields.
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Please note that your ability to edit contracts in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.
Administrators in Sugar may configure both the Contracts edit view and quick
create via Admin > Studio. For more information on configuring layouts, please
refer to the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit contracts via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve your changes.
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Editing Via List View

You can edit contracts via the list view by clicking the Pencil icon to the left of
each contract's name. A pop-up window will open with the quick create form which
is a shortened version of the edit view layout. Update the necessary fields, then
click "Save" to preserve your changes.

 

Editing Via Reports

Sugar reports also allow you to edit a contract record by clicking on the pencil icon
next to a contract's name. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes.

 
Please note that you may only directly edit contracts from Rows and Columns-type
or Summation with Details-type reports as Summation-type and Matrix-type
reports do not include the pencil icon. For more information on reports, please
refer to the Reports documentation.

Deleting Contracts

If a contract record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Contracts detail view or list view.
Deleting via the detail view allows you to delete a single record while the list view
allows for mass deleting multiple records at once. Deleting contract records will
not delete the related records and will only remove the relationship, so you may
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wish to also delete any related records to avoid orphaned records.
Please note that your ability to delete contracts may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Delete options.

Deleting Via Detail View

Use the following steps to delete a contract record via the detail view:

1. Navigate to a contract record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more contract records via the list view:

1. Navigate to the Contracts list view by clicking the Contracts module tab.
2. Use the Basic or Advanced Search to find the contract records you wish to

delete.
3. Select the desired contract records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of contract records. If you
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encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Contracts

Sugar's Export option allows users to download all fields for the selected contracts
to their computers as a .CSV (comma-separated values) file. This may be useful
when needing to use Contract data with other software such as Microsoft Excel or
to update existing records by exporting, making changes, then importing the
altered contracts back into Sugar. For more information on updating existing
records via import, please refer to the Import documentation. Due to PHP memory
limitations on the server, there may be occasions when the application times out
while exporting a large number of contract records. If you encounter an error
when performing this action, we recommend selecting the records in smaller
batches.
Contracts may be exported from the Contracts list view by selecting "Export" from
the Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for contracts
and their related record(s). Please note that only Rows and Columns-type reports
have the ability to be exported. For more information on exporting records in
Sugar, please refer to the Export documentation.

 
Please note that your ability to export contracts from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Contracts

Mass Updating allows users to make the same change to multiple contract records
at once from the Contracts list view. Users with administrator or developer access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
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on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of contract records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.
Please note that your ability to mass update contracts may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.
Use the following steps to mass update contract records from the list view:

1. Navigate to the Contracts list view by clicking the Contracts module tab.
2. Use the list view's Basic or Advanced Search to find contracts you wish to

modify.
3. Select the desired contracts individually or using the checkbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.
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6. Click "Update" to save the changes to all of the currently selected contract
records.

Favoriting Contracts

Each Sugar user has the option to designate their own favorite contracts which are
important or will be viewed often. Once records are marked as favorites, use the
My Favorites checkbox in the Contracts Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Contracts
module tab .

Favoriting Via List View

Use the following steps to mark records as favorites via the Contracts list view:

1. Navigate to the Contracts list view by clicking the Contracts module tab.
2. Use the Basic or Advanced Search to find the contract records you wish to

mark as favorites.
3. Click the star icon on the left of each desired contract's row.
4. To remove the contract as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Contracts detail view:

1. Navigate to a contract record's detail view.
2. Click the star icon to the right of the contract's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the contract as a favorite, click the star again to revert it to white.
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Viewing Contract Change Logs

Changes made to each contract record are tracked over time, and users are able to
view the history of changes via the change log in each contract's detail view. To
view the change log, navigate to a contract in detail view and select "View Change
Log" from the Actions menu. Please note that only fields marked as "Audit" in
Admin > Studio will be displayed in the change log. For more information on
designating for audit, please refer to the Studio documentation in the
Administration guide.

 

Last Modified: 09/26/2015 06:25pm

Documents

Overview

Sugar's Documents module gives your users a way to access and update
company-specific files. These files can range from internal policies to
customer-distributed content. There are various ways you can create documents in
Sugar such as via the Documents module and via the quick create menu. Once the
document record is created, you can view and edit information pertaining to the
document via the Documents detail view. Each document record may then relate to
other Sugar records such as accounts, cases, opportunities, and many others. This
documentation will cover how to use the Documents module as well as the various
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actions and options available from within the module.

Document Fields

The Documents module contains a number of stock fields which come
out-of-the-box with Sugar. The below definitions are suggested meanings for the
fields, but the fields can be leveraged differently to best meet your organization's
needs. Users with administrator or developer access have the ability to alter, add,
or remove fields via Admin > Studio. For more information on configuring fields,
please refer to the Studio documentation in the Administration guide.

Field Description
Assigned To The Sugar user assigned to the

document
Category Primary category for locating

documents
Description A description or other information about

the document
Document Name The name or designation of the

Document (Defaults to the filename of
the Document)

Document Type The type of the Document (e.g. NDA,
Mail Merge, License Agreement, etc.)

Exiration Date The date the Document expires
File Name Click "Choose File" to navigate to the

location to upload a Document
Publish Date The date the Document is published

(Defaults to today)
Related Document A Document record that is related to

this Document
Related Document Revision The Related Document's current

revision
Revision The most recent revision number for the

Document
Note: The Revision field becomes
read-only after the initial save.

Source Where the Document is stored (i.e
Sugar, Google, IBM SmartCloud, etc.)

Status The current status of the document (e.g.
Active, Draft, Expired, etc.)
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Sub Category Secondary category for locating
documents

Teams The Sugar team(s) assigned to the
document record

Template Classifies a Document as a template or
not

Documents Module Tab

The Documents module tab is typically located under the More tab on the
navigation bar at the top of any Sugar screen to the right of the home cube icon.
Depending on your settings, you may have to click "Show More" in order to see the
Documents module tab. Click the tab to access the Documents list view. You may
also hover on the tab to display the Actions, Recently Viewed, and Favorites menu.
The Actions menu allows you to perform important actions within the module. The 

 
The Actions menu allows you to perform the following operations:

Menu Item Description
Create Document Opens the edit view layout to create a

new document
View Documents Opens the list view layout to search and

display documents
Mail Merge Opens up the Mail Merge wizard

Note : Only shows when Mail Merge is
enabled in Admin > System.

If you do not see the Documents module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Documents module is not a member.
Click the More tab (last tab on navigation bar) then hover on "Filter Menu By"
to check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation in the Application
guide.
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The Documents module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Documents module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section of
the Getting Started documentation in the Application guide.

The administrator may have disabled the Documents module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Documents
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Documents

There are various methods for creating documents in Sugar including via the
Documents module, quick create, and via duplication. The full edit view layout
opens when creating the document directly from the Documents menu and
includes all of the relevant fields for your organization's documents. The quick
create form is a shortened version of the documents edit view and typically
contains fewer fields. Both the Edit View and Quick Create layouts can be
configured by administrators via Admin > Studio. For more information on
configuring layouts, please refer to the Studio documentation in the Administration
guide.

Creating Via Documents Module

You can create a library of documents and graphics that you can share with other
users and contacts, ranging from marketing collateral to contracts. You can also
create templates for frequently used documents. One of the most common methods
of document creation is via the Create Document option in the Documents module
tab. This opens up the edit view layout which allows you to enter in all the relevant
information for the document.
Use the following steps to create a document via the Documents module:

1. Hover on the documents module and select "Create Document".
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2. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to saving.

3. Once the necessary information is entered, click "Save".

 

Creating Via Google Docs

Sugar has the ability to create documents in the system that are linked to external
sources, the most popular of these is Google Docs, or Google Drive.
Use the following steps to create a document linked to Google Docs via the
Documents module:

1. Hover on the documents module and select "Create Document".

 
2. Select "Google Docs" from the Source dropdown to reveal the External Source

selector.

 
Note : If Google Docs is not an option in the Source dropdown, then you most
likely need to connect your Sugar account to your Google Id through your
user profile. For more information on how to connect to your Google Id in
Sugar, please refer to the Google Docs Integration section in this
documentation.

3. Click "Choose File" to navigate to a file on your local computer. The selected
file will be uploaded to Google Docs. Not all file extensions are currently
supported for uploading to Google Docs. The following file extensions are
currently allowed:
File Description
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CSV Comma Separated Values
DOC Microsoft Word 97-2004
DOCX Microsoft Word
HTML Web Text File
HTM Web Text File
JPG Image File
ODS OpenDocument Spreadsheet
ODT OpenDocument Text
PDF Portable Document Format
PNG Image File
PPT Microsoft PowerPoint Presentation
PPS Microsoft PowerPoint Slideshow
RTF Rich Text Format
SXW OpenOffice.org XML
TAB Tab Separated Values
TXT Plain Text
TEXT Plain Text
TSV Tab Separated Values
XLS Microsoft Excel 97-2004 Workbook
XLSX Microsoft Excel Workbook

Alternatively click "File on External Source" to reveal the external source
selector.

 
Click the arrow button to launch the selector. This window will show the 20
most recently modified documents in your Google Drive.
Note : This will only show documents owned by you in your Google Drive, and
will show documents through all folders in your drive.
Use the Search box to find a specific document. Select a document by clicking
on the document's file name.
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Enter appropriate values for the remaining fields in the edit view layout. All
required fields are marked with a red asterisk and must be completed prior to
saving.
Once the necessary information is entered, click "Save".

 

Note : Documents that link to an external account (i.e. Google Docs, IBM Smart
Cloud) cannot be used as attachments in emails composed through the Sugar
Email Client.

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a document from any Documents
subpanel on related module records.
Use the following steps to create a document via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Document". If you do not see the "Create Document" option, please
click "Show More" to see more Quick Create options. You can also select
"Create" on any Documents subpanel on a related module's detail view.
From Quick Create menu:
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From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".
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Creating Via Duplication

You can also create a new document by duplicating an existing document record.
The duplicate option is useful if the document you are creating has similar
information to an existing document. Related records on the original document will
not be related to the newly created document, but the last revision of the original
document will copy over to the new document with the change log contents :
"Document Created".
Use the following steps to create a document by duplicating an existing record:

1. Navigate to a document record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original document's values.

Update the necessary fields, then click "Save"

 
Note : The Source and File Name fields can not be modified when duplicating
a document.

Viewing Documents

There are various options available for viewing document records in Sugar
including via Documents list view, Documents detail view, Documents Recently
Viewed menu, dashlets, and reports. Please note that you will only be able to see
document records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
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Viewing Via List View

The Documents list view displays all document records meeting the current search
criteria. To access the list view, simply click the documents module tab. While list
view shows key document fields, you can click the document's name to open the
record in detail view. For more information on viewing documents via list view,
please refer to the Documents List View section of this documentation.

Viewing Via Detail View

The Documents detail view displays thorough document information including all
document fields followed by subpanels of the document's related records
belonging to various modules. The detail view can be reached by clicking a
document record's link from anywhere in the application including from the
Documents list view. For more information on viewing documents via detail view,
please refer to the Documents Detail View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which documents you have recently viewed.
Hover on the Documents module tab to see a list of your most recently viewed
documents and click each name to open the document in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view document
information in document-based dashlets such as "My documents". Clicking a
document's name from any dashlet will open the document in detail view. For more
information on using dashlets and viewing document records via dashlets, please
refer to the Modules section of the Home documentation in the Application guide.
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Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding documents and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the document record's detail view by clicking the document's
name in the report results. Please note that you can only directly access document
detail views with Rows and Columns-type and Summation with Details-type reports
as Summation-type and Matrix-type reports do not include hyperlinks in their
display columns. For more information on using reports, please refer to the 
Reports documentation in the Application guide.

 
Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Documents

The Documents list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Documents list view below.
Global Search allows users to search for information across their entire Sugar
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database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.
For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation in the Application guide.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.
The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Favorites" and enter a document name, Sugar will only return
document records with a matching name that you have marked as favorites. Once
the search is complete, the relevant results will populate in the list view below the
search panel. To see all document records to which you have access, simply click
"Clear" and then "Search" to perform a blank search with no filters. Please note
that you will only be able to see document records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentations in the Administration guide.
Administrators can configure what fields appear on the Documents Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
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Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.
The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation in the Application Guide.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation in the Application guide.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a document name to search, Sugar will only return
document records with a matching name that you have marked as favorites. When
searching by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar
will return records matching any of these selections. Once the search completes,
the relevant results will populate in the list view below the search panel. To see all
document records to which you have access, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see document records as allowed by your team membership, user access
type, and assigned roles. For more information on teams and roles, please refer to
the Team Management and Role Management documentations in the
Administration guide.
Administrators can configure what fields appear on the Documents Advanced
Search via Admin > Studio. For more information on editing layouts, please refer
to the Studio documentation in the Administration guide.
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Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 
To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation in the Application guide.
Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation in the Application
guide. Administrators can control additional elements of global search via Admin >
Search and Admin > Studio. For more information on administrator configuration
of Global Search, please refer to the Studio documentation as well as the Search
section of the System documentation in the Administration guide.

Documents List View

The Documents list view displays all document records meeting the current search
criteria and to which your user has access. You can view the basic details of each
document within the field columns. Please note that you will only be able to see
document records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
You have the option to change what fields are displayed in list view by configuring
your layout options in the Documents Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation in the Application guide. Users with administrator or developer
access also have the ability to change what fields are visible in the list view via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.
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Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.
By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on document records directly from the list view by
first selecting the desired records. To select individual document records on the
Documents list view, mark the checkbox on the left of each row. To select or
deselect multiple document records on the list view, use the options in the
checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of document
results.
Select All : Selects all records in the current search results across all pages of
document results.
Deselect All : Deselects all records that are currently selected.
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Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more documents at a time
Mass Update Mass update one or more documents at

a time
Export Export one or more documents to a CSV

file

Favorite Designation

Users have the option to mark document records as favorites via the list view as
well as the detail view. This allows users to designate records that are important
or will be viewed often so that they can easily be accessed via search or from the
Documents module tab. In the Documents list view, the star on the left of each
document's row is yellow once marked to indicate a favorite document. For more
information on how to mark records as favorites, please refer to the Favoriting
Documents section of this documentation.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
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Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation in the Application
guide.

 

Documents Detail View

The Documents detail view displays thorough document information including all
document fields which are grouped by default into the Overview and Revision
Details panels. You can also view a document's related records (Document
Revisions, Related Contracts, Accounts, etc.) which appear in subpanels beneath
the document fields. The detail view can be reached by clicking a document
record's link from anywhere in the application including from the Documents list
view.
Please note that you will only be able to view a document record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentations in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each document's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this document
Duplicate Duplicate this document
Delete Delete this document

Next or Previous Record

On the upper right of the Documents detail view, there are two buttons that allow
you to page through each document in the Documents list view's current search
results. Clicking the Previous button displays the previous document of the current
search results while clicking the Next button displays the next document of the
current search results. The text in between shows which document result you are
currently viewing within the total number of current results.

 

Subpanels

Beneath a document record's fields are subpanels containing related records from
various modules, document revision history, and the document's related Contract
records.
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Related Records Subpanels

The most common type of subpanels displayed on a document's detail view
contains the document's related records belonging to various modules. The
relationship type determines whether a related record will be displayed in the field
listing or in a subpanel. For example, a document may be related to only one other
document but related to multiple accounts. This means that the related document
will be displayed amongst the document's fields while accounts will be displayed in
a subpanel beneath the fields.
Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information modifying subpanels, please refer to the Studio documentation in
the Administration guide.
Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the document, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the document, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To delete the document's relationship to a record, choose "unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.
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Document Revisions Subpanel

The Document Revisions subpanel lists the document revisions for this document
record. The revisions are sorted in descending order on the revision number by
default. Each revision retains the copy of the document loaded on that revision.
This provides you with the ability to look back at the history of the document to
compare revisions.
Note : This does not work as expected with External Documents (i.e. Google Docs,
IBM Smart Cloud) as the document is not stored in Sugar for these document
sources, but only a link to the document. To retain change history, either utilize
Google Doc's change features, or select a different document for every revision.
You can click the Create button on this subpanel to create a new revision of the
document you are currently viewing. The revision number is automatically
populated with the current highest revision number plus one, but can be modified.
However, once the new Document is saved, this field becomes read-only for all
users.

Note : If you skip numbers, it will not go back and fill in the missing numbers.

You may also populate an optional Change Log field with a short description of the
change being made for this revision. Click "Save" to complete the revision record.
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Editing Documents

Documents may be edited at any time to update or add information to the record.
You can make changes to existing document records via the Documents edit view
and quick create forms. Edit view is available within the Documents module and
includes all of the Document fields you should need.

 
Quick create is available for editing documents from outside the Documents
module and opens as a pop-up without navigating away from your current page. It
generally contains fewer fields, but the Full Form button may be used to access the
full edit view should you need to edit additional fields.
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Please note that your ability to edit documents in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.
Administrators in Sugar may configure both the Documents edit view and quick
create via Admin > Studio. For more information on configuring layouts, please
refer to the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit documents via the Detail View by clicking the Edit button on the
upper left of the page. Once the edit view layout is open, update the necessary
fields, then click "Save" to preserve the changes made.

 

Editing Via List View

You can edit documents via the List View by clicking the Pencil icon to the left of
each document's name. A pop-up window will open with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes.

 

Editing Via Dashlets

You can edit documents by clicking the pencil icon to the far right of any
documents-based dashlet on your Sugar home page. For example, clicking the
pencil icon within the My Documents dashlet will open a pop-up window with the
quick create form which is a shortened version of the edit view layout. Update the
necessary fields, then click "Save" to preserve the changes. For more information
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on dashlets, please refer to the Home documentation in the Application guide.

 

Editing Via Reports

Sugar reports also allow you to edit a document record by clicking on the pencil
icon next to a document's name. This opens a pop-up window with the quick create
form which is a shortened version of the edit view layout. Update the necessary
fields, then click "Save" to preserve the changes. Please note that you may only
directly edit documents from Rows and Columns-type or Summation with
Details-type reports as Summation-type and Matrix-type reports do not include the
pencil icon. For more information on reports, please refer to the Reports
documentation in the Application guide.

 

Deleting Documents

If a document record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Documents detail view or list
view. Deleting via the detail view allows you to delete a single record while the list

 454 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Home
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Reports


 

view allows for mass deleting multiple records at once. Deleting document records
will not delete the related records and will only remove the relationship, so you
may wish to also delete any related records to avoid orphaned records. Document
revision records will be deleted when deleting the parent document record.
Please note that your ability to delete documents in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a document record via the detail view:

1. Navigate to a document record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more document records via the list view:

1. Navigate to the Documents list view by clicking the Documents module tab.
2. Use the Basic or Advanced Search to find the Document records you wish to

delete.
3. Select the desired document records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.
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5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of document records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Document Records

Sugar's Export option allows users to download all fields for the selected
documents to their computers as a .CSV (comma-separated values) file. This may
be useful when needing to use document data with other software such as
Microsoft Excel. Due to PHP memory limitations on the server, there may be
occasions when the application times out while exporting a large number of
document records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.
Documents may be exported from the Documents list view by selecting "Export"
from the Actions menu. Users with access to the Reports module also have the
option of creating or accessing reports containing specifically chosen fields for
documents and their related record(s). Please note that only Rows and
Columns-type reports have the ability to be exported. For more information on
exporting records in Sugar, please refer to the Export documentation in the
Application guide.

 
Please note that your ability to export documents from Sugar may be restricted by
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a role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Downloading Documents

Exporting a document from Sugar will only export the document record with the
metadata about the document, but the document itself will not be included in the
export. In order to download a document from the documents module, simply click
on the File Name link in the list view or the detail view and the document will be
downloaded to your computer. If the document is linked to an external source (i.e.
Google Docs, IBM Smart Cloud), then the file name link will open directly to the
doc inside a new window or tab.

 

 

Mass Updating Documents

Mass Updating allows users to make the same change to multiple document
records at once from the Documents list view. Users with administrator or
developer level access can control which fields are available to change during
mass update via Admin > Studio. Currently, only fields with the data type of date,
datetime, dropdown, multiselect, and radio may be altered during a mass update.
For more information on configuring mass update, please refer to the Studio
documentation in the Administration guide. Due to the PHP memory limitations on
the server, there may be occasions when the application times out while mass
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updating a large number of contact records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.
Please note that your ability to mass update documents may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.
Use the following steps to mass update document records from the list view:

1. Navigate to the Documents list view by clicking the Documents module tab.
2. Use the list view's Basic or Advanced Search to identify documents you wish

to modify.
3. Select the desired documents individually or using the checkbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected document

records.

Favoriting Documents
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Each Sugar user has the option to designate their own favorite documents which
are important or will be viewed often so that they can easily be accessed via search
or from the documents module tab. Once records are marked as favorites, use the
My Favorites checkbox in the Documents Basic or Advanced Search to retrieve
your favorites or select from your most recent favorites directly from the 
Documents Module Tab .

Favoriting Via List View

Use the following steps to mark records as favorites via the Documents list view:

1. Navigate to the Documents list view by clicking the Documents module tab.
2. Use the Basic or Advanced Search to find the Document records you wish to

mark as favorites.
3. Mark the star icon on the left of each desired document's row.
4. To remove the document as a favorite, click the star again to revert it to

white.

 

Google Docs Integration

Sugar comes with Google Docs (Google Drive) integration by default. In order to
be able to create a document in Sugar from a Google Doc in your Google Drive you
will first need to link your Google Account with your profile in sugar.
For more information regarding setting up external accounts in your user profile,
please refer to the External Accounts Tab section in the Getting Started document
in the Application guide.

Last Modified: 03/02/2016 02:58pm

Calendar
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Overview

Sugar's Calendar module allows users to easily schedule, view, and manage their
activities (e.g. calls, meetings, tasks) in one place. The calendar will show your
calls, meetings, and tasks provided you are an invitee on the call or meeting, or the
task is assigned to you. You can also view other user's scheduled activities via the
shared calendar option. This documentation will cover how to use the Calendar
module as well as the various actions and options available from within the
module.

Calendar Module Tab

The Calendar module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access your calendar. You may also hover on the tab
to display the Actions menu, which allows you to perform important actions within
the module.

 

The Actions menu allows you to perform the following options:

Menu Item Description
Schedule Meeting Schedule a new meeting via the

Meetings edit view
Schedule Call Schedule a new call via the Calls edit

view
Create Task Create a new task via the Tasks edit

view
Today View the current day on the calendar

Calendar Actions

When viewing your calendar, there are several options across the top of the
calendar to help you navigate the calendar and increase the functionality available.
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These buttons are accessible from any calendar screen, with some notable
exceptions. Most of the buttons are used to change the view of the calendar to
show a specific time period, or jump to a specific period. The buttons are defined
as follows:

Options Description
Day View the current day on the calendar
Week View the current week on the calendar
Month View the current month on the calendar
Year View the current year on the calendar
Shared View the shared calendar for other

users in Sugar
User List Select which users will show on the

shared calendar
Note: This option is only available when
viewing the Shared calendar

Calendar Icon Click the calendar icon to quickly jump
to a specific date
Note: This option is not available when
using the year view

Settings Change the settings on the calendar as
described in Viewing Via Calendar

Creating Activities

There are various methods for creating the different activities available in Sugar,
including via the calendar itself, the Calendar module's actions menu, the
individual activity's module, or via quick create. The full edit view layout opens
when creating the activity from the actions menu or directly from the individual
module. The quick create form is a shortened version of the edit view and typically
contains fewer fields. When using quick create to make an activity while viewing
an existing record of another module, Sugar automatically creates a relationship
between both records. For example, if you are viewing a contact record and create
a new meeting via the quick create form, the contact will automatically be set as
an invitee. Both the Edit View and Quick Create layouts can be configured by
administrators via Admin > Studio. For more information on configuring layouts,
please refer to the Studio documentation in the Administration guide.

Note: When creating a recurring meeting or call , the record must be created on
the calendar or from the full form edit view of the module. The standard quick
create form does not include the recurring functionality.

 461 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Calendar/#Shared_Calendar
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Calendar/#Viewing_Via_Calendar
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Calendar/#Setting_Meetings_and_Calls_to_Recur


 

Creating Via Calendar Grid

The calendar allows you to create meetings and calls easily by clicking on the
specific date or time when your activity will occur. Clicking on a the calendar will
bring up a quick create form where you can dictate if this activity will be a call or a
meeting, and the start date and time will be automatically populated with the time
slot that you clicked.

Use the following steps to create an activity via the calendar grid:

1. Navigate to the calendar by clicking on the Calendar module tab.
2. Click the time slot that your activity will start to open the quick create form.

 
3. Select if the activity will be a meeting or a call using the radio buttons at the

top of the page.

 
4. Enter appropriate values for the fields in the Details tab. All required fields

are marked with a red asterisk and must be completed prior to saving. Email
and popup reminders can be configured from this tab. You can also add
invitees to meetings and calls from the Invitees tab, or set them to be 
recurring from the Recurrence tab.
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5. If additional fields are desired, click the Full Form button to use the edit view

instead.
6. Once the necessary information is entered, click Save or, if you would like an

invitation email to go out to the invitees where they can accept or deny the
call or meeting, click Save & Send Invites.

Creating Via Actions Menu

One of the ways to create an activity is via the create options in the Calendar 
module tab . This opens up the edit view layout which allows you to enter in all the
relevant information for the activity.

Use the following steps to create an activity via the Calendar module tab:

1. Hover on the Calendar module and select one of the actions for the type of
activity you are creating.

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
You can also add invitees to meetings and calls, or set them to be recurring .
Email and popup reminders can also be configured from this page.

3. Once the necessary information is entered, click one of the save or close
options:

Option Description
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Save Creates the activity record with the
given values in the fields

Save & Send Invites Creates the activity record with the
given values in the fields and sends a
call or meeting invitation to the listed
invitees where they can accept or
deny the call or meeting

Close and Create New Creates the activity record with the
given values in the fields, except for
the status field which will update to
be either "Held" or "Completed",
depending on the activity module

Creating Via Activities Modules

Calls, meetings, and tasks will show on the calendar when created from the
activity's module. The activity will show on your calendar if you are listed as an
invitee on the call or meeting, or if you are the assigned user on the task. Activities
can be created directly from the Calls , Meetings , or Tasks modules.

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create an activity from any Activities
subpanel on related module records. The recurring meeting or call functionality is
not available in the quick create form. Please use the full form option if you would
like to create a recurring event.

Note: It is suggested that if you are going to be relating the activity to any other
record in Sugar, it is best practice to create the activity while on the related
record's detail view, which will automatically relate the two records.
Use the following steps to create an activity via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Log Call", "Schedule Meeting", or "Create Task" or select "Log Call",
"Schedule Meeting", or "Create Task" on any Activities subpanel on a related
module's detail view.
From Quick Create menu:
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From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead. Email and popup reminders can be configured from full form. You
can also add invitees to meetings and calls from the full form, or set the call
or meeting to be recurring .

4. Once the necessary information is entered, click "Save". If you navigated to
the full form, once the necessary information is entered, click Save or, if you
would like an invitation email to go out to the invitees where they can accept
or deny the call or meeting, click Save & Send Invites.

 

Adding Reminders
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Sugar includes the ability to remind users when they have a call or meeting that is
scheduled to begin in a given amount of time. Reminders can be presented to users
by a popup window that will appear within your Sugar window or by an email
being sent to all of the invitees. By default, reminders have to be manually added
to calls and meetings upon creating or editing the activity. Users can update their
default reminders to be specific times for each type of reminder through User
Preferences .

Adding Email Reminders

Email reminders are scheduled upon creation of or while editing a call or meeting
record. The email reminders are emailed to all invitees, including non-Sugar users.
Select the "Email all invitees" checkbox in the create activity form and set the time
for the reminder email to be sent out by selecting one the options in the dropdown
list.

 

The email that is received by recipients will contain the subject of the call or
meeting, the start date and time, and who created the record.

Adding Popup Reminders

Popup reminders are scheduled upon creation of or while editing a call or meeting
record. The popup reminders appear for any users listed as invitees, as long as
they are logged in to Sugar when the reminder is set to trigger. Select the "Popup"
checkbox in the create activity form and set the time for the reminder to appear by
selecting one the options in the dropdown list.
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The popup that is received by recipients will contain the subject of the call or
meeting, the start date and time, and the location of the activity. Click "OK" to
open the meeting or call record, or "Cancel" to stay on your current page.

Adding Invitees

Users have the option of adding additional invitees (i.e. Contacts, Leads, Users) to
calls and meetings via the Add Invitees or Create an Invitee option in the Calls or
Meetings edit or quick create view. Please note that the user creating the call or
meeting as well as the contact or lead selected in the Related To field will
automatically be added as invitees to the call or meeting. You can simply remove
yourself or an attendee from the call by choosing the remove button the
Scheduling panel or "Unlink" from the Invitees panel. For more information on
removing invitees, please refer to the Calls or Meetings documentation.

Adding Via Add Invitees

Use the following steps to add attendees via the Add Invitees panel:

1. Navigate to Invitees panel and perform a search to find the attendee you wish
to add.

The search results will appear below the Add Invitees panel.

 
2. To add the invitee, click "Add" to the far right of the record's name.

Please note that the icons to the left of the record's name indicate if it is
a Contact (Rolodex Card icon), Lead (Magnifying Glass icon), or User
(People icon) record.
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The added invitee(s) will appear in the Scheduling panel in the Calls and Meetings
edit view as well as the Invitees subpanel in the detail view. For more information
on viewing attendees via the Invitees subpanels, please refer to the Invitees
Subpanels section of the Calls and Meetings documentation.

 

Adding Via Create an Invitee

Use the following steps to add attendees via the Create an Invitee option:

1. Navigate to the Create an Invitee section and click either the As Contact or As
Lead button.

 
2. Enter in the relevant information (e.g. First Name, Last Name, etc.) for the

contact or lead then click "Create & Add".
Note: The created contact or lead record will be added and appear in the
corresponding module (Contact or Lead) as well.

 

The contact or lead will appear as an invitee in the Scheduling panel in the Calls or
Meetings edit view as well as the Invitees subpanel in the detail view. For more
information on viewing attendees via the Invitees subpanels, please refer to the
Invitees Subpanels section of the Calls and Meetings documentation.
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Setting Meetings and Calls to Recur

Meetings and calls can be set be recurring events so that users do not have to
create individual meeting or call records for regularly occurring events.
Recurrences can be set up to occur daily, weekly, monthly, or yearly. When a
recurring meeting or call is configured, individual meeting records are created in
Sugar, so when viewing the Meetings or Calls list view, all recurrences will show.

Note: Recurring meetings and calls must be created on the calendar or from the
full form edit view of the module. The standard quick create form does not include
the recurring functionality.

Use the following steps to set a meeting or call to recur from the calendar:

1. Navigate to the Recurrence tab of the calendar creation view.
2. Select the type of recurrence for the call or meeting, either daily, weekly,

monthly, or yearly.

 
3. Select how often you would like the event to recur, and if it will end after a

given amount of occurrences, or if it will end by a specific day.
Note: If the recurrence is weekly, you will be presented with an option to
decide which day or days of the week the recurrence should occur.
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Use the following steps to set a meeting or call to recur from the edit view:

1. Navigate to the Recurrence panel of the edit view.
2. Select the type of recurrence for the call or meeting, either daily, weekly,

monthly, or yearly.

 
3. Select how often you would like the event to recur, and if it will end after a

given amount of occurrences, or if it will end by a specific day.
Note: If the recurrence is weekly, you will be presented with an option to
decide which day or days of the week the recurrence should occur.
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Viewing Via Calendar

The Calendar module allows users to schedule, view, and manage various activities
(Calls, Meetings, Tasks) in Sugar. The Calendar module can be accessed by
clicking the Calendar module tab . The three activity types are color coded as:

Module Color
Calls Red
Meetings Blue
Task Green

 

You can click the cell of an existing call or meeting to view the details via the
Quick Create form. You can also click the "i" icon to the far right of the call record
cell for a quick view of additional details (e.g. Subject, Start Date & Time,
Duration, Related to, etc.) of any activity without opening up the record.

 

Please note that you will only be able to see activity records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Teams and Roles documentation in the
Administration guide.

The Calendar module defaults to the week view and can be viewed as a day, week,
month, or year view using the buttons at the top of the page. The week view can be
changed to have a different day of the week using the Calendar Options in your
user profile. To edit this, click on the First Day of Week dropdown list under the
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User Preference's Advanced tab. For more information on the user profile, please
refer to the User Preferences documentation in this guide.

 

When viewing the day, week, or month view of the calendar, you can jump to a
specific date using the calendar popup in the top right of the screen. Select any
date within the same month or use the left or right arrows to navigate to previous
or upcoming months. You can also jump to today's date with the Today button in
the popup calendar, or jump to a specific month or year by clicking on the
displayed month in the popup calendar. Alternately, you can jump to the next day,
week, month, or year, depending on your current view, using the next and previous
buttons at the top and bottom of the calendar view. For more information on using
the next and previous buttons, please review the Next or Previous Calendar View
section of this documentation.

 

The look and feel of the calendar can also be changed via the Settings option to the
right of the calendar popup. The settings allow you to perform the following
actions:

Display time slots in Day and Week views : When this option is enabled,
activities are displayed in their specified time cells when viewing a day or
week via the calendar. If this option is disabled, all activities will appear as a
list. This option is enabled by default.
Start Time : The value set in this field represents the first time cell displayed
on your day or week calendar view (e.g. 09:00 am).

Note: This option is disabled and hidden if "Display time slots in Day and
Week views" is disabled.

End Time : The value set in this field represents the last time cell displayed on
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your day or week calendar view (e.g. 05:00 pm).
Note: This option is disabled and hidden if "Display time slots in Day and
Week views" is disabled.

Show Calls : When this option is set to "Yes", scheduled calls are also
displayed in the calendar view. If you do not wish to see calls in the calendar
view, set this option to "No". This option is set to "Yes" by default.
Show Tasks : When this option is set to "Yes", scheduled tasks are also
displayed in the calendar view. If you do not wish to see tasks in the calendar
view, set this option to "No". This option is set to "Yes" by default.
Show Completed Meetings, Calls and Tasks : When this option is set to "Yes",
completed meetings, calls, and tasks are also displayed in the calendar view.
If you do not wish to see completed activities in the calendar view, set this
option to "No". This option is set to "Yes" by default.

After all settings have been changed, click Apply to update the calendar with your
changes.

 

The calendar can also be viewed on the home page in a dashlet. To add the
calendar to your home dashboard, click on the Add Sugar Dashlets button and
select "My Calendar" in the modules tab. Once added to your dashboard, the
calendar dashlet can be configured to show either your weekly or daily schedule.
For more information on dashlets, please review the User Interface
documentation.
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Viewing Shared Calendar

The Calendar module allows you to view not just your own activities, but you can
also view the calendar of other Sugar users using the Shared Calendar. The
calendar will show the selected user in a weekly view on one page. Using the
shared calendar, users will also have the option to create activities for other users
directly from the calendar. For more information on using the shared calendar,
please review the Shared Calendar section of this documentation.

Please note that you will only be able to see activity records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Teams and Roles documentation in the
Administration guide.

 

Moving Scheduled Activities

The Sugar calendar allows for the start time and duration of meetings and calls to
be edited from the calendar, instead of having to directly edit the activity record
through the module. The records that appear on the calendar can be dragged and
dropped to new locations to change the start date and time.

Note: All occurrences of recurring meetings and calls cannot be modified by
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dragging one record of the series.

 
In addition, the activities can be dragged from the bottom of the box to be able to
change the duration of the activity. To do this, simply hover over the activity's box
to make the two lines appear at the bottom. Click those two lines and drag to your
new duration.

 

Note: Changing the meeting details with drag-and-drop does not send a
system-generated update to the meeting invitees.

More Information

Additional details for each activity can be viewed by clicking the "i" icon on the far
right of each activity block on the calendar. This provides users a quick view of
additional information in addition to what appears on the block. The popup window
can also be used to access the record. Click the Pencil button to view the edit view
for the record, the Eyeball button to view the detail view of the record, or the "X"
button to close the popup window.
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The resulting popup window will show the following fields by default:

Module Fields
Calls Start Date & Time

Duration

Related to

Description (abbreviated)
Meetings Start Date & Time

Duration

Related to

Description (abbreviated)
Tasks Start Date & Time

Due Date & Time

Priority

Status

Description (abbreviated)
Note: The list of fields appearing here may only be configured through a code-level
customization.

Next or Previous Calendar View

On the four corners of the Calendar, there are buttons that allow you to page
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through the given time frame in groups at a time, either the next or previous day,
week, month, or year. The timeframe will change depending on which calendar you
are viewing. When viewing the shared calendar , these buttons will always
paginate by the week.

 

Editing Activities

Activities on the calendar can be edited directly from the calendar instead of
having to access the record throughout the individual modules. Dragging and
dropping activity cells within the calendar can make changes to the start date and
time and the duration. For more information about moving activities from within
the calendar, please refer to the Moving Scheduled Activities section of this
documentation. You can make other changes to existing activity records via the
quick create or edit view forms. Use the following steps to edit an activity via the
calendar:

1. Navigate to the calendar by clicking on the Calendar module tab.
2. Locate the activity you would like to edit and click on the cell to open the

quick create form for that module with all of the details of the record filled in.
When viewing the quick create form, you can click on Full Form to reach that
record's edit view.
Note: Tasks cannot be edited directly from the calendar using the quick
create form.
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3. Make the necessary changes to the activity, including setting reminders , 

adding invitees , or set any recurrences of the activity.
4. Once the necessary information is entered, click Save or, if you would like an

invitation email to go out to the invitees where they can accept or deny the
call or meeting, click Save & Send Invites.

The full form edit view can also be reached by clicking the Pencil button on the
More Information popup for the activity. Please review the More Information
section of this documentation for more information about using this popup.

 

Please note that your ability to edit activities in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure all of the edit view and quick create forms
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

 478 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Calendar/#Adding_Reminders
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Calendar/#Adding_Invitees
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Calendar/#Setting_Meetings_and_Calls_to_Recur
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Calendar/#More_Information
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio


 

Editing Recurring Meetings and Calls

When a meeting or call is set to be recurring, additional copies or duplicates of the
call or meeting record are created for the specific time and date of each
recurrence. Therefore, editing one record's cell on the calendar will not affect the
other recurrences of the same call or meeting and will only affect the one
recurrence you are editing. Changes to recurring events must be made from the
Recurrence tab on the meeting or call's quick create form. Use the following steps
to edit a recurring meeting or call:

1. Click on one instance of the recurring event that you would like to update.
2. Navigate to the Recurrence tab and click "Edit All Recurrences".

 
3. Change the recurrence cycle of the event, how often you would like it to

repeat, and when you would like it to end.

 
4. Once the necessary information is entered, click Save or, if you would like an

invitation email to go out to the invitees where they can accept or deny the
call or meeting, click Save & Send Invites.

Deleting Calls and Meetings Via Calendar

If a call or meeting record is invalid or should no longer appear on your calendar
or in Sugar, it may be deleted via the quick create view. Deleting via the quick
create view allows you to delete a single record directly from the calendar, instead
of having to navigate to the module and re-locate the record.

Note: Tasks cannot be edited or deleted directly from the calendar using the quick
create form. 

Use the following steps to delete a call or meeting from the calendar:
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1. Navigate to the calendar by clicking on the Calendar module tab
2. Locate the call or meeting you would like to edit and click on the cell to open

the quick create form for that module
3. Click Delete at the bottom of the form, and then "OK" on the confirmation

popup message

 

Recurring calls and meetings can be deleted by this method if you would like to
delete the individual call or meeting. Deleting one record through this process will
not remove the entire series. Use the following steps to delete a recurring series of
calls or meetings from the calendar:

1. Click on one instance of the recurring event that you would like to update
2. Navigate to the Recurrence tab
3. Click "Delete All Recurrences" and then "OK" on the confirmation popup

message

 

Please note that your ability to delete calls and meetings in Sugar may be
restricted by a role. For more information on roles, please refer to the Role
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Management documentation in the Administration guide. Check with your system
administrator if you do not see the Delete options.

Shared Calendar

The Shared Calendar option in the Calendar module allows you to view other
user's calendars so as to help you schedule with other users or keep track of their
activities. The shared calendar also gives you the ability to schedule meetings and
calls for other users so that they are automatically an invitee to the activity and the
assigned user, as if they had created it themselves. The Shared Calendar is always
viewed as a weekly view. Use the following steps to enable the shared calendar:

1. Navigate to the calendar by clicking on the Calendar module tab.
2. Click on the Shared button in the list of the different view types.

 
3. Click the User List button to select the user's calendars you would like to

view.

 
Note: You can filter the user list by the team that users are associated with
using the dropdown above the user list.

 
4. Click Select after choosing the users to display all of the user's weekly

calendars on the Calendar page.
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Please note that you will only be able to see and edit activity records on the shared
calendar as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Teams and 
Roles documentation in the Administration guide.

Publishing Calendars

Sugar allows users to share calendars between applications so as to ensure that
activities do not overlap between calendars. The Sugar calendar can be viewed in
other applications, including the Outlook calendar displaying the user's free/busy
time from Sugar.

Publishing Your Sugar Calendar

Sugar calendars can be shared and viewed with various iCal compatible calendar
applications (e.g. Apple iCal or Google Calendar). The calendars are viewable as
read-only in the external calendar applications and any edits to existing activities
can only be done in Sugar. For more information on sharing your calendar on
another application, please review the Calendar Options section in the Getting
Started guide.

Publishing to Your Outlook Calendar

You can specify settings in another application, such as Outlook, to enable the
ability to view a user's free/busy information from the Sugar calendar. The settings
must be configured on each user's computer. Once configured, the invitee shows
as busy for any times currently scheduled in Sugar if the user's email address in
Sugar matches the invitee email address in Outlook.

Use the following steps to configure this functionality:

1. In Sugar, navigate to your user preferences and select the Advanced tab
2. Copy the "Search location" URL located at the bottom in the Calendar Options

panel
3. In Outlook, go to File > Options > Calendar > Free/Busy Options
4. In the "Internet Free/Busy" section, paste the "Search location" URL into the

corresponding box

Integrating With MS Outlook
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Sugar allows you to sync meetings and calls in Sugar with your local installation of
Microsoft Outlook using the Outlook Plug-in. The plug-in also allows you to archive
emails and sync contacts . All meetings and calls, including recurring ones, can be
synced using the plug-in. When a meeting or call is synced from Outlook to Sugar,
the meeting or call will show on the Sugar calendar, but not be editable through
Sugar; just viewable.

For more information on using the Outlook Plug-in, please review the Sugar
Plug-in for MS Outlook User Guide.

Integrating With IBM Lotus Notes

Sugar allows you to sync activities in Sugar with your local installation of Lotus
Notes using the Lotus Notes Plug-in. The plug-in also allows you to archive emails
and sync contacts . All activities, including recurring ones, can be synced using the
plug-in. When a meeting or call is synced from Lotus Notes to Sugar, the activity
will show on the Sugar calendar, but not be editable through Sugar; just viewable.

For more information on using the Lotus Notes Plug-in, please review the Sugar
Plug-in for Lotus Notes User Guide.

Last Modified: 11/12/2015 04:05pm

Calls

Overview

Sugar's Calls module consists of open, upcoming, or closed call records logged by
users in your organization. There are various ways you can create calls in Sugar
such as via the Calls module, Calendar module, importing calls, etc. Users can also
log calls via the Activities subpanel on related module records (e.g. Contacts,
Accounts, Leads, etc.), which automatically creates a relationship between both
records. Once the call record is created, you can view and edit information
pertaining to the call via the Calls detail view. This documentation will cover how
to use the Calls module as well as the various actions and options available from
within the module.

Call Fields

The Calls module contains a number of stock fields which come out-of-the-box with
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Sugar. The below definitions are suggested meanings for the fields, but the fields
can be leveraged differently to best meet your organization's needs. Users with
administrator or developer access have the ability to alter, add, or remove fields
via Admin > Studio. For more information on configuring fields, please refer to the
Studio documentation in the Administration guide.

Field Description
Assigned To The Sugar user assigned to the call
Created By The Sugar user who created the call
Date Created The date the call record was created
Date Modified The date the call record was last

modified
Description A description or other information about

the call
Direction Indication of whether the call is inbound

or outbound
Duration The duration of the call specified in

hours/minutes
End Date The end date and time for the call
Modified By Name The name of user who last modified the

call record
Outlook ID The Outlook appointment item ID when

the Sugar Plug-in for Microsoft Outlook
syncs an Outlook appointment

Related To The related module record associated to
the call

Reminders Set a reminder (Popup and Email) alert
for invitees

Note: Popup notifications appear for all
invitees using Sugar and email
reminders are sent to all invitees.

Start Date & Time The start date and time for the
scheduled call

Status The current status (e.g. Planned, Held,
Not Held) of the call

Subject The subject of the scheduled call
Teams The Sugar team(s) assigned to the call

record
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Calls Module Tab

The Calls module tab is typically located under the More tab of the navigation bar
at the top of any Sugar screen. Sugar normally displays the top six modules shown
in the Display Modules list of your user preferences, so the remaining displayed
modules are grouped under the More tab. For more information on displayed
modules for the navigation bar, please refer to the Layout Options section of the
Getting Started documentation. Click the tab to access the Calls list view. You may
also hover on the tab to display the Actions, Recently Viewed, and Favorites menu.
The Actions menu allows you to perform important actions within the module. The 

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Log Call Opens the edit view layout to create a

new call
View Calls Opens the list view layout to search and

display calls
Import Calls Opens the import wizard to create or

update calls using external data
If you do not see the Calls module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Sales, Reports, etc.) of which the Calls module is not a member. Click the
More tab (last tab on navigation bar) then hover on "Filter Menu By" to check
how the navigation bar is grouped. For more information on tab grouping,
please refer to the User Interface documentation.
The Calls module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Calls module in the Hide Modules list, simply
move it to the Display Modules list. For more information on hiding and
displaying modules, please refer to the Layout Options section of the Getting
Started documentation.
The administrator may have disabled the Calls module for your entire Sugar
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instance. Reach out to your Sugar administrator to have the Calls module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Calls

There are various methods for creating calls in Sugar including via the Calls
module, Calendar module, quick create, duplication, and importing calls. The full
edit view layout opens when creating the call directly from the Calls menu and
includes all of the relevant fields for your organization's calls. The quick create
form is a shortened version of the calls edit view and typically contains fewer
fields. When using quick create to make a call while viewing an existing record of
another module, Sugar automatically creates a relationship between both records.
For example, if you are viewing a contact record (e.g. John Smith) and create a
new call via the quick create form, the Related to field in the call record will
automatically populate with "John Smith", thus creating the relationship. Both the
Edit View and Quick Create layouts can be configured by administrators via Admin
> Studio. For more information on configuring layouts, please refer to the Studio
documentation in the Administration guide.

Creating Via Calls Module

One of the most common methods of call creation is via the Log Call option in the
Calls module tab. This opens up the edit view layout which allows you to enter in
all the relevant information for the call.
Use the following steps to create a call via the Calls module:

1. Hover on the Calls module and select "Log Call".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. To set a reminder for invitees, mark the checkboxes (Popup, Email all

invitees) in the Reminders field then select the time of the alert (e.g. 10
minutes prior) to occur prior to the call's scheduled start date and time.

Please note that if you set a default reminder in your user preferences,
the Reminders field in the calls edit view will automatically be selected
along with your default reminder time. For more information on setting
your default reminder, please refer to the User Settings section of the
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Getting Started documentation.
The outbound mail server must also be configured via Admin > Email
Settings in order for email reminders to be sent out. For more
information on setting up the system email settings, please refer to the 
documentation in the Administration guide.

 
4. To add invitees (i.e. Contacts, Leads, and Users) to the call, scroll to the Add

Invitees panel to search and add an attendee.
For more information on adding attendees via the Add Invitees panel,
please refer to the Adding Via Add Invitees section of this
documentation.

 
5. To create and add an invitee, scroll to the Create an Invitee section then click

either the As Contact or As Lead button.
For more information on creating and adding attendees via the Create an
Invitee section, please refer to the Adding Via Create an Invitee section
of this documentation.

 
6. The list of all invitees will appear in the Scheduling panel.

The duration of the call will be indicated by a green line (start time) and
red line (end time).
The Scheduling panel will display any busy times (e.g. Calls already
scheduled) by blocking it out in blue, and any scheduling conflicts with
other calls will be blocked out in brown.

 
7. Once all the appropriate information is entered, click "Save" or "Save & Send

Invites".
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Save : Saves the call record but does not send an email invite to invitees.
Save & Send Invites : Saves the call record and sends an email invite to
invitees. The invitees will be able to accept, tentatively accept, or decline
the scheduled call via the email invite.
Close and Create New : Closes the original call record as "Held" and
creates a new copy of the call. For more information on closing and
creating new calls, please refer to the Closing and Creating New Call
section of this documentation.

 

Creating Via Calendar

There are two methods of creating calls in the Calendar module. The first method
is to create a call via the Schedule Call option in the Calendar module tab. This will
open up the Calls edit view layout to create a new call record. For more
information on creating calls via the Calls module, please refer to the Creating Via
Calls Module section of this documentation. The second method is to create the
call directly via the user's Sugar calendar.

Use the following steps to create a call via the Calendar module:

1. Click the Calendar module tab.
2. On the calendar view, click the cell corresponding to the date and time you

wish to schedule the call.
You can choose to view the calendar by Day, Week, Month, Year, or
Shared. For more information on viewing the shared calendar, please
refer to the Calendar documentation.

 
3. Enter appropriate values for the fields on the Details tab of the quick create
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form. All required fields are marked with a red asterisk and must be
completed prior to saving.

Please note that the "Start Date & Time" will automatically be populated
based on the date and time cell you select in the calendar.

 
4. If additional fields are desired, click the Full Form button to use the Calls edit

view instead.
5. To add invitees (e.g. Contacts, Leads, etc.) to the call, click the Invitees tab.

For more information on adding invitees to calls, please refer to the Adding
Invitees to Calls section of this documentation.

6. To schedule the call as recurring, click the Recurrence tab, and select the
appropriate interval (e.g. Daily, Weekly, etc.).

When you select an interval, you must specify how often the scheduled
call will recur as well as when the last call takes place. For more
information on scheduling recurring calls, please refer to the Setting
Meetings and Calls to Recur section of the Calendar documentation.

 
7. Once all the appropriate information is entered, click "Save" or "Save & Send

Invites".
Save : Saves the call record but does not send an email invite to invitees.
Save & Send Invites : Saves the call record and sends an email invite to
invitees. The invitees will be able to accept, tentatively accept, or decline
the scheduled call via the email invite.
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Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a call from any Activities subpanel
on related module records.

Use the following steps to create a call via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Log Call" or select "Log Call" from the Actions menu of any Activities
subpanel on a related module's detail view.
From Quick Create menu:

 
From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. The Related To field is automatically populated with the module and record

you are currently viewing.
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Note: When creating from the Contacts module, the contact will be populated
in the Contacts relationship and the account assigned to the contact will be
populated in the Related To.

4. If additional fields or options (e.g. add invitees) are desired, click the Full
Form button to use edit view instead.

For more information on adding invitees to calls, please refer to the 
Adding Invitees to Calls section of this documentation.

5. Once the necessary information is entered, click "Save".

 

Creating Via Duplication

You can also create a new call by duplicating an existing call record. The duplicate
option is useful if the call you are creating has similar information to an existing
call.

Use the following steps to create a call by duplicating an existing record:

1. Navigate to a call record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original call's values.

Update the necessary fields, then click "Save" or "Save & Send Invites".
Please note that the original invitees will also be included in the
duplicated call record. You can remove the invitees from the Scheduling
panel by clicking the Remove icon on the far right of the invitee names.
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For more information on adding invitees to calls, please refer to the 
Adding Invitees to Calls section of this documentation.

 

Importing Calls

The import function allows you to push multiple call records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.

Use the following steps to import calls via the Import Calls option:

1. Hover on the Calls module tab and select "Import Calls".

 
2. In Step 1, select the import file and choose "Create new records only". Click

"Next".
3. In Step 2, confirm the import file properties. Click "Next".
4. In Step 3, confirm the field mappings for the import. Click "Next".
5. In Step 5, view the import results.

The Created Records tab will show all of the new call records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Viewing Calls

There are various options available for viewing call records in Sugar including via
Calls list view, Calls detail view, Calls Recently Viewed menu, Calendar module,
dashlets, and reports. Please note that you will only be able to see call records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
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Management documentation in the Administration guide.

Viewing Via List View

The Calls list view displays all call records meeting the current search criteria. To
access the list view, simply click the Calls module tab. While list view shows key
call fields, you can click the call's name to open the record in detail view. For more
information on viewing calls via list view, please refer to the Calls List View section
of this documentation.

Viewing Via Detail View

The Calls detail view displays thorough call information including all call fields
followed by subpanels of the call's related records belonging to various modules.
The detail view can be reached by clicking a call record's link from anywhere in
the application including from the Calls list view. For more information on viewing
calls via detail view, please refer to the Calls Detail View section of this
documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which calls you have recently viewed. Hover
on the Calls module tab to see a list of your most recently viewed calls and click
each name to open the call in detail view.

 

Viewing Via Calendar

The Calendar module allows users to schedule, view, and manage various activities
(Calls, Meetings, Tasks) in Sugar. Call records are displayed in red on the calendar
and you can click the corresponding cell to view the call details via the Quick
Create form. You can also click the "i" icon to the far right of the call record cell
for a quick view of additional details (e.g. Subject, Start Date & Time, Duration,
Related to, etc.) of the call without opening up the record. For more information on
viewing and managing calls on the calendar, please refer to the Calendar
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documentation. Users also have the ability to view other users scheduled activities
via the shared calendar option. For more information on viewing the shared
calendar, please refer to the Calendar documentation.

Please note that you will only be able to see call records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view call information
in call-based dashlets such as "My Calls" as well as in dashlets based on other
modules such as "My Notes". Clicking a call's name from any dashlet will open the
call in detail view. For more information on using dashlets and viewing call records
via dashlets, please refer to the Modules section of the Home documentation. You
can also accept, tentatively accept, or decline the call in the My Calls dashlet, as
well as close the call as held by clicking the "x" icon to the far left of each list view
row. For more information on closing calls as held, please refer to the Closing
Calls section of this documentation.

Please note that when viewing the Calls dashlet, the start date will be shown in
one of three colors: black, orange, or red. Start dates change color on the calls list
view to allow the user to quickly see which scheduled calls are past their due
date/time, regardless of the current status.

The date colors in the Calls dashlet are as follows:

Black : The start date has not passed yet.
Orange : The start date and time is within 2 hours of the current time.
Red : The start date is expired.
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Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding calls and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the call record's detail view by clicking the call's name in the
report results. Please note that you can only directly access call detail views with
Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Managementdocumentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Calls

The Calls list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Calls list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
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that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %call). This will pull up
any record that has the word "call" in the name, regardless of how it starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.
Open Items : Select this box to return only records with an open status (e.g.
Planned).

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a call subject, Sugar will only return call records with
a matching subject that are assigned to you. Once the search is complete, the
relevant results will populate in the list view below the search panel. To see all call
records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
call records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Managementdocumentation in the Administration guide.
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Administrators can configure what fields appear on the Calls Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.
My Items : Select this box to return only records assigned to you.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a call subject to search, Sugar will only return call records
with a matching subject that you have marked as favorites. When searching by a
multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
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results will populate in the list view below the search panel. To see all call records
to which you have access, simply click "Clear" and then "Search" to perform a
blank search with no filters. Please note that you will only be able to see call
records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Administrators can configure what fields appear on the Calls Advanced Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
Search section of the System documentation in the Administration guide.

Calls List View

The Calls list view displays all call records meeting the current search criteria and
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to which your user has access. You can view the basic details of each call within
the field columns. Please note that you will only be able to see call records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

When viewing the Calls list view, the start date will be shown in one of three
colors: black, orange, or red. Start dates change color on the calls list view to
allow the user to quickly see which scheduled calls are past their due date/time,
regardless of the current status.

The date colors in the Calls list view are as follows:

Black : The start date has not passed yet.
Orange : The start date and time is within 2 hours of the current time.
Red : The start date is expired.

 

You have the option to change what fields are displayed in list view by configuring
your layout options in the Calls Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
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information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on call records directly from the list view by first
selecting the desired records. To select individual call records on the Calls list
view, mark the checkbox on the left of each row. To select or deselect multiple call
records on the list view, use the options in the checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of call
results.
Select All : Selects all records in the current search results across all pages of
call results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:
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Menu Item Description
Delete Delete one or more calls at a time
Mass Update Mass update one or more calls at a time
Export Export one or more calls to a CSV file

Favorite Designation

Users have the option to mark call records as favorites via the list view as well as
the detail view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Calls
module tab. In the Calls list view, the star on the left of each call's row is yellow
once marked to indicate a favorite call. For more information on how to mark
records as favorites, please refer to the Favoriting Calls section of this
documentation.

 

More Information

Additional details for each call can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional call
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Start Date & Time, Duration, and Related to fields by
default. The list of fields appearing here may only be configured through a
code-level customization.

 

Closing Calls

Users have the option to close calls as held via the list view once it has taken place
by clicking the "x" icon to the far left of each list view row. Once the call is closed,
the "x" icon will no longer appear under the Close column of the list view and the
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status of the call will change to "Held". For more information on closing calls to
mark as "Held", please refer to the Closing Callssection of this documentation.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Calls Detail View

The Calls detail view displays thorough call information including all call fields
which are grouped by default into the Overview and Other panels. You can also
view the invitees (i.e. Contacts, Leads, Users) for the call which appear in
subpanels beneath the call fields. The detail view can be reached by clicking a call
record's link from anywhere in the application including from the Calls list view.

Please note that you will only be able to view a call record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management documentation
in the Administration guide. Users with administrator or developer access have the
ability to change the detail view by configuring the layout via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation in
the Administration guide.

Actions Menu

The Actions menu on the top left of each call's detail view allows you to perform
various actions on the current record. Administrator users can change the action
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items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this call
Duplicate Duplicate this call
Delete Delete this call
Close and Create New Close this call as "Held" and create a

new copy of the call

Note: The Close and Create New button
appears as long as the status does not
equal "Held".

Close Close this call as "Held"

Note: The Close button appears as long
as the status does not equal "Held".

Favorite Designation

Users have the option to mark call records as a favorite via the detail view as well
as the list view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Calls
module tab. In the Calls detail view, the star on the right of the call's name is
yellow once marked to indicate a favorite call. For more information on how to
mark records as favorites, please refer to the Favoriting Calls section of this
documentation.
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Next or Previous Record

On the upper right of the Calls detail view, there are two buttons that allow you to
page through each call in the Calls list view's current search results. Clicking the
Previous button displays the previous call of the current search results while
clicking the Next button displays the next call of the current search results. The
text in between shows which call result you are currently viewing within the total
number of current results.

 

Subpanels

Beneath a call record's fields are subpanels containing invitees to the call as well
as related records from the Notes module.

Related Record Subpanels

Modules in Sugar display subpanels, which allow users to view related records
from other modules. Users can view the details of the related record as well as
relate new or existing records via the subpanel. Administrators can easily modify
the fields (e.g. Name, Assigned User, etc.) displayed on subpanels as well as the
label of each subpanel through Admin > Studio so that users have visibility to the
most important fields for their organization. For more information on working with
related record subpanels, please refer to the Subpanels section of the User
Interface documentation.

For the Calls module, you can relate a new note record by clicking "Create Note or
Attachment" from the Notes subpanel. Complete the Quick Create form then click
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"Save" and the note record will appear in the Notes subpanel. Ifadditional fields
are desired, click the Full Form button to use the Notes edit view instead. You can
edit the note, as well as view the note's detail view by clicking the Pencil/Note icon
to the left of the subject. To delete the call's relationship to the note, choose
"Unlink" from the dropdown on the far right of the record's row. Please note that
this removes the relationship, but does not delete the record itself. The subpanel
can also be collapsed or expanded by clicking the double arrow to the left of the
subpanel's name.

 

Invitees Subpanels

The Contacts, Users, and Leads subpanels in the Calls detail view display all
invitees for the call. Normally the contact or lead record you select in the Related
to field on the Calls edit view will appear in one of these subpanels (i.e. Contacts or
Leads). Additional attendees (i.e. Contacts, Leads, Users) can be added to the call
via the Add Invitees or Create an Invitee option in the Calls edit view. For more
information on adding invitees, please refer to the Adding Invitees to Calls section
of this documentation. Once added, all the invitees will appear in their respective
subpanels in the Calls detail view as well as the Scheduling panel in the edit view.

The Accept Status field on the subpanel will be updated once the invitee's accept,
tentatively accept, or decline the scheduled call via the email invite or dashlet (For
Sugar users) . You can edit the record's in the subpanel by clicking "Edit" on the
far right of the record's row. You can also remove attendee's from the call by
choosing "Unlink" from the dropdown on the far right of the record's row or
clicking the Remove icon ("-") in the Scheduling panel. Once removed from the
Invitees subpanel, the contact, lead, or user will no longer appear in the
Scheduling panel and vice versa. Also, if you select a different contact or lead to
relate the call to in the Related to field, the original contact or lead you selected
will remain as an attendee in the Invitees subpanel and Scheduling panel. Please
note that if you remove the contact or lead as an attendee, then the call will no
longer appear in the Activities subpanel of the record's detail view as the
relationship is removed.
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Editing Calls

Calls may be edited at any time to update or add information to the record. You
can make changes to existing call records via the Calls edit view and quick create
forms. Edit view is available within the Calls module and includes all of the Call
fields you should need.

 

Quick create is available for editing calls from outside the Calls module and opens
as a pop-up without navigating away from your current page. It generally contains
fewer fields, but the Full Form button may be used to access the full edit view
should you need to edit additional fields.

 

Please note that your ability to edit calls in Sugar may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Edit options.

Administrators in Sugar may configure both the Calls edit view and quick create
via Admin > Studio. For more information on configuring layouts, please refer to
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the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit calls via the detail view by clicking the Edit button on the upper left of
the page. Once the edit view layout is open, update the necessary fields and panels
(e.g. Scheduling, Add Invitees, etc.), then click "Save" to preserve the changes
made. To send a new invite to the attendees (if applicable), please click "Save &
Send Invites".

 

Editing Via List View

You can edit calls via the list view by clicking the Pencil icon to the left of each
call's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes. I f additional fields or panels (e.g. Scheduling, Add
Invitees, etc.) need to be updated,click the Full Form button to use edit view
instead.

 

Editing Via Dashlets

You can edit calls by clicking the pencil icon to the far right of any calls-based
dashlet on your Sugar home page. For example, clicking the pencil icon within the
My Calls dashlet will open a pop-up window with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes. If additional fields or panels (e.g. Scheduling, Add
Invitees, etc.) need to be updated, click the Full Form button to use edit view
instead. For more information on dashlets, please refer to the Home
documentation.
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Editing Via Reports

Sugar reports also allow you to edit a call record by clicking on the pencil icon
next to a call's name. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. I f additional fields or panels (e.g.
Scheduling, Add Invitees, etc.) need to be updated,click the Full Form button to
use edit view instead.

Please note that you may only directly edit calls from Rows and Columns-type or
Summation with Details-type reports as Summation-type and Matrix-type reports
do not include the pencil icon. For more information on reports, please refer to the
Reports documentation.

 

Deleting Calls

If a call record is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Calls detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once. Deleting call records will not delete the
related records and will only remove the relationship, so you may wish to also
delete any related records to avoid orphaned records.

Please note that your ability to delete calls in Sugar may be restricted by a role.
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For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a call record via the detail view:

1. Navigate to a call record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more call records via the list view:

1. Navigate to the Calls list view by clicking the Calls module tab.
2. Use the Basicor Advanced Searchto find the Call records you wish to delete.
3. Select the desired call records individually or using the checkbox dropdown's
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of call records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.
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Adding Invitees to Calls

Users have the option of adding additional invitees (i.e. Contacts, Leads, Users) to
calls via the Add Invitees or Create an Invitee option in the Calls edit view. Please
note that the user creating the call as well as the contact or lead selected in the
Related to field will automatically be added as invitees to the call. You can simply
remove yourself or an attendee from the call by choosing "Remove" from either the
Invitees subpanel or the Scheduling panel. For more information on removing
invitees, please refer to the Invitees Subpanels section of this documentation.

Adding Via Add Invitees

Use the following steps to add attendees via the Add Invitees panel:

1. Navigate to a call record's edit view.
2. Scroll to the Add Invitees panel and perform a search to find the attendee you

wish to add.
The search results will appear below the Add Invitees panel.

 
3. To add the invitee, click "Add" to the far right of the record's name.

Please note that the icons to the left of the record's name indicate if it is
a Contact (Rolodex Card icon), Lead (Magnifying Glass icon), or User
(People icon) record.

 

The added invitee(s) will appear in the Scheduling panel in the Calls edit view as
well as the Invitees subpanel in the detail view. For more information on viewing
attendees via the Invitees subpanels, please refer to the Invitees Subpanels section
of this documentation.
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Adding Via Create an Invitee

Use the following steps to add attendees via the Create an Invitee option:

1. Navigate to a call record's edit view.
2. Scroll to the Create an Invitee section and click either the As Contact or As

Lead button.

 
3. Enter in the relevant information (e.g. First Name, Last Name, etc.) for the

contact or lead then click "Create & Add".
Please note that the created contact or lead record will be added and
appear in the corresponding module (Contact or Lead) as well.

 

The contact or lead will appear as an invitee in the Scheduling panel in the Calls
edit view as well as the Invitees subpanel in the detail view. For more information
on viewing attendees via the Invitees subpanels, please refer to the Invitees
Subpanels section of this documentation.
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Closing Calls

Once a call has taken place or is complete, users will change the status of the call
to "Held" on the edit view. Outside of the Calls edit view, Sugar provides users
with alternative options to close calls as "Held" via the Calls list view or detail
view. Please note that the Close option will only appear on the list view or detail
view if the call currently has any status besides "Held".

Closing Via List View

Use the following steps to close a call record via the list view:

1. Navigate to a call record's list view.
2. Use the Basic or Advanced Search to find the Call record(s) you wish to close

.
3. Click the "x" icon to the far left of each call's list view row.

 
4. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Once the call is closed, the "x" icon will no longer appear under the Close column
and the status of the call record will change to "Held".

Please note that open or upcoming calls appear in the Activities subpanel of the
invitees record (e.g. Contacts, Leads), but once a call is marked as held, the call
will instead appear in the History subpanel.

Closing Via Detail View

Use the following steps to close a call record via the detail view:

1. Navigate to a call record's detail view.
2. Select "Close" from the Actions menu.
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Once the call is closed, the status of the call record will change to "Held" and the
Close option will no longer appear in the Actions menu.

Closing and Creating New Call

The Close and Create New option in the Calls edit and detail view allows you to
close the current call record as "Held" and create a new copy of the call. The
displayed edit view is pre-populated with the original call's values except for the
status, which will display "Planned" by default. This option may be useful if you are
logging a call that has already taken place and need to create a new call record for
the same contact, lead, etc. using similar information. Please note that the Close
and Create Newoption will only appear if the call currently has a status that does
not equal "Held".

From Edit View:

 

From Detail View:

 

Exporting Calls

Sugar's Export option allows users to download all fields for the selected calls to
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their computers as a .CSV (comma-separated values) file. This may be useful when
needing to use Call data with other software such as Microsoft Excel or to update
existing records by exporting, making changes, then importing the altered calls
back into Sugar. For more information on updating existing records via import,
please refer to the Import documentation. Due to PHP memory limitations on the
server, there may be occasions when the application times out while exporting a
large number of call records. If you encounter an error when performing this
action, we recommend selecting the records in smaller batches.

Calls may be exported from the Calls list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for calls and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export calls from Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Calls

Mass Updating allows users to make the same change to multiple call records at
once from the Calls list view. Users with administrator or developer level access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of call records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update calls may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see

 514 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Import
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Export
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management


 

the Mass Update option.

Use the following steps to mass update call records from the list view:

1. Navigate to the Calls list view by clicking the Calls module tab.
2. Use the list view's Basicor Advanced Search to identify calls you wish to

modify.
3. Select the desired calls individually or using thecheckbox dropdown's options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected call

records.

Favoriting Calls

Each Sugar user has the option to designate their own favorite calls which are
important or will be viewed often so that they can easily be accessed via search or
from the Calls module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Calls Basicor Advanced Searchto retrieve your favorites
or select from your most recent favorites directly from the Calls module tab .
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Favoriting Via List View

Use the following steps to mark records as favorites via the Calls list view:

1. Navigate to the Calls list view by clicking the Calls module tab.
2. Use the Basicor Advanced Search to find the Call records you wish to mark as

favorites.
3. Mark the star icon on the left of each desired call's row.
4. To remove the call as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Calls detail view:

1. Navigate to a call record's detail view.
2. Click the star icon to the right of the call's name in the upper left of the detail

view to designate it as a favorite.
3. To remove the call as a favorite, click the star again to revert it to white.

 

Last Modified: 09/26/2015 06:25pm

Meetings

Overview

Sugar's Meetings module consists of open, upcoming, or closed meeting records
logged by users in your organization. There are various ways you can create
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meetings in Sugar such as via the Meetings module, Calendar module, importing
meetings, etc. Users can also schedule meetings via the Activities subpanel on
related module records (e.g. Contacts, Accounts, Leads, etc.), which automatically
creates a relationship between both records. Once the meeting record is created,
you can view and edit information pertaining to the meeting via the Meetings
detail view. This documentation will cover how to use the Meetings module as well
as the various actions and options available from within the module.

Meeting Fields

The Meetings module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Assigned To The Sugar user assigned to the meeting
Created By The Sugar user who created the

meeting
Date Created The date the meeting record was

created
Date Modified The date the meeting record was last

modified
Description A description or other information about

the meeting
Display URL The URL to access the meeting hosted

by an external application (e.g. WebEx,
GoToMeeting, etc.)

Note: This is a dependent field, which
will appear when a value other than
"Sugar" is selected as the meeting type.

Duration The duration (e.g. 30 minutes, 1 hour, 1
day, etc.) of the meeting

End Date The end date and time of the meeting
Location The meeting location
Meeting Password The password to access the meeting via

WebEx, GoToMeeting, etc.
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Note: This is a dependent field, which
will appear when a value other than
"Sugar" is selected as the meeting type.

Meeting Type The application (e.g. Sugar, WebEx,
GoToMeeting, etc.) hosting the meeting

Note: External meeting accounts (e.g.
WebEx, GoToMeeting) are added to the
Meeting Type field when users connect
to their account via the External
Accounts tab in their user preferences.
For more information on connecting to
external applications, please refer to the
External Accounts Tab section in the
Getting Started documentation.

Meeting Update Sequence Meeting update sequence for meetings
as per iCalendar standards

Modified By Name The name of the Sugar user who last
modified the meeting record

Outlook ID The Outlook appointment item ID when
the Sugar Plug-in for Microsoft Outlook
syncs an Outlook appointment

Related To The related module record associated to
the meeting

Reminders Set a meeting reminder (Popup and
Email) alert for invitees

Note: Popup notifications appear for all
invitees using Sugar and email
reminders are sent to all invitees.

Start Date The start date and time for the
scheduled meeting

Status The current status (e.g. Planned, Held,
Not Held) of the meeting

Subject The subject of the scheduled meeting
Teams The Sugar team(s) assigned to the

meeting record

Meetings Module Tab

The Meetings module tab is typically located under the More tab on the navigation

 518 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Getting_Started


 

bar at the top of any Sugar screen. Sugar normally displays the top six modules
shown in the Display Modules list of your user preferences, so the remaining
displayed modules are grouped under the More tab. For more information on
displayed modules for the navigation bar, please refer to the Layout Options
section of the Getting Started documentation.Click the tab to access the Meetings
list view. You may also hover on the tab to display the Actions, Recently Viewed,
and Favorites menu. The Actions menu allows you to perform important actions
within the module. The Recently Viewed menu displays the list of meetings you last
viewed in the module. The Favorites menu displays the list of meetings you most
recently marked as favorites in the module.

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Schedule Meeting Opens the edit view layout to create a

new meeting
View Meetings Opens the list view layout to search and

display meetings
Import Meetings Opens the import wizard to create or

update meetings using external data
If you do not see the Meetings module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Sales, Reports, etc.) of which the Meetings module is not a member. Click the
More tab (last tab on navigation bar) then hover on "Filter Menu By" to check
how the navigation bar is grouped. For more information on tab grouping,
please refer to the User Interface documentation.
The Meetings module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Meetings module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section of
the Getting Started documentation.
The administrator may have disabled the Meetings module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Meetings
module displayed. For more information on displaying and hiding modules

 519 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Getting_Started
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Meetings/#Viewing_Via_Recently_Viewed
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Meetings/#Favoriting_Meetings
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Meetings/#Creating_Meetings
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Meetings/#Viewing_Meetings
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Meetings/#Importing_Meetings
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Getting_Started


 

throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Meetings

There are various methods for creating meetings in Sugar including via the
Meetings module, Calendar module, quick create, duplication, and importing
meetings. The full edit view layout opens when creating the meeting directly from
the Meetings menu and includes all of the relevant fields for your organization's
meetings. The quick create form is a shortened version of the meetings edit view
and typically contains fewer fields. When using quick create to make a meeting
while viewing an existing record of another module, Sugar automatically creates a
relationship between both records. For example, if you are viewing a contact
record (e.g. John Smith) and create a new meeting via the quick create form, the
Related to field in the meeting record will automatically populate with "John
Smith", thus creating the relationship. Both the Edit View and Quick Create
layouts can be configured by administrators via Admin > Studio. For more
information on configuring layouts, please refer to the Studio documentation in the
Administration guide.

Creating Via Meetings Module

One of the most common methods of meeting creation is via the Schedule Meeting
option in the Meetings module tab. This opens up the edit view layout which allows
you to enter in all the relevant information for the meeting.
Use the following steps to create a meeting via the Meetings module:

1. Hover on the Meetings module and select "Schedule Meeting".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. To set a reminder for invitees, mark the checkboxes (Popup, Email all

invitees) in the Reminders field then select the time of the alert (e.g. 10
minutes prior) to occur prior to the meeting's start date and time.

Please note that if you set a default reminder in your user preferences,
the Reminders field in the meetings edit view will automatically be
selected along with your default reminder time. For more information on
setting your default reminder, please refer to the User Settingssection of
the Getting Started documentation.
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The outbound mail server must also be configured via Admin > Email
Settings in order for email reminders to be sent out. For more
information on setting up the system email settings, please refer to the 
documentation in the Administration guide.

 
4. To add invitees (i.e. Contacts, Leads, and Users) to the meeting, scroll to the

Add Invitees panel to search and add an attendee.
For more information on adding attendees via the Add Invitees panel,
please refer to the Adding Via Add Invitees section of this
documentation.

 
5. To create and add an invitee, scroll to the Create an Invitee section then click

either the As Contact or As Lead button.
For more information on creating and adding attendees via the Create an
Invitee section, please refer to the Adding Via Create an Inviteesection of
this documentation.

 
6. The list of all invitees will appear in the Scheduling panel.

The duration of the meeting will be indicated by a green line (start time)
and red line (end time).
The Scheduling panel will display any busy times (e.g. Meetings already
scheduled) by blocking it out in blue, and any scheduling conflicts with
other meetings will be blocked out in brown.

 
7. Once all the appropriate information is entered, click "Save" or "Save & Send

Invites".
Save : Saves the meeting record but does not send an email invite to
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invitees.
Save & Send Invites : Saves the meeting record and sends an email
invite to invitees. The invitees will be able to accept, tentatively accept,
or decline the scheduled meeting via the email invite.
Close and Create New : Closes the original meeting record as "Held" and
creates a new copy of the meeting. For more information on closing and
creating new meetings, please refer to the Closing and Creating New
Meeting section of this documentation.

 

Creating Via Calendar

There are two methods of creating meetings in the Calendar module. The first
method is to create a meeting via the Schedule Meeting option in the Calendar
module tab. This will open up the Meetings edit view layout to create a new
meeting record. For more information on creating meetings via the Meetings
module, please refer to the Creating Via Meetings Modulesection of this
documentation. The second method is to create the meeting directly via the user's
Sugar calendar.

Use the following steps to create a meeting via the Calendar module:

1. Click the Calendar module tab.
2. On the calendar view, click the cell corresponding to the date and time you

wish to schedule the meeting.
You can choose to view the calendar by Day, Week, Month, Year, or
Shared. For more information on viewing the shared calendar, please
refer to the Calendar documentation.
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3. Enter appropriate values for the fields on the Details tab of the quick create
form. All required fields are marked with a red asterisk and must be
completed prior to saving.

Please note that the "Start Date" will automatically be populated based
on the date and time cell you select in the calendar.

 
4. If additional fields are desired, click the Full Form button to use the Meetings

edit view instead.
5. To add invitees (i.e. Contacts, Leads, and Users) to the meeting, click the

Invitees tab. For more information on adding invitees to meetings, please
refer to the Adding Invitees to Meetingssection of this documentation.

6. Toschedule the meeting as recurring, click the Recurrence tab, and select the
appropriate interval (e.g. Daily, Weekly, etc.).

When you select an interval, you must specify how often the scheduled
meeting will recur as well as when the last meeting takes place. For
more information on scheduling recurring meetings, please refer to the 
section of the Calendar documentation.

 
7. Once all the appropriate information is entered, click "Save" or "Save & Send

Invites".
Save : Saves the meeting record but does not send an email invite to
invitees.
Save & Send Invites : Saves the meeting record and sends an email
invite to invitees. The invitees will be able to accept, tentatively accept,
or decline the scheduled meeting via the email invite.
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Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a meeting from any Activities
subpanel on related module records.

Use the following steps to create a meeting via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Schedule Meeting" or select "Schedule Meeting" from the Actions menu of
any Activities subpanel on a related module's detail view.
From Quick Create menu:

 
From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. The Related To field is automatically populated with the module and record

you are currently viewing.
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Note : When creating from the Contacts module, the contact will be populated
in the Contacts relationship and the account assigned to the contact will be
populated in the Related To.

4. If additional fields or options (e.g. add invitees) are desired, click the Full
Form button to use edit view instead.

For more information on adding invitees to meetings, please refer to the 
5. Once the necessary information is entered, click "Save".

 

Creating Via Duplication

You can also create a new meeting by duplicating an existing meeting record. The
duplicate option is useful if the meeting you are creating has similar information to
an existing meeting.

Use the following steps to create a meeting by duplicating an existing record:

1. Navigate to a meeting record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original meeting's values.

Update the necessary fields, then click "Save" or "Save & Send Invites".
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Please note that the original invitees will also be included in the
duplicated meeting record. You can remove the invitees from the
Scheduling panel by clicking the Remove icon on the far right of the
invitee names. For more information on adding invitees to meetings,
please refer to the Adding Invitees to Meetingssection of this
documentation.

 

Importing Meetings

The import function allows you to push multiple meeting records into Sugar using
a comma (or other character) delimited file instead of creating them one-by-one.
For more information on importing, please refer to the Import documentation.

Use the following steps to import meetings via the Import Meetings option:

1. Hover on the Meetings module tab and select "Import Meetings".

 
2. In Step 1, select the import file and choose "Create new records only". Click

"Next".
3. In Step 2, confirm the import file properties. Click "Next".
4. In Step 3, confirm the field mappings for the import. Click "Next".
5. In Step 5, view the import results.

The Created Records tab will show all of the new meeting records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Viewing Meetings

There are various options available for viewing meeting records in Sugar including
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via Meetings list view, Meetings detail view, Meetings Recently Viewed menu,
Calendar module, dashlets, and reports. Please note that you will only be able to
see meeting records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Viewing Via List View

The Meetings list view displays all meeting records meeting the current search
criteria. To access the list view, simply click the Meetings module tab. While list
view shows key meeting fields, you can click the meeting's name to open the
record in detail view. For more information on viewing meetings via list view,
please refer to the Meetings List Viewsection of this documentation.

Viewing Via Detail View

The Meetings detail view displays thorough meeting information including all
meeting fields followed by subpanels of the meeting's related records belonging to
various modules. The detail view can be reached by clicking a meeting record's
link from anywhere in the application including from the Meetings list view. For
more information on viewing meetings via detail view, please refer to the 
Meetings Detail View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which meetings you have recently viewed.
Hover on the Meetings module tab to see a list of your most recently viewed
meetings and click each name to open the meeting in detail view.

 

Viewing Via Calendar

The Calendar module allows users to schedule, view, and manage various activities
(Calls, Meetings, Tasks) in Sugar. Meeting records are displayed in blue on the
calendar and you can click the corresponding cell to view the meeting details via
the Quick Create form. You can also click the "i" icon to the far right of the
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meeting record cell for a quick view of additional details (e.g. Subject, Start Date
& Time, Duration, Related to, etc.) of the meeting without opening up the record.
For more information on viewing and managing meetings on the calendar, please
refer to the Calendar documentation. Users also have the ability to view other
users scheduled activities via the shared calendar option. For more information on
viewing the shared calendar, please refer to the Calendardocumentation.

Please note that you will only be able to see meeting records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration guide.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view meeting
information in meeting-based dashlets such as "My Meetings" as well as in
dashlets based on other modules such as "My Notes". Clicking a meeting's name
from any dashlet will open the meeting in detail view. For more information on
using dashlets and viewing meeting records via dashlets, please refer to the 
Modules section of the Home documentation. You can also accept, tentatively
accept, or decline the meeting in the My Meetings dashlet, as well as close the
meeting as held by clicking the "x" icon to the far left of each list view row. For
more information on closing meetings as held, please refer to the Closing
Meetings section of this documentation.

Please note that when viewing the Meetings dashlet, the start date will be shown
in one of three colors: black, orange, or red. Start dates change color on the
meetings list view to allow the user to quickly see which scheduled meetings are
past their due date/time, regardless of the current status.

The date colors in the Meetings dashlet are as follows:
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Black : The start date has not passed yet.
Orange : The start date and time is within 2 hours of the current time.
Red : The start date is expired.

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding meetings and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the meeting record's detail view by clicking the meeting's
name in the report results. Please note that you can only directly access meeting
detail views with Rows and Columns-type and Summation with Details-type reports
as Summation-type and Matrix-type reports do not include hyperlinks in their
display columns. For more information on using reports, please refer to the 
Reports documentation.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Managementdocumentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Meetings
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The Meetings list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Meetings list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %review). This will pull
up any record that has the word "review" in the name, regardless of how it starts
or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.
Open Items : Select this box to return only records with an open status (e.g.
Planned).

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a meeting subject, Sugar will only return meeting
records with a matching subject that are assigned to you. Once the search is
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complete, the relevant results will populate in the list view below the search panel.
To see all meeting records to which you have access, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see meeting records as allowed by your team membership, user access
type, and assigned roles. For more information on teams and roles, please refer to
the Team Management and Role Managementdocumentation in the Administration
guide.

Administrators can configure what fields appear on the Meetings Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.
My Items : Select this box to return only records assigned to you.
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When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a meeting subject to search, Sugar will only return meeting
records with a matching subject that you have marked as favorites. When
searching by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar
will return records matching any of these selections. Once the search completes,
the relevant results will populate in the list view below the search panel. To see all
meeting records to which you have access, simply click "Clear" and then "Search"
to perform a blank search with no filters. Please note that you will only be able to
see meeting records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Administrators can configure what fields appear on the Meetings Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
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Search section of the System documentation in the Administration guide.

Meetings List View

The Meetings list view displays all meeting records meeting the current search
criteria and to which your user has access. You can view the basic details of each
meeting within the field columns. Please note that you will only be able to see
meeting records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

When viewing the Meetings list view, the start date will be shown in one of three
colors: black, orange, or red. Start dates change color on the meetings list view to
allow the user to quickly see which scheduled meetings are past their due
date/time, regardless of the current status.

The date colors in the Meetings list view are as follows:

Black : The start date has not passed yet.
Orange : The start date and time is within 2 hours of the current time.
Red : The start date is expired.

 

You have the option to change what fields are displayed in list view by configuring
your layout options in the Meetings Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
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currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on meeting records directly from the list view by
first selecting the desired records. To select individual meeting records on the
Meetings list view, mark the checkbox on the left of each row. To select or deselect
multiple meeting records on the list view, use the options in the checkbox
dropdown menu:

Select This Page : Selects all records shown on the current page of meeting
results.
Select All : Selects all records in the current search results across all pages of
meeting results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more meetings at a time
Mass Update Mass update one or more meetings at a

time
Export Export one or more meetings to a CSV

file

Favorite Designation

Users have the option to mark meeting records as favorites via the list view as well
as the detail view. This allows users to designate records that are important or will
be viewed often so that they can easily be accessed via search or from the
Meetings module tab. In the Meetings list view, the star on the left of each
meeting's row is yellow once marked to indicate a favorite meeting. For more
information on how to mark records as favorites, please refer to the Favoriting
Meetings section of this documentation.

 

More Information

Additional details for each meeting can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional meeting
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Subject, Start Date & Time, Duration, Related to,
Status, and Description fields by default. The list of fields appearing here may only
be configured through a code-level customization.
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Closing Meetings

Users have the option to close meetings as held via the list view once it has taken
place by clicking the "x" icon to the far left of each list view row. Once the meeting
is closed, the "x" icon will no longer appear under the Close column of the list view
and the status of the meeting will change to "Held". For more information on
closing meetings to mark as "Held", please refer to the Closing Meetingssection of
this documentation.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Meetings Detail View

The Meetings detail view displays thorough meeting information including all
meeting fields which are grouped by default into the Overview and Other panels.
You can also view the invitees (i.e. Contacts, Leads, Users) for the meeting which
appear in subpanels beneath the meeting fields. The detail view can be reached by
clicking a meeting record's link from anywhere in the application including from
the Meetings list view.

Please note that you will only be able to view a meeting record according to your
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team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each meeting's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this meeting
Duplicate Duplicate this meeting
Delete Delete this meeting
Close and Create New Close this meeting as "Held" and create

a new copy of the meeting

Note: The Close and Create New button
appears as long as the status does not
equal "Held".

Close Close this meeting as "Held"

Note: The Close button appears as long
as the status does not equal "Held".

Favorite Designation
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Users have the option to mark meeting records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often so that they can easily be accessed via search or from the
Meetings module tab. In the Meetings detail view, the star on the right of the
meeting's name is yellow once marked to indicate a favorite meeting. For more
information on how to mark records as favorites, please refer to the Favoriting
Meetings section of this documentation.

 

Next or Previous Record

On the upper right of the Meetings detail view, there are two buttons that allow
you to page through each meeting in the Meetings list view's current search
results. Clicking the Previous button displays the previous meeting of the current
search results while clicking the Next button displays the next meeting of the
current search results. The text in between shows which meeting result you are
currently viewing within the total number of current results.

 

Subpanels

Beneath a meeting record's fields are subpanels containing invitees to the meeting
as well as related records from the Notes module.

Related Record Subpanels

Modules in Sugar display subpanels, which allow users to view related records
from other modules. Users can view the details of the related record as well as
relate new or existing records via the subpanel. Administrators can easily modify
the fields (e.g. Name, Assigned User, etc.) displayed on subpanels as well as the
label of each subpanel through Admin > Studio so that users have visibility to the
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most important fields for their organization. For more information on working with
related record subpanels, please refer to the Subpanels section of the User
Interface documentation.

For the Meetings module, you can relate a new note record by clicking "Create
Note or Attachment" from the Notes subpanel. Complete the Quick Create form
then click "Save" and the note record will appear in the Notes subpanel.
Ifadditional fields are desired, click the Full Form button to use the Notes edit view
instead. You can edit the note, as well as view the note's detail view by clicking the
Pencil/Note icon to the left of the subject. To delete the meeting's relationship to
the note, choose "Unlink" from the dropdown on the far right of the record's row.
Please note that this removes the relationship, but does not delete the record
itself. The subpanel can also be collapsed or expanded by clicking the double
arrow to the left of the subpanel's name.

 

Invitees Subpanels

The Contacts, Users, and Leads subpanels in the Meetings detail view display all
invitees for the meeting. Normally the contact or lead record you select in the
Related to field on the Meetings edit view will appear in one of these subpanels
(i.e. Contacts or Leads). Additional attendees (i.e. Contacts, Leads, Users) can be
added to the meeting via the Add Invitees or Create an Invitee option in the
Meetings edit view. For more information on adding invitees, please refer to the 
Adding Invitees to Meetingssection of this documentation. Once added, all the
invitees will appear in their respective subpanels in the Meetings detail view as
well as the Scheduling panel in the edit view.

The Accept Status field on the subpanel will be updated once the invitee's accept,
tentatively accept, or decline the scheduled meeting via the email invite or 
dashlet (For Sugar users). You can edit the record's in the subpanel by clicking
"Edit" on the far right of the record's row. You can also remove attendee's from the
meeting by choosing"Unlink" from the dropdown on the far right of the record's
row or clicking the Remove icon ("-") in the Scheduling panel. Once removed from
the Invitees subpanel, the contact, lead, or user will no longer appear in the
Scheduling panel and vice versa. Also, if you select a different contact or lead to
relate the meeting to in the Related to field, the original contact or lead you
selected will remain as an attendee in the Invitees subpanel and Scheduling panel.
Please note that if you remove the contact or lead as an attendee, then the meeting
record will no longer appear in the Activities subpanel of the record's detail view
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as the relationship is removed.

 

Editing Meetings

Meetings may be edited at any time to update or add information to the record.
You can make changes to existing meeting records via the Meetings edit view and
quick create forms. Edit view is available within the Meetings module and includes
all of the Meeting fields you should need.

 

Quick create is available for editing meetings from outside the Meetings module
and opens as a pop-up without navigating away from your current page. It
generally contains fewer fields, but the Full Form button may be used to access the
full edit view should you need to edit additional fields.
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Please note that your ability to edit meetings in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure both the Meetings edit view and quick
create via Admin > Studio. For more information on configuring layouts, please
refer to the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit meetings via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fieldsand
panels (e.g. Scheduling, Add Invitees, etc.), then click "Save" to preserve the
changes made. To send a new invite to the attendees (if applicable), please click
"Save & Send Invites".

 

 541 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Meetings/#Meetings_Detail_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Meetings/#Meeting_Fields


 

Editing Via List View

You can edit meetings via the list view by clicking the Pencil icon to the left of each
meeting's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes. If additional fields or panels (e.g. Scheduling, Add
Invitees, etc.) need to be updated, click the Full Form button to use edit view
instead.

 

Editing Via Dashlets

You can edit meetings by clicking the pencil icon to the far right of any
meetings-based dashlet on your Sugar home page. For example, clicking the pencil
icon within the My Meetings dashlet will open a pop-up window with the quick
create form which is a shortened version of the edit view layout. Update the
necessary fields, then click "Save" to preserve the changes. If additional fields or
panels (e.g. Scheduling, Add Invitees, etc.) need to be updated, click the Full Form
button to use edit view instead. For more information on dashlets, please refer to
the Homedocumentation.

 

Editing Via Reports

Sugar reports also allow you to edit a meeting record by clicking on the pencil icon
next to a meeting's name. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. If additional fields or panels (e.g.
Scheduling, Add Invitees, etc.) need to be updated, click the Full Form button to
use edit view instead.
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Please note that you may only directly edit meetings from Rows and Columns-type
or Summation with Details-type reports as Summation-type and Matrix-type
reports do not include the pencil icon. For more information on reports, please
refer to the Reportsdocumentation.

 

Deleting Meetings

If a meeting record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Meetings detail view or list view.
Deleting via the detail view allows you to delete a single record while the list view
allows for mass deleting multiple records at once. Deleting meeting records will
not delete the related records and will only remove the relationship, so you may
wish to also delete any related records to avoid orphaned records.

Please note that your ability to delete meetings in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a meeting record via the detail view:

1. Navigate to a meeting record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.
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Mass Deleting Via List View

Use the following steps to delete one or more meeting records via the list view:

1. Navigate to the Meetings list view by clicking the Meetings module tab.
2. Use the Basicor Advanced Searchto find the Meeting records you wish to

delete.
3. Select the desired meeting records individually or using the checkbox

dropdown'soptions.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of meeting records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Adding Invitees to Meetings

Users have the option of adding additional invitees (i.e. Contacts, Leads, Users) to
meetings via the Add Invitees or Create an Invitee option in the Meetings edit
view. Please note that the user creating the meeting as well as the contact or lead
selected in the Related to field will automatically be added as invitees to the
meeting. You can simply remove yourself or an attendee from the meeting by
choosing "Unlink" f rom the Invitees subpanel or clicking the Remove icon ("-") in
the Scheduling panel. For more information on removing invitees, please refer to
the Invitees Subpanelssection of this documentation.

Adding Via Add Invitees

Use the following steps to add attendees via the Add Invitees panel:

1. Navigate to a meeting record's edit view.
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2. Scroll to the Add Invitees panel and perform a search to find the attendee you
wish to add.

The search results will appear below the Add Invitees panel.

 
3. To add the invitee, click "Add" to the far right of the record's name.

Please note that the icons to the left of the record's name indicate if it is
a Contact (Rolodex Card icon), Lead (Magnifying Glass icon), or User
(People icon) record.

 

The added invitee(s) will appear in the Scheduling panel in the Meetings edit view
as well as the Invitees subpanel in the detail view. For more information on
viewing attendees via the Invitees subpanels, please refer to the Invitees
Subpanels section of this documentation.

 

Adding Via Create an Invitee

Use the following steps to add attendees via the Create an Invitee option:

1. Navigate to a meeting record's edit view.
2. Scroll to the Create an Invitee section and click either the As Contact or As

Lead button.

 
3. Enter in the relevant information (e.g. First Name, Last Name, etc.) for the

Contact or Lead then click "Create & Add".
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Please note that the created contact or lead record will be added and
appear in the corresponding module (Contact or Lead) as well.

 

The contact or lead will appear as an invitee in the Scheduling panel in the
Meetings edit view as well as the Invitees subpanel in the detail view. For more
information on viewing attendees via the Invitees subpanels, please refer to the 
Invitees Subpanels section of this documentation.

 

Closing Meetings

Once a meeting has taken place or is complete, users will change the status of the
meeting to "Held" on the edit view. Outside of the Meetings edit view, Sugar
provides users with alternative options to close meetings as "Held" via the list view
or detail view. Please note that the Close option will only appear on the list view or
detail view if the meeting currently has a status that does not equal "Held".

Closing Via List View

Use the following steps to close a meeting record via the list view:

1. Navigate to a meeting record's list view.
2. Use the Basic or Advanced Searchto find the Meeting record(s) you wish to

close.
3. Click the "x" icon to the far left of each meeting's list view row.
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4. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Once the meeting is closed, the "x" icon will no longer appear under the Close
column and the status of the meeting record will change to "Held".

Please note that open or upcoming meetings appear in the Activities subpanel of
the invitees record (e.g. Contacts, Leads), but once a meeting is marked as held,
the meeting will instead appear in the History subpanel.

Closing Via Detail View

Use the following steps to close a meeting record via the detail view:

1. Navigate to a meeting record's detail view.
2. Select "Close" from the Actions menu.

 

Once the meeting is closed, the status of the meeting record will change to "Held"
and the Close option will no longer appear in the Actions menu.

Closing and Creating New Meeting

The Close and Create New option in the Meetings edit and detail view allows you
to close the current meeting record as "Held" and create a new copy of the
meeting. The displayed edit view is pre-populated with the original meeting's
values except for the status, which will display "Planned" by default. This option
may be useful if you are logging a meeting that has already taken place and need
to create a new meeting record for the same contact, lead, etc. using similar
information. Please note that the Close and Create New option will only appear if
the meeting currently has a status that does not equal "Held".
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From Edit View:

 

From Detail View:

 

Exporting Meetings

Sugar's Export option allows users to download all fields for the selected meetings
to their computers as a .CSV (comma-separated values) file. This may be useful
when needing to use Meeting data with other software such as Microsoft Excel or
to update existing records by exporting, making changes, then importing the
altered meetings back into Sugar. For more information on updating existing
records via import, please refer to the Import documentation. Due to PHP memory
limitations on the server, there may be occasions when the application times out
while exporting a large number of meeting records. If you encounter an error
when performing this action, we recommend selecting the records in smaller
batches.

Meetings may be exported from the Meetings list view by selecting "Export" from
the Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for meetings and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export meetings from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
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documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Meetings

Mass Updating allows users to make the same change to multiple meeting records
at once from the Meetings list view. Users with administrator or developer level
access can control which fields are available to change during mass update via
Admin > Studio. Currently, only fields with the data type of date, datetime,
dropdown, multiselect, and radio may be altered during a mass update. For more
information on configuring mass update, please refer to the Studio documentation
in the Administration guide. Due to the PHP memory limitations on the server,
there may be occasions when the application times out while mass updating a
large number of meeting records. If you encounter an error when performing this
action, we recommend selecting the records in smaller batches.

Please note that your ability to mass update meetings may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update meeting records from the list view:

1. Navigate to the Meetings list view by clicking the Meetings module tab.
2. Use the list view's Basic or Advanced Search to identify meetings you wish to

modify.
3. Select the desired meetings individually or using thecheckbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.
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6. Click "Update" to save the changes to all of the currently selected meeting

records.

Favoriting Meetings

Each Sugar user has the option to designate their own favorite meetings which are
important or will be viewed often so that they can easily be accessed via search or
from the Meetings module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Meetings Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Meetings
module tab.

Favoriting Via List View

Use the following steps to mark records as favorites via the Meetings list view:

1. Navigate to the Meetings list view by clicking the Meetings module tab.
2. Use the Basic or Advanced Search to find the Meeting records you wish to

mark as favorites.
3. Mark the star icon on the left of each desired meeting's row.
4. To remove the meeting as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Meetings detail view:
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1. Navigate to a meeting record's detail view.
2. Click the star icon to the right of the meeting's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the meeting as a favorite, click the star again to revert it to white.

 

Last Modified: 09/26/2015 06:25pm

Emails

Overview

Sugar's Emails module allows users to receive and send email through the
application using their personal email address or a group inbox. Users have the
ability to view email through Sugar and also the ability to store email in Sugar.
Email stored in Sugar may then relate to other Sugar records such as contacts,
cases, accounts, and many others. This documentation will cover how to use the
Emails module as well as the various actions and options available from within the
module.

Email Fields

The Emails module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs.

Field Description
Assigned To The Sugar user assigned to the email
Teams The Sugar team(s) assigned to the email

record
Date Sent The date the email was sent
From The email address the email was sent

from
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To The email address(es) the email was
sent to

Cc The email address(es) the email was
copied to

Bcc The email address(es) the email was
blind copied to

Subject The subject of the email
Body The content of the email
Attachments Any attachments included with the

email
Related To The module and record that is related to

this email
Note : This will decide which module
this email will show in the History
subpanel

Emails Module Tab

The Emails module tab is typically located under the More tab on the navigation
bar at the top of any Sugar screen. Depending on your settings, you may have to
click "Show More" in order to see the Emails module tab. Click the tab to access
the Emails list view. You may also hover on the tab to display the Actions and
Recently Viewed menus. The Actions menu allows you to perform important
actions within the module. The Recently Viewed menu displays the list of emails
you last viewed in the module.

 
The Actions menu allows you to perform the following operations:

Menu Item Description
View My Email Opens the list view layout to search and

display emails
Create Email Template Opens the edit view layout to create a

new email template
View Email Templates Opens the list view layout to search and
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display email templates
If you do not see the Emails module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (i.e.
Activities, Reports, etc.) of which the Emails module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Emails module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Emails module in the Hide Modules list, simply
move it to the Display Modules list and save. For more information on hiding
and displaying modules, please refer to the Layout Options section of the
Getting Started documentation.
The administrator may have disabled the Emails module for your entire Sugar
instance. Reach out to your Sugar administrator to have the Emails module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Prerequisites

There are several key components that need to be configured to enable sending
and viewing personal email in Sugar. Some prerequisites need to be configured by
a Sugar administrator and some need to be configured by the end users
themselves. Please ensure the following is configured before utilizing the emails
module:

Personal Email Settings : To view and import personal email into Sugar, each
user must configure the settings in the Emails module with their personal
email account information. For more information on how to configure your
personal email settings, please refer to the Configuring Mail Accounts section
in this document.
Outbound Email Settings : To send email through Sugar, users need to have
an outgoing email account configured. Administrators have the option to
allow the system outgoing email account to send email for the users. For
more information on configuring an outbound email account, please refer to
the Configuring Outgoing Mail Servers section in this document.
Group Email Settings : Sugar adminsitrators need to configure any group
handling email accounts before users can access them. For more information
on setting up a group email account in Sugar, please refer to the Email

 553 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Getting_Started
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails/#Configuring_Mail_Accounts
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails/#Configuring_Outgoing_Mail_Servers
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Email


 

documentation in the administration guide.
Inbound Email Scheduler : The inbound email scheduler needs to be
configured and running in order to pull Group email accounts into Sugar. For
more information on setting up and configuring the inbound email scheduler,
please refer to the Schedulers documentation in the administration guide.

Settings

Settings in the Emails module enable you to manage how you view and compose
emails. Some settings are pre-configured with default values and some settings are
optional. You can customize these settings to suit your requirements. The Settings
window displays tabs for General settings and for Mail Account settings. To access
the Emails module settings, simply click the Settings button towards the top of the
page.

 
Note : Many settings require you to reload the Emails module page before the
settings take effect.

General Settings

The General Settings tab displays options to specify the character set, signature,
automatic or manual checks for incoming emails, etc. Some of these settings have
default values which you can modify. General Settings apply to all your personal
mail accounts in Sugar and will not apply to group email accounts.
The options in the General tab have the following functions:

Check for New Mail : Select a time interval from the dropdown list to check
your mail accounts for new email (Manually, Every 5 minutes, Every 15
minutes, etc.). The default setting is to check email manually.
Send Plain Text Emails Only : Check this box to send emails in plain text
format instead of the default HTML format.
Character Set : Specify the default character set for outbound emails from
this dropdown list. The default setting is UTF-8.
Signatures : Select an existing Signature from the dropdown or select
"Create" to create a new signature. The signature selected will appear by
default on all outgoing email. Before sending you do have the option to
change or remove the signature from the email.
Signatures Above Reply : Check this box to place your signature above the
content of the email to which you are replying to. Alternatively, the signature
will appear below the content of the email to which you are replying to.
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Emails Per Page : Select the count of emails to display per page from the
dropdown (10,20,50). The default setting is 20.
Available User Folders : Select the options you wish to display in the Folders
panel on the left side of the Emails module. Folders with a period preceding
the name are subfolders. For example : ".My Drafts", ."Sent Emails", and ".My
Archived Emails" are subfolders of "My Email". When selecting a subfolder
the parent folder will automatically be selected as well.

 

Mail Accounts

The Mail Accounts tab allows users to manage their mail accounts and outbound
mail servers.

Configuring Mail Accounts

Sugar allows users to link one or more personal mail accounts to view within
Sugar. Email from these external accounts can then be imported into Sugar and
linked to existing records throughout the application. Group mail accounts work
the same, but allow multiple users access to the incoming email. For more
information on how to add a group mail account, please refer to the Email
documentation in the administration guide.
Use the following steps to add a new personal mail account to the emails module:
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1. Navigate to the Mail Accounts tab on the Settings screen.
2. Click "Add" under the Mail Accounts section.

 
3. Select "Prefill Gmail Defaults" to automatically populate the following fields

with Gmail default values in the Incoming Email section or enter appropriate
values for your mail provider:

 
Mail Account Name : The name or designation of the account.
User Name : The user name for your external account.
Password : The password for your external account.
Mail Server Address : The web address of the external email server from
which emails will be viewed in Sugar.
Note : If you are unfamiliar with these terms and values, please check
with your IT department or email provider for the appropriate values for
these fields.
Mail Server Protocol : The mail protocol used to communicate with the
mail server. IMAP is the default selection and provides the best
functionality with Sugar.
Use SSL : Check this box to force the connection and communication
between Sugar and the mail server to use a secure socket layer of
encryption.
Mail Server Port : The communication port number used for connecting
to the mail server.
Monitored Folders : The folders in your external account that Sugar will
monitor. Inbox is selected by default. To select one or more folders to
monitor click "Select" and then pick the folders in your external account
for Sugar to monitor.
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Trash Folder : Select a folder from your external account to be
designated as the trash folder. Sugar will place deleted emails into this
folder on your external account.
Sent Folder : Select a folder from your external account to store any
email being sent from that account through Sugar.

Select "Test Settings" to verify the Incoming Email settings. A window will
popup indicating if the test was successful or not.

 
4. Enter appropriate values in the following fields in the Outgoing Email section:

From Name : The name outgoing email will come from. Defaults to your
first and last name from your user profile.
From Address : The email address outgoing email will come from.
Defaults to the email address from your user profile.
Reply to Address : The email address that will receive any replys from
your email. If left blank, replies will be sent to the From Address.
Outgoing SMTP Mail Server : Select an existing SMTP server from the
dropdown list or select Add to specify a new SMTP server. For more
information on adding an outgoing SMTP mail server, please refer to the 

5. All required fields are marked with a red asterisk and must be completed
prior to saving.

6. Once the necessary information is entered, click "Done" to preserve the
changes.

 

In the mail accounts section you will see any personal and group accounts you
have configured.

 
The buttons and checkboxes in the grid will perform the following actions on the
mail account:
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Active : Select this checkbox to either show or hide a mail account in your
view of the Emails module. When you deactivate a mail account, the account
is not listed on the Folders tab and emails from that account will not display
in the Sugar inbox.
Default : When you have multiple personal email accounts configured, one
must be set as the default. When sending email, the "From Name" and "From
Address" entered on the default mail account will be automatically selected.
Type : Displays whether this email account is a group or personal email
account.
Edit : Click the Pencil icon to open the personal account in a popup window to
view or edit the details.
Note : Only administrators can modify group accounts. For more information
on how to add or modify a group account, please refer to the Email
documentation in the administration guide.
Delete : Click the Minus icon to remove the personal account from Sugar.

Configuring Outgoing Mail Servers

Outgoing mail servers are what allow users to send email through Sugar. Sugar
allows users to configure multiple outgoing mail servers to send email from. Users
have the ability to use the system's outgoing mail server with their own user name
and password. If Sugar is not configured with a system outbound account, users
may create a personal inbound account to pair with their personal outbound
account in order to send emails.
Administrators also have the ability to allow users to use the system user name and
password configured in Admin > Email Settings. For more information on how to
configure the system outgoing mail server, please refer to the Email
documentation in the administration guide.
If the Sugar administrator has disabled the ability to use the system account for
outgoing email, then users will need to enter their user name and password for the
mail server in their user profile. For more information on how to enter credentials
for the system mail server through the user profile, please refer to the Getting
Started documentation.
Use the following steps to add a new outgoing mail account from the Emails
module:

1. Navigate to the Mail Accounts tab on the Settings screen.
2. Click "Add" under the Outgoing SMTP Mail Servers section.
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3. Enter appropriate values in the following fields in the Incoming Email section:
Name : The name or designation of the outgoing mail server.
Choose Your Email Provider : Choose your mail provider to populate
provider specific values.
SMTP Server : The web address of the external email server Sugar will
connect to.
SMTP Port : The communication port number used for connecting to the
mail server.
Use SMTP Authentication? : Check this box to connect to the SMTP
server using a user name and password. If left unchecked, the SMTP
server must accept anonymous connections, which is not recommended.
Enable SMTP over SSL or TLS? : Select the appropriate option from the
dropdown to use Secure Socket Layer, Transport Layer Security, or no
encryption when connecting to the mail server.
Email Address / Username : Enter the email address or user name to
connect to the SMTP server with.
Note : The user name used to connect to the SMTP server can be
different than the From Address being specified, but the email server
needs to be configured properly to allow that account to send email as
that email address.
Password : Enter the password associated with the entered email
address or user name.

4. All required fields are marked with a red asterisk and must be completed
prior to saving.

5. Optionally click "Send Test Email" to test the settings entered by sending an
email.

6. Once the necessary information is entered, click "Done".

 

In the Outgoing SMTP Mail Servers section you will see any mail servers you have
configured.
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The buttons in the grid will perform the following actions on the mail server
settings:

Edit : Click the Pencil icon to open the settings in a popup window to view or
edit the details.
Note : If the ability to use the system account is enabled, the pencil icon will
not be available here on the system mail server settings. Alternatively, if the
system account is disabled for users, then editing the information here will
change the information in your user profile.
Delete : Click the Minus icon to remove the mail server from Sugar.
Note : The system outgoing mail settings cannot be removed.

For more information on configuring the system outgoing mail server settings and
allowing users to use the system account, please refer to the Email documentation
in the administration guide.

Checking Emails

Sugar provides a couple of different ways to check email accounts within the
application. Group email boxes are automatically checked and imported via
schedulers. For more information regarding settings up schedulers, please refer to
the Schedulers documentation in the administration guide.
Personal mail accounts can be configured to be checked manually. Use one of the
following options to check a personal mail account manually:

Click the Check Mail button at the top of the Emails module page.

 
This will check for new email in each personal account you have configured.
Right click on the specific personal account you wish to check email for, and
select "Check Email"
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This will pull new email for only the selected mail account.
Note : Check mail will only pull in new email. If you delete and view email for
a personal email account in a mail viewer other than Sugar (Outlook, GMail,
etc.) the changes will not always be reflected in Sugar. To get Sugar to see
these changes, right click on the mail account and select "Synchronize".

The monitored folders in each personal mail account show under the associated
account in the folder view. The number of unread messages in each folder is shown
in parentheses next to the monitored folder's name.

 
Select the folder name to pull the list of emails in that folder into the email view.

Composing Emails

Sugar allows users to compose email from a variety of locations through the
application. When you compose an email, if you have configured multiple mail
accounts, you can choose the account from which to send the email. This can
change the From Name, From address, and Reply To for the email being sent to
what is configured on the account you selected. For more information how to add
and configure accounts, please refer to the Mail Accounts section in this
documentation.

Emails composed in Sugar can contain plain text or rich text formatting utilizing
the TinyMCE text editor. For more information on how to use TinyMCE, please
refer to the TinyMCE section in the User Interface document in the Application
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guide.

Composing Via Emails Module

One of the most common methods of composing email is via the Compose button in
the Emails module. This opens up the compose layout which allows you to enter in
all the relevant information for the email.
Use the following steps to create a compose an email via the Emails module:

1. Click "Compose"

 
2. Enter appropriate values for the fields in the layout. All required fields are

marked with a red asterisk and must be completed prior to saving.
3. The From is automatically populated with the name and email address for the

default mail account. Select the appropriate combination from the dropdown.

 
4. Once the necessary information is entered, click "Send".

 

Composing Via Quick Compose

The Quick Compose allows you to easily compose email from anywhere in Sugar.
Simply click any email address in any module's list view, detail view, or elsewhere
to launch the quick compose. You can also quick compose an email from any
Activities subpanel on related module records.

Use the following steps to compose an email via Quick Compose:
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1. Click on an email address on any Sugar page or select "Compose Email" on
any Activities subpanel on a related module's detail view.
From email address :

 
From subpanel :

 
2. Enter appropriate values for the fields in the layout. All required fields are

marked with a red asterisk and must be completed prior to saving.
3. The To address is automatically populated with the email address you clicked

on, or the email address for the record you were viewing. The email is also
automatically related to the record the email address came from.

 
4. Once the necessary information is entered, click "Send".

 

Composing Via Module's List View

For modules which include an Email field, the Email option allows users to
compose an email message and send it to one or more records at a time from the
module's list view. Simply select the desired record(s) from the list view then
choose "Email" from the list view Actions menu. The Compose Email window will
open allowing you to enter in all relevant information (e.g. subject, body, etc.).
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Please note that the email will be sent to the selected record's primary email
address on file.

The following steps cover composing and sending an email from the Accounts list
view as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the Basic or Advanced Search to find the account records you wish to

include on the email.
3. Select the desired accounts then choose "Email" from the Actions menu.

 
4. In the Quick Compose window, enter in the subject and body of the email

message, then click "Send".
Note: The email's To field will automatically populate with the name and
email address of the selected account record(s).

Once the email is sent successfully, the email record will appear in the History
subpanel of each account record.

 

Adding Recipients

Sugar, just like many other email clients, allows multiple recipients for a single
email. Recipients can be placed in the To, Cc, and Bcc sections. To enable the Cc
and Bcc sections simply click "Add Cc" or "Add Bcc".
When composing an email, you can select email recipients from the address book,
which lists existing users, contacts, leads, targets, and accounts. By default, all of
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these individuals are listed in the address book; however, you can filter the list if
you want to view a specific group such as contacts or users. You can also search
for an individual by first name, last name, email address, or account name.
Use the following steps to add recipients via the address book while composing an
email:

1. Click "To", "Cc", or "Bcc" to open the Address Book.

 
2. The Address Book opens defaulting to showing all. Enter a First Name, Last

Name, or Email address to search. You can also narrow the results down by
selecting a Recipient Type from the dropdown.

 
Click the magnifying glass to perform the search and click the "X" to clear the
search.

3. The search results show in the grid below. The grid shows 25 records at a
time and is paginated.
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Click the number of the page you wish to view or the single arrows left and
right to go back a page and forward a page respectively. You can also select
the far right arrow to navigate to the last page or the far left arrow to
navigate to the first page of results.

4. Click on a record in the grid to add the record as a recipient in the To field.

Select the checkbox next to one or more records and then click "Add To To",
"Add To Cc", or "Add To Bcc" to add the selected records to the
corresponding recipient field.

  
5. The records in the grid on the left that have been added as recipients will be

highlighted in blue. To remove a recipient, simply click the record in the grid
on the left and it will be removed from the Selected recipients grid on the
right.

 
6. Once the necessary recipients have been selected, click "Done".

 566 / 1.013



 

 
7. Alternatively, you can add recipients by hand by typing in the email address

in the recipient fields separated by a semi-colon.

Note : If the email you are composing is related to a record, there is an option in
the address book to only show recipients related to the record selected.

Adding Attachments

Sugar allows you to send attachments along with your email. Attachments can be
files from your local computer or documents from within Sugar.
Use to following steps to add attachments to an email while composing:

1. Click "Attach" from the Compose screen.

 
2. This opens the Attach pane on the right side of the window.
3. To add files from your local computer, select "Add Files".
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4. In the popup window, select "Choose File" and then navigate your local

computer to select the file you wish to attach.

 
Click "Attach".

5. Click the Minus icon next to the file name to remove a file from the email.

 
6. To add documents from within Sugar, select "Add Documents"

 
7. Click the Arrow icon to launch the search page on the Documents module.

 
Note : Documents that link to an external account (i.e. Google Docs, IBM
SmartCloud, etc.) cannot be used as attachments in emails composed through
the Sugar Email client.

8. Locate the document you wish to attach by searching and then selecting the
document.

9. Click the "X" next to the document to remove it from the email.
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Setting Email Options

Sugar comes with some specific options that are available to you while composing
email. To access these options while composing an email, simply click "Options"
towards the top of the page.

 
This opens the Options pane on the right side of the page.

Using a Template

Email templates allow users to create an email based off of a predetermined
template. This can reduce typing errors and save time by having common emails
prepared into a template. For more information on how to create or modify an
email template, please refer to the Email Templates section in this documentation.
Use the following steps to utilize a template while composing an email.

1. From the Options pane, select a template to use.

 
2. Anything currently written in the body or subject of the email you are

currently composing will be removed and replaced with the template data.
3. If the selected template has any variable fields defined in it (i.e.

$contact_name) then when Sugar sends the email it will replace these
variable placeholders with values from the associated record. If no associated
record is found, the variable placeholders will be replaced with an empty
string.
Note : If multiple records share the same email address or multiple recipients
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are on the email, Sugar will pick one of the record's values to place in the
email template to send to all of the email addresses. This can provide
undesired results. For more information on how to send a dynamic variable to
many recipients, please refer to the Campaigns documentation in the
Application guide.

Using a Signature

Sugar allows you to create multiple signatures to use when composing email. For
more information on how to create or edit signatures, please refer to the General
Settings section in this document.

Use the following steps to add a signature while composing an email.

1. From the Options pane, select a signature to use.

 
2. Depending on your settings, the Signature will appear below or above any

content in the body of the email.

Setting Teams

By default, Sugar assigns any composed email to your default teams as specified in
your user profile. For more information on how to change your default team,
please refer to the Getting Started documentation. When composing an email you
can change or add teams to the email before sending.
Use the following steps to add or remove teams from an email while composing the
email:

1. From the Options pane, select the arrow icon to add a team to the email.
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2. Search for and select the desired team in the popup window.
3. Select the Primary option on a team to set the team as the primary for the

email.

 
4. Click the minus icon to remove a team from the email.

 

Sending in Plain Text

By default, Sugar sends email as HTML content. Some email clients can not render
HTML content, but prefer email sent as plain text. If there are no images, links, or
formatting in your email, then sending it as plain text may be a good option.
To send an email as plain text, simply click "Send in Plain Text" from the Options
pane.
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Note : TinyMCE is removed from the compose screen when selecting this option
since plain text emails contain no formatting.

Relating to Records

Emails in Sugar are implicitly related to records in Sugar that match an email
address in the From, To, or Cc fields in the email. This implicit relationship is made
for emails sent from Sugar as well as any email imported into Sugar via Inbound
email accounts or email archiving. Any emails that contain the implicit relationship
will show in the History subpanel of the related record.
While composing an email, users have the ability to set an explicit relationship via
the flex relate field. This allows the new email to be related to a single record from
one of many modules.
Use the following steps to set the Related To field while composing an email:

1. Select a module from the Related To dropdown.

 
2. In the field next to the dropdown, you can begin typing the name of the

record for the specified module. The type ahead feature will show you any
results fro mthat module that match what you have typed.

3. Alternatively, you can select the arrow icon to open up a search window for
the selected module.
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4. Use the search window to locate and select the desired record to relate to the

email.
5. This email will now show in the History subpanel of the selected record.

To modify the flex relate for an email, right click on it in the emails module and
select "Relate".

 
The flex relate field is not the only way to relate an email to records within Sugar.
Emails can also be related directly to one or more Accounts, Contacts, and more.
Use the following steps to relate an email to other records in Sugar:

1. From the emails module, right click on an email and select "View
Relationships"

 
2. The email's detail view will show in a popup window with subpanels to

multiple modules below the email content.
3. Click "Create" or "Select" from a subpanels action menu to either create a

new record or select and existing one to relate to this email.

 
4. Relating a record to an email this way will also force this email to show up in

the related record's history subpanel.

Saving Drafts
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As an alternative to sending an email right away is to saving it as a draft. You can
save an email as a draft so you can continue composing it at a later time. To save
an email as a draft while composing, simply click "Save As Draft".

 
Any emails saved as drafts can be retrieved from the folder pane under "My
Emails" > "My Drafts". Any recipients added, templates used, and signatures used
on the email are all saved in the draft.

Sending

To send an email to the recipients added on the To, Cc, and Bcc fields, simply click
"Send".

 
Sent emails will use the settings configured to connect to your external mail server
to send the email. A copy of every email sent will be in the folder pane under "My
Emails" > "My Sent Email".

Viewing Emails

There are various options available for viewing email in Sugar including via Emails
Module, Emails detail view, Emails Recently View menu, dashlets, and reports.
Sugar allows users to view email from their personal accounts and to import email
into Sugar. Once an email is imported into Sugar it is treated just like any other
record in Sugar. Please note that you will only be able to see email imported into
Sugar as allowed by your team membership, user access type, and assigned roles.
For more information on teams and roles, please refer to the Team Management
and Role Management documentations in the Administration guide.
Note : Group email accounts are automatically imported into Sugar.

Viewing Via Emails Module
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The Emails module displays all emails for the accounts currently configured. To
access the Emails module, simply click the Emails module tab. While the Emails
module shows key email fields, you can click on the email to view the email details
below. You can also double click an email to open it up in a new tab within the
Emails module view. For more information on viewing emails via the emails
module, please refer to the Emails Module View section.

Viewing Via Detail View

The Emails detail view displays thorough email information including all email
fields followed by subpanels of the email's related records belonging to various
modules. The detail view can be reached by clicking a email record's link from
many subpanels and dashlets within the application. For more information on
viewing emails via detail view, please refer to the Emails Detail View section.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which emails and email templates you have
recently viewed. Hover on the Emails module tab to see a list of your most recently
viewed records and click each name to open the email or email template in the
detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view email
information in email-based dashlets such as "My Email". Clicking a email's subject
from any dashlet will open the email in detail view. For more information on using
dashlets and viewing email records via dashlets, please refer to the Modules
section of the Home documentation.

 575 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails/#Emails_Module_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails/#Emails_Detail_View
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Home


 

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding email and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the email record's detail view by clicking the email's subject in
the report results. Please note that you can only directly access contact detail
views with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 

Emails Module View

The Emails module view displays any configured email accounts and emails within
those accounts. You can view the basic details of each email within the field
columns. Please note that for imported Emails you will only be able to see email
records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
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Folders

The folders pane typically appears on the left side of the screen and contains a tree
structure of any personal email accounts configured as well as any group inboxes
being monitored. Sugar comes with some local folders created by default (i.e. My
Email, My Drafts, My Sent Email, My Archived Emails), but users have the ability
to create their own as well.

Creating Folders

Local folders can be created to hold specific emails that have been imported into
Sugar.
Use the following steps to create a new folder from within the Emails module view:

1. From within the Folders pane in the Email module, right click on the folder
you wish to create a folder under and click "Create Folder".

 
2. Enter in the name of the new folder and click "Ok".

 
3. The new folder will now show in the Folders pane under the selected folder.

Managing Accounts and Folders

Sugar has some actions you can perform to manage any personal email accounts
and folders directly from the folders pane. To access these actions simply right
click on the folder or account you wish to perform actions on.
Note : Actions can not be performed on group email accounts. For more
information on how to manage group email accounts, please refer to the Email
documentation in the administration guide.
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The following actions can be performed from the folders pane:

Check Mail : Checks the personal email account or folder selected for any
new email.
Synchronize : Synchronizes the view of your personal email account or folder
to the copy on the external server. Any changes made to email via other email
clients will not show in Sugar until synchronized.
Create Folder : Creates a new subfolder from the folder or account selected.
Delete Folder : Deletes the folder currently selected.
Rename Folder : Renames the folder or account currently selected.
Empty Trash : Removes any deleted email from the account's trash directory.
Clear cache files : Removes any cached email for a personal account.

Search

Sugar allows users to search imported emails to help you locate emails easily and
effectively. Once the search is performed, the relevant results will be displayed in
the Search Results tab. Please note that Sugar automatically appends the wildcard
character (%) to the beginning and end of your search phrase. This allows the
system to retrieve all records that contain the keyword entered in the search.
Use the following steps to search imported email via the emails module:

1. Click the magnifying glass icon in the folders pane to view the search form.

 
2. Enter criteria to search on into one or more of the following fields:

1. Subject : The subject of the email
2. From : Who the email was sent from. Includes any name and email

address in the From field.
3. To : Who the email was sent to. Includes any name and email address in

the To field.
Note : Cc and Bcc is not included.

3. Click "Search" to execute the search or "Clear" to empty the search form.
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4. Click "More" to be able to search on the additional fields:

1. Date From : Select a date to search the "Date Sent" field on. Picking a
date will show any email sent on or after the date selected.

2. Date Until : Select a date to search the "Date Sent" field on. Picking a
date will show any email sent before the date selected.

3. Assigned To : Select a user to search on emails assigned to that user.
Defaults to the currently logged in user.

4. Has Attachment? : Select "Yes" to show only emails that have an
attachment.

5. Related To : Select a module and a record in that module to search any
emails related to that record.
Note : Only searches the Flex Relate field, not the additional related
subpanels.

5. Click "Less" to hide these additional fields.
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When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and options for which you have given a value. For example, if you
select "Has Attachment?" as Yes and enter a subject, Sugar will only return emails
with a matching subject that have an attachment. To see all emails to which you
have access, simply click "Clear" and then "Search" to perform a blank search with
no filters. Please note that you will only be able to see emails as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentations in the Administration guide.

Emails List

The emails list displays all emails meeting the current search criteria or the
selected account/folder and to which your user has access. You can view the basic
details of each email within the field columns. Unread emails display in bold font
where read emails are normal. Please note that you will only be able to see emails
as allowed by your team membership, user access type, and assigned roles. For
more information on teams and roles, please refer to the Team Management and 
Role Managementdocumentations in the Administration guide.
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Columns

The columns in the email list show specific information about the emails being
shown. The below definitions are the meanings of each column in the emails list:

Field Description
Attachment Shows a paperclip icon if the email has

an attachment
Note : Only shows for emails imported
into Sugar.

Flagged Shows an exclamation point if an email
is marked as flagged

Reply Shows an arrow when you have replied
to the specified email

From The name and email address the email
was sent from

Subject The subject of the email
Date Sent The date the email was sent
To The name and email address(es) the

email was sent to

Column Sorting

Emails list provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list may be sorted by only one column at a time.

 

Pagination

Emails list displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. Below the
emails list you can see which records of the total results set are currently being
displayed. The two single-arrow Next and Previous buttons can be used to scroll
through the records page-by-page. The two double-arrow First Page and Last Page
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buttons allow you to skip to the beginning or the end of your current results. Sugar
displays 20 records per list view page.

 

Actions Menu

Sugar can perform specific actions on emails within the emails module. Some of
the actions depend on if the email is imported or not. To access the action menu,
simply right click on an email from within the emails module.

 
The following definitions are the available actions users can perform on emails:

Menu Item Description
View Relationships Opens a popup window to the detail

view of the selected email
Note : Only available for imported
emails

Open Multiple Messages Opens the email in a new tab in the
emails view giving you the ability to pen
multiple emails

Import to Sugar Triggers the import popup allowing you
to set a team, assigned to user, and
related to while importing the email to
Sugar

Reply Compose a new email directed to the
sender as a reply to the selected email

Reply All Compose a new email directed to all
recipients as a reply to the selected
email

Forward Forward the selected email to aditional
recipients
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Delete Send the selected email to the trash
folder

Print Send the selected email to the printer
Mark Set the selected email as unread, read,

flagged, or unflagged
Assign To Opens a popup window to change the

assigned to or team fields
Relate Opens a popup window to change the

flex related to field

Email Panel

The email panel is typically shown in the bottom right corner of the Emails module,
but can also be opened in a separate tab within the module. The email panel
displays thorough email information including all fields of the email. The email
panel can be reached by clicking an email in the emails list or by right clicking an
email in the emails list and selecting "Open Multiple Messages".

 
The email panel comes with specific actions that can be performed on the specified
email. The following actions can be performed from the email panel:

Menu Item Description
Reply Compose a new email directed to the

sender as a reply to the selected email
Reply All Compose a new email directed to all

recipients as a reply to the selected
email

Forward Forward the selected email to additional
recipients

Delete Send the selected email to the trash
folder

Print Send the selected email to the printer
View Select "Display Headers" or "Display

Raw Email" to view the respected detail
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in a popup window
Note : Only available on email not
imported into Sugar.

Import to Sugar Imports the email into Sugar in order to
be related to records and viewable by
others

Quick Create Launches the quick create form for the
selected module while importing the
email, defaulting values into the name
and description fields of the module,
and automatically relating the email to
the new record

View Relationships Opens a popup window to the detail
view of the selected email
Note : Only available for imported
emails

Emails Detail View

The Emails detail view displays thorough email information including all email
fields. You can also view an email's related records (Accounts, Contacts,
Opportunities, etc.) which appear in subpanels beneath the email fields. The detail
view can be reached by clicking an email's subject link from anywhere in the
application outside of the emails module.
Please note that you will only be able to view a email record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentations in the Administration guide.

Actions Menu

The Actions menu on the top left of each email's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Forward Forward the selected email to additional

recipients
Reply Compose a new email directed to the

sender as a reply to the selected email
Reply All Compose a new email directed to all

recipients as a reply to the selected
email

Delete Send the selected email to the trash
folder

Subpanels

Beneath an email record's fields are subpanels containing related records from
various modules, attachments, and the email's activities.

Related Record Subpanels

The most common type of subpanels displayed on a email's detail view contain the
email's related records belonging to various modules. The relationship type
determines whether a related record will be displayed in the field listing or in a
subpanel. For example, an email may be related to only one task via the flex relate
but related to multiple opportunities. This means that the related task will be
displayed amongst the email's fields while opportunities will be displayed in a
subpanel beneath the fields.
Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

 585 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails/#Forwarding_Emails
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails/#Replying_to_Emails
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails/#Replying_to_Emails
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Emails/#Deleting_Emails
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/System


 

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the email, choose "Select" from the subpanel's
Action menu, then locate and select the desired record.
To relate a new record to the email, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To edit a related record, choose "Edit" on the far right of the record's row.
To delete the email's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

 

Attachments Subpanel

The Attachments subpanel lists file attachments that are related to the email
record. Attachments are stored in Sugar connected to Note records. The Note
record and the attachment can be accessed directly from the Attachments
subpanel.

 

Email Contacts Subpanel

The Email Contacts subpanel will lookup any contact records in Sugar that match
an email address listed in the To, Cc, Bcc, or From fields in the current email. The
contact records do not need to be directly related to the email for the contacts to
show in this subpanel as the connection is dynamically made via the email
addresses.
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Importing Emails

Importing emails from external mail accounts enables you to manage them within
Sugar. You can assign imported emails to other users for follow-up, and relate
them to records. Imported emails display in the My Emails folder. You can also
view unread imported emails in the My Emails Dashlet on your homepage. For
more information on using dashlets and viewing email records via dashlets, please
refer to the Commonly Used Dashlets section of the Home documentation.
Use the following steps to import an email from an external account to Sugar:

1. From the Folders pane, select a monitored folder from an external account.

 
2. Right click on an email you wish to import and select "Import to Sugar".

 
Alternatively, select the email and in the email pane, select "Import to Sugar"
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A Third option is to drag and drop the email from the Emails list to the "My
Emails" section of the folder pane.

 
3. Update the necessary fields, then click "Import to Sugar" to complete the

import.

 
Note : The Delete message from server option will delete the email from the
monitored folder in the external account.

Viewing Email Relationships
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From the emails list you can select an email to view the relationships that email
has to other records within Sugar. Select "View Relationships" by right clicking on
an email:

 
or by selecting an email and clicking the button in the email pane:

 
This will open up a popup window with the detail view of the email. For more
information on the detail view, please refer to the Emails Detail View section in
this documentation.

Opening Multiple Messages

In the Emails module, users can view emails in the email pane by selecting an
email. Another way to view emails would be to open the email into a new tab
within the emails module. You can do this by right clicking on an email and
selecting "Open Multiple Messages".

 
This will open the selected email into a new tab within the emails module.
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Replying to Emails

Sugar includes the standard "Reply" and "Reply All" functions that are included in
most email clients. When replying to an email, Sugar composes a new email while
populating the body, subject, and recipients of the email. The subject line from the
email you are replying to comes over to the new email, but is preceded with "RE: ".
The body from the email you are replying to is also pulled into the new email, but
is indented and has a line above the contents to separate the original email from
the content you are adding to the reply.
Select "Reply" to reply to only the sender of the selected email or select "Reply All"
to reply to the sender and any other recipient on the original email. You can access
"Reply" and "Reply All" by right clicking on an email:

 
Or from the email pane:
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Or from the email's detail view:

 
Enter your reply above the divider line in the compose email screen. For more
information on how to compose an email, please refer to the Composing Emails
section.

Forwarding Emails

Sugar includes the standard "Forward" function that is included in most email
clients. When forwarding an email, Sugar composes a new email while populating
the body, subject, and recipients of the email. The subject line from the email you
are forwarding comes over to the new email, but is preceded with "FW: ". The body
from the email you are replying to is also pulled into the new email, but is indented
and has a line above the contents to separate the original email from any content
you are adding to the forward.
You can access "Forward" by right clicking on an email:
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Or from the email pane:

 
Or from the email's detail view:

 
Enter any additional content above the divider line in the compose email screen.
For more information on how to compose an email, please refer to the Composing
Emails section.

Printing Emails

Sugar comes with the ability to print email. When printing, Sugar will open the
email in a popup window and displays the email in a printer friendly version.
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You can access "Print" by right clicking on an email:

 
Or from the email pane:

 

Marking Emails

Sugar allows users to mark emails as read, unread, flagged, and unflagged. This
can be helpful for locating important emails from within the emails module.
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The options in the Mark menu allow you to perform the following operations:

Menu Item Description
Marking as Unread Sets an email to be unread making it

show in bold.
Marking as Read Sets an email to be read making it show

as nornal text.
Marking as Flagged Sets an email as flagged placing an

exclaimation mark new to the email.
Marking as Unflagged Sets an email as unflagged, removing

the exclaimation mark from a flagged
email.

Assigning Emails

When importing an email into Sugar you can set the assigned to and team fields to
a Sugar user and a Sugar team. If you wish to change these fields for an already
imported email, you can right click on the email from the emails list and select
"Assigned To".

 
The Assign To popup window opens defaulting in the current assigned user for the
selected email.
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Change the Assigned To and Teams fields to the desired records.
Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here to
any existing team assignments.

Relating Emails

When importing an email into Sugar, you can assign a single module and record to
be related to this email via the flex relate field. For already imported email, you
can change the related to field by right clicking on the email in the emails list and
selecting "Relate".

 
The Relate Email popup window opens defaulting the current assigned module for
the selected email.

 

Change the Module from the dropdown and select the desired record for that
module.
Note : This field controls which module and record this email shows up in the
history subpanel for.

Viewing Email Details

Users can view some additional backend detail about email from external accounts
by clicking "View" from the email pane.
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Note : The View option is only available on email that is not imported into Sugar.

Displaying Headers

From the View option, select "Display Headers" to view the header details for an
email. The header details include information such as the email servers used and
the content-type of the email.

Displaying Raw Email

From the View option, select "Display Raw Email" to view the raw contents of an
email. The raw contents show the html content of the body as well as the email
header information.

Creating Records From Emails

Users in Sugar can launch a quick create form for many modules directly from an
external email or from an imported email. From the emails pane, click "Quick
Create" and select the desired module record to create from the email.

 
The quick create form for the selected module opens in a popup window. The name
and description fields for the selected module are populated by default with the
subject and body of the email. All required fields are marked with a red asterisk
and must be completed prior to saving. Once the necessary information is entered,
click "Save".

 
The email selected will then be imported, if not already, and will be related to the
new record. If a relationship does not exist between emails and the selected
module (i.e. Tasks) then the relationship will be made via the flex relate field.
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Deleting Emails

If a email is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Emails detail view or Emails Module.
Deleting via the detail view allows you to delete a single record while the module
view allows for mass deleting multiple records at once. Deleting email records will
not delete the related records and will only remove the relationship, so you may
wish to also delete any related records to avoid orphaned records.
Please note that your ability to delete emails may be restricted by a role. For more
information on roles, please refer to the Role Management documentation in the
Administration guide. Check with your system administrator if you do not see the
Delete options.

Deleting Via Detail View

Use the following steps to delete an email record via the detail view:

1. Navigate to an email record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via Emails Module

Use the following steps to delete one or more email records via the emails module:

1. Navigate to the emails module by clicking the Emails module tab.
2. Select an account or folder, or perform a search from the Folders pane.
3. Select the desired email records individually or hold ctrl (command on Mac)

to select multiple.
4. Choose "Delete" from the right click menu.

 597 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management


 

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of email records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Email Templates

Email templates are used in Sugar as simple form letters, automated email
responses, or just commonly used emails to save time and prevent typos. When a
user receives an email regarding a case or bug, then can send back a standard
response email using an email template. Email templates are also used for
campaigns within Sugar as well as workflows. For more information on how to
create and modify email templates for campaigns, please refer to the Creating
Email Templates section in the Campaigns documentation. For more information
on how to create and modify email templates for workflows, please refer to the 
Creating Alert Templates section in the Workflow Management documentation.
Email templates can contain text, HTML content, and images. Users can embed
.jpg or .png image files from their local computers or from the Sugar database into
the template. Image files such as .gif, .bmp, .png, .jpg, .jpeg can be included as
attachments, but cannot be embedded. Placeholder variables can be added to the
template for field values like the contact's name so you can personalize the email
to your recipients.

Creating Email Templates

Use the following steps to create an email template via the Emails module:

1. Hover on the Emails module and select "Create Email Template".
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2. Complete the fields on the screen as follows. Any required fields are marked

with a red asterisk and must be completed:
Name : Enter an internal name for the email template.
Type : Select either "Campaign" or "Email".
Note : You can create an email template for a campaign through this
interface; although, you cannot insert tracker URL links to the template. For
more information on how to create an email template for campaigns, please
refer to the Campaigns documentation in the Application guide.
Teams : Select the Sugar team(s) assigned to the email template.
Assigned To : The Sugar user assigned to the email template.
Description : Enter a description or other information about the template.
Subject : Enter the subject of the emails that will be sent.
Body : Enter the body of the emails that will be sent.
Attachments : Click "Choose File" to navigate to a location on your computer
to attach a file. Click "Sugar Document" to attach a file from the sugar
database.
Note : Documents that link to an external account (i.e. Google Docs, IBM
SmartCloud, etc.) cannot be used as attachments in emails composed through
the Sugar Email client.

3. Using the TinyMCE functions, add simple formatting to your email's content.
For more advanced customization you can click the HTML button in the top
left to access and edit the generated HTML code.
For more information on using TinyMCE, please refer to the TinyMCE section
fn the User Interface documentation in the Application guide.
Note: If images or advanced CSS are required in your email template, it is
highly recommended to host the images or CSS file on a publicly available
hosting service and link to it in the email template.

4. Click "Save" to preserve your changes to the email template.
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Inserting Variables

When constructing the subject and body of your email, Sugar allows you to insert
variables, or placeholders, into the template that will be populated with the
record's information for that variable. Use the following steps to insert a variable
for the recipient's first name into the template:

1. Click to place your cursor on the location in the subject or body where the
recipient's first name should appear.

 
2. In the Insert Variable row, select the module you would like to insert a

variable from.

 
3. Set the second dropdown to the desired field from the modules selected in the

first dropdown. For our example, select "First Name".

 
4. Click "Insert" to insert the generated variable name to your subject or body at

your cursor's location.

 

If there are no images, links, or formatting in your email, then sending it as text
only may be a good option. Click the Send Text Only checkbox to remove the
HTML formatting options. Alternatively you can click "Edit Plain Text" at the
bottom of the page to have the plain text option send differently than the HTML
text.
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Viewing Email Templates

There are various options available for viewing email templates in Sugar including
via list view, detail view, and Emails Recently Viewed menu. Please note that you
will only be able to see email templates as allowed by your team membership, user
access type, and assigned roles. For more information on teams and roles, please
refer to the Team Management and Role Management documentations in the
Administration guide.
The list view displays all email templates meeting the current search criteria. To
access the list view, simply hover over the Emails module tab and select "View
Email Templates".

 
While list view shows key fields, you can click the email template's name to open
the record in detail view.

 
The detail view displays thorough information including all email template fields.
Select "Edit" to edit the email template.

 

Sugar Email Archiving

Sugar Email Archiving is an automatic email importing service that allows users to
import emails into Sugar by sending them from any mail client or service to a
Sugar-provided email address. Each Sugar instance has its own unique Sugar
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Email Archiving mailbox. To import emails, a user sends or forwards emails to the
unique Sugar Email Archiving email address using the To, Cc, or Bcc fields. The
Sugar Email Archiving service will import the email into the Sugar instance. The
service imports the email, along with any attachments, images, and calendar
events, and creates records within the application that are associated with existing
records by matching email addresses in the To and Cc fields. The imported emails
will also be related to a specified case number by including the case macro and the
case number (i.e. [CASE:{number}]) in the subject of the email.
Note : Email Archiving cannot read email addresses from the Bcc field the same as
when you receive an email.
Emails can be sent to the Sugar Email Archiving address and viewed in the History
subpanels in Detail View pages for the following modules:

Accounts
Contacts
Leads
Opportunities
Cases

Emails with .ics meeting attachments sent to SNIP are parsed by Sugar. The
Meeting record is created and for every email that is invited to the meeting, if
User, Contact or Lead record exists matching this email, this record is added to
the list of invitees for the meeting.
Email Archiving can be configured via Admin > Email Archiving. For more
information on how to setup and configure Email Archiving, please refer to the 
Email documentation in the administration guide.
Note : If the email client is configured to use non-English From, To, and Cc fields,
forwarding emails inline to Email Archiving may not work. Send the email to Email
Archiving directly using the Cc and Bcc fields or forward the email as an
attachment. For large volume of non-English emails that need to be archived using
Email Archiving, set a rule in your email application to copy the emails to the SNIP
email address.

Last Modified: 01/04/2016 02:27pm

Tasks

Overview

Sugar's Tasks module consists of individual tasks throughout your organization.
Task records can be related to one record in most modules via the flex relate field
and can also be related to a single Contact. There are various ways you can create

 602 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Email


 

tasks in Sugar such as via the Tasks module, importing tasks, via Activities
subpanels, etc. Once the task record is created, you can view and edit information
pertaining to the task via the Tasks detail view. Depending on the details on the
task, you may also be able to view and edit the task information via the Calendar
module. Each task record may then relate to other Sugar records such as accounts,
contacts, opportunities, and many others. This documentation will cover how to
use the Tasks module as well as the various actions and options available from
within the module.

Task Fields

The Tasks module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Assigned To The Sugar user assigned to the task
Contact Name The contact record the task is related to

Note: When populated, this task will
show in the contact's Activities or
History subpanel depending on status.

Description A description or other information about
the task

Due Date The date and time the task is due to be
completed
Note: When populated, the task will
show on the assigned user's Calendar.

Priority The priority or importance of the task
(e.g. High, Medium, Low)

Related to The module and record that is related to
this task
Note: This will decide which module the
task will show in the Activities and
History subpanels.

Start Date The date and time the task is started
Status The current status of the task (e.g. Not

Started, In Progress, Completed, etc.)
Subject The subject or brief summary of the task
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Teams The Sugar team(s) assigned to the task
record

Tasks Module Tab

The Tasks module tab is typically located under the More tab on the navigation bar
at the top of any Sugar screen to the right of the home cube icon. Depending on
your settings, you may have to click "Show More" in order to see the Tasks module
tab. Click the tab to access the Tasks list view. You may also hover on the tab to
display the Actions, Recently Viewed, and Favorites menu. The Actions menu
allows you to perform important actions within the module. The Recently Viewed
menu displays the list of tasks you last viewed in the module. The Favorites menu
displays the list of tasks you most recently marked as favorites in the module.

 
The Actions menu allows you to perform the following operations:

Menu Item Description
Create Tasks Opens the edit view layout to create a

new task
View Tasks Opens the list view layout to search and

display tasks
Import Tasks Opens the import wizard to create or

update tasks using external data
If you do not see the Tasks module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Tasks module is not a member. Click the
More tab (last tab on navigation bar) then hover on "Filter Menu By" to check
how the navigation bar is grouped. For more information on tab grouping,
please refer to the User Interface documentation.
The Tasks module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Tasks module in the Hide Modules list, simply
move it to the Display Modules list. For more information on hiding and
displaying modules, please refer to the Layout Options section of the Getting
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Started documentation.
The administrator may have disabled the Tasks module for your entire Sugar
instance. Reach out to your Sugar administrator to have the Tasks module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Tasks

There are various methods for creating tasks in Sugar including via the Tasks
module, quick create, duplication, importing tasks, and via the activities subpanel.
The full edit view layout opens when creating the task directly from the Tasks
menu and includes all of the relevant fields for your organization's tasks. The quick
create form is a shortened version of the tasks edit view and typically contains
fewer fields. When using quick create to make a task while viewing an existing
record of another module, Sugar automatically creates a relationship between both
records. For example, if you are viewing an account record (e.g. ABC Company)
and create a new task via the quick create form, the Account module is selected
and the Related to will automatically populate with "ABC Company", thus creating
the relationship. Both the Edit View and Quick Create layouts can be configured by
administrators via Admin > Studio. For more information on configuring layouts,
please refer to the Studio documentation in the Administration guide.

Creating Via Tasks Module

One of the most common methods of task creation is via the Create Task option in
the Tasks module tab. This opens up the edit view layout which allows you to enter
in all the relevant information for the task.
Use the following steps to create a task via the Tasks module:

1. Hover on the Tasks module and select "Create Task".
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2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. Once the necessary information is entered, click "Save".

 

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. If you do not see the "Create Task" option, please click "Show
More" to see more Quick Create options. You can also quick create a task from any
Activities subpanel on related module records.
Use the following steps to create a task via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Task" or select "Create Task" on any Activities subpanel on a related
module's detail view.
From Quick Create menu:
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From Activities subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. The Related To field is automatically populated with the module and record

you are currently viewing.
Note: When creating from the Contacts module, the contact will be populated
in the Contacts relationship and the account assigned to the contact will be
populated in the Related To.

4. If additional fields are desired, click the Full Form button to use edit view
instead.

5. Once the necessary information is entered, click "Save".
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Creating Via Duplication

You can also create a new task by duplicating an existing task record. The
duplicate option is useful if the task you are creating has similar information to an
existing task.
Use the following steps to create a task by duplicating an existing record:

1. Navigate to a task record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original task's values.

Update the necessary fields, then click "Save".

 

Creating Via Email

Users in Sugar can launch a quick create form to create a task from an external
email or from an imported email. From the emails pane in the Emails module, click
"Quick Create" and select "Task".
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The quick create form opens in a popup window. The name and description fields
for the task are populated by default with the subject and body of the email. All
required fields are marked with a red asterisk and must be completed prior to
saving. Once the necessary information is entered, click "Save".
The email selected will then be imported, if not already, and will be related to the
new task. A relationship will be made between the email and the task created via
the flex relate field.

Importing Tasks

The import function allows you to push multiple task records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.
Use the following steps to import tasks via the Import Tasks option:

1. Hover on the Tasks module tab and select "Import Tasks".

 
2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only". Click

"Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. In Step 6, view the import results.

The Created Records tab will show all of the new task records.
The Duplicates tab will show any records in the file that were identified
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as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Viewing Tasks

There are various options available for viewing task records in Sugar including via
Tasks list view, Tasks detail view, Tasks Recently Viewed menu, dashlets, and
reports. Please note that you will only be able to see task records as allowed by
your team membership, user access type, and assigned roles. For more information
on teams and roles, please refer to the Team Management and Role Management
documentations in the Administration guide.

Viewing Via List View

The Tasks list view displays all task records meeting the current search criteria. To
access the list view, simply click the Tasks module tab. While list view shows key
task fields, you can click the task's name to open the record in detail view. For
more information on viewing tasks via list view, please refer to the Tasks List
View section of this documentation.

Viewing Via Detail View

The Tasks detail view displays thorough task information including all task fields
followed by subpanels of the task's related records belonging to various modules.
The detail view can be reached by clicking a task record's link from anywhere in
the application including from the Tasks list view. For more information on viewing
tasks via detail view, please refer to the Tasks Detail View section of this
documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which tasks you have recently viewed. Hover
on the Tasks module tab to see a list of your most recently viewed tasks and click
each name to open the task in detail view.
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Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view task
information in task-based dashlets such as "My Open Tasks". Clicking a task's
subject from any dashlet will open the task in detail view. For more information on
using dashlets and viewing task records via dashlets, please refer to the Modules
section of the Home documentation. You can also close the task in the My Open
Tasks dashlet, by clicking the "x" icon to the far left of each list view row. For more
information on closing tasks, please refer to the Closing Tasks section of this
documentation.
Please note that when viewing the Tasks dashlet, the due date will be shown in one
of three colors: black, orange, or red. Due dates change color on the tasks list to
allow the user to quickly see which scheduled tasks are past their due date,
regardless of the current status.
The date colors in the Tasks dashlet are as follows:

Black : The due date has not passed yet.
Orange : The due date is today.
Red : The due date has passed.
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Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding tasks and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the task record's detail view by clicking the task's subject in
the report results. Please note that you can only directly access task detail views
with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 
Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.
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Searching Tasks

The Tasks list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Tasks list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.
For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.
The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a task subject, Sugar will only return task records with
a matching subject that are assigned to you. Once the search is complete, the
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relevant results will populate in the list view below the search panel. To see all
task records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
task records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
Administrators can configure what fields appear on the Task Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.
The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a task subject to search, Sugar will only return task records
with a matching subject that you have marked as favorites. When searching by a
multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all task records
to which you have access, simply click "Clear" and then "Search" to perform a
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blank search with no filters. Please note that you will only be able to see task
records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
Administrators can configure what fields appear on the Task Advanced Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 
To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.
Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Advanced Options section of the Search
documentation. Administrators can control additional elements of global search via
Admin > Search and Admin > Studio. For more information on administrator
configuration of Global Search, please refer to t he Studio documentation as well
as the Search section of the System documentation in the Administration guide.

Tasks List View

The Tasks list view displays all task records meeting the current search criteria
and to which your user has access. You can view the basic details of each task
within the field columns. Please note that you will only be able to see task records
as allowed by your team membership, user access type, and assigned roles. For
more information on teams and roles, please refer to the Team Management and 
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Role Management documentations in the Administration guide.
When viewing the Tasks list view, the due date will be shown in one of three
colors: black, orange, or red. Due dates change color on the tasks list to allow the
user to quickly see which scheduled tasks are past their due date, regardless of the
current status.

The date colors in the Tasks list view are as follows:

Black : The due date has not passed yet.
Orange : The due date is today.
Red : The due date has passed.

 
You have the option to change what fields are displayed in list view by configuring
your layout options in the Tasks Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.
By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the
System documentation in the Administration guide.
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Checkbox Selection

You can perform several actions on task records directly from the list view by first
selecting the desired records. To select individual task records on the Tasks list
view, mark the checkbox on the left of each row. To select or deselect multiple task
records on the list view, use the options in the checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of task
results.
Select All : Selects all records in the current search results across all pages of
task results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more tasks
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Mass Update Mass update one or more tasks
Export Export one or more tasks to a CSV file

Favorite Designation

Users have the option to mark task records as favorites via the list view as well as
the detail view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Tasks
module tab. In the Tasks list view, the star on the left of each task's row is yellow
once marked to indicate a favorite task. For more information on how to mark
records as favorites, please refer to the Favoriting Tasks section of this
documentation.

 

Closing Tasks

Tasks in Sugar have a status field which indicate whether a task is Open, In
Progress, or Completed. Rather than force users to open the Tasks edit view and
change the status when completing a task, you have the ability to complete a task
directly from the Tasks list view by clicking the Close button to the left of the
task's subject.

 
For more information on closing tasks please refer to the Closing Tasks section in
this document.

More Information

Additional details for each task can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional task
information in addition to what appears in the display column fields. The resulting
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pop-up window will show the Start Date & Time, Due Date & Time, Priority, Status,
and Description fields by default. The list of fields appearing here may only be
configured through a code-level customization.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Tasks Detail View

The Tasks detail view displays thorough task information including all task fields
which are grouped by default into the Overview and Other panels. You can also
view a task's related records (Notes and Attachments) which appear in subpanels
beneath the task fields. The detail view can be reached by clicking a task record's
link from anywhere in the application including from the Tasks list view.
Please note that you will only be able to view a task record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management
documentations in the Administration guide.Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.
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Actions Menu

The Actions menu on the top left of each task's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this task
Duplicate Duplicate this task
Delete Delete this task
Close and Create New Close this task as "Completed" and

duplicate to a new task
Note: This option only appears as long
as the status does not equal
"Completed".

Close Close this task as "Completed"
Note: This option only appears as long
as the status does not equal
"Completed".

Favorite Designation

Users have the option to mark task records as a favorite via the detail view as well
as the list view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Tasks
module tab. In the Tasks detail view, the star on the right of the task's subject is
yellow once marked to indicate a favorite task. For more information on how to
mark records as favorites, please refer to the Favoriting Tasks section of this
documentation.
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Next or Previous Record

On the upper right of the Tasks detail view, there are two buttons that allow you to
page through each task in the Tasks list view's current search results. Clicking the
Previous button displays the previous task of the current search results while
clicking the Next button displays the next task of the current search results. The
text in between shows which task result you are currently viewing within the total
number of current results.

 

Subpanels

Beneath a task record's fields are subpanels containing related records from
various modules. By default the only related module to the Tasks module is the
Notes module.

Related Record Subpanels

The types of subpanels displayed on a task's detail view contain the tasks related
records belonging to various modules. The relationship type determines whether a
related record will be displayed in the field listing or in a subpanel. For example, a
task may be related to only one contact but related to multiple notes. This means
that the related contact will be displayed amongst the task's fields while notes will
be displayed in a subpanel beneath the fields.
Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
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documentation in the Administration guide.
Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the task, choose "Select" from the subpanel's
Action menu, then locate and select the desired record.
To relate a new record to the task, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To delete the task's relationship to a record, choose "Remove" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

 

Editing Tasks

Tasks may be edited at any time to update or add information to the record. You
can make changes to existing task records via the Tasks edit view and quick create
forms. Edit view is available within the Tasks module and includes all of the Task
fields you should need.
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Quick create is available for editing tasks from outside the Tasks module and
opens as a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields.

 
Please note that your ability to edit tasks in Sugar may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
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the Edit options.
Administrators in Sugar may configure both the Tasks edit view and quick create
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit tasks via the detail view by clicking the Edit button on the upper left
of the page. Once the edit view layout is open, update the necessary fields, then
click "Save" to preserve the changes made.

 

Editing Via List View

You can edit tasks via the list view by clicking the Pencil icon to the left of each
task's subject. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.

 

Editing Via Dashlets

You can edit tasks by clicking the pencil icon to the far right of any task-based
dashlet on your Sugar home page. For example, clicking the pencil icon within the
My Open Tasks dashlet will open a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. For more information on dashlets,
please refer to the Home documentation.
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Editing Via Reports

Sugar reports also allow you to edit a task record by clicking on the pencil icon
next to a task's subject. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. Please note that you may only directly
edit tasks from Rows and Columns-type or Summation with Details-type reports as
Summation-type and Matrix-type reports do not include the pencil icon. For more
information on reports, please refer to the Reports documentation.

 

Deleting Tasks

If a task record is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Tasks detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once. Deleting task records will not delete the
related records and will only remove the relationship, so you may wish to also
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delete any related records to avoid orphaned records.
Please note that your ability to delete tasks in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a task record via the detail view:

1. Navigate to a task record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more task records via the list view:

1. Navigate to the Tasks list view by clicking the Tasks module tab.
2. Use the Basic or Advanced Search to find the task records you wish to delete.
3. Select the desired task records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.
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Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of task records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Closing Tasks

Tasks in Sugar have a status field which indicate whether a task is Open, In
Progress, or Completed. Rather than force users to open the Tasks edit view and
change the status when completing a task, you have the ability to complete a task
from a variety of locations.

Closing Via List View

Use the following steps to close a task via the list view:

1. Navigate to the Tasks list view by clicking the Tasks module tab.
2. Use the Basic or Advanced Search to find the task records you wish to delete.
3. Mark the X icon on the left of each desired task's row.

 
4. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Closing Via Detail View

Use the following steps to close a task via the detail view:

1. Navigate to a task record's detail view.
2. Select "Close" from the Actions menu.
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Close and Create New Via Detail View

Use the following steps to close and duplicate a task via the detail view:

1. Navigate to a task record's detail view.
2. Select "Close and Create New" from the Actions menu.

 
3. The displayed edit view is pre-populated with the original task's values. By

default, the new task's status is set to "Not Started". Update the necessary
fields, then click "Save".

 

Close and Create New Via Edit View

Use the following steps to close and duplicate a task via the edit view:

1. Navigate to a task record's edit view.
2. Select "Close and Create New".
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3. The displayed edit view is pre-populated with the original task's values. By

default, the new task's status is set to "Not Started". Update the necessary
fields, then click "Save".

 

Exporting Tasks

Sugar's Export option allows users to download all fields for the selected tasks to
their computers as a .CSV (comma-separated values) file. This may be useful when
needing to use task data with other software such as Microsoft Excel or to update
existing records by exporting, making changes, then importing the altered tasks
back into Sugar. For more information on updating existing records via import,
please refer to the Import documentation. Due to PHP memory limitations on the
server, there may be occasions when the application times out while exporting a
large number of tasks records. If you encounter an error when performing this
action, we recommend selecting the records in smaller batches.

Tasks may be exported from the Tasks list view by selecting "Export" from the
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Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for tasks and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export tasks from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Tasks

Mass Updating allows users to make the same change to multiple task records at
once from the Tasks list view. Users with administrator or developer level access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of task records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.
Please note that your ability to mass update tasks may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Mass Update option.

Use the following steps to mass update task records from the list view:

1. Navigate to the Tasks list view by clicking the Tasks module tab.
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2. Use the list view's Basic or Advanced Search to identify tasks you wish to
modify.

3. Select the desired tasks individually or using the checkbox dropdown's
options.

4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected task

records.

Favoriting Tasks

Each Sugar user has the option to designate their own favorite tasks which are
important or will be viewed often so that they can easily be accessed via search or
from the Tasks module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Tasks Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Tasks Module
Tab .
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Favoriting Via List View

Use the following steps to mark records as favorites via the Tasks list view:

1. Navigate to the Tasks list view by clicking the Tasks module tab.
2. Use the Basic or Advanced Search to find the task records you wish to mark

as favorites.
3. Mark the star icon on the left of each desired task's row.
4. To remove the task as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Tasks detail view:

1. Navigate to a task record's detail view.
2. Click the star icon to the right of the task's subject in the upper left of the

detail view to designate it as a favorite.
3. To remove the task as a favorite, click the star again to revert it to white.

 

Last Modified: 09/26/2015 06:25pm

Notes
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Overview

Sugar's Notes module consists of individual notes throughout your organization.
Note records can be related to one record in most modules via the flex relate field
and can also be related to a single Contact. Notes can hold generic text about a
record or even an attachment related to the record. There are various ways you
can create notes in Sugar such as via the Notes module, importing notes, via
History subpanels, etc. Once the note record is created, you can view and edit
information pertaining to the note via the Notes detail view. Each note record may
then relate to other Sugar records such as accounts, contacts, opportunities, and
many others. This documentation will cover how to use the Notes module as well
as the various actions and options available from within the module.

Note Fields

The Notes module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Assigned To The Sugar user assigned to the note
Attachment An optional file to attach to the note

Note : The Sugar administrator can
specify the maximum file size allowed to
be uploaded.

Contact The contact record the note is related
to.
Note : If populated, this note will show
in the contact's History subpanel

Display in Portal? Select this checkbox to allow the note to
be displayed in the customer portal

Note The details and content of the note
Related to The module and record that is related to

this note
Note : This will decide which module
this note will show in the History
subpanel
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Subject The subject or designation of the note
Teams The Sugar team(s) assigned to the note

record

Notes Module Tab

The Notes module tab is typically located under the More tab on the navigation bar
at the top of any Sugar screen to the right of the home cube icon. Depending on
your settings, you may have to click "Show More" in order to see the Notes module
tab. Click the tab to access the Notes list view. You may also hover on the tab to
display the Actions, Recently Viewed, and Favorites menu. The Actions menu
allows you to perform important actions within the module. The Recently Viewed
menu displays the list of notes you last viewed in the module. The Favorites menu
displays the list of notes you most recently marked as favorites in the module.

 
The Actions menu allows you to perform the following operations:

Menu Item Description
Create Note or Attachment Opens the edit view layout to create a

new note
View Notes Opens the list view layout to search and

display notes
Import Notes Opens the import wizard to create or

update notes using external data
If you do not see the Notes module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Notes module is not a member. Click the
More tab (last tab on navigation bar) then hover on "Filter Menu By" to check
how the navigation bar is grouped. For more information on tab grouping,
please refer to the User Interface documentation.
The Notes module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Notes module in the Hide Modules list, simply
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move it to the Display Modules list. For more information on hiding and
displaying modules, please refer to the Layout Options section of the Getting
Started documentation.
The administrator may have disabled the Notes module for your entire Sugar
instance. Reach out to your Sugar administrator to have the Notes module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Notes or Attachments

There are various methods for creating notes in Sugar including via the Notes
module, quick create, duplication, importing notes, and via the history subpanel.
The full edit view layout opens when creating the note directly from the Notes
menu and includes all of the relevant fields for your organization's notes. The quick
create form is a shortened version of the notes edit view and typically contains
fewer fields. When using quick create to make a note while viewing an existing
record of another module, Sugar automatically creates a relationship between both
records. For example, if you are viewing an account record (e.g. ABC Company)
and create a new note via the quick create form, the Account module is selected
and the Related to will automatically populate with "ABC Company", thus creating
the relationship. Both the Edit View and Quick Create layouts can be configured by
administrators via Admin > Studio. For more information on configuring layouts,
please refer to the Studio documentation in the Administration guide.

Creating Via Notes Module

One of the most common methods of note creation is via the Create Note or
Attachment option in the Notes module tab. This opens up the edit view layout
which allows you to enter in all the relevant information for the note.
Use the following steps to create a note via the Notes module:

1. Hover on the Notes module and select "Create Note or Attachment".
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2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. Once the necessary information is entered, click "Save".

 

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a note from any history subpanel on
related module records.
Use the following steps to create a note via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Note or Attachment" or select "Create Note or Attachment" on any
history subpanel on a related module's detail view.
From Quick Create menu:
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From History subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. The Related To field is automatically populated with the module and record

you are currently viewing.
Note : When creating from the Contacts module, the contact will be populated
in the Contacts relationship and the account assigned to the contact will be
populated in the Related To.

4. If additional fields are desired, click the Full Form button to use edit view
instead.

5. Once the necessary information is entered, click "Save".
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Creating Via Duplication

You can also create a new note by duplicating an existing note record. The
duplicate option is useful if the note you are creating has similar information to an
existing note or if you would like to put the same note on a different account
record.
Use the following steps to create a note by duplicating an existing record:

1. Navigate to a note record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original note's values.

Update the necessary fields, then click "Save".
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Note : When duplicating a note with an attachment, the attachment will also be on
the new note created via duplication.

Importing Notes

The import function allows you to push multiple note records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.
Use the following steps to import notes via the Import Notes option:

1. Hover on the Notes module tab and select "Import Notes".

 
2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only". Click

"Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. In Step 6, view the import results.

The Created Records tab will show all of the new note records.

The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.

The Errors tab will show records that were not imported due to errors
detected during import.
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Note : You can not import attachments during this process, only note
records themselves can be imported.

Viewing Notes

There are various options available for viewing notes records in Sugar including
via Notes list view, Notes detail view, Notes Last Viewed menu, dashlets, and
reports. Please note that you will only be able to see note records as allowed by
your team membership, user access type, and assigned roles. For more information
on teams and roles, please refer to the Team Management and Role Management
documentations in the Administration guide.

Viewing Via List View

The Notes list view displays all note records meeting the current search criteria.
To access the list view, simply click the Notes module tab. While list view shows
key note fields, you can click the note's subject to open the record in detail view.
For more information on viewing notes via list view, please refer to the Notes List
View section of this documentation.

Viewing Via Detail View

The Notes detail view displays thorough note information including all note fields
followed by subpanels of the note's related records belonging to various modules.
The detail view can be reached by clicking a note record's link from anywhere in
the application including from the Notes list view. For more information on
viewing notes via detail view, please refer to the Notes Detail View section of this
documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which notes you have recently viewed. Hover
on the Notes Module Tab to see a list of your most recently viewed notes and click
each name to open the note in detail view.

 640 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Team_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Notes/#Notes_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Notes/#Notes_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Notes/#Notes_Detail_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Notes/#Notes_Module_Tab


 

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view note
information in note-based dashlets such as "My Notes". Clicking a note's subject
from any dashlet will open the note in detail view. For more information on using
dashlets and viewing note records via dashlets, please refer to the Modules section
of the Home documentation.

 

Viewing Via Reports
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Users with access to the Reports module can build, run, and manage reports to
gather key data regarding notes and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the note record's detail view by clicking the note's subject in
the report results. Please note that you can only directly access note detail views
with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 
Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Notes

The Notes list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Notes list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.
For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.
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Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.
The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a note subject, Sugar will only return note records
with a matching subject that are assigned to you. Once the search is complete, the
relevant results will populate in the list view below the search panel. To see all
note records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
note records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
Administrators can configure what fields appear on the Notes Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studiodocumentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.
The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:
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Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a note subject to search, Sugar will only return note
records with a matching subject that you have marked as favorites. When
searching by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar
will return records matching any of these selections. Once the search completes,
the relevant results will populate in the list view below the search panel. To see all
note records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
note records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentations in the Administration guide.
Administrators can configure what fields appear on the Notes Advanced Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.
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To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.
Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to t he Studio documentation as well as the Search section of the
System documentation in the Administration guide.

Notes List View

The Notes list view displays all note records meeting the current search criteria
and to which your user has access. You can view the basic details of each note
within the field columns. Please note that you will only be able to see note records
as allowed by your team membership, user access type, and assigned roles. For
more information on teams and roles, please refer to the Team Management and 
Role Management documentations in the Administration guide.
You have the option to change what fields are displayed in list view by configuring
your layout options in the Notes Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
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results.
By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on note records directly from the list view by first
selecting the desired records. To select individual note records on the Notes list
view, mark the checkbox on the left of each row. To select or deselect multiple
note records on the list view, use the options in the checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of note
results.
Select All : Selects all records in the current search results across all pages of
note results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more notes at a time
Mass Update Mass update one or more notes at a

time
Export Export one or more notes to a CSV file

Favorite Designation

Users have the option to mark note records as favorites via the list view as well as
the detail view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Notes
module tab. In the Notes list view, the star on the left of each note's row is yellow
once marked to indicate a favorite note. For more information on how to mark
records as favorites, please refer to the Favoriting Notes section of this
documentation.

 

More Information

Additional details for each note can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional note
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information in addition to what appears in the display column fields. The resulting
pop-up window will show the Team and Note fields by default. The list of fields
appearing here may only be configured through a code-level customization.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Notes Detail View

The Notes detail view displays thorough note information including all note fields
which are grouped by default into the Overview and Other panels. The detail view
can be reached by clicking a note record's link from anywhere in the application
including from the Notes list view.
Please note that you will only be able to view a note record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management
documentations in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
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Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each note's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this note
Duplicate Duplicate this note
Delete Delete this note

Favorite Designation

Users have the option to mark note records as a favorite via the detail view as well
as the list view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Notes
module tab. In the Notes detail view, the star on the right of the note's subject is
yellow once marked to indicate a favorite note. For more information on how to
mark records as favorites, please refer to the Favoriting Notes section of this
documentation.
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Next or Previous Record

On the upper right of the Notes detail view, there are two buttons that allow you to
page through each note in the Notes list view's current search results. Clicking the
Previous button displays the previous note of the current search results while
clicking the Next button displays the next note of the current search results. The
text in between shows which note result you are currently viewing within the total
number of current results.

 

Editing Notes

Notes may be edited at any time to update or add information to the record. You
can make changes to existing note records via the Notes edit view and quick
create forms. Edit view is available within the Notes module and includes all of the
Note fields you should need.
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Quick create is available for editing notes from outside the Notes module and
opens as a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields.

 
Please note that your ability to edit notes in Sugar may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Edit options.
Administrators in Sugar may configure both the Notes edit view and quick create
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit notes via the detail view by clicking the Edit button on the upper left
of the page. Once the edit view layout is open, update the necessary fields, then
click "Save" to preserve the changes made.
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Editing Via List View

You can edit notes via the list view by clicking the Pencil icon to the left of each
note's subject. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.

 

Editing Via Dashlets

You can edit notes by clicking the pencil icon to the far right of any note-based
dashlet on your Sugar home page. For example, clicking the pencil icon within the
My Notes dashlet will open a pop-up window with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes. For more information on dashlets, please refer to
the Home documentation.

 

Editing Via Reports
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Sugar reports also allow you to edit a note record by clicking on the pencil icon
next to a note's subject. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. Please note that you may only directly
edit notes from Rows and Columns-type or Summation with Details-type reports as
Summation-type and Matrix-type reports do not include the pencil icon. For more
information on reports, please refer to the Reports documentation.

 

Deleting Notes

If a note record is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Notes detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once.
Please note that your ability to delete notes in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a note record via the detail view:

1. Navigate to a note record's detail view.
2. Select "Delete" from the Actions menu.
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3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more note records via the list view:

1. Navigate to the Notes list view by clicking the Notes module tab.
2. Use the Basic or Advanced Search to find the Notes records you wish to

delete.
3. Select the desired note records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of note records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Notes

Sugar's Export option allows users to download all fields for the selected notes to
their computers as a .CSV (comma-separated values) file. This may be useful when
needing to use note data with other software such as Microsoft Excel or to update
existing records by exporting, making changes, then importing the altered notes
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back into Sugar. For more information on updating existing records via import,
please refer to the Import documentation. Due to PHP memory limitations on the
server, there may be occasions when the application times out while exporting a
large number of note records. If you encounter an error when performing this
action, we recommend selecting the records in smaller batches.
Notes may be exported from the Notes list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for notes and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 
Please note that your ability to export notes from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Notes

Mass Updating allows users to make the same change to multiple note records at
once from the Notes list view. Users with administrator or developer level access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of note records. If you encounter an error when performing this action, we
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recommend selecting the records in smaller batches.
Please note that your ability to mass update notes may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Mass Update option.

Use the following steps to mass update note records from the list view:

1. Navigate to the Notes list view by clicking the Notes module tab.
2. Use the list view's Basic or Advanced Search to identify notes you wish to

modify.
3. Select the desired notes individually or using the checkbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.
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6. Click "Update" to save the changes to all of the currently selected note

records.

Favoriting Notes

Each Sugar user has the option to designate their own favorite notes which are
important or will be viewed often so that they can easily be accessed via search or
from the Notes module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Notes Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Notes Module
Tab .

Favoriting Via List View

Use the following steps to mark records as favorites via the Notes list view:

1. Navigate to the Notes list view by clicking the Notes module tab.
2. Use the Basic or Advanced Search to find the Note records you wish to mark

as favorites.
3. Mark the star icon on the left of each desired note's row.
4. To remove the note as a favorite, click the star again to revert it to white.
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Favoriting Via Detail View

Use the following steps to mark records as favorites via the Notes detail view:

1. Navigate to a note record's detail view.
2. Click the star icon to the right of the note's subject in the upper left of the

detail view to designate it as a favorite.
3. To remove the note as a favorite, click the star again to revert it to white.

 

Last Modified: 09/26/2015 06:25pm

Targets

Overview

Sugar's Target module is intended to store potential prospects that have not yet
been qualified as leads. Information (e.g. name, email address) regarding these
targets is normally acquired from business cards, industry lists, or similar
resources. Targets in Sugar are stand-alone records as they are not related to
contacts, leads, accounts, or opportunities.

There are various ways you can create targets in Sugar such as via the Targets
module, importing targets, etc. Once the target record is created, you can view
and edit information pertaining to the target via the Targets detail view. This
documentation will cover the basics of the Targets module as well as the various
options available in performing the actions related to the module.

Target Fields

The Targets module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
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fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Account Name The account to which the target belongs
Alternate Address The target's alternate address (e.g.

billing or shipping)
Assigned To The Sugar user assigned to the target
Assistant The name of the target's assistant within

his or her company
Assistant Phone The assistant's phone number
Birthdate The target's date of birth
Date Created The date the target record was created
Date Modified The date the target record was last

modified
Department The target's department within their

company
Description A description or other information about

the target
Do Not Call Indication that the target should not be

called
Email Address The target's email address
Email Opt Out Indication that the target has opted out

of receiving emails
Fax The target's fax number
First Name The target's first name
Home The target's residence number
Last Name The target's last name
Mobile The target's mobile number
Name When viewing, the target's full name
Office Phone The target's office number
Other Phone The target's alternate phone number
Primary Address The target's primary address
Salutation Standard greeting for the target (e.g.

Mr., Ms., Mrs., etc.)
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Teams The Sugar team(s) assigned to the
target record

Title The target's business title

Targets Module Tab

The Targets module tab is typically located under the More tab of the navigation
bar at the top of any Sugar screen. Sugar normally displays the top six modules
shown in the Display Modules list of your user preferences, so the remaining
displayed modules are grouped under the More tab. For more information on
displayed modules for the navigation bar, please refer to the User Preferences
section of the Getting Started documentation. Click the tab to access the Targets
list view. You may also hover on the tab to display the Actions, Recently Viewed,
and Favorites menu. The Actions menu allows you to perform important actions
within the module. The Recently Viewed menu displays the list of targets you last
viewed in the module. The Favorites Menu displays the list of targets you most
recently marked as favorites in the module.

 

The options in the Actions menu allow you to perform the following types of action:

Menu Item Description
Create Target Opens the edit view layout to create a

new target
View Targets Opens the list view layout to search and

display targets
Import Targets Opens the import wizard to create or

update targets using external data
If you do not see the Targets module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Targets module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
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check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Targets module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Targets module in the Hide Modules list,
simply move it to the Display Modules list. For more information on hiding
and displaying modules, please refer to the Layout Options section of the
Getting Started documentation.
The administrator may have disabled the Targets module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Targets
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Targets

There are various methods for creating targets in Sugar including via the Targets
module, quick create, duplication, and importing targets. The full edit view layout
opens when creating the target directly from the Targets menu and includes all of
the relevant fields for your organization's targets. The quick create form is a
shortened version of the targets edit view and typically contains fewer fields. Both
the Edit View and Quick Create layouts can be configured by administrators via
Admin > Studio. For more information on configuring layouts, please refer to the 
documentation in the Administration guide.

Creating Via Targets Module

One of the most common methods of target creation is via the Create Target option
in the Targets module tab. This opens up the edit view layout which allows you to
enter in all the relevant information for the target.
Use the following steps to create a target via the Targets module:

1. Hover on the Targets module and select "Create Target".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. Once the necessary information is entered, click "Save".
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Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a target from any Targets subpanel
on related module records.

Please note that the Targets module may not be available in the Quick Create
menu as it could be disabled for quick create. Reach out to your Sugar
administrator to have the Targets module enabled for quick create via Admin >
Configure Navigation Bar Quick Create. For more information on enabling and
disabling modules for the Quick Create menu, please refer to the Developer Tools
documentation.

Use the following steps to create a target via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Target" or select "Create" on any Targets subpanel on a related
module's detail view.
From Quick Create menu:

 
From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

 662 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Targets/#Target_Fields


 

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".

 

Creating Via Duplication

You can also create a new target by duplicating an existing target record. The
duplicate option is useful if the target you are creating has similar information to
an existing target.

Use the following steps to create a target by duplicating an existing record:

1. Navigate to a target record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original target's values.

Update the necessary fields, then click "Save".
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Importing Targets

The import function allows you to push multiple target records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.

Use the following steps to import targets via the Import Targets option:

1. Hover on the Targets module tab and select "Import Targets".

 
2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only". Click

"Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. In Step 6, view the import results.

The Created Records tab will show all of the new target records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Viewing Targets

There are various options available for viewing target records in Sugar including
via Targets list view, Targets detail view, Targets Recently Viewed menu, dashlets,
and reports. Please note that you will only be able to see target records as allowed
by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

Viewing Via List View

The Targets list view displays all target records meeting the current search
criteria. To access the list view, simply click the Targets module tab. While list
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view shows key target fields, you can click the target's name to open the record in
detail view. For more information on viewing targets via list view, please refer to
the Targets List View section of this documentation.

Viewing Via Detail View

The Targets detail view displays thorough target information including all target
fields followed by subpanels of the target's related records belonging to various
modules. The detail view can be reached by clicking a target record's link from
anywhere in the application including from the Targets list view. For more
information on viewing targets via detail view, please refer to the Targets Detail
View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which targets you have recently viewed.
Hover on the Targets module tab to see a list of your most recently viewed targets
and click each name to open the target in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view target
information in dashlets based on other modules such as "My Calls". Clicking a
target's name from any dashlet will open the target in detail view. For more
information on using dashlets and viewing target records via dashlets, please refer
to the Modules section of the Home documentation.
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Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding targets and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the target record's detail view by clicking the target's name in
the report results. Please note that you can only directly access target detail views
with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide.Check with your system administrator if you cannot
access the Reports module.

Searching Targets

The Targets list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Targets list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
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wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in the Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter in a target name to search, Sugar will only return the
target records with a matching name that are assigned to you. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all target records to which you have access, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see target records as allowed by your team membership, user access type,
and assigned roles. For more information on teams and roles, please refer to the 
Team Management and Role Managementdocumentation.

Administrators can configure what fields appear on the Targets Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
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including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Favorites" and enter in a target name to search, Sugar will only return
the target records with a matching name that are marked as favorites. When
searching by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar
will return records matching any of these selections. Once the search completes,
the relevant results will populate in the list view below the search panel. To see all
target records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
target records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation.

Administrators can configure what fields appear on the Targets Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
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Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
Search section of the System documentation in the Administration guide.

Targets List View

The Targets list view displays all target records meeting the current search criteria
to which your user has access. You can view the basic details of each target within
the field columns. Please note that you will only be able to see target records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options available in Targets Advanced Search. For more information on
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configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than potentially displaying thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on target records directly from the list view by
first selecting the desired records. To select individual target records on the
Targets list view, mark the checkbox on the left of each row. To select or deselect
multiple target records on the list view, use the options in the checkbox dropdown
menu.

Select This Page : Selects all records shown on the current page of target
results.
Select All : Selects all records in the current search results across all pages of
target results.
Deselect All : Deselects all records that are currently selected.
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Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more targets at a time
Email Email one or more targets at a time
Mass Update Mass update one or more targets at a

time
Add to Target List Add one or more targets to a target list
Export Export one or more targets to a CSV file

Favorite Designation

Users have the option to mark target records as favorites via the list view as well
as the detail view. This allows users to designate records that are important or will
be viewed often so that they can easily be accessed via search or from the Targets
module tab. In the Targets list view, the star on the left of each target's row is
yellow once marked to indicate a favorite target. For more information on how to
mark records as favorites, please refer to the Favoriting Targets section of this
documentation.
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More Information

Additional details for each target can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional target
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Primary Address, Mobile, Home, Other Phone, Email
Address, and Description fields by default. The list of fields appearing here may
only be configured through a code-level customization .

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Targets Detail View

The Targets detail view displays thorough target information including all target
fields which are grouped by default into the Overview, More Information, and
Other panels. You can also view a target's related records (Activities, History,
Campaigns) which appear in subpanels beneath the target fields. The detail view
can be reached by clicking a target record's link from anywhere in the application
including from the Targets list view.
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Please note that you will only be able to view a target record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu

The Actions menu on the top left of each target's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this target
Duplicate Duplicate this target
Delete Delete this target
Get Data Search, view, and merge additional lead

data via Hoover's and/or Zoominfo
connector

Convert Target Convert this target to a lead
Manage Subscriptions Manage this target's newsletter

campaign subscriptions

Favorite Designation

Users have the option to mark target records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often as they can easily be accessed via search or from the Targets
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module tab. In the Targets detail view, the star on the right of the target's name is
yellow once marked to indicate a favorite target. For more information on how to
mark records as favorites, please refer to the Favoriting Targets section of this
documentation.

 

Next or Previous Record

On the upper right of the Targets detail view, there are two buttons that allow you
to page through each target in the Targets list view's current search results.
Clicking the Previous button displays the previous target of the current search
results while clicking the Next button displays the next target of the current
search results. The text in between shows which target result you are currently
viewing within the total number of current results.

 

Subpanels

Beneath a target record's fields are subpanels containing related records from
various modules and campaign interaction history for this target.

Related Record Subpanels

Modules in Sugar display subpanels, which allow users to view related records
from other modules. Users can view the details of the related record as well as
relate new or existing records via the subpanel. Administrators can easily modify
the fields (e.g. Name, Assigned User, etc.) displayed on these subpanels as well as
the label of each subpanel through Admin > Studio so that users have visibility to
the most important fields for their organization. For more information on working
with related record subpanels, please refer to the Subpanels section of the User
Interface documentation.
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Activities and History Subpanel

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the target record. Once the activities have taken place or are completed,
they will instead appear within the History subpanel. The History subpanel also
includes notes and emails associated with the target record. For more information
on the history and activities subpanel, please refer to the User Interface
documentation.

 

Campaign Log Subpanel

The Campaign Log subpanel contains historical information regarding a target
record's interaction with all Sugar campaigns. When a mass marketing campaign
is sent to a target (or manually marked as sent in the case of non-email
campaigns), the related campaign activity information will appear within the
Campaigns subpanel. This information mirrors the "View Status" page available
from within each individual campaign and shows activities such as when a
campaign was sent, when the target viewed the campaign message, when the
target clicked a tracked link within the campaign, etc. Since this subpanel contains
historical campaign interactions for the target, it cannot be used to associate a
target with a campaign or otherwise manage a campaign or target list. For more
information on associating a target with a campaign, please refer to the Adding
Targets to a Target List section of this documentation.For more information on
campaigns, please refer to the Campaigns documentation.
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Editing Targets

Targets may be edited at any time to update or add information to the record. You
can make changes to existing target records via the Targets edit view and quick
create forms. Edit view is available within the Targets module and includes all of
the Target fields you should need.

 

Quick create is available for editing targets from outside the Targets module and
opens in a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields.

 

Please note that your ability to edit targets in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure both the Targets edit view and quick create
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via Admin > Studio. For more information on configuring layouts, please refer to
the Studiodocumentation in the Administration guide.

Editing Via Detail View

You can edit targets via the detail view by clicking the Edit button on the upper left
of the page. Once the edit view layout is open, you can update the necessary fields,
then click "Save" to preserve the changes made.

 

Editing Via List View

You can edit targets via the list view by clicking the Pencil icon to the left of each
target's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.

 

Editing Via Reports

Sugar reports also allow you to edit a target record by clicking on the pencil icon
next to a target's name. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. Please note that you may only directly
edit targets from Rows and Columns-type or Summation with Details-type reports
as Summation-type and Matrix-type reports do not include the pencil icon. For
more information on reports, please refer to the Reports documentation.
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Deleting Targets

If a target record is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Targets detail view or list view.
Deleting via the detail view allows you to delete a single record while the list view
allows for mass deleting multiple records at once. Deleting target records will not
delete the related records and will only remove the relationship, so you may wish
to also delete any related records to avoid orphaned records.

Please note that your ability to delete targets in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a target record via the detail view:

1. Navigate to a target record's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more target records via the list view:
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1. Navigate to the Targets list view by clicking the Targets module tab.
2. Use the Basic or Advanced Search to find the Target records you wish to

delete.
3. Select the desired target records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of target records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Converting Targets

Sugar enables you to convert targets into leads as you determine they qualify for
your organization's definition of a lead (e.g. after an evaluation/qualification
process) and becomes a valid sales prospect. Please note that targets are only
converted into leads in Sugar, and the new lead record will have a relationship to
the original target record. Once the lead is qualified as a sales opportunity, they
can be converted into contacts, opportunities, and accounts. For more information
on lead conversions, please refer to the Leads documentation.

Steps to Convert a Target

Once the target has been evaluated and qualified, they are ready to be converted
to a lead in Sugar.
The following steps cover converting a target to a lead as an example:

 679 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Targets/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Targets/#Advanced_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Targets/#Checkbox_Selection
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Targets/#Checkbox_Selection
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Leads


 

1. Navigate to a target record's detail view.

 
2. Select "Convert Target" from the Actions menu.

 
3. Enter appropriate values for the fields in the Leads edit view layout then click

"Save".
Since targets only convert to a lead, the Leads edit view displays all lead
fields which are grouped by default into the Overview, More Information,
and Other panels. Administrators have the ability to determine what
fields are displayed on the Leads edit view via Admin > Studio. For more
information on configuring layouts, please refer to the Studio
documentation in the Administration guide.

 

Once the conversion is complete, the target record will display the converted lead
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name at the top of the detail view page. You can click the records name to view the
detail of the converted lead.

 

Exporting Targets

Sugar's Export option allows users to download all fields for the selected targets to
their computers as a .CSV (comma-separated values) file. This may be useful when
needing to use Target data with other software such as Microsoft Excel or to
update existing records by exporting, making changes, then importing the altered
targets back into Sugar. For more information on updating existing records via
import, please refer to the Import documentation. Due to PHP memory limitations
on the server, there may be occasions when the application times out while
exporting a large number of target records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.

Targets may be exported from the Targets list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for targets and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export targets from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.
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Downloading a Target's vCard

vCards are electronic business cards that are exchanged through applications such
as email and web browsers. You can download a vCard from Sugar in order to
transfer the target's information to another application.

The following steps cover downloading a vCard and saving it as a contact in
Microsoft Outlook as an example:

1. Navigate to a target record's detail view.
2. Click the vCard icon to the right of the target's name to download the vCard

file.

 
3. Open the downloaded file in your mail or address book application. For this

example, double clicking opens the vCard in Outlook.
4. Make any necessary changes to the information, then click "Save & Close" to

save this target in Outlook.

 

Mass Updating Targets

Mass Updating allows users to make the same change to multiple target records at
once from the Targets list view. Users with administrator or developer level access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, t here may
be occasions when the application times out while mass updating a large number
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of target records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update targets may be restricted by a role.
For more information on roles, please refer to the Role Managementdocumentation
in the Administration guide. Check with your system administrator if you do not
see the Mass Update option.

Use the following steps to mass update target records from the list view:

1. Navigate to the Targets list view by clicking the Targets module tab.
2. Use the list view's Basic or Advanced Search to identify targets you wish to

modify.
3. Select the desired targets individually or using the checkbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected target

records.

Favoriting Targets
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Each Sugar user has the option to designate their own favorite targets which are
important or will be viewed often so thatthey can easily be accessed via search or
from the Targets module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Targets Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Targets
module tab.

Favoriting Via List View

Use the following steps to mark records as favorites via the Targets list view:

1. Navigate to the Targets list view by clicking the Targets module tab.
2. Use the Basic or Advanced Search to find the Target records you wish to

mark as favorites.
3. Mark the star icon on the left of each desired target's row.
4. To remove the target as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Targets detail view:

1. Navigate to a target record's detail view.
2. Click the star icon to the right of the target's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the target as a favorite, click the star again to revert it to white.

 

Emailing Targets
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Sugar allows users to compose and send outbound emails to targets. There are
various ways to send outbound mail to targets including emailing via the Emails
module, Emails quick compose, Targets module, campaigns, and workflows. Please
note that administrators in Sugar must first configure the outbound mail server for
the system via Admin > Email Settings in order for users to send outbound emails.
For more information on setting up the system email settings, please refer to the 
documentation in the Administration guide. Users will also need to have their
email settings configured in their user preferences prior to sending outbound
email from the Emails module, Emails quick compose, or Targets module. For more
information on setting up your user preferences' email settings, please refer to the 

Emailing Via the Emails Module

Use the following steps to compose and send an email to a target via the Emails
module. For more detailed information on sending emails via the Emails module,
please refer to the Emails documentation.

1. Navigate to the Emails module by clicking the Emails module tab.
2. Click the Compose button on the upper left of the Emails module.

 
3. For the "Related To" field, select "Target" as the module then enter or select

the desired target's name. The email's To field will automatically populate
with the name and email address of the selected target record.

4. Enter a subject and body for the email message, then click "Send".

 

Once the email is sent successfully, the email record will appear in the History
subpanel of the target record.
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Emailing Via Quick Compose

The quick compose option allows users to compose emails from various places in
Sugar without navigating away from the current page.

While viewing a target record, you can select "Send Email" from the Quick Create
menu on the top right of any Sugar page. Quick creating an email while viewing a
target record's detail view automatically populates the To field with the target's
name and email address as well as relating the email to the target record.

 

Users can also use Quick Compose by clicking a target's email address anywhere it
is displayed as a link. Clicking the email address automatically populates the To
field with the target's name and email address as well as relating the email to the
target record.

 

Quick Compose is also available from the Activities subpanel in a target's detail
view. Choosing "Compose Email" from the Actions menu automatically populates
the To field with the target's name and email address as well as relating the email
to the target record.
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Once the email is sent successfully, the email record will appear in the History
subpanel of the target record. For more detailed information on sending emails via
quick compose, please refer to the Emails documentation.

 

Emailing Via Targets List View

One or more targets may be emailed at a time from the Targets list view. For more
information on sending emails via the Targets list view, please refer to the Emails
documentation.

Use the following steps to compose and send an email from the Targets list view:

1. Navigate to the Targets list view by clicking the Targets module tab.
2. Use the Basic or Advanced Search to find the Target records you wish to

include on the email.
3. Select the desired targets individually or using the checkbox dropdown's

options.
4. Select "Email" from the Actions menu.

 
5. In the Quick Compose email template, enter in the subject and body of the

email message, then click "Send".
The To field will be automatically populated with the name and email address
of the selected target record(s).

Once the email is sent successfully, the email record will appear in the History
subpanel of the target record(s).
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Emailing Via Campaigns

Sugar's Campaigns module can be used to create email and newsletter campaigns
to send mass emails to a relevant set of targets. Email-type campaigns are mass
emails sent to a target list while newsletter-type campaigns are a series of mass
emails sent to a consistent or growing target list periodically or on a regular basis.
For more information on sending mass emails to targets via a campaign, please
refer to the Email Campaign section of the Campaigns documentation.

Emailing Via Workflows

Sugar's Workflow module enables you to automate tasks, send email alerts, and
execute various actions. With each workflow, a set of conditions trigger a
combination of actions and email alerts potentially including alerts to target
records. You also can create alert email templates used by workflows to insert
relevent data to the automated email notifications. For more information on
workflow email notifications, please refer to the Email Alertsection of the
Workflows documentation.

Adding Targets to a Target List

A target list consists of a group of individuals or organizations you want to be
included or excluded on a mass marketing campaign. These targets are typically
identified based on a set of predetermined criteria such as being a prospect or
existing customer, age group, industry, etc. There are various ways to add targets
to a target list in Sugar including using the Add to Target List option from the
Target list view's Actions menu. For more information on target lists and the other
methods of adding targets, please refer to the Target Lists documentation. Due to
the PHP memory limitations on the server, t here may be occasions when the
application times out while adding target records to a target list.If you encounter
an error when performing this action, we recommend selecting the records in
smaller batches.

The following steps cover adding target records to a target list via the Targets list
view as an example:
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1. Navigate to the Targets list view by clicking the Targets module tab.
2. Use the Basic or Advanced Search to find the Target records you wish to add

to a target list.
3. Select the desired target records individually or using the checkbox

dropdown's options.
4. Choose "Add to Target List" from the Actions menu.

 
5. Locate and select the desired target list in the pop-up window or click "Create

Target List" to add to a new target list.

 

In order to view the targets that have been added, you can navigate to the Target
Lists module. Click the target list's name to enter the detail view, and you will see
the target records within the Targets subpanel.
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Connectors

Connectors in Sugar allow the system to connect existing target records in Sugar
to external applications such as Hoovers and Zoominfo. Users can search, view,
and merge additional data for the target from the specific data source by selecting
"Get Data" from the Actions menu of the Targets detail view. For more information
on utilizing the connectors to get data, please refer to the Get Data section of the
User Interface documentation. Please note that the Hoovers and Zoominfo
connectors are not enabled by default for the Targets module. Administrators must
first enable the connectors via Admin > Connectors in order for the Get Data
option to appear in the Actions menu. For more information on enabling
connectors, please refer to the Enabling Connectors section of the System
documentation in the Administration guide.

Managing Target Subscriptions

Targets who receive newsletter-type campaign emails from your Sugar instance
are considered subscribers to that newsletter. Users can manage these newsletter
subscriptions from the Targets detail view using the Manage Subscriptions option
in the Actions menu. Please note that you can only manage subscriptions for
newsletter-type campaigns. A newsletter campaign you have created will have one
or more default-type target lists. Targets are added to these target lists in order to
receive your newsletter. The Manage Subscriptions option allows you to add a
target to the default-type or suppression-type target lists of your newsletter
campaigns without leaving the Targets module. For more information on
newsletter subscriptions, please refer to the Campaigns documentation.

Use the following steps to manage target subscriptions via a target's detail view:

1. Navigate to a target record's detail view.
2. Select "Manage Subscriptions" from the Actions menu.

 
3. To add the target to a newsletter subscription mailing list, select the

newsletter from the Available/Newsletters Unsubscribed To list and drag it to
the Newsletters Subscribed To list. This will add the target to the campaign's
default target list.

4. To remove the target from the newsletter subscription mailing list, select the
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newsletter from the Newsletters Subscribed To list and drag it to the
Available/Newsletters Unsubscribed To list. This will add them to the
suppression-type unsubscription target list for the newsletter campaign,
which will prevent the target from receiving the newsletter. Please note that
the target will not be removed from the campaign's default target list.

 
5. Click "Save" to preserve your changes.

Last Modified: 09/26/2015 06:25pm

Target Lists

Overview

A target list consists of a collection of individuals or organizations you want to
include or exclude in a mass marketing campaign. Target Lists can contain any
number and any combination of Targets, Contacts, Leads, Users, and Accounts.
Targets can be grouped into a target list according to a set of predetermined
criteria such as age group, geographic location, or spending habits. Target lists are
used in mass email marketing campaigns that can be configured in the Campaigns
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module. For more information regarding creating campaigns please refer to the 
Campaigns documentation in the Application guide.

Target Lists Fields

The Target Lists module contains a number of stock fields, which come
out-of-the-box with Sugar. The below definitions are suggested meanings for the
fields, but the fields can be leveraged differently to best meet your organization's
needs.

Field Description
Assigned To The Sugar user assigned to the target

list
Date Created The date the target list record was

created
Date Modified The date the target list record was last

modified
Description A description or other information about

the target list
Name The name or designation of the target

list
Teams The Sugar team(s) assigned to the

target list
Type The type of the target list (e.g. default,

test, etc.)
Domain Name The name of the domain to exclude from

the campaign recipient list (e.g.
"example.com")

All email addresses containing the
domain name will not receive the
campaign email.

Note: This field only displays when
"Suppression List - By Domain" is
selected for the Type field. 

Target List Types

A target list can specify individuals or organization who need to be included in a
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campaign or excluded from a campaign. This can be controlled using the following
target list types:

Target List Type Description
Default A list of people who are the primary

recipients of the campaign email
Seed A list of people who need to receive the

campaign email but not be tracked in
the campaign statistics

Note: This list is typically used for
internal purposes where the individuals
in this group need to approve the
campaign before it is launched. The
seed list is ignored in the campaign's
View Status page.

Suppression List - By Domain A list of people who should be excluded
from the campaign email recipient list
and whose email addresses share a
common domain name, such as
"website.com"

Note: Suppression by domain can be
used to prevent marketing to entire
organizations such as competitors.

Suppression List - By Email Address A list of people who should be excluded
from the campaign email recipient list

Note: This list typically consists of
people who chose to opt out from
receiving your campaign message. 

Suppression List - By Id A list of people who should be excluded
from a Newsletter-type campaign email
recipient list

Note: The "Suppression List - By Id"
must be related to the Newsletter
campaign in order for the message's
opt-out link to function properly.

Test A list of people who receive test email
campaigns to make sure that the
message's layout is displayed properly
before the campaign is finalized and
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sent to the default list

Note: A campaign may be sent to the
test list multiple times by using the
Delete Test Entries button on the View
Status page between re-sends.

Target Lists Module Tab

The Target Lists module tab is typically located under the More tab on the
navigation bar at the top of any Sugar screen to the right of the home cube icon.
Depending on your settings, you may have to click "Show More" in order to see the
Target Lists module tab. Click the tab to access the Target Lists list view. You may
also hover on the tab to display the Actions, Recently Viewed, and Favorites menu.
The Actions menu allows you to perform important actions within the module. The 

 
The options in the Actions menu allow you to perform the following types of action:

Menu Item Description
Create Target List Opens the edit view layout to create a

new target list
View Target Lists Opens the list view layout to search and

display target lists
If you do not see the Target Lists tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Target Lists module is not a member.
Click the More tab (last tab on navigation bar) then hover your mouse on
"Filter Menu By" to check how the navigation bar is grouped. For more
information on tab grouping, please refer to the User Interface documentation
in the Application guide.
The Target Lists module may be marked as hidden in your user preferences,
which will prevent it from being displayed. You can check by navigating to
your user profile (upper right of Sugar), clicking the Advanced tab, and
viewing the modules displayed under the Layout Options section. If you see

 694 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Target_Lists/#Creating_Target_Lists
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Target_Lists/#Viewing_Target_Lists
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/User_Interface


 

the Target Lists module in the Hide Modules list, simply move it to the
Display Modules list. For more information on hiding and displaying modules,
please refer to the Layout Options section of the Getting Started
documentation in the Application guide.
The administrator may have disabled the Target Lists module system wide.
Reach out to your Sugar administrator to have the Target Lists module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Target Lists

There are various methods for creating target lists in Sugar including via the
Target Lists module, duplication, importing of targets, and from the list view of
other modules. The full edit view layout opens when creating the target lists and
includes all of the relevant fields for your organization's target lists.

Creating Via Target Lists Module

One of the most common methods of creating a target list is via the Create Target
List option in the Target Lists module tab. This opens up the edit view layout,
which allows you to enter in all the relevant information for the target list.
Use the following steps to create a target list via the Target Lists module:

1. Hover on the Target Lists module and select "Create Target List".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. Once the necessary information is entered, click "Save".

 

Alternatively, you can create or select an existing target list from a Campaign's
detail view via the Target List subpanel. This will launch the same edit view
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mentioned above for creating a target list. For more information on how to select a
target list from a campaign, please refer to the Campaigns documentation in the
Application guide.
You can now add records to the target list from the list view of Accounts, Contacts,
Leads, and Targets. For more information on how to populate a target list, please
refer to the section Populating Target Listsin this documentation.

Creating Via Duplication

You can also create a new target list by duplicating an existing target list record.
The duplicate option is useful if the target list you are creating has similar
information to an existing target list since you have less new data to enter. A major
advantage to creating a target list via duplication is that the related records on the
original target list will also be related to the newly created target list.
Use the following steps to create a target list by duplicating an existing target list
record:

1. Navigate to a target list record's detail view.
2. Click the Actions menu and select "Duplicate".

 
This opens a new edit view pre-populated with the original target list's values.

3. Update the necessary fields (e.g. Name, Type, Description, etc.) then click
"Save".

 

Creating Via Importing Targets

In Sugar you cannot import a target list, but you can import targets. During the
import process of targets you have the option to create a target list that contains
the imported targets. Perform an import following the instructions in the Import
documentation in the Application guide. During step 6 of the import process ,you
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will have an option to add the targets you just imported to a target list.
For more information regarding how to select a target list during target importing
or creating a new target list via target importing please refer to the Populating
Via Importing Targets section in this documentation.

Creating Via Module List View

Sugar gives you the ability to create a target list by selecting pre-existing records
from the list view of the Accounts, Contacts, Leads, and Targets modules.
For more information regarding how to populate a target list from the module list
view or create a new target list wilhe populating from the module list view, please
refer to the Populating Via Module List View section in this documentation.

Searching Target Lists

The Target Lists module's list view includes Basic and Advanced Search
functionality to help you locate records easily and effectively in a module-specific
manner. Once the search is performed, the relevant search results will be
displayed in the Target Lists list view below. Global Search allows users to search
for information across their entire Sugar database as opposed to restricting search
within a specific module.
Note : Global Search is turned off for the Target Lists module by default. For more
information on how to enable and disable modules for Gobal Search, please refer
to the System documentation in the Application guide.
Sugar automatically appends the wildcard character (%) to the end of your search
phrase. This allows the system to pull up all records that include the keyword
entered in the search. If you would like to broaden the search, you can use the
wildcard at the beginning of your text as well (e.g. %services). This will pull up any
record that has the word "services" in the name, regardless of how it starts or
ends.
For more information on using the various search methods as well as how
wildcards are used, please refer to the Searchdocumentation in the Application
guide.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic search panel, you can click "Advanced Search" to access additional
search functionality.
The buttons and checkboxes available in the Basic Search panel are also available
in Advanced Search.
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Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter in a target list name to search, Sugar will only return
the target list records with a matching name that are assigned to you. Once the
search is complete, the relevant results will populate in the list view below the
search panel. To see all target list records to which you have access, simply click
"Clear" and then "Search" to perform a blank search with no filters. Please note
that you will only be able to see target list records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentations in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.
The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation in the Application guide.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
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Search documentation in the Application guide.

 
When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Favorites" and enter in a target list name to search, Sugar will only
return the target list records with a matching name that are marked as favorites.
When searching by a multiselect or dropdown field (e.g. "Assigned to"), however,
Sugar will return records matching any of these selections. Once the search
completes, the relevant results will populate in the list view below the search
panel. To see all target list records to which you have access, simply click "Clear"
and then "Search" to perform a blank search with no filters. Please note that you
will only be able to see target list records as allowed by your team membership,
user access type, and assigned roles. For more information on teams and roles,
please refer to the Team Management and Role Management documentations in
the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, full text search was introduced in Sugar, which allows users to
search throughout all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 
To use global search, you need to first enter the keyword into the search box. With
full text search, the autocomplete is enabled, so Sugar will start searching the
system once you provide three or more characters into the search field and show
results in a pop-up search box. If you click the magnifying glass icon or hit
Return/Enter, Sugar will look for an exact match based on the keyword entered.
For more information on using and configuring Global Search, please refer to the 
section of the Search documentation in the Application guide.

You can configure some aspects of global search such as what modules you want
displayed in the search results etc.
Note : Global Search is turned off for the Target Lists module by default. For more
information on how regular users can configure their Global Search, please refer
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to the System documentation in the Application guide.

Viewing Target Lists

There are various options available for viewing target list records in Sugar
including via Target Lists list view, Target Lists detail view, and Target Lists
Recently Viewed menu.

Viewing Via List View

The Target Lists list view displays all target list records meeting the current
search criteria. To access the list view, simply click the Target Lists module tab.
While list view shows key target list fields, you can click the target list's name to
open the record in detail view. For more information on viewing target list via list
view, please refer to the Target Lists List View section of this documentation.

Viewing Via Detail View

The Target Lists detail view displays thorough target list information including all
target list fields followed by subpanels of the target list's related records belonging
to various modules. The detail view can be reached by clicking a target list
record's link from anywhere in the application including from the Target Lists list
view. For more information on viewing target list via detail view, please refer to
the Target Lists Detail View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which target lists you have recently viewed.
Hover on the Target Lists module tab to see a list of your most recently viewed
target lists and click each name to open the target list in detail view.
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Populating Target Lists

Target list can be populated with targets, contacts, leads, users, and accounts.
There are various methods to populating a target list with the different types of
targets. Due to the PHP memory limitations on the server, there may be occasions
when the application times out while populating a large number of records to a
target list. If you encounter an error when performing this action, we recommend
selecting the records in smaller batches.
Note : If you have multiple targets with the same email address, Sugar will send
the campaign email to only one of the targets, chosen at random. The other email
addresses, considered to be duplicates, are suppressed even though they are not
on the opt-out list.

Populating Via Individual Selection

The detail view of each target list will display the targets, contacts, leads, users,
and accounts subpanels. You can select and add the desired targets directly via
these subpanels.
Use the following steps to populate a target list with contacts from the edit view in
the Target Lists module:

1. Choose the Select button from the Actions dropdown menu in the Contacts
subpanel.

 

2. In the Contacts popup list view you can perform a search for the contacts you
wish to add

3. Select the desired results individually by clicking on the contact name or
choose multiple using the checkboxes and click the Select button.
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4. Once the contacts have been selected, you will see the contacts within the
Contacts subpanel in your target list's detail view.

Populating Via Reports

The detail view of each target list will display the targets, contacts, leads, users,
and accounts subpanels. You can select and add the desired targets from an
existing report directly to the target list via these subpanels.
Use the following steps to populate a target list with a report of leads from the edit
view in the Target Lists module:

1. Choose the Select from Reports button from the Actions dropdown menu in
the Leads subpanel.

 
2. In the Reports popup list view, you will see the list of reports based on the

Leads module. Select the report you would like to add to the target list by
clicking on the report's name.

 
3. Once the report has been selected, you will see the lead records from the

report results within the Leads subpanel of your target list.
Note : When selecting a report the default runtime filters will be applied and
you will not be able to overwrite them when selecting the report.
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Populating Via Module List View

You can select records directly from the Accounts, Contacts, Leads, and Targets
list views to add them to a target list.
Use the following steps to populate a target list by selecting records rom the list
view in the Accounts module:

1. Select the account records to add to the target list by checking them or
choosing "Select All" from the checkbox dropdown.

2. Choose "Add to Target List" from the actions dropdown menu.

 
3. Select your desired target list in the popup window or click "Create Target

List" to add to a new target list.

 
4. If creating a new target list, enter appropriate values for the fields in the edit

view layout. All required fields are marked with a red asterisk and must be
completed prior to saving.

5. Once the necessary information is entered, click "Save".

 
6. This will return you to the original popup window with the target list you just

created in search results.
7. Select the newly created target list and the accounts you selected are now

associated with the new target list.
8. You will now see the Account records within the Accounts subpanel of your

target list.
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Populating Via Importing Targets

In Sugar you cannot import a target list, but you can import targets. Perform an
import in the Targets module following the instructions in the Import
documentation in the Application guide.
Use the following steps to populate a new or existing target list containing the
targets you just imported:

1. On Step 6 of the import process, click the Add to Target List button.

 
2. A popup window will open with the option to select an existing Target List to

add the targets to.
3. Search and select an existing target list or click the Create Target List button

to create a new target list.

 
4. If creating a new target list, enter appropriate values for the fields in the edit

view layout. All required fields are marked with a red asterisk and must be
completed prior to saving.

5. Once the necessary information is entered, click "Save".
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6. This will return you to the original popup window with the Target List you just

created in search results.
7. Select the newly created target list and the targets you imported are now

associated with the new target list.

Target Lists List View

The Target Lists list view displays all target list records meeting the current
search criteria to which your user has access. You can view the basic details of
each target list within the columns of fields. Please note that you will only be able
to see target list records as allowed by your team membership, user access type,
and assigned roles. For more information on teams and roles, please refer to the 
Team Management and Role Management documentations in the Administration
guide.

Checkbox Selection

You can perform several actions on target list records directly from the list view by
first selecting the desired records. To select individual target list records on the
Target Lists list view, mark the checkbox on the left of each row. To select or
deselect multiple target list records on the list view, use the options in the
checkbox dropdown menu.

Select This Page : Selects all records shown on the current page of target lists
results.
Select All : Selects all records in the current search results including all pages
of target lists results.
Deselect All : Deselects all records that are currently selected.
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Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more contacts at a time
Mass Update Mass update one or more contacts at a

time
Export Export one or more contacts to a CSV

file

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than potentially displaying thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow next and previous buttons can be
used to scroll through the records page-by-page. The two double-arrow first and
last page buttons allow you to skip to the beginning or the end of your current
results.
By default, Sugar displays 20 records per list view page, but administrators can
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change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Favorite Designation

Users have the option to mark target list records as a favorite via the list view as
well as the detail view. This allows users to designate records that are important
or will be viewed often so that they can easily be accessed on the list view or from
the Target Lists module tab. In the Target Lists' list view, the star on the left of
each target list's row is yellow once marked to indicate a favorite target list. For
more information on how to mark records as favorites via the Taget Lists list view,
please refer to the Favoriting Target Lists section of this documentation.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields that allow sorting will
have a pair of arrows in the column header. The list view may be sorted by only
one column at a time. You can also set a default order-by column using the layout
options in Advanced Search to specify which field to automatically sort results by
in the list view. For more information on setting a default column sort, please refer
to the Layout Options section of the Search documentation in the Application
guide.

 

Target Lists Detail View

The Target Lists detail view displays thorough target list information including all
target list fields, which are grouped by default into the Overview, and Other
panels. You can also view a target list's related records (Targets, Contacts, Leads,
etc.), which appear in subpanels beneath the target list fields. The detail view can
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be reached by clicking a target list record's link from anywhere in the application
including from the Target Lists list view.
Please note that you will only be able to view a target list record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentations in the Administration guide.

Actions Menu

The Actions menu on the top left of each target lists' detail view allows you to
perform various actions on the current record. Please note that administrators in
Sugar can change the action items to be displayed as separate buttons instead of a
dropdown menu via Admin > System Settings. For more information on how to
configure the actions menu, please refer to the System documentation in the
Administration guide.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this target list
Duplicate Duplicate this target list
Delete Delete this target list
Export Export the members of this target list

Related Record Subpanels

Beneath a target list record's fields are subpanels containing the target lists
related records belonging to various modules.
The following operations may be performed on or with related record subpanels.
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Please note that administrators in Sugar can change the subpanel's Action menu to
be displayed as separate buttons instead of a dropdown via Admin > System
Settings. For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the target list, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the target list, choose "Create" from the subpanel's
Action menu, complete the Quick Create form, and then click "Save".
To delete the target list's relationship to a record, choose "unlink" from the
dropdown on the far left of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange the subpanels.

 

Next or Previous Record

On the upper right of the Target Lists detail view, there are two buttons displayed
that allow you to view and scroll through different target list records. Clicking the
Previous button displays the previously viewed target list record's detail view.
Clicking the Next button allows you to scroll through the target list record that
follows the current one you are viewing.
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Favorite Designation

Users have the option to mark target list records as a favorite via the detail view as
well as the list view. This allows users to group records that are important or will
be viewed often as they can easily be accessed. To add a target list record to your
favorite list, click on the star icon to the right of the target list name in the detail
view. Once target lists are marked as favorites, you can select "My Favorites" in
the Basic or Advanced Search panel to pull up just your favorite target list records.
For more information on marking records as favorites via the Target Lists detail
view, please refer to the Favoriting Via Detail View section of this documentation.

 

Editing Target Lists

Target Lists may be edited at any time to update or add information to the record.
You can make changes to existing target list records via the Target Lists edit view
and quick create forms. Edit view is available within the Taget Lists module and
includes all of the Target Lists fields you should need.

 
Quick create is available for editing target lists from outside the Target Lists
module and opens in a pop-up box without navigating away from your current
page. It generally contains fewer fields, but the Full Form button may be used to
access the full edit view form should you need to edit additional fields.
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Please note that your ability to edit target lists in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Editing Via Detail View

You can edit target lists via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, you can update the necessary
field values then click "Save" to preserve the changes made.

 

Editing Via List View

You can edit target lists via the list view by clicking the Pencil icon to the left of
each target list's name. A pop-up window will open with the quick create form
which is a shortened version of the edit view layout. You can make the necessary
updates to field values on the form, then click "Save" to preserve the changes.
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Deleting Target Lists

If a target list record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Target Lists detail view or list
view. Deleting via the detail view allows you to delete a single record while the list
view allows for mass deleting multiple records at once. Deleting target list records
will not delete the related records and will only remove the relationship, so you
may wish to also delete any related records to avoid orphaned records.
Please note that your ability to delete target lists in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete option.

Deleting Via Detail View

Use the following steps to delete a target list record via the detail view:

1. Navigate to a target list record's detail view.

2. Select "Delete" from the Actions menu.

 

3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more target list records via the list view:
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1. Navigate to the Target Lists list view by clicking the Target Lists module tab.
2. Use the Basic or Advanced Search to find the Target Lists records you wish to

delete.
3. Select the desired target list records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Exporting Target Lists

Sugar's Export option allows users to download all fields for the selected target
lists to their computers in a .CSV format. This may be useful when needing to use
target list data with other software such as Microsoft Excel. Target Lists may be
exported from the Target Lists list view by selecting "Export" from the Actions
menu. For more information on exporting records in Sugar, please refer to the 
Export documentation in the Application guide.
Please note that your ability to export target lists from Sugar may be restricted by
a role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Exporting Target List Members

In addition to exporting target list records from the Target Lists list view, Sugar
allows you to export the members of a target list from the detail view of a target
list record. This allows users to download all fields for the members of the selected
target list to their computers in a .CSV format.
Use the following steps to export the members of a target list via the target lists
detail view:

1. Navigate to a target list record's detail view.

2. Select "Export" from the Actions menu.
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Please note that your ability to export target list members from Sugar may be
restricted by a role. For more information on roles, please refer to the Role
Management documentation in the Administration guide. Check with your system
administrator if the Export option returns an access restriction message.

Mass Updating Target Lists

The Mass Update option allows users to make the same change to multiple records
at once. Target list records can be mass updated from the Target Lists list view.
Please note that your ability to mass update target lists may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the mass update option.
Use the following steps to mass update target list records from the list view:

1. Navigate to the Target Lists list view by clicking the Target Lists module tab.
2. Use the list view's Basic or Advanced Search to identify target lists you wish

to modify.
3. Select the desired target lists individually or by using the checkbox

dropdown's options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.
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6. Click "Update" to save the changes to all of the currently selected target list

records.

Favoriting Target Lists

Each Sugar user has the option to easily designate their own favorite target lists.
Designating target list records as favorites allow you to group records and easily
find the target lists most important to you. Once records are marked as favorites,
use the My Favorites checkbox in the Target Lists' Basic or Advanced Search to
retrieve your favorites or select from your most recent favorites directly from the  .

Favoriting Via List View

Use the following steps to mark records as favorites via the Target Lists list view:

1. Navigate to the Target Lists list view by clicking the Target Lists module tab.
2. Use the Basic or Advanced Search to find the Target List records you wish to

mark as favorites.
3. Mark the star icon on the left of each desired target lists' row.
4. To remove the target list as a favorite, click the star again to revert it to

white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Target Lists detail
view:
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1. Navigate to a target list record's detail view.
2. Click the star icon to the right of the target list's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the target list as a favorite, click the star again to revert it to

white.

 

Last Modified: 09/26/2015 06:25pm

Campaigns

Overview

Sugar's Campaigns module can be used to create and manage email and non-email
marketing and advertisement campaigns for your organization. Email-based
campaigns can be used to send mass emails or a series of newsletter emails to
individuals with whom you have an active or growing relationship. The results of
each campaign are recorded to measure the success of your campaigns.

Campaign Fields

The Campaigns module contains a number of stock fields, which come
out-of-the-box with Sugar. The below definitions are suggested meanings for the
fields, but the fields can be leveraged to best meet your organization's needs.
Users with administrator or developer access have the ability to alter, add, or
remove fields via Admin > Studio. For more information on configuring fields,
please refer to the Studio documentation in the Administration guide.

Field Description
Actual Cost The total cost of the campaign
Assigned To The Sugar user assigned to the

campaign record
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Budget The budgeted amount for the
campaign's cost

Currency The currency of the campaign costs
Description A description or other information about

the campaign
Date Created The date the campaign record was

created
Date Modified The date the campaign record was last

modified
End Date The date the campaign is expected to

end
Expected Cost The expected cost of the campaign
Expected Revenue The expected revenue stemming from

the campaign
Frequency For newsletter-type campaigns, the

frequency the campaign is expected to
be sent

Impressions The expected number of recipient
click-throughs

Name The name of the campaign record
Objective The objective or purpose of the

campaign
Start Date The date the campaign is expected to

start
Status The current status of the campaign 

Note: This field is manually set, not
automatic

Teams The Sugar team(s) assigned to the
campaign

Type The campaign's format or type (e.g.
email, web)

Campaigns Module Tab

The Campaigns module tab is typically located under the More tab on the
navigation bar at the top of any Sugar screen. Depending on your settings, you
may have to click "Show More" in order to see the Campaigns module tab. Click
the tab to access the Campaigns list view. You may also hover on the tab to display
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the Actions, Recently Viewed, and Favorites menus. The Actions menu allows you
to perform important actions within the module. The Recently Viewed menu
displays the campaigns, target lists, and targets you last viewed in the module. The
Favorites menu displays the list of campaigns you most recently marked as
favorites.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Create Campaign (Wizard) Opens the campaign wizard to create a

new campaign
Create Campaign (Classic) Opens the edit view layout to create a

new campaign
View Campaigns Opens the list view layout to search and

display campaigns
View Newsletters Opens the list view layout to search and

display newsletter-type campaigns
Create Email Template Opens the Email Templates edit view

layout to create a new email template
View Email Template Opens the Email Templates list view

layout to search and display email
templates

Set Up Email For users with administrator access,
opens the email setup for campaigns
wizard

View Diagnostics Displays your system's configuration
status for sending email-based
campaigns
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Create Lead Form Opens the Lead Form wizard to
generate a web-to-lead form

If you do not see the Campaigns tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Campaigns module is not a member.
Click the More tab (last tab on navigation bar) then hover on "Filter Menu By"
to check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Campaigns module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Campaigns module in the Hide Modules
list, simply move it to the Display Modules list and save. For more information
on hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Campaigns module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Campaigns
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Prerequisites

There are several key components involved when executing an email or newsletter
campaign in Sugar. Before sending out an email-based campaign, an administrator
must make sure the following items are set up properly:

Outbound Emails : Configure Sugar to send outbound emails via Admin >
Email Settings. For more information on configuring outbound email, please
refer to Set Up Email below or to the Email documentation in the
Administration Guide.
Campaign Batch Size : Specify the number of emails sent per batch via Admin
> Campaign Email Settings. Due to some email providers throttling the
number of emails allowed to be sent at one time, we recommend setting this
to 200 and adjusting as necessary. For more information on configuring the
campaign batch size, please refer to Set Up Email below or to the Email
documentation in the Administration Guide.
Bounce Handling Account : Create the bounce-handling inbox for bounced
campaign emails via Admin > Inbound Email. For more information on
configuring the bounce handling account, please refer to the Email
documentation in the Administration Guide.
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Campaigns Scheduler : Configure the scheduler job that automatically sends
campaign emails via Admin > Schedulers > Run Nightly Mass Email
Campaigns Scheduler. The frequency of this scheduler should be determined
in conjunction with the campaign batch size to ensure you do not exceed
sending limitations imposed by your email provider. For more information on
configuring schedulers, please refer to the Schedulers documentation in the
Administration Guide.
Bounced Emails Scheduler : Configure the scheduler job to process the
bounced campaign emails via Admin > Schedulers > Run Nightly Process
Bounced Campaign Emails Scheduler. For more information on configuring
schedulers, please refer to the Schedulers documentation in the
Administration Guide.
Note: The Run Nightly Mass Email Campaigns and Run Nightly Processed
Bounced Campaign Emails schedulers are configured by default to run every
night on the hour from 2:00 AM to 6:00 AM for the time zone of the admin
user (User Id = 1). For quicker processing of campaign information we
recommend changing both schedulers to run every 10 minutes throughout the
day. Please note that if your email provider throttles the number of emails
allowed to be sent in a given time period, you may need to reduce the
frequency of sending.

Set Up Email

In addition to navigating directly to the email settings on the Administration page,
you can also configure Sugar's email settings for campaigns via the Set Up Email
option in the Campaigns module tab. This launches a wizard that walks through
entering all of the relevant information for email set up. This link is only visible to
administrator users and only needs to be configured once for the Sugar instance.

Use the following steps to configure email settings via the Campaigns module:

1. Hover on the Campaigns module tab and select "Set Up Email".
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2. Enter the appropriate values for your email server. All required fields (e.g.
From Name, From Address, SMTP Server, etc.) are marked with a red
asterisk and must be completed. Please be aware that any values entered
during this step will affect the system-wide email settings located within
Admin > Email Settings.

3. Once the necessary information is entered for the Setup Email page, click
"Next".

 

4. Enter the information for your bounce handling email account in the "New
Mail Account" screen. If you have already configured a bounce handling
account, there will be nothing to populate on this step.

5. Once the necessary information is entered for the New Mail Account page,
click "Next".

 

6. The "Summary" page shows the information entered in the previous steps.
Click "Save" to preserve your changes.
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Campaign Diagnostic Tool

The campaign diagnostic tool enables you to check if all pending administrative
tasks have been completed before you attempt to launch the campaign. We
recommend running this tool well in advance of sending out a campaign to ensure
plenty of time to get any issues resolved before the campaign emails need to be
sent.

Use the following steps to run the campaign diagnostic tool:

1. Hover on the Campaigns module tab and select "View Diagnostics".

 

2. Sugar will check your instance's email and scheduler configuration and
display warnings if additional configuration is necessary. Administrator users
will also see links to appropriate sections of the Administration page to
correct the issues. If you are not an administrator user, please contact your
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administrator to complete these tasks. For more information on these
required elements, please refer to the Prerequisites section above.

 

4. Once all necessary configurations have been completed, click "Re-Check" to

re-run the campaign diagnostic tool. 

Campaign Types

Sugar supports many different types of campaigns. The main types and their
differences are as follows:

Newsletter : A series of mass emails sent to a consistent or growing target list
periodically or on a regular basis. Each newsletter is intended to be managed
on a subscription basis and is normally targeted towards individuals with
whom you have an existing relationship. The Frequency field is only available
for campaigns with the type set to "Newsletter". Recipients opting out of
newsletter-type campaigns are added to that campaign's unsubscription list
but will still be able to receive other campaigns' emails.

Email Campaign : A one-time or series of mass emails sent to a target list.
Email campaigns are typically targeted towards a wide audience with the
intention of lead generation. Recipients opting out of email-type campaigns
have their email address marked as "opt-out" and are prevented from
receiving any future campaign emails.

Non-email based Campaign : A non-email mass marketing effort delivered via
mail, web, radio, television, print, or telesales. These campaigns are not
executed through Sugar, but you can create a campaign record and manually
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update send dates and results for record keeping and to assess return on
investment.

Note : Non-email based campaigns will not display Tracker URLs and Email
Marketing subpanels in the detail view.

Creating Campaigns

There are two primary methods for creating a campaign in Sugar: the Create
Campaign (Classic) option and the Create Campaign (Wizard) option. When using
the classic option, you will create the campaign record then create the required
records in each following subpanel on the campaign's detail view. The wizard
option will guide you through the process of creating the campaign as well as
completing the related tasks. The classic creation option is recommended for
simplicity and empowering users to make later modifications to the campaign.

Creating Via Classic Option

Creating a campaign using the classic method opens the Campaigns edit view
where you may enter the basic campaign information. Use the following steps to
create a campaign via the classic option:

1. Hover on the Campaigns module tab and select "Create Campaign (Classic)".

 

2. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to saving.

3. Once the necessary information is entered, click "Save".
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Once the campaign record has been created, you will progress down the
resulting detail view page to populate the necessary subpanels including Target
List, Tracker URLs (if desired), and Email Marketing.

Creating Via Duplication

You can also create a new campaign by duplicating an existing campaign record.
The duplicate option is useful if the campaign you are creating has similar
information to an existing campaign. When duplicating a campaign, the campaign
data and the related target lists will copy over, but the original campaign's tracker
URLs and Email Marketing records will not be related to the new campaign.

Use the following steps to create a campaign by duplicating an existing campaign
record:

1. Navigate to a campaign record's detail view.
2. Select "Duplicate" from the Actions menu.

 
3. The displayed edit view is pre-populated with the original campaign's values.

Update the necessary fields, then click "Save".

 

Once the campaign record has been created, you will progress down the resulting
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detail view page to populate the necessary subpanels including Target List,
Tracker URLs (if desired), and Email Marketing.

Creating Target Lists

A target list consists of a collection of individuals or organizations you want to
include or exclude in a mass marketing campaign. Target lists can contain any
number and any combination of contacts, leads, targets, users, and accounts. You
have the option to associate existing target lists with your new campaign or to
create target lists during the campaign creation process.

The target list type determines some specific functionality within the campaign.
Target list types are "Default", "Seed", "Suppression List", and "Test". Default- and
seed-type target lists will receive emails when campaigns are sent. Test-type target
lists will receive emails when campaigns are tested.

Sugar will create some target lists for you by default; for example, when selecting
a campaign type of "Newsletter", Sugar automatically generates three target lists
for the campaign: default-type "Subscription List", suppression by ID-type
"Unsubscription List", and test-type "Test List". Please note that these three target
list types are required for the Newsletter campaign. You may add additional target
list types to the campaign as necessary. If you wish to remove the system
generated target list types (e.g. suppression by ID-type "Unsubscription List"),
please keep in mind that you must replace it with the same target list type (e.g.
Suppression List - By Id). For more information about target lists, please refer to
the Target Lists documentation.

Use the following steps to add an existing target list to your campaign via the
Target List subpanel on the Campaign detail view:

1. Navigate to the Target List subpanel.
2. Choose "Select" from the Actions menu.

 

4. Locate and click the name of the desired target list in the resulting pop-up
window. To add several target lists at once, select their checkboxes and click
"Select".
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Creating Tracker URLs

A campaign email may text or image links in addition to the message's text which,
when clicked, open a website, web-to-lead form , or other URL in your recipient's
browser. If you choose to create your links as tracker links, then Sugar will log
your recipients' clicks by assigning each tracker link a unique key and routing the
link through Sugar before loading the final URL in their browser. The
click-through results can be reported on and are visible in the Campaign Status
section of the Campaigns module. For more information on the Campaign Status
page, please refer to the section Campaign Status of this documentation. A specific
type of tracker URL is the opt-out link which allows the recipient to opt out of
receiving your campaign emails instead of directing them to another web location.

Creating Redirect URLs

Redirect tracker URLs can appear as text or images in your campaign email and,
when clicked, will navigate your recipient's browser to the URL of your choice: a
page within your organization's website, a targeted advertisement, or even a
web-to-lead form where they can provide details that will be saved as a Sugar lead
record. For more information on web-to-lead forms, please refer to the Web To
Lead Forms documentation. The power of redirect URLs is that on each click they
pass through your Sugar instance before arriving at their final destination. This
allows the clicks to be tracked by your campaign to provide visibility into how your
recipients are responding to the campaign.

Use the following steps to create a redirect URL via your campaign's detail view:

1. Navigate to the Tracker URLs subpanel.
2. Click the Create button to create a new tracker URL.
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3. Complete the fields as follows. All required fields are marked with a red

asterisk and must be completed:
Tracker Name : Enter an internal name for the tracker URL.
Opt-out Link : Leave this box unchecked.
Tracker URL : Enter the destination URL where recipients will be directed
after clicking the link in the email.

4. Click the Save button to complete creating the tracker URL record.

 

You can now insert this tracker URL into the email template of your choice. For
more information on adding redirect URL links to your template, please refer to
the Create Email Template section of this documentation.

Creating Opt-out Links

You can create an opt-out tracker URL to embed an "Unsubscribe" link that
recipients may click if they do not wish to receive your campaign. If an opt-out link
is not included in the email template, Sugar will add a default opt-out link to the
bottom of your campaign email. When targets click on the Opt-out link, Sugar logs
the action for your records and the target recieves a message stating they have
elected to opt out of receiving emails.

Note : The message returned to targets can be modified by changing the
LBL_ELECTED_TO_OPTOUT label via Admin > Studio. For more information on
how to modify labels, please refer to the Studio documentation in the
Administration guide.

For a newsletter-type campaign, they will also be added to the suppression-type
list which prevents them receiving emails from that particular campaign in the
future. In the case of an email-type campaign, their Sugar record's email address is
marked to prevent them receiving emails from any campaign. You must manually
add your opt-out link by inserting the tracker URL into the email template via the
Email Marketing record.
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Note : Opt-out links for newsletters behave differently than other campaign types.
When a target clicks an opt-out for a newsletter type campaign they are removed
only from that campaign that sent the email. They are still able to receive email
from other campaigns.

Use the following steps to create an opt-out link via your campaign's detail view:

1. Navigate to the Tracker URLs subpanel.
2. Click the Create button to create a new tracker URL.

 
3. Complete the fields as follows. All required fields are marked with a red

asterisk and must be completed:

Tracker Name : Enter an internal name for the tracker URL.
Opt-out Link : Mark the checkbox so that this link will be used to allow
recipients to opt out.
Tracker URL : This is defaulted and disabled for opt-out links.

 
Click the Save button to complete creating the tracker URL record.

You can now insert this tracker URL into the email template of your choice. For
more information on adding an opt-out link to your template, please refer to the 
Creating Email Templates section of this documentation.

Creating Email Marketing Records

When you create an email campaign, you must also create an Email Marketing
record that specifies the body of the message in the form of an email template,
which bounce handling account will catch automated replies from invalid email
addresses, and which target lists will receive this particular mass email of your
campaign.

When you are sending more than once from a single campaign, both
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newsletter-type and email-type campaigns will need a new Email Marketing for
each subsequent send. For example, a monthly newsletter campaign will have 12
Email Marketing records created in a year, each one with a different email
template with the same target lists. Or, if you wish to send an introductory email to
all of your newest prospects every 3 months, this email-type campaign will have 4
Email Marketing records created in a year, each one using the same email
template but different target lists. Sugar will not allow the same Email Marketing
record to be sent to a recipient more than once.

Use the following steps to create an Email Marketing record via your campaign's
detail view:

1. Click the Create button to create a new email marketing record.

 
2. Complete the fields as follows. All required fields are marked with a red

asterisk and must be completed:

Name : Enter an internal name for the email marketing record.
Status : Select "Active" from the dropdown. Only active Email Marketing
records may be sent.
Start Date & Time : Enter a date and time when the emails needs to begin
being sent. This start date and time must have passed before the campaign
may be queued for delivery.
Email Template : Select or create an email template. For more information on
creating an email template, please refer to the Creating Email Templates
section of this documentation.
Send This Message To : Check this box to send this email to all target lists
that are associated with this campaign or select individual target lists via the
multiselect box below.

 
Use Mailbox : Select the bounce handling account that will catch automated
replies from invalid email addresses.

 730 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Campaigns/#Creating_Email_Templates


 

From Name : This will automatically populate based on the selected bounce
handling account. You can enter a different name that will appear as the
email's From name.
From Email Address : This will automatically populate based on the selected
bounce handling account. You can override the field to enter a different email
address that the campaign will be sent from. Please note that your system
outbound email account may need to grant specific 'Send As' permissions if
you wish to use an From email address that differs from the address set up in
Admin > Email Settings. If these permissions are not granted, emails may fail
to send or the authenticated email account will be imposed in place of the
address depending on your mail server settings. Also, if the From address
entered is not configured as a bounce handling email address in Sugar, you
will not see the results of the bounced emails in your campaign's Status page .
"Reply-to" Name : This will automatically populate if it is provided on the
bounce handling account. You can enter a different name that will appear as
the email's Reply-to name.
"Reply-to" Address : This will automatically populate if it is provided on the
bounce handling account. You can enter a different address that will appear
as the email's Reply-to address.
Click the Save button to complete the creation of the Email Marketing record.

 

Creating Email Templates

Email templates contain the design and content of the emails your campaign will
send. Placeholder variables can be added to the template for field values like the
target name so you can personalize the email to your recipients. Creating an email
template through the Campaigns module rather than via the Emails module sets
the template's type to "Campaign" and allows you to add redirect and opt-out
tracker URLs.

Use the following steps to create an email template from the Email Marketing
record:

1. While creating or editing your campaign's Email Marketing record, click
"Create" below the Email Template dropdown.
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2. Enter the appropriate values for the fields in the pop-up window. The

required field is marked with a red asterisk and must be completed.
Name : Enter an internal name for the email template.
Teams : Select the Sugar team(s) assigned to the email template.
Type : This will automatically populate as "Campaign".
Description : Enter a description or other information about the
template.
Subject : Enter the subject of the emails that will be sent.
Body : Enter the body of the emails that will be sent.

3. Using the TinyMCE functions, add simple formatting to your email's content.
For more advanced customization you can click the HTML button in the top
left to access and edit the generated HTML code.
Note: Only inline CSS may be used in email templates. Inline CSS is a method
of using CSS within your HTML content instead of storing it in an external
CSS file. So, every HTML element must be styled using inline CSS by virtue of

the "style=" declaration. 
4. Click "Save" to preserve your changes to the email template.

 

Inserting Variables

When constructing the subject and body of your email, Sugar allows you to insert
variables, or placeholders, into the template that will be populated with the
record's information for that variable. Use the following steps to insert a variable
for the recipient's first name into the template:

1. Click to place your cursor on the location in the subject or body where the
recipient's first name should appear.
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2. In the Insert Variable row, the first dropdown defaults to

"Contact/Lead/Target" to specify you'd like to insert a field from the
associated person-type recipient's record.

3. Set the second dropdown to the desired field from the modules selected in the
first dropdown. For our example, select "First Name".

 
4. Click "Insert" to insert the generated variable name to your subject or body at

your cursor's location.

 

Inserting Tracker URLs

When constructing the body of your email, Sugar also allows you to insert redirect
or opt-out tracker URLs. Use the following steps to insert a tracker URL or opt-out
link into the template.

1. Click to place your cursor on the location in the body where the link should
appear.
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2. Select the link you wish to add from the Insert Tracker URL dropdown. For

more information on creating tracker URLs, please refer to the Creating
Tracker URLs section.

 
3. Type the text you wish to appear as a link between the curly braces in the

following text box.

 
4. Click the Insert URL Reference button to place the link in the body of the

email at the location of your cursor.

 

Testing Campaigns

Before you launch an email or newsletter campaign, it is recommended that you
perform tests to check how different email clients display the campaign message.
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A test-type target list must be selected under the Target Lists subpanel as well as
in the Email Marketing record in order to test the campaign.

Note that in test mode, the system disables your suppression lists allowing the
campaign message to be sent to targets on your suppression-type target lists. The
system also disables checks for duplicate email addresses thereby allowing users
to send a message multiple times to the same recipients.

Use the following steps to test an email-based campaign:

1. Navigate to a campaign record's detail view.
2. Select "Send Test" from the Actions menu.

 
3. Select the Email Marketing record and test target list combination that you

would like to test and click "Send".
Note: If an Email Marketing record does not have a test-type target list
associated to it, then the Targeted Lists section will remain empty and no test
emails will be sent.

 

Once the campaign testing is complete be sure to click the Delete Test Entries
button on the Campaign Status page of the campaign before sending the campaign
to your real recipients. If this is not done, then the statistics from the tests will be
included in the campaign's final totals.

Sending Campaigns

Once the Sugar email settings are configured and your campaign has been tested
successfully, you are now ready to send the campaign. Upon sending a campaign,
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the emails are queued to be sent out in intervals. The administrator can configure
how many emails are sent and when to send them. For more information on the
relevant configurations, please refer to the Prerequisites section.

Use the following steps to send an email-based campaign:

1. Navigate to a campaign record's detail view.
2. Select "Send Emails" from the Actions menu.

 
3. Select the Email Marketing record and target list combination that you would

like to test and click "Send".
Note: If the email marketing record does not have a default-type target list
associated to it, then the Targeted Lists section will remain empty and no
emails will be sent.

 

The specified start date and time on the email marketing record must have passed
before the campaign will be queued for delivery. Once the emails enter the queue
in Admin > Email Queue, the relevant scheduler will send the emails in set batches
on an interval configured as configured by an administrator. For more information
on the Email Queue, please refer to the Email documentation in the Administration
guide. For more information on the schedulers used by the Campaigns module,
please refer to the Prerequisites section.

Viewing Campaign Status

After you launch a campaign, you can view its results on the Campaign Status page
to gauge its impact and progress. The Campaign Status page includes several
subpanels, which display information such as the recipients who viewed the
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message, the recipients who clicked a tracker URL in the email, as well as how
many leads and contacts were created from the campaign. This enables you to
evaluate the effectiveness of the campaign.

Use the following steps to view the Campaign Status page:

1. Navigate to a campaign record's detail view.
2. Click the View Status button.

 

Campaign Status Chart

This is a visual representation of the counts of your recipients' activities which are
also detailed in the below subpanels. Use the dropdown to view a particular Email
Marketing record's data or choose "--None--" to view the cumulative results of all
of this campaign's sends.

 

Message Queue Subpanel

The Message Queue subpanel shows the campaign emails waiting to be sent in the
email queue. The emails will remain in the queue until the start time of the Email
Marketing record has passed and the scheduler picks and sends them in batches
as specified in Admin > Campaign Email Settings. For more information on batch
size, please refer to the Prerequisites section. For more information on monitoring
this queue, please refer to the Email documentation of the Administration guide.
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Campaign Response Subpanels

The success of a campaign can be determined by analyzing the response statistics.
Knowing how many of your targets saw your email, clicked its links, and became
leads or contacts, for example, can provide insight for your campaign strategy.

 
The following subpanels measure different aspects of your recipients' responses to
the campaign or a specific send of the campaign based on your selection in the
"Filter Chart By" dropdown at the top of the page:

Message Sent/Attempted : The list of campaign emails that were sent out to
targets.
Viewed Message : The list of targets who viewed the emails that were
delivered. Sugar includes a very small, invisible image in each email. Each
time the recipient downloads this image, Sugar records that they viewed the
email.
Click-thru Link : The list of targets who clicked on a redirect tracker URL in
the email. This does not include opt-outs. For more information on redirect
tracker URLs, please refer to the Creating Tracker URLs section.
Leads Created : The list of leads who have been generated from a web-to-lead
form assigned to this campaign record.
Contacts Created : The list of contacts who have been converted from a lead
generated from a web-to-lead form assigned to this campaign record.
Bounced Messages, Invalid Email : The list of campaign emails that bounced
back due to invalid email addresses.
Bounced Message, Other : The list of campaign emails that failed to send
despite having valid email addresses. After six failed attempts, these
messages will be removed from the queue.
Opted Out : The list of targets who chose to opt out of receiving campaign
emails by clicking the opt-out link.
Note : Opt-out links for newsletter-type and email-type campaigns behave
differently. When a target clicks an opt-out for a newsletter-type campaign,
they are prevented from receiving future emails from that specific campaign
by being added to the campaign's suppression-type list. When clicking an
opt-out for an email-type campaign, they are prevented from receiving future
emails from any campaign by having their email address marked on their
Sugar record.
Suppressed by Email Address or domain : The list of email addresses which
were not sent the campaign email because they had previously opted out,
were a member of a suppression list, or were invalid addresses.
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Note : If you do not see the campaign response subpanels, the administrator may
have disabled the Campaign Log subpanels for your entire Sugar instance. Reach
out to your Sugar administrator to have the Campaign Log subpanels displayed.
For more information on displaying and hiding subpanels throughout Sugar, please
refer to the Developer Tools documentation in the Administration guide.

Campaign Results Subpanels

The last three subpanels can be used to demonstrate the broader effects of the
campaign by showing what new accounts, leads, and opportunities were generated
as a result of the effort.

 

Accounts : The list of accounts that are related to this campaign record either
through lead generation and then conversion or manually related through the
Campaign field on the account's edit view.
Leads : The list of leads that are related to this campaign record either
through lead generation or manually related through the Campaign field on
the lead's edit view.
Opportunities : The list of opportunities that are related to this campaign
record either through lead generation and then conversion or manually
related through the Campaign field on the opportunity's edit view.

Viewing Campaign ROI

The return on investment page displays the actual revenue you earned through the
campaign versus the estimated expected revenue. It also reflects the actual cost
you incurred by executing the campaign versus the budget that you set for the
campaign. The budget, actual cost, and expected revenue amounts entered in the
campaign overview screen are displayed as bars in the campaign return on
investment chart. The actual revenue is calculated from of the campaign's related
opportunities that have a sales stage of "Closed Won".
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Use the following steps to view a campaign's ROI:

1. Navigate to a campaign record's detail view.
2. Click the View ROI button.

 

Viewing Campaigns

There are various options available for viewing campaign records in Sugar
including via Campaigns list view, Campaigns detail view, Campaigns Recently
Viewed menu, dashlets, and reports. Please note that you will only be able to see
campaign records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Viewing Via List View

The Campaigns list view displays all campaign records meeting the current search
criteria. To access the list view, simply click the Campaigns tab. While list view
shows key campaign fields, you can click the campaign's name to open the record
in detail view. For more information on viewing campaigns via list view, please
refer to the Campaigns List View section.

Viewing Via Detail View

The Campaigns detail view displays thorough campaign information including all
campaign fields followed by subpanels of the campaign's related records. The
detail view can be reached by clicking a contact record's link from anywhere in the
application including from the Campaigns list view. For more information on
viewing campaigns via detail view, please refer to the Campaigns Detail View
section.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which campaigns you have recently viewed.
Hover on the Campaigns Module Tab to see a list of your most recently viewed
campaigns and click each name to open the campaign in detail view.
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Viewing Via Dashlets

The Home page displays a collection of Sugar dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view campaign
information in campaign-based dashlets such as "Top Campaigns" as well as access
campaign detail views by clicking a campaign name in any dashlet. For more
information on using dashlets and viewing campaign records via dashlets, please
refer to the Modules section of the Home documentation.

 

Viewing Via Reports

Users with access to the Reports module have the option to build, generate, and
manage various reports in Sugar. You can generate reports to gather key data
regarding your campaigns plus information for related records. You also have the
option to filter the report based on the campaign and related module(s) to only
include records that is of importance. The display columns will only show data for
fields (e.g. campaign name, type, related leads etc.) that you choose specifically
when creating the report. Once the report is run, you will be able to view the
campaign record's detail view by clicking the campaign's name in the report
results. Please note that you can only click into campaign records for Rows and
Columns Report and Summation Report with Details Report type. The other two
report types (Summation Report, Matrix Report) are summation reports and do not
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include display columns with hyperlinks (e.g. Campaign Name) to allow for
navigating to campaign record detail views. For more information on viewing
campaign records via the Reports module, please refer to the

For more information on viewing campaign records via the Reports module, please
refer to the Reports documentation.

Searching Campaigns

The Campaigns list view includes a Basic and Advanced Search to help you find
your records easily and effectively in a module-specific manner. Once the search is
performed, the relevant search results will be displayed in the Campaigns list view
below. Global Search allows users to search for information across their entire
Sugar database as opposed to restricting search within a specific module. Please
note that Sugar automatically appends the wildcard character (%) to the end of
your search phrase. This allows the system to retrieve all records that start with
the keyword entered in the search. If you would like to broaden the search, you
can use the wildcard at the beginning of your text as well (e.g. %offer). This will
pull up any record that has the word "offer" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in the Basic Search panel have the following
functions:

Search : Click the Search button or hit Return/Enter key to perform the
search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.
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When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a campaign's name, Sugar will only return campaign
records with a matching name that are assigned to you. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all campaign records to which you have access, simply click "Clear" and
then "Search" to perform a blank search with no filters. Please note that you will
only be able to see campaign records as allowed by your team membership, user
access type, and assigned roles. For more information on teams and roles, please
refer to the Team Management and Role Management documentation in the
Administration guide.

Administrators can configure what fields appear on the Campaigns Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.
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When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a campaign's name to search, Sugar will only return
campaign records with a matching name that you have marked as favorites. When
searching by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar
will return records matching any of these selections. Once the search completes,
the relevant results will populate in the list view below the search panel. To see all
campaign records to which you have access, simply click "Clear" and then "Search"
to perform a blank search with no filters. Please note that you will only be able to
see campaign records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.
Administrators can configure what fields appear on the Campaigns Advanced
Search via Admin > Studio. For more information on editing layouts, please refer
to the

Administrators can configure what fields appear on the Campaigns Advanced
Search via Admin > Studio. For more information on editing layouts, please refer
to the Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.
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To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the

For more information on using and configuring Global Search, please refer to the 
section of the Search documentation. Regular Sugar users can configure some
aspects of global search such as what modules are displayed in the search results.
For more information on configuring your Global Search, please refer to the 
Search documentation. Administrators can control additional elements of global
search via Admin > Search and Admin > Studio. For more information on
administrator configuration of Global Search, please refer to the Studio
documentation as well as the Search section of the System documentation in the
Administration guide.

Campaigns List View

The Campaigns list view displays all campaign records meeting the current search
criteria to which your user has access. You can view the basic details of each
campaign within the field columns. Please note that you will only be able to see
campaign records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.
You have the option to change what fields are displayed in list view by configuring
your layout options in the Campaigns Advanced Search. For more information on
configuring your list view, please refer to the

You have the option to change what fields are displayed in list view by configuring
your layout options in the Campaigns Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing list view layouts, please refer to the Studio documentation
in the Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
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just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on campaign records directly from the list view by
first selecting the desired records. To select individual campaign records on the
Campaigns list view, mark the checkbox on the left of each row. To select or
deselect multiple campaign records on the list view, use the options in the
checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of campaign
results.
Select All : Selects all records in the current search results across all pages of
campaign results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.
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The options in the actions menu allow you to perform the following operations:

Delete one or more campaigns at a time Mass update one or more campaigns at a
time Export one or more campaigns to a CSV file

Menu Item Description
Delete Delete one or more campaigns at a time
Mass Update Mass update one or more campaigns at

a time
Export Export one or more campaigns to a CSV

file

Favorite Designation

Users have the option to mark campaign records as favorites via the list view as
well as the detail view. This allows users to designate records that are important
or will be viewed often as they can easily be accessed via search or from the
Campaigns module tab. In the Campaigns list view, the star on the left of each
campaign's row is yellow once marked to indicate a favorite campaign. For more
information on marking records as favorites, please refer to the Favoriting
Campaigns section of this documentation.

 

Campaign Status

Each campaign's status page may be accessed directly from the list view by
clicking the chart icon on the right of each list view row. For more information on
the campaign status page, please refer to the Campaign Status section of this
documentation.
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Campaign Wizard

The Campaign Wizard may be directly accessed from the list view by clicking the
wand icon on the right far right of each list view row. For more information
regarding the Campaign Wizard, please refer to the Using the Campaign Wizard
section of this documentation.

 

More Information

Additional details for each campaign can be viewed by clicking the "i" to the far
right of each list view row. This provides users a quick view of additional campaign
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Start Date, Description, and Objective fields by
default. The list of fields appearing here may only be configured through a
code-level customization.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Campaigns Detail View

The Campaigns detail view displays thorough campaign information including all
campaign fields which are grouped by default into the Overview and Other panels.

 748 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Campaigns/#Using_the_Campaign_Wizard
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Search


 

You can also view a campaign's related records which appear in subpanels beneath
the campaign fields. The detail view can be reached by clicking a campaign
record's link from anywhere in the application including from the Campaigns list
view. Please note that you will only be able to view a campaign record according to
your team membership, user type, and role restrictions. For more information on
teams and roles, please refer to the

Please note that you will only be able to view a campaign record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Actions Menu

The actions menu on the top left of each campaign's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

 

The options in the actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this campaign
Duplicate Duplicate this campaign
Delete Delete this campaign
Send Test Send test emails for this campaign
Send Emails Send all emails for this campaign
Mail Merge Perform a mail merge
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Mark As Sent Mark a non-email campaign as being
sent

View Change Log View a record of changes to this
campaign

Favorite Designation

Users have the option to mark campaign records as a favorite via the detail view as
well as the list view. This allows users to group records that are important or will
be viewed often as they can easily be accessed via search or from the Contacts
module tab. In the Campaigns detail view, the star on the right of the contact's
name is yellow once marked to indicate a favorite contact. For more information on
marking records as favorites, please refer to the Favoriting Via Detail View section
of this documentation.

 

Next or Previous Record

On the upper right of the Campaigns detail view, there are two buttons that allow
you to page through each campaign in the Campaigns list view's current search
results. Clicking the Previous button displays the previous campaign of the current
search results while clicking the Next button displays the next campaign of the
current search results. The text in between shows which campaign result you are
currently viewing within the total number of current results.

 

Related Record Subpanels

Every campaign record's detail view will display subpanels which list related
records from other modules. Users with administrator or developer access have
the ability to change the fields (e.g. Name, Assigned User, etc.) and labels of each
subpanel by configuring the layout via Admin > Studio to provide visibility to the
most important fields. For more information on modifying subpanels, please refer
to the Studio documentation in the Administration guide.
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Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the campaign, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the campaign, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To edit the campaign's related record, choose "Edit" on the far right of the
record's row.
To delete the campaign's relationship to a record, choose "Remove" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

 

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Editing Campaigns

Campaigns may be edited at any time to update or add information to the record.
You can make changes to existing campaign records via the Campaigns edit view.
Edit view is available within the Campaigns module and includes all of the
Campaign fields you should need.
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Please note that your ability to edit campaigns in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Edit
options.

Administrators in Sugar may configure the Campaigns edit view via Admin >
Studio. For more information on configuring these layouts, please refer to the 
Studio documentation in the Administration guide.

Editing Via Detail View

You can edit campaigns via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary field, then
click "Save" to preserve your changes.

 

Editing Via List View

You can edit campaigns via the list view by clicking the pencil icon to the left of
each campaign's name. A pop-up window will open with the edit view layout.
Update the necessary fields, then click "Save" to preserve your changes.

 

 752 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Campaigns/#Campaigns_Detail_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Campaigns/#Campaigns_List_View


 

Editing Via Reports

Sugar reports also allow you to edit a campaign record by clicking on the pencil
icon next to a campaign's name. This opens a pop-up window with the edit view
layout. Update the necessary fields, then click "Save" to preserve your changes.

 

Please note that you may only directly edit campaigns from Rows and
Columns-type or Summation with Details-type reports as Summation and
Matrix-type reports do not include the pencil icon. For more information on
reports, please refer to the Reports documentation.

Deleting Campaigns

If a campaign record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Campaigns detail view or list
view. Deleting via the detail view allows you to delete a single record while the list
view allows for mass deleting multiple records at once. Deleting campaign records
will not delete the related records and will only remove the relationship, so you
may wish to also delete any related records to avoid orphaned records.

Please note that your ability to delete campaigns may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Delete options.

Deleting Via Detail View

Use the following steps to delete a campaign record via the detail view:

1. Navigate to a campaign record's detail view.
2. Select "Delete" from the Actions menu.
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3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more campaign records via the list view:

1. Navigate to the Campaigns list view by clicking the Campaigns module tab.
2. Use the Basic or Advanced Search to find the campaign records you wish to

delete.
3. Select the desired campaign records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Exporting Campaigns

Sugar's Export option allows users to download all fields for the selected
campaigns to their computers as a .CSV (comma-separated values) file. This may
be useful when needing to use campaign data with other software such as
Microsoft Excel. Due to PHP memory limitations on the server, there may be
occasions when the application times out while exporting a large number of
campaign records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches. Campaigns may be exported
from the Campaigns list view by selecting "Export" from the Actions menu. Users
with access to the Reports module also have the option of creating or accessing
reports containing specifically chosen fields for campaigns and their related
record(s). Please note that only Rows and Columns-type reports have the ability to
be exported. For more information on exporting records in Sugar, please refer to
the
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Campaigns may be exported from the Campaigns list view by selecting "Export"
from the Actions menu. Users with access to the Reports module also have the
option of creating or accessing reports containing specifically chosen fields for
campaigns and their related record(s). Please note that only Rows and
Columns-type reports have the ability to be exported. For more information on
exporting records in Sugar, please refer to the Export documentation.

 
Please note that your ability to export campaigns from Sugar may be restricted by
a role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Campaigns

Mass Updating allows users to make the same change to multiple campaign
records at once from the Campaigns list view. Users with administrator or
developer access can control which fields are available to change during mass
update via Admin > Studio. Currently, only fields with the data type of date,
datetime, dropdown, multiselect, and radio may be altered during a mass update.
For more information on configuring mass update, please refer to the Studio
documentation in the Administration guide. Due to the PHP memory limitations on
the server, there may be occasions when the application times out while mass
updating a large number of campaign records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches. 

Please note that your ability to mass update campaigns may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update campaign records from the list view:

1. Navigate to the Campaigns list view by clicking the Campaigns module tab.
2. Use the list view's Basic or Advanced Search to find campaigns you wish to

modify.
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3. Select the desired campaigns individually or using the checkbox dropdown's
options.

4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here

to any existing team assignments. 
6. Click "Update" to save the changes to all of the currently selected campaign

records.

Favoriting Campaigns

Each Sugar user has the option to designate their own favorite campaigns which
are important or will be viewed often. Favorite records can then be easily be
accessed via search or from the Campaigns module tab. Once records are marked
as favorites, use the My Favorites checkbox in the Campaigns Basic or Advanced
Search to retrieve your favorites or select from your most recent favorites directly
from the Campaigns module tab .

Favoriting Via List View

Use the following steps to mark records as favorites via the Campaigns list view:

1. Navigate to the Campaigns list view by clicking the Campaigns module tab.
2. Use the Basic or Advanced Search to find the campaign records you wish to
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mark as favorites.
3. Click the star icon on the left of each desired campaign's row.
4. To remove the campaign as a favorite, click the star again to revert it to

white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Campaigns detail view:

1. Navigate to a campaign record's detail view.
2. Click the star icon to the right of the campaign's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the campaign as a favorite, click the star again to revert it to

white.

 

Marking Campaigns As Sent

When launching a non-email campaign such as a telesales or mail campaign Sugar
will need to be told that the campaign has been sent since the sending is
performed outside of the application. Once you mark the campaign as sent, the
Campaigns subpanel on the detail view of each member of the campaign's target
populates with a row indicating and activity of "Message Sent" to indicate that the
campaign material was sent to that individual. The Campaign's status page will
then display these recipients in the Message Sent/Attempted subpanel. For more
information on the Campaigns status page, please refer to the Viewing Campaign
Status section of this documentation.

Use the following steps to mark a campaign as sent via the Campaigns detail view :
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1. Navigate to a campaign record's detail view.
2. Select "Mark As Sent" from the actions menu.

 

Viewing Campaign Change Logs

Changes made to each campaign record are tracked over time, and users are able
to view the history of changes via the change log in each campaign's detail view.
To view the change log, navigate to a campaign in detail view and select "View
Change Log" from the Actions menu. Please note that only fields marked as "Audit"
in Admin > Studio will be displayed in the change log. For more information on
designating for audit, please refer to the Studio documentation in the
Administration guide.

 

Using the Campaign Wizard

You can use the Campaign Wizard to guide you through the process of creating a
campaign, however, it is recommended to create and modify campaigns using the
classic interface instead. For instructions on creating and editing campaign
records using the classic interface, please refer to the Creating Campaigns and 
Editing Campaigns sections of this documentation.

Last Modified: 01/13/2017 11:57am
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Mail Merge

Overview

Sugar's Mail Merge module allows users to combine data from Sugar with a
message to mail to clients or customers. This simplifies the process of mailing
letters or marketing information to many different addresses.
Mail merge is disabled by default in Sugar, but can be enabled through Admin >
System Settings. The mail merge options will not be accessible until an
administrator enables the mail merge feature. For more information on how to
enable or disable mail merge, please refer to the Mail Merge section of the System
documentation in the Administration Guide.
Mail merge can also be enabled or disabled for a specific user via the user profile.
For more information on how to enable or disable mail merge from your user
profile, please refer to the User Settings section of the Getting Started
documentation in the Application guide.
There are various ways you can initiate a mail merge in Sugar such as via the
Documents or Knowledge Base module tabs, certain module's list views, and from
the Sugar Plug-in for Microsoft Word. Once the mail merge is created, you can
download and print the mail merge file using the Sugar Plug-in for Microsoft Word.
Mail merge is available in the following modules:

Accounts
Campaigns
Cases
Contacts
Leads
Opportunities

This documentation will cover how to use the Mail Merge module as well as the
various actions and options available from within the module.

Creating Mail Merge Templates

Mail merge templates are required to perform a mail merge. The template will
contain the content for the mail merge which can include variables from modules
within Sugar. When you perform the mail merge, the content from the template
will be repeated for each record selected and the variables will be replaced with
the data from that record. Templates are created with the Sugar Plug-in for
Microsoft Word and are stored in the Documents module in Sugar.
For more information on how to create a mail merge template through the Sugar
Plug-in for Microsoft Word, please refer to the Creating a Mail Merge Template
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section in the Sugar Plug-in for MS Word User Guide.
The template document must be stored as a Document Type of Mail Merge and
specified as a Template in order to be used by the Mail Merge. For more
information on creating or modifying records in the Document module, please refer
to the Documents documentation in the Application guide.

Accessing Mail Merge

Mail merge can be accessed via the following ways through Sugar:

Method Modules
Module Tab Documents

Knowledge Base
List View Action Accounts

Cases
Contacts
Leads
Opportunities

Detail Action View Campaigns

Accessing Via Module Tab

When mail merge is enabled, the Documents and Knowledge Base modules will
have a Mail Merge option available in their module tabs. Click "Mail Merge" from
either of these module tabs to access mail merge.

 
If you do not see the Documents or Knowledge Base module tabs in Sugar, please
check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the modules are not members. Click the
More tab (last tab on navigation bar) then hover on "Filter Menu By" to check
how the navigation bar is grouped. For more information on tab grouping,
please refer to the User Interface documentation.
The modules may be marked as hidden in your user preferences which will
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prevent the module tab from being displayed. Navigate to your user profile
(upper right of Sugar), click the Advanced tab, and check the Layout Options
section. If you see the module in the Hide Modules list, simply move it to the
Display Modules list and save. For more information on hiding and displaying
modules, please refer to the Layout Options section of the Getting Started
documentation.
The administrator may have disabled the modules for your entire Sugar
instance. Reach out to your Sugar administrator to have the module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Accessing Via List View

When mail merge is enabled, the Accounts, Cases, Contacts, Leads, and
Opportunity modules will have a Mail Merge option available in their list view
action menu. From the desired module, follow these steps to perform a mail
merge:

1. Use the Basic or Advanced Search to find the records you wish to send a mail
merge to.

 
2. Select the desired records individually or using the checkbox dropdown's

options. The records selected here will be the ones to receive the mail merge.

 
3. Choose "Mail Merge" from the Actions menu.
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Administrator users can change the action items to be displayed as separate
buttons instead of a dropdown menu via Admin > System Settings. For more
information on configuring the actions menu, please refer to the System
documentation in the Administration guide.
For more information on how to use the list view to select the records, please refer
to the List View section of the desired module's documentation.

Accessing Via Campaigns

When mail merge is enabled, the Campaigns module will have a Mail Merge option
available in the detail view action menu. The mail merge will allow you to select
any Contacts, Leads, Targets (Prospects), or Users from the target lists on the
campaign. From the desired campaign, select "Mail Merge" from the actions menu.

 
Administrator users can change the action items to be displayed as separate
buttons instead of a dropdown menu via Admin > System Settings. For more
information on configuring the actions menu, please refer to the System
documentation in the Administration guide.
For more information on how to setup and configure a campaign, please refer to
the Campaigns documentation in the Application guide.

Performing a Mail Merge

A mail merge can be initiated from within Sugar or from the Sugar Plug-in for
Microsoft Word. Performing a mail merge from Sugar still requires the Sugar
Plug-in for Microsoft Word to be used to finish the mail merge.
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Performing From Sugar

Access the mail merge wizard from any of the methods listed in the Accessing
Mail Merge section.
Use the following steps to run a mail merge from the Contacts module's list view in
Sugar:

1. On Step 1 of the mail merge, select the template to use for the mail merge
and click "Next".

 
The selected module and the amount of records included in the mail merge
are shown on this step.

2. Step 2 allows you to change the records selected for the mail merge.
1. Enter criteria into the search box and click "Search" to locate records to

add to the mail merge.

 
2. Select any records in the Available panel and click the right arrow to

move them to the Selected panel to include them in the mail merge.
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3. Select any records in the Selected panel and click the left arrow to move

them to the Available panel to exclude them in the mail merge.

 
Note : When performing a mail merge from a campaign, there is a
dropdown to select which target type to perform a search under.
Click "Next" to continue.

3. Step 3 allows you to review before completing the mail merge. If the
information looks correct, click "Begin Merge".
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4. Sugar will then prompt you to either open or save a Microsoft Word

document. When that document is opened, the Sugar Plug-in for Microsoft
Word will access your instance to fill in any variables in the template and will
generate a page for each record selected.

Performing From MS Word

You can also perform a mail merge directly from the Sugar Plug-in for Microsoft
Word. You must download the mail merge template document to your computer or
create a new one in Microsoft Word. For more information on how to perform a
mail merge from Microsoft Word, please refer to the Performing a Mail Merge
From MS Word section in the Sugar Plug-in for MS Word User Guide. 

Last Modified: 11/18/2015 03:08am

Web-To-Lead Forms

Overview

Sugar provides a simple way to allow visitors to your website or other online
locations to become leads in your Sugar instance. You can generate a web-to-lead
form in Sugar and place the form on an external website. When a visitor to your
site completes and submits the form, their information is entered into Sugar as a
new lead record. You can use this lead information to generate more opportunities
for your organization.

Creating Web-To-Lead Forms

The Sugar Campaigns module contains a lead form wizard to assist in generating a
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custom web-to-lead form. Use the following steps to create a web-to-lead form via
the Campaigns module:

1. Hover on the Campaigns module and select "Create Lead Form".

 
2. Click and drag the desired fields from the Available Fields list to the Lead

Form (First Column) or Lead Form (Second Column) lists.
Note: You can also choose to add all fields to either column by clicking
the Add All Fields button.

3. All required fields marked with an asterisk must be added to a column on the
lead form prior to continuing.

4. Once the fields you desire have been moved to the appropriate columns, click
the Next button to continue.
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5. Enter appropriate values for the fields in the next page of the wizard:

Form Header : This will be the title at the top of your form. A generic
title has been populated; modify or remove this to suit your needs.
Form Description : This will be a brief description of the form and will
show below the form header, but before the form begins. A generic
description has been populated; modify or remove this to suit your
needs.
Submit Button Label : Enter in the label for the button that will be used
to complete the form. Submit is the default; you may change this to say
"Sign Up", "Save", "Complete", or any other label to suit your needs.
Post URL : This is the location the form will send the data entered and is
defaulted to your instance of Sugar. Select "Edit Post URL" to edit this
field.

Note: If you change this location to be anything other than your
Sugar instance then a lead will not be generated when the form is
completed.

Redirect URL : This is the location your visitors will be directed to after
completing the form. You may enter the location of your corporate
website, a custom "Thanks for signing up" page, or any URL to suit your
needs.

Note: Leaving this field empty will display a message that says:
"Thank You For Your Submission".

Related Campaign : Use the Select button to enter an existing campaign
that is related to this lead form. Leads generated from this form will
automatically be associated to this campaign.
Assigned to : Use the Select button to enter the user to be assigned to
the new lead record when the form is submitted. By default, this field is
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populated with the current user who is generating the form.
Team : Enter the name of the team that is allowed access to the leads
generated from this form. To change the primary team, either enter the
team name here or select the team. By default the primary team selected
will be Global. More than one team can be assigned simultaneously. For
more information on teams, please refer to the Team Management
documentation.
Form Footer : The form footer displays the text entered here below the
form inputs, but before the submit button.

6. All required fields are marked with a red asterisk and must be completed
prior to continuing.

7. Once the necessary information is entered, click "Generate Form".
8. Sugar then generates the HTML needed for your form and shows you a

preview in a TinyMCE editor. At this point you can continue to add text and
images and change the layout of your form.

9. For more advanced customizations, you can click on the HTML button in the
top left to access and edit the generated HTML code.

10. Once any additional changes have been completed, click "Save Web To Lead
Form".

 

Saving Web-To-Lead Forms

Since your web-to-lead form will be hosted outside of Sugar, you will need to save
the generated HTML to a different hosting location. Your generated form will not
be saved or accessible through Sugar after leaving this screen. If you need to add
or remove fields to your form after generation, you will have to go through the
steps to generate a new form.
Use the following steps to save your generated web-to-lead form:

1. You may download the generated HTML file by clicking on the Web to Lead
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Form link.
2. This will download the HTML file to your local computer. Simply transfer this

file to the final hosting destination.
3. Alternatively, you may copy the HTML directly out of the text box on this

screen and add it to a preexisting HTML file of your choosing.

 
4. Once the web-to-lead form is accessible to your potential customers, include a

link to the form on your corporate website, social media websites, or add as a
tracker URL in a campaign. For more information regarding adding tracker
URLs to a campaign, please refer to the Campaigns documentation in the
Application guide.

Lead Generation

Once a web-to-lead form is submitted the data entered in the form becomes a lead
record in your instance of Sugar tied to the campaign selected during form
generation. Leads can be converted to contacts, accounts, and opportunities. For
more information on the Leads module, please refer to the Leads documentation in
the Application guide.
The campaign selected during form generation is linked to the created lead via the
Campaign field under the More Information panel:

 
As well as a subpanel called Campaigns:
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Leads created from the web-to-lead form can be tracked in the Campaigns status
page via the Status Chart:

 
And the subpanel titled Leads Created:

 
If the lead that was captured in the web-to-lead form is converted to a contact, this
will be shown in the Campaigns status page as well:

 

 
For more information regarding the Campaigns status page, please refer to the 
Viewing Campaign Status section in the Campaigns documentation in the
Application guide.

Last Modified: 09/26/2015 06:25pm

Cases

Overview

Sugar's Cases module is used to track and manage product- or service-related
inquiries submitted to your organization by customers. Cases are typically related
to an account record, and multiple cases may be associated to a single account.
There are various ways you can create cases in Sugar such as via the Cases
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module, importing cases, or converted from email. Once the case is created, you
can view and edit information pertaining to the case via the Cases detail view.
Each case record may then relate to other Sugar records such as calls, contacts,
bugs, and many others. This documentation will cover how to use the Cases
module as well as the various actions and options available from within the
module.

Case Fields

The Cases module contains a number of stock fields which come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration guide.

Field Description
Account Name The account that submitted the case
Assigned To The Sugar user assigned to the case

Note: Case owners receive an email
whenever a case is assigned to them if
the administrator has enabled email
notification

Case Number An automatically incremented number
to identify every case, which cannot be
edited through Sugar

Date Created The date the case was created
Date Modified The date the case was last modified
Description Explanation of the cause and details of

the case when submitted
Priority Specify the urgency of the problem from

this dropdown list
Resolution Results of the investigation into the

problem.
Show In Portal Check this checkbox if the customer

should be able to view this via the 
Portal if applicable

Status Specifies the status of the case as the
support representative moves the case
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along the process from submission to
resolution

Subject Brief statement of the problem
Teams The Sugar team(s) assigned to the case
Type Type of categorization that this case

falls in to
Work Log Free form field to add activities and

notable events while working on the
case

Cases Module Tab

The Cases module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Cases list view. You may also hover on
the tab to display the Actions, Recently Viewed, and Favorites menu. The Actions
menu allows you to perform important actions within the module. The Recently
Viewed menu displays the list of cases you last viewed in the module. The 
Favorites menu displays the list of cases you most recently marked as favorites in
the module.

 
The Actions menu allows you to perform the following operations:

Menu Item Description
Create Case Opens the edit view layout to create a

new case
View Cases Opens the list view layout to search and

display cases
View Case Reports Displays existing reports based on the

Cases module
Import Cases Opens the import wizard to create or

update cases using external data
If you do not see the Cases module tab in Sugar, please check the following:
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The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Cases module is not a member. Click the
More tab (last tab on navigation bar) then hover on "Filter Menu By" to check
how the navigation bar is grouped. For more information on tab grouping,
please refer to the User Interface documentation.
The Cases module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Cases module in the Hide Modules list, simply
move it to the Display Modules list. For more information on hiding and
displaying modules, please refer to the Layout Options section of the Getting
Started documentation.
The administrator may have disabled the Cases module for your entire Sugar
instance. Reach out to your Sugar administrator to have the Cases module
displayed. For more information on displaying and hiding modules throughout
Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Cases

There are various methods for creating cases in Sugar including via the Cases
module, quick create, duplication, and importing cases. Customers can also create
cases via emailing a specific email account or through the Case Portal. The full edit
view layout opens when creating the case directly from the Cases menu and
includes all of the relevant fields for your organization's cases. The quick create
form is a shortened version of the Cases edit view and typically contains fewer
fields. When using quick create to make a case while viewing an existing record of
another module, Sugar automatically creates a relationship between both records.
For example, if you are viewing an account record (e.g. ABC Company) and create
a new case via the quick create form, the Account Name field in the case record
will automatically populate with "ABC Company", thus creating the relationship.
Both the edit view and quick create layouts can be configured by administrators
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

Creating Via Cases Module

One of the most common methods of case creation is via the Create Case option in
the Cases module tab. This opens up the edit view layout which allows you to enter
in all the relevant information for the case.
Use the following steps to create a case via the Cases module:
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1. Hover on the Cases module tab and select "Create Case".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
Note: Case Number is marked with a red asterisk as it is a required field, but
no value is required to be added for the save to occur.

3. Once the necessary information is entered, click "Save".

 

Creating Via Quick Create

The quick create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a case from any Cases subpanel on
related module records.
Use the following steps to create a case via Quick Create:

1. Open the quick create menu on the upper right of any Sugar page and select
"Create Case" or select "Create" on any Cases subpanel on a related module's
detail view.
Note: The quick create menu can be reconfigured by administrators via
Admin > Configure Navigation Bar Quick Create. For more information on
configuring layouts, please refer to the Configure Navigation Bar Quick
Create documentation in the Administration guide.
From quick create menu:
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From subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".

 

Creating Via Duplication

You can also create a new case by duplicating an existing case. The duplicate
option is useful if the case you are creating has similar information to an existing
case, such as reopening a previously closed case.

Use the following steps to create a case by duplicating an existing record:
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1. Navigate to a case record's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original case's values.

Update the necessary fields, then click "Save".
Note: Case Number is not duplicated and a unique number is generated upon
saving the duplicate case.

 

Importing Cases

The import function allows you to push multiple case records into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.

Use the following steps to import cases via the Import Cases option:

1. Hover on the Cases module tab and select "Import Cases".
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2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only". Click

"Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. In Step 6, view the import results.

The Created Records tab will show all of the new case records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Creating Via Case Portal

The Case Portal allows a way for customers to submit a case directly into Sugar
instead of a Sugar user having to input the information and submit the case
manually. Customers will have to be registered users of the portal to be able to
submit cases. For more information on using the Case Portal, please refer to the 
Portal Deployment User Guide and Portal User Guide.

Creating Cases From Email

Creating cases via email allows users added convenience in the case creation
process, therefore expediting the amount of time before the support team can
begin working on the issue. Cases can be created from emails sent to individual
users through the emails module or can be automatically created when emails are
sent to a group mailbox which is monitored by Sugar.

Creating Via Emails Module

Users in Sugar can launch a quick create form to create a case from an external
email or from an imported email. From the emails pane in the Emails module, click
"Quick Create" and select "Case".
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The quick create form opens in a popup window. The subject and description fields
for the case are populated by default with the subject and body of the email. All
required fields are marked with a red asterisk and must be completed prior to
saving. Once the necessary information is entered, click "Save".
The email selected will then be imported, if not already, and will be related to the
new case. A relationship will be made between the email and the case created via
the flex relate field.

Creating Via Inbound Email

The Inbound Email functionality allows a way for customers to submit a case
directly into Sugar via email instead of a Sugar user having to imput the
information and submit the case manually. Sugar has the ability to monitor specific
email boxes to be able to automatically create these cases. For more information
on Inbound Email, please refer to the Inbound Email documentation.

Viewing Cases

There are various options available for viewing case records in Sugar including via
Cases list view, Cases detail view, Cases Last Viewed menu, dashlets, and reports.
Please note that you will only be able to see case records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Teams and Roles documentation in the
Administration guide.

Viewing Via List View

The Cases list view displays all case records meeting the current search criteria.
To access the list view, simply click the Cases module tab. While list view shows
key case fields, you can click the case's subject to open the record in detail view.
For more information on viewing cases via list view, please refer to the Cases List
View section of this documentation.

Viewing Via Detail View
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The Cases detail view displays thorough case information including all case fields
followed by subpanels of the case's related records belonging to various modules.
The detail view can be reached by clicking a case record's link from anywhere in
the application including from the Cases list view. For more information on
viewing cases via detail view, please refer to the Cases Detail View section of this
documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which cases you have recently viewed. Hover
on the Cases module tab to see a list of your most recently viewed cases and click
each name to open the case in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view case
information in case-based dashlets such as "My Open Cases" as well as in dashlets
based on other modules such as "My Calls". Clicking a case's subject from any
dashlet will open the case in detail view. For more information on using dashlets
and viewing case records via dashlets, please refer to the Modules section of the
Home documentation.
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Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding cases and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the case record's detail view by clicking the case's subject in
the report results. Please note that you can only directly access case detail views
with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 

In addition to navigating to the Reports module and finding or building relevant
reports, you can use the Case module tab's View Case Reports option to see all
case-based reports to which you have access.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.
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Searching Cases

The Cases list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Cases list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %system). This will pull
up any record that has the word "system" in the name, regardless of how it starts
or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.
Open Items : Select this box to return records where the status is not Closed,
Rejected, or Duplicate.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a case subject, Sugar will only return case records
with a matching name that are assigned to you. Once the search is complete, the
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relevant results will populate in the list view below the search panel. To see all
case records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
case records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Teams and 
Roles documentation in the Administration guide.

Administrators can configure what fields appear on the Cases Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
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of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a case subject to search, Sugar will only return case
records with a matching name that you have marked as favorites. When searching
by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all case records
to which you have access, simply click "Clear" and then "Search" to perform a
blank search with no filters. Please note that you will only be able to see case
records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Teams and 
Roles documentation in the Administration guide.

Administrators can configure what fields appear on the Cases Advanced Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Field Options section of the Studio documentation as well as the
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Search section of the System documentation in the Administration guide.

Cases List View

The Cases list view displays all case records meeting the current search criteria
and to which your user has access. You can view the basic details of each case
within the field columns. Please note that you will only be able to see case records
as allowed by your team membership, user access type, and assigned roles. For
more information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Cases Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on case records directly from the list view by first
selecting the desired records. To select individual case records on the Cases list
view, mark the checkbox on the left of each row. To select or deselect multiple
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case records on the list view, use the options in the checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of case
results.
Select All : Selects all records in the current search results across all pages of
case results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more cases at a time
Mass Update Mass update one or more cases at a

time
Mail merge Perform a mail merge on one or more

accounts at a time.

Note: This option only appears when
Mail Merge is enabled at the system
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level and under the user's profile.
Merge Merge two or more duplicate cases
Export Export one or more cases to a CSV file

Favorite Designation

Users have the option to mark case records as favorites via the list view as well as
the detail view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Cases
module tab. In the Cases list view, the star on the left of each case's row is yellow
once marked to indicate a favorite case. For more information on how to mark
records as favorites, please refer to the Favoriting Cases section of this
documentation.

 

More Information

Additional details for each case can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional case
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Description and Resolution fields by default. The list
of fields appearing here may only be configured through a code-level
customization.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
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refer to the Layout Options section of the Search documentation.

 

Cases Detail View

The Cases detail view displays thorough case information including all case fields
which are grouped by default into the Overview and Other panels. You can also
view a case's related records (Activities, Contacts, Bugs, etc.) which appear in 
subpanels beneath the case fields. The detail view can be reached by clicking a
case record's link from anywhere in the application including from the Cases list
view.

Please note that you will only be able to view a case record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Teams and Roles documentation in the Administration
guide. Users with administrator or developer access have the ability to change the
detail view by configuring the layout via Admin > Studio. For more information on
editing layouts, please refer to the Studio documentation in the Administration
guide.

Actions Menu

The Actions menu on the top left of each case's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:
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Menu Item Description
Edit Edit this case
Duplicate Duplicate this case
Delete Delete this case
Find Duplicates Locate potential duplicates of this case
Create Article Converts information from case to the

edit view of a Knowledge Base article.
Please refer to the Knowledge Base
documentation in the Application Guide

View Change Log View a record of changes to this case

Favorite Designation

Users have the option to mark case records as a favorite via the detail view as well
as the list view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Cases
module tab. In the Cases detail view, the star on the right of the case's subject is
yellow once marked to indicate a favorite case. For more information on how to
mark records as favorites, please refer to the Favoriting Cases section of this
documentation.

 

Next or Previous Record

On the upper right of the Cases detail view, there are two buttons that allow you to
page through each case in the Cases list view's current search results. Clicking the
Previous button displays the previous case of the current search results while
clicking the Next button displays the next case of the current search results. The
text in between shows which case result you are currently viewing within the total
number of current results.
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Subpanels

Beneath a case record's fields are subpanels containing related records from
various modules, communication history regarding the case, and what contacts to
work with regarding the case.

Related Record Subpanels

The most common type of subpanels displayed on a case's detail view contain the
case's related records belonging to various modules. The relationship type
determines whether a related record will be displayed in the field listing or in a
subpanel. For example, a case may be related to only one account but related to
multiple contacts. This means that the related account will be displayed amongst
the case's fields while contacts will be displayed in a subpanel beneath the fields.

Users with administrator or developer access have the ability to change the fields
(e.g. Subject, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the case, choose "Select" from the subpanel's
Action menu, then locate and select the desired record.
To relate a new record to the case, choose "Create" from the subpanel's
Action menu, then complete the Quick Create form and click "Save".
To delete the case's relationship to a record, choose "Unlink" from the
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dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

 

Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the case record. Once the activities have taken place or are completed,
they will instead appear within the History subpanel. The History subpanel also
includes notes and emails associated with the case record. For more information
on the history and activities subpanel, please refer to the User Interface
documentation.

 

Editing Cases
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Cases may be edited at any time to update or add information to the record. You
can make changes to existing case records via the Cases edit view and quick
create forms. Edit view is available within the Cases module and includes all of the
Case fields you should need.

 

Quick create is available for editing cases from outside the Cases module and
opens as a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields.

 

Please note that your ability to edit cases in Sugar may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Edit options.

Administrators in Sugar may configure both the Cases edit view and quick create
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via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit cases via the detail view by clicking the Edit button on the upper left
of the page. Once the edit view layout is open, update the necessary fields, then
click "Save" to preserve the changes made.

 

Editing Via List View

You can edit cases via the list view by clicking the Pencil icon to the left of each
case's subject. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.

 

Editing Via Dashlets

You can edit cases by clicking the pencil icon to the far right of any cases-based
dashlet on your Sugar home page. For example, clicking the pencil icon within the
My Open Cases dashlet will open a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. For more information on dashlets,
please refer to the Home documentation.
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Editing Via Reports

Sugar reports also allow you to edit a case record by clicking on the pencil icon
next to a case's subject. This opens a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. Please note that you may only directly
edit cases from Rows and Columns-type or Summation with Details-type reports as
Summation-type and Matrix-type reports do not include the pencil icon. For more
information on reports, please refer to the Reports documentation.

 

Deleting Cases

If a case record is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Cases detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once. Deleting case records will not delete the
related records and will only remove the relationship.

Please note that your ability to delete cases in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
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documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a case record via the detail view:

1. Navigate to a case record's detail view.
2. Select "Delete" from the Actions menu. 

 

3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more cases via the list view:

1. Navigate to the Cases list view by clicking the Cases module tab.
2. Use the Basic or Advanced Search to find the cases you wish to delete.
3. Select the desired case records individually or using the checkbox

dropdown'soptions.
4. Choose "Delete" from the Actions menu. 

 

5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.
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Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of case records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Cases

Sugar's Export option allows users to download all fields for the selected cases to
their computers as a CSV (comma-separated values) file. This may be useful when
needing to use Case data with other software such as Microsoft Excel or to update
existing records by exporting, making changes, then importing the altered cases
back into Sugar. For more information on updating existing records via import,
please refer to the Import documentation. Due to PHP memory limitations on the
server, there may be occasions when the application times out while exporting a
large number of case records. If you encounter an error when performing this
action, we recommend selecting the records in smaller batches.

Cases may be exported from the Cases list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for cases and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export cases from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Cases

Mass Updating allows users to make the same change to multiple case records at
once from the Cases list view. Users with administrator or developer level access
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can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of case records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update cases may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Mass Update option.

Use the following steps to mass update case records from the list view:

1. Navigate to the Cases list view by clicking the Cases module tab.
2. Use the list view's Basic or Advanced Search to identify cases you wish to

modify.
3. Select the desired cases individually or using the checkbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu. 

 

5. Scroll to the Mass Update panel and set values for the fields you wish to alter.
Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments. 
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6. Click "Update" to save the changes to all of the currently selected case
records.

Finding Duplicate Cases

Between multiple users working in Sugar, importing new records, and creating
cases via email, it is possible for duplicate case records to be accidentally input to
the system. Before creating a new case record, a good practice is to first check
that the same issue for the same account does not already exist in Sugar. You can
locate duplicate records for cleanup using Basic and Advanced Search from the
Cases list view. Searching for cases with similar names, related accounts, or other
information can turn search a powerful, duplicates-finding tool. Sugar also
provides a wizard for finding potential duplicates that is available from the Cases
detail view and may be used as shown below. If duplicate case records are
detected, you can perform a merge per the Merging Cases section of this
documentation.

Please note that your ability to use the Find Duplicate action may be restricted by
any role which prevents case deletion. For more information on roles, please refer
to the Role Management documentation in the Administration guide. Check with
your system administrator if you do not see the Find Duplicates option.

Use the following steps to locate duplicate cases using the Find Duplicates option
from the Cases detail view:

1. Navigate to a case record's detail view.
2. Choose "Find Duplicates" from the Actions menu. 

 797 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Cases/#Basic_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Cases/#Advanced_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Cases/#Merging_Cases
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management


 

 

3. Move any fields you wish to use in identifying duplicates to the list on the
right by selecting the field and clicking the arrow. 

 

4. Click "Next Step" to display a list of potential duplicate case records which
match all of the specified filters. 

 

Once you determine which cases of the resulting list are indeed duplicates of
your original record, select the duplicates by marking the checkboxes, then click
"Perform Merge" to begin a merge with the current record. Instructions for the
merge process that follows can be found in the Merging Via Detail View section of
this documentation.

Merging Cases

When duplicate records are identified in Sugar, you have the option to merge two
or more cases into a single record. Once the merge is complete, the duplicate case
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record(s) will be deleted, and the primary record will remain. Please note that all
relationships belonging to the duplicate cases will be merged to the primary
record meaning that any calls, meetings, contacts, etc. related to the duplicate
case record(s) will automatically be related to the resulting, merged case record.

Merging Via Detail View

Use the following steps to merge cases via the Cases detail view:

1. Navigate to a case record's detail view.
2. Use the Find Duplicates option as shown in Finding Duplicate Cases to

identify duplicate cases.
3. Possible duplicates will be displayed in the results list. Select the duplicate

record(s). 

 

4. Click "Perform Merge" to display the Merge Cases page. The primary record's
field values are displayed on the left while other records' values are in
columns to the right. Saving the merge will preserve only the leftmost values
for each field into a single case record. 

 

5. To change which record is considered the primary, click the "Set as primary"
double arrows.

6. Review the field values in each column and use the associated double arrows
to move the best value for each field to the leftmost column.

7. Click "Save Merge" once the left column contains all fields you wish to appear
on the single, merged record.
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8. A pop-up message will display confirming that the duplicate record(s) should
be deleted. Click "Ok" to proceed.

Merging Via List View

Basic and Advanced Search may be used to identify duplicate cases by, for
example, searching for cases with similar names or related accounts. Once your
search has identified duplicate cases, you can merge them directly from the Cases
list view.

Use the following steps to merge cases via the list view:

1. Use the list view's Basic or Advanced Search to identify duplicate cases.
2. Possible duplicates will be displayed in the list view. Select the duplicate

record(s) that you wish to merge. 

 

3. Select "Merge" from the Actions menu to display the Merge Cases page. The
primary record's field values are displayed on the left while other record's
values are in columns to the right. Saving the merge will preserve only the
leftmost values for each field into a single case record. 
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4. To change which record is considered the primary, click the "Set as primary"
double arrows.

5. Review the field values in each column and use the associated double arrows
to move the best value for each field to the leftmost column.

6. Click "Save Merge" once the left column contains all fields you wish to appear
on the single, merged record.

7. A pop-up message will display confirming that the duplicate record(s) should
be deleted. Click "Ok" to proceed.

Favoriting Cases

Each Sugar user has the option to designate their own favorite cases which are
important or will be viewed often so that they can easily be accessed via search or
from the Cases module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Cases Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Cases module
tab .

Favoriting Via List View

Use the following steps to mark records as favorites via the Cases list view:

1. Navigate to the Cases list view by clicking the Cases module tab.
2. Use the Basic or Advanced Search to find the Cases records you wish to mark

as favorites.
3. Mark the star icon on the left of each desired case's row.
4. To remove the case as a favorite, click the star again to revert it to white. 

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Cases detail view:

1. Navigate to a case record's detail view.
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2. Click the star icon to the right of the case's name in the upper left of the
detail view to designate it as a favorite.

3. To remove the case as a favorite, click the star again to revert it to white. 

 

Viewing Cases Change Logs

Changes made to each case record are tracked over time, and users are able to
view the history of changes via the change log in each case's detail view. To view
the change log, navigate to a case in detail view and select "View Change Log"
from the Actions menu. Please note that only fields marked as "Audit" in Admin >
Studio will be displayed in the change log. For more information on designating for
audit, please refer to the Studio documentation in the Administration guide.

 

Communicating Regarding Cases

Sugar includes the functionality to allow users to communicate with customers and
keep an archive of communication between a support representative and the
customer with regards to cases. Communication between cases can be performed
via emails and via the Case Portal and Cases module.

When using email communication, please note that administrators in Sugar must
first configure the outbound mail server for the system via Admin > Email Settings
in order for users to send outbound emails. For more information on setting up the
system email settings, please refer to the Email documentation in the
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Administration guide. Users will also need to have their email settings configured
in their user preferences prior to sending outbound email from the Emails module
or Cases module. For more information on setting up your user preferences' email
settings, please refer to the Getting Started documentation.

Communicating Via Emails

Sugar allows emails to be archived to cases and visible in the History Subpanel
regardless of them being sent and received in Sugar directly. When an email is
received by Sugar, using either Inbound Email or Email Archiving, Sugar will
utilize a Case Macro to relate the email. The Case Macro is placed in the subject
line of the email and contains the case number that the email should be related to.
Case Macros are configurable by an administrator via Admin > Inbound Email, but
will typically use the standard format of [CASE:##] to be placed in the subject
line. For more information on configuring the case macro, please refer to the 
Inbound Email documentation. The formatting of the macro is imperative for Sugar
to properly read the subject of the email for import. For example, a proper subject
line with the macro will be: "[CASE:125] System not responding".

One way that the emails can be received in Sugar to use the case macro is through
a monitored inbound mailbox. This is a mailbox on your company's mail server that
Sugar is granted the ability to read. For example, this would function where an
email is sent from to support@mycompany.com and includes a proper case macro.
Sugar would then poll the mailbox, find the case macro, and associate the email to
the specified case in the macro. This can also be used by support representatives
who are directly emailing with a customer. The group mailbox can be CC'd and,
using the case macro, have the email thread archived. For more information on
configuring an inbound email box, please refer to the Inbound Email
documentation.

The other option that users have to archive emails is using Sugar's Email Archiving
functionality. Email Archiving must be configured and enabled by administrators in
Sugar via Admin > Email Settings. Once configured, an email address will be
generated that is specific to your instance of Sugar. When this email address
receives an email, it scans the email for any email addresses. The email is then
imported into Sugar, where the email is associated to any contact, lead, etc.
containing an email address on the email. When including the case macro on the
email, Sugar will also import this email to the referenced case. For more
information on setting up Email Archiving, please refer to the Email Archiving
documentation in the Administration guide.

Communicating Via Portal

The Case Portal can be used to both view and submit cases from a customer to a
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support department, but can also be used as a method of communication regarding
a case. Both customers and Sugar users have the option to add notes to cases.
Users can do this via the History subpanel. Customers have this as an available
option when viewing the details of a case. For more information on using the Case
Portal, please refer to the Portal Deployment User Guide. When a customer adds a
note to the portal, the note will be available for viewing inside Sugar. Alternately,
when a user adds a note to a case from Sugar and the "Display in Portal?"
checkbox is selected on the note, the note will be available to view in the portal.
These notes are visible by anyone tied to the account that the case is associated to
and with access to the support portal. For more information on the Notes module,
please review the Notes documentation.

Last Modified: 09/26/2015 06:25pm

Knowledge Base

Overview

Sugar's Knowledge Base module provides the ability to create, maintain, and
publish articles. Knowledge Base articles can cover a variety of topics like case
resolutions or frequently asked questions and can be for internal purposes or
published externally via the Sugar Portal. Once an article is created, you can view
and edit information pertaining to the article via the detail view. This
documentation will cover how to use the Knowledge Base module as well as the
various actions and options available from within the module.

Knowledge Base Fields

The Knowledge Base module contains a number of stock fields which come
out-of-the-box with Sugar. The below definitions are suggested meanings for the
fields, but the fields can be leveraged differently to best meet your organization's
needs.

Field Description
Approver The Sugar user to approve the article

Note: When selecting "In Review"
status; defaults to the admin user.

Attachments Any external files to be attached to the
article

Author The Sugar user who owns the article
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Note: Defaults to the current user
Body The HTML content of the article
Expiration Date The date the article information is

expired
External Article Determines if an article is visible

through the Sugar Portal
Revision The article's current revision number
Status The current status of the article (e.g.

Draft, Expired, In Review, Published)
Tags Which topics or categories are assigned

to the article
Teams The Sugar team(s) assigned to the

article
Title The title or designation of the article

Knowledge Base Module Tab

The Knowledge Base module tab is typically located under the More tab on the
navigation bar at the top of any Sugar screen to the right of the home cube icon.
Depending on your settings, you may have to click "Show More" in order to see the
Knowledge Base module tab. Click the tab to access the Knowledge Base list view.
You may also hover on the tab to display the Actions, and Recently Viewed menu.
The Actions menu allows you to perform important actions within the module. The
Recently Viewed menu displays the list of articles you last viewed in the module.

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Article Opens the edit view layout to create a

new article
View Articles Opens the list view layout to search and

display articles
Administer Knowledge Base Opens up the admin page to configure
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the Knowledge Base
If you do not see the Knowledge Base module tab in Sugar, please check the
following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Knowledge Base module is not a
member. Click the More tab (last tab on navigation bar) then hover on "Filter
Menu By" to check how the navigation bar is grouped. For more information
on tab grouping, please refer to the User Interface documentation.
The Knowledge Base module may be marked as hidden in your user
preferences which will prevent the module tab from being displayed. Navigate
to your user profile (upper right of Sugar), click the Advanced tab, and check
the Layout Options section. If you see the Knowledge Base module in the Hide
Modules list, simply move it to the Display Modules list. For more information
on hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Knowledge Base module for your
entire Sugar instance. Reach out to your Sugar administrator to have the
Knowledge Base module displayed. For more information on displaying and
hiding modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration guide.

Creating Articles

There are a few methods for creating articles in Sugar including via the Knowledge
Base module, duplication, and from a case record. The edit view layout opens when
creating the article directly from the Knowledge Base menu and includes all of the
relevant fields for your organization's articles.

Draft : The article is undergoing changes.
Expired : The article is outdated.
In Review : The article is being reviewed by the designated approver. When
this status is selected, Sugar sends a notification email to the Approver.
Published : The article is complete.

In order for an article to be visible through the Sugar Portal, it must meet the
following requirements:

External Article = Checked
Status = Published
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If either of these conditions is not met, the article will not be visible in the Sugar
Portal.

Creating Via Knowledge Base Module

One of the most common methods of article creation is via the Create Article
option in the Knowledge Base module tab. This opens up the edit view layout
which allows you to enter all the relevant information for the article.
Use the following steps to create an article via the Knowledge Base module:

1. Hover on the Knowledge Base module and select "Create Article".

 
2. Enter appropriate values for the fields in the edit view layout. Fields marked

with a red asterisk as well as the article body are required and must be
completed prior to saving.

3. Once the necessary information is entered, click "Save".

 

Creating Via Duplication

You can also create a new article by duplicating an existing article. The duplicate
option is useful if the article you are creating has similar information to an existing
article.
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Note: Article tags do not copy over to the new article.

Use the following steps to create an article by duplicating an existing record:

1. Navigate to an article's detail view.
2. Click the Actions menu and select "Duplicate".

 
3. The displayed edit view is pre-populated with the original article's values.

Update the necessary fields, then click "Save".
Note: Duplicating a published article will default the new article to a status of
"Draft".

 

Creating Via Cases

Sugar enables you to transfer details from a case record to create a knowledge
base article. This is designed for situations where a case has documented a
resolution to a problem. Creating an article from such records enables the user to
share the information with other users without manually copying or duplicating the
information. A new article is created using the subject of the case as the title of the
article. The body of the new article is automatically populated with the case
number, subject, description, and resolution from the case. For more information
on creating and modifying cases, please refer to the Cases documentation.

Use the following steps to create an article from a case:

1. Navigate to a case record's detail view.
2. Select "Create Article" from the Actions menu.
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3. Update the necessary fields, then click "Save".

 

Viewing Articles

There are various options available for viewing articles in Sugar including via
Knowledge Base list view, Knowledge Base detail view, Knowledge Base Last
Viewed menu, and reports. Please note that you will only be able to see articles as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

Viewing Via List View

The Knowledge Base list view displays all articles meeting the current search
criteria. To access the list view, simply click the Knowledge Base module tab.
Before performing a search, the list view populates with the top ten most viewed
articles. While the list view shows key article fields, you can click the article's title
to open the article in the detail view. For more information on viewing articles via
list view, please refer to the Knowledge Base List View section of this
documentation.

Viewing Via Browsing

The Knowledge Base browse view displays all of the tags in a tree structure and all
of the articles under each tag. To access the browse view, simply click the Browse
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tab on the Knowledge Base list view.

 
Select a tag on the left hand side of the page to view any articles assigned to that
tag. If there are more tags nested under a tag, you can click the plus sign (+) to
view the nested tags. All tags are visible to all users, but you will only be able to
see articles as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

 
While the list view shows key article fields, you can click the article's title to open
the article in the detail view. For more information on viewing articles via list view,
please refer to the Knowledge Base List View section of this documentation.

Viewing Via Detail View

The Knowledge Base detail view displays thorough article information including all
article fields. The detail view can be reached by clicking an article's title link from
anywhere in the application including from the Knowledge Base list view. For more
information on viewing articles via detail view, please refer to the Knowledge
Base Detail View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which articles you have recently viewed.
Hover on the Knowledge Base module tab to see a list of your most recently viewed
articles and click each title to open the article in the detail view.
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Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding articles and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. For more information on
using reports, please refer to the Reports documentation.
Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Articles

The Knowledge Base list view includes a Basic and Advanced Search to help you
locate records easily and effectively in a module-specific manner. Once the search
is performed, the relevant results will be displayed in the Knowledge Base list view
below. Global Search allows users to search for information across their entire
Sugar database as opposed to restricting search within a specific module.

Basic Search

The Basic Search in the Knowledge Base module utilizes the Full Text Search built
into the database. This is enabled and configured by default for On-Demand
instances and On-Site instances running MySQL. For more information on how to
enable Full Text search on MSSQL for On-Site instances, please refer to the 
Enabling Search on MSSQL section in the Knowledge Base Administration
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documentation in the Administration guide.
Basic Search offers a keyword search as well as a category option.

 

The keyword search uses syntax understood by the database sugar is running on
and searches the full text index of the body of the article. Click the "i" icon to get
some guidance on the syntax used for keyword searches.
The syntax listed below is specifically for MySQL although many, if not all, of these
features will work on MSSQL as well:

Case Insensitive : Searching for "device" will locate articles that contain
"Device" as well.
Phrase Search : Phrases can be searched, but must be enclosed by double
quotes (e.g. "the settings screen").
Multiple Keywords : Search for multiple keywords by separating them with a
space character. Sugar assumes an "or" operator between the words. For
example, search for "battery device" will find any article that contains the
word "battery" or the word "device".
Require Words or Phrases : To require a word or phrase in your results the
word or phrase should be preceded by a plus sign (+). For example, search
for "+battery +device" will find any article that has the word "battery" and
the word "device".
Exclude Words or Phrases : To exclude a word or phrase in your results the
word or phrase should be preceded by a minus sign (-). For example, search
for "+device -internet" will find any article that has the word "device" but
does not have the word "internet".
Wildcards : Use an asterisk (*) to have your keyword return a partial match.
For example, search for "batt*" will return any article that contains a word
that start with batt (e.g. battery).

Note: Words that contain less than four letters are treated as stop words in
MySQL, unless they are part of a phrase. Hence, the search results will not display
articles containing such words. There is also a list of default stop words that
MySQL will exclude from Full Text Searching. For the complete list of default stop
words in MySQL 5.5, please refer to the Stop Words documentation on the 
MySQL website.

In addition to the keyword search you can also select a category to perform the
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search in.

 
The categories included by default are the following :

All : Searches all articles.
Added Last 30 days : Searches any articles created within the last 30 days.
Pending my Approval : Searches any articles that have a status of "In Review"
and the Approver are set to the current user.
Updated Last 30 days : Searches any articles modified within the last 30 days.
FAQs : Searches any articles currently set to the FAQ tag.

You can use the category search in coordination with the keyword search in order
to find any articles containing the keyword that also matches one of the categories.
Once the search is complete, the relevant results will populate in the list view
below the search panel. To see all articles to which you have access, simply click
"Clear" and then "Search" to perform a blank search with no filters. Please note
that you will only be able to see articles as allowed by your team membership, user
access type, and assigned roles. For more information on teams and roles, please
refer to the Team Management and Role Management documentation in the
Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields and saved search capability. From the Advanced search
panel, you can click "Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
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following functions: 

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.
Containing these words : Enter one or more keywords or phrases. Use a space
to separate keywords from each other. Use quotes to enclose a phrase.
Note: The plus sign (+) mentioned in Basic Search is not required in this
section.
Search within : Select the category to filter the results by (e.g. All, Added last
30 days, etc.).
Excluding these words : Enter one or more keywords or phrases to exclude
from the search. Use a space to separate keywords or phrases from each
other.
Note: The minus sign (-) mentioned in Basic Search is not required in this
section.
Using This Tag : Enter the tag name or click "Select" to choose the tag from
the Tags list.
Title : Enter a title name. Please note that Sugar automatically appends the
wildcard character (%) to the end of your search phrase.
Viewing Frequency : Select the frequency category to filter the results by
(e.g. Top 5, Top 10, Bottom 5, etc.).
Status : Select the status to filter the results by (e.g. Draft, Expired, In
Review, or Published).
Team : Enter the team name or click "Select" to choose the team from the
Teams list.
Approved By : Enter the person's name or click "Select" to choose a user from
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the Users list to see articles approved by a specific user.
Author : Enter the person's name or click "Select" to choose a user from the
Users list to see articles authored or assigned to a specific user.
Published : Select an option from the dropdown to filter articles by published
date (e.g. On a specific date, Is Between two specific dates, Last 7 days, etc.).
Expires : Select an option from the dropdown to filter articles by expires date
(e.g. On a specific date, Is Between two specific dates, Last 7 days, etc.).
Attachments : Select an option from the dropdown to filter articles with or
without attachments. You can also search using criteria like Mime Type and
Attachment name.
External Article? : Select this checkbox to search for external articles.

When you perform a search, Sugar will return records matching all (as opposed to
any) of the fields for which you have given a value. For example, if you specify a
tag filter via "Using This Tag" and enter an article title into the search box, Sugar
will only return articles with a matching title that are marked as external. Once the
search completes, the relevant results will populate in the list view below the
search panel. To see all articles to which you have access, simply click "Clear" and
then "Search" to perform a blank search with no filters. Please note that you will
only be able to see articles as allowed by your team membership, user access type,
and assigned roles. For more information on teams and roles, please refer to the 
Team Management and Role Management documentation in the Administration
guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right-hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 
To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.
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Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Studio documentation as well as the Search section of the
System documentation in the Administration guide.

Note: Global Search is turned off for the Knowledge Base module by default. For
more information on how to enable and disable modules for the global search,
please refer to the System documentation in the Application guide.

Knowledge Base List View

The Knowledge Base list view displays all articles meeting the current search
criteria and to which your user has access. You can view the basic details of each
article within the field columns. Please note that you will only be able to see
articles as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.
By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.
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More Information

Additional details for each article can be viewed by hovering over the title of the
article. This provides users a quick view of additional information in addition to
what appears in the display column fields. The resulting pop-up window will show
the Publish Date, Expiration Date, External Article, and Body fields by default. The
list of fields appearing here may only be configured through a code-level
customization.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time.

 

Knowledge Base Detail View

The Knowledge Base detail view displays thorough article information including all
knowledge base fields. The detail view can be reached by clicking an article's link
from anywhere in the application including from the Knowledge Base list view.
Please note that you will only be able to view an article according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management documentation
in the Administration guide.

Actions Menu
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The Actions menu on the top left of each article's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 
The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this article
Duplicate Duplicate this article
Delete Delete this article
Send Email Send an email with the contents of this

article

Show More Details

The Knowledge Base detail view hides some of the fields on the article by default.
Click "Show More Details" to reveal the following fields: External Article?, Status,
Team, Approver, Publish Date, Revision, and Expiration Date.

 

Editing Articles

Articles may be edited at any time to update or add information to the record. You
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can make changes to existing articles via the Knowledge Base edit view. Edit view
is available within the Knowledge Base module and includes all of the article fields
you should need.

 
Please note that your ability to edit articles in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Editing Via Detail View

You can edit articles via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve the changes.

 

Editing Via List View

You can edit articles via the list view by clicking the Pencil icon to the right of each
row. The article will open directly to the edit view. Update the necessary fields,
then click "Save" to preserve the changes.

 

Deleting Articles
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If an article is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from the Knowledge Base detail view.
Please note that your ability to delete articles in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete an article via the detail view:

1. Navigate to an article's detail view.
2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Exporting Articles

Sugar's Export option allows users to download all fields for articles to their
computers as a .CSV (comma-separated values) file. This may be useful when
needing to use article data with other software such as Microsoft Excel. Due to
PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of articles. If you encounter
an error when performing this action, we recommend selecting the records in
smaller batches.

Users with access to the Reports module have the option of creating or accessing
reports containing specifically chosen fields for articles and their related record(s).
Please note that only Rows and Columns-type reports have the ability to be
exported. For more information on exporting records in Sugar, please refer to the 
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Please note that your ability to export articles from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export optio n.

Tags

Tags are similar to folders and enable you to categorize articles according to
specific criteria, such as a topic, to make locating articles easier. When you tag an
article, the system creates a link between the tag and the article which resides in
the Sugar database. An article can be linked with more than one tag. Similarly, a
tag can be linked with multiple articles. Tags can be parent tags or child tags.
Parent tags are the top most category and child tags are nested within parent tags.

Creating Tags

Administrative users can create tags from the Knowledge Base Administration
page. For more information on how to create tags from Knowledge Base
Administration please refer to the Knowledge Base Administration document in the
administration guide. Users who do not have admin or developer access can create
tags while creating or editing an article.
Use the following steps to create a tag while creating or editing an article:

1. From the article's edit view, click "Select" in the Tags field.

 
2. This opens up the tags dialog box where you can search and select existing
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tags. Click "Create New Tag".

 
Note : The numbers next to the tag name indicate the number of articles
currently tagged.

3. The dialog then prompts you to select a parent tag. Click any tag in the tree
to nest the new tag underneath. If the tag you are creating should be a new
parent tag, select "Tags" in the tree to add the new tag to the same level as
the other parent tags.

 
4. Click "Save" to complete the tag creation.
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5. The tags dialog box remains open for you to continue creating new tags, or

select the appropriate tag to add it to the article.

Deleting Tags

Administrative users can delete tags entirely from the system, but only if the tag
does not have any articles assigned to it. For more information on how to delete
tags from Sugar, please refer to the Knowledge Base Administration
documentation in the administration guide. Users who do not have admin or
developer access can delete a tag off of an article while creating or editing an
article.
Use the following steps to delete a tag from an article while creating or editing the
article:

1. From the article's edit view, click the trash can icon in the Tags field next to
the tag you wish to remove.

 
2. If you have added the tag during this edit of the article, the trash icon is

replaced with a minus icon.
3. Once the necessary tags have been removed, click "Save".

Send Article as Email
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Sugar allows users to create an email based off of the content of a Knowledge Base
article. Please use the following steps to send an email from an article's detail
view:

1. Navigate to an article's detail view.
2. Select "Send Email" from the Actions menu.

 
3. This launches a compose email within the emails module. The body of the

article is automatically placed in the body of the email and the title of the
article is set as the subject of the email.

 
4. Populate any recipients and optionally attach the email to a record in Sugar

via the Related To field and click "Send"

 

For more information on sending emails from the Emails module, please refer to
the Emails documentation.

Last Modified: 09/26/2015 06:25pm
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Bugs

Overview

Sugar's Bug Tracker module is used to track and manage product-related
problems, commonly referred to as bugs or defects, either found internally or
reported by customers. The bugs can be further triaged by tracking the found and
fixed in release. The Bug Tracker module gives users a way to quickly review all
details of the bug and the process being used to rectify it. Once a bug is created or
submitted, you can view and edit information pertaining to the bug via the Bugs
detail view. Each bug record may then relate to other Sugar records such as calls,
contacts, cases, and many others. This documentation will cover how to use the
Bug Tracker module as well as the various actions and options available from
within the module.

Note: This module is hidden by default. The administrator must display it for your
use.

Bug Fields

The Bug Tracker module contains a number of stock fields which come
out-of-the-box with Sugar. The below definitions are suggested meanings for the
fields, but the fields can be leveraged differently to best meet your organization's
needs. Users with administrator or developer access have the ability to alter, add,
or remove fields via Admin > Studio. For more information on configuring fields,
please refer to the Studio documentation in the Administration guide.

Field Description
Assigned To The Sugar user assigned to the bug
Category The general area of the product or

service where the bug was discovered
Date Created The date the bug report was created
Date Modified The date the bug report was last

modified
Description Explanation of the details and

reproduction steps of the bug when
submitted

Fixed in Release The version of product where the bug
was fixed
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Found in Release The version of product where the bug
was found

Number An automatically incremented number
to identify every bug, which cannot be
edited through Sugar

Priority Specify the urgency of the bug from this
dropdown list

Resolution Results of the investigation of the bug
and how it can be fixed

Show in Portal Check this checkbox if customers should
be able to view this record via the 
Portal if applicable

Source The method in which this bug was
submitted, (e.g. internal, customer
email, etc.)

Status Specify the status of the bug as it moves
along the process from submission to
resolution

Subject Brief statement of the problem
Teams The Sugar team(s) assigned to the bug
Type Type of categorization that this bug falls

in to (e.g. Defect, Feature, etc.)
Work Log Free form field to add activities and

actions while working on the bug

Bugs Module Tab

The Bug tracker module tab is located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Bug Tracker list view. You may also hover
on the tab to display the Actions, Recently Viewed, and Favorites menu. The
Actions menu allows you to perform important actions within the module. The 
Recently Viewed menu displays the list of bugs you last viewed in the module. The 

 826 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Portal_Deployment_User_Guide
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Bugs/#Viewing_Via_Recently_Viewed


 

 

The Bug Tracker menu allows you to perform the following operations:

Menu Item Description
Report Bug Opens the edit view layout to report a

new bug
View Bugs Opens the list view layout to search and

display bugs
View Bug Reports Displays existing reports based on the

Bug Tracker module
Import Bugs Opens the import wizard to create or

update bug reports using external data
If you do not see the Bug Tracker module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Bug Tracker module is not a member.
Click the More tab (last tab on navigation bar) then hover on "Filter Menu By"
to check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Bug Tracker module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Bug Tracker module in the Hide
Modules list, simply move it to the Display Modules list. For more information
on hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Bug Tracker module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Bug
Tracker module displayed. For more information on displaying and hiding
modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration guide.
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Creating Bugs

There are various methods for reporting bugs in Sugar including via the Bug
Tracker module, quick create, duplication, and importing bugs. Customers can also
submit bug reports via the Bug Portal. The full edit view layout opens when
creating the bug report directly from the Bug Tracker menu and includes all of the
relevant fields for your organization's bugs. The quick create form is a shortened
version of the bugs edit view and typically contains fewer fields. When using quick
create to submit a bug while viewing an existing record of another module, Sugar
automatically creates a relationship between both records. For example, if you are
viewing a case record and create a new bug report via the quick create form, the
Cases subpanel in the bug record will automatically populate with the case you
were working on, thus creating the relationship. Both the edit view and quick
create layouts can be configured by administrators via Admin > Studio. For more
information on configuring layouts, please refer to the Studio documentation in the
Administration guide.

Creating Via Bugs Module

One of the most common methods of bug submission is via the Report Bug option
in the Bugs module tab. This opens up the edit view layout which allows you to
enter in all the relevant information for the bug.
Use the following steps to submit a bug via the Bug Tracker module:

1. Hover on the Bug Tracker module and select "Report Bug". 

 

2. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to saving.
Note: Number is marked with a red asterisk as it is a required field, but no
value is required to be added for the save to occur.

3. Once the necessary information is entered, click "Save". 
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Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick create a bug submission from any Bugs
subpanel on related module records.
Use the following steps to submit a bug via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Report Bug" or select "Create" on any Bugs subpanel on a related module's
detail view.
Note: The Quick Create menu can be reconfigured by administrators via
Admin > Configure Navigation Bar Quick Create. For more information on
configuring layouts, please refer to the Configure Navigation Bar Quick
Create documentation in the Administration guide.
From Quick Create menu: 

 

From subpanel: 
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2. Enter appropriate values in the fields in the quick create form. All required
fields are marked with a red asterisk and must be completed prior to saving.

3. If additional fields are desired, click the Full Form button to use edit view
instead.

4. Once the necessary information is entered, click "Save". 

 

Creating Via Duplication

You can also create a new bug report by duplicating an existing bug. The duplicate
option is useful if the bug you are creating has similar information to an existing
bug, such as similar reproduction steps, or you are creating it to tie it to a different
version of your product.

Use the following steps to create a bug by duplicating an existing record:
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1. Navigate to a bug record's detail view.
2. Click the Actions menu and select "Duplicate". 

 

3. The displayed edit view is pre-populated with the original bug's values.
Update the necessary fields, then click "Save".
Note: Number is not duplicated and a unique number is generated upon
saving the duplicate bug report. 

 

Creating Via Email

Users in Sugar can launch a quick create form to create a bug report from an
external email or from an imported email. From the emails pane in the Emails
module, click "Quick Create" and select "Bug".

 

The quick create form opens in a popup window. The subject and description fields
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for the bug are populated by default with the subject and body of the email. All
required fields are marked with a red asterisk and must be completed prior to
saving. Once the necessary information is entered, click "Save".

The email selected will then be imported, if not already, and will be related to the
new bug report. A relationship will be made between the email and the bug
created via the flex relate field.

Importing Bugs

The import function allows you to push multiple bug reports into Sugar using a
comma (or other character) delimited file instead of creating them one-by-one. For
more information on importing, please refer to the Import documentation.

Use the following steps to import bug reports via the Import Bugs option:

1. Hover on the Bug Tracker module tab and select "Import Bugs". 

 

2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only". Click

"Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. In Step 6, view the import results.

The Created Records tab will show all of the new bug records.
The Duplicates tab will show any records in the file that were identified
as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to errors
detected during import.

Creating Via Bug Portal
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The Bug Portal allows a way for customers to submit a bug report directly into
Sugar instead of a Sugar user having to input the information and report the bug
manually. Customers will have to be registered users of the portal to be able to
report bugs. For more information on using the Bug Portal, please refer to the 
Portal Deployment User Guide and Portal User Guide documentation.

Viewing Bugs

There are various options available for viewing bug reports in Sugar including via
Bug Tracker list view, Bug Tracker detail view, Bug Tracker Last Viewed menu,
dashlets, and reports. Please note that you will only be able to see bug records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

Viewing Via List View

The Bug Tracker list view displays all bug reports meeting the current search
criteria. To access the list view, simply click the Bug Tracker module tab. While list
view shows key bug fields, you can click the bug's subject to open the record in
detail view. For more information on viewing bugs via list view, please refer to the 

Viewing Via Detail View

The Bug Tracker detail view displays thorough bug information including all bug
fields followed by subpanels of the bug's related records belonging to various
modules. The detail view can be reached by clicking a bug record's link from
anywhere in the application including from the Bug Tracker list view. For more
information on viewing bugs via detail view, please refer to the Bugs Detail View
section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which bugs you have recently viewed. Hover
on the Bug Tracker Module Tab to see a list of your most recently viewed bugs and
click each name to open the bug in detail view.
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Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view bug information
in bug-based dashlets such as "My Assigned Bugs" as well as in dashlets based on
other modules such as "My Calls". Clicking a bug's subject from any dashlet will
open the bug report in detail view. For more information on using dashlets and
viewing bug records via dashlets, please refer to the Modules section of the Home
documentation.

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding bugs and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the bug report's detail view by clicking the bug's subject in the
report results. Please note that you can only directly access bug detail views with
Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.
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In addition to navigating to the Reports module and finding or building relevant
reports, you can use the Bug Tracker module tab's View Bug Reports option to see
all bug-based reports to which you have access.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Roles documentation in the
Administration guide. Check with your system administrator if you cannot access
the Reports module.

Searching Bugs

The Bugs list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Bugs list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
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search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %system). This will pull
up any record that has the word "system" in the name, regardless of how it starts
or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.
Open Items : Select this box to return records where the status is not Closed
or Rejected.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a bug subject, Sugar will only return bug records with
a matching name that are assigned to you. Once the search is complete, the
relevant results will populate in the list view Link needed below the search panel.
To see all bug records to which you have access, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see bug records as allowed by your team membership, user access type,
and assigned roles. For more information on teams and roles, please refer to the 
Teams and Roles documentation in the Administration guide.
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Administrators can configure what fields appear on the Bugs Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
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Favorites" and enter in a bug subject to search, Sugar will only return bug records
with a matching name that you have marked as favorites. When searching by a
multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all bug reports
to which you have access, simply click "Clear" and then "Search" to perform a
blank search with no filters. Please note that you will only be able to see bug
reports as allowed by your team membership, user access type, and assigned roles.
For more information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

Administrators can configure what fields appear on the Bugs Advanced Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.
Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Studio documentation as well as the Search section of the 
System documentation in the Administration guide.
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Bugs List View

The Bugs list view displays all bug reports meeting the current search criteria and
to which your user has access. You can view the basic details of each bug within
the field columns. Please note that you will only be able to see bug records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Bugs Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on bug reports directly from the list view by first
selecting the desired records. To select individual bug reports on the Bugs list
view, mark the checkbox on the left of each row. To select or deselect multiple bug
reports on the list view, use the options in the checkbox dropdown menu:
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Select This Page : Selects all records shown on the current page of contact
results.
Select All : Selects all records in the current search results across all pages of
bug results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more bug reports at a

time
Mass Update Mass update one or more but reports at

a time
Merge Merge two or more duplicate bug

reports
Export Export one or more bug reports to a

CSV file
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Favorite Designation

Users have the option to mark bug reports as favorites via the list view as well as
the detail view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Bug
Tracker module tab. In the Bugs list view, the star on the left of each bug's row is
yellow once marked to indicate a favorite bug. For more information on how to
mark records as favorites, please refer to the Favoriting Bugs section of this
documentation.

 

More Information

Additional details for each bug can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional bug
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Date Created, Source, Category, Resolution,
Description, and Work Log fields by default if they are populated. The list of fields
appearing here may only be configured through a code-level customization.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.
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Bugs Detail View

The Bugs detail view displays thorough bug report information including all bug
fields which are grouped by default into the Overview and Other panels. You can
also view a bug's related records (Activities, Contacts, Cases, etc.) which appear in
subpanels beneath the bug fields. The detail view can be reached by clicking a bug
report's link from anywhere in the application including from the Bugs list view.

Please note that you will only be able to view a bug report according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Teams and Roles documentation in the Administration
guide. Users with administrator or developer access have the ability to change the
detail view by configuring the layout via Admin > Studio. For more information on
editing layouts, please refer to the Studio documentation in the Administration
guide.

Actions Menu

The Actions menu on the top left of each bug's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this bug report
Duplicate Duplicate this bug report
Delete Delete this bug report
Find Duplicates Locate potential duplicates of this bug

report
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View Change Log View a record of changes to this bug
report

Favorite Designation

Users have the option to mark bug records as a favorite via the detail view as well
as the list view. This allows users to designate records that are important or will be
viewed often so that they can easily be accessed via search or from the Bug
Tracker module tab. In the Bugs detail view, the star on the right of the bug's
subject is yellow once marked to indicate a favorite bug. For more information on
how to mark records as favorites, please refer to the Favoriting Bugs section of
this documentation.

 

Next or Previous Record

On the upper right of the Bugs detail view, there are two buttons that allow you to
page through each bug in the Bugs list view's current search results. Clicking the
Previous button displays the previous bug report of the current search results
while clicking the Next button displays the next bug report of the current search
results. The text in between shows which bug result you are currently viewing
within the total number of current results.

 

Subpanels

Beneath a bug report's fields are subpanels containing related records from
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various modules, communication history regarding the bug, and what cases are
examples of reports from customers of the bug.

Related Record Subpanels

The most common type of subpanels displayed on a bug's detail view contains the
bug's related records belonging to various modules. The relationship type
determines whether a related record will be displayed in the field listing or in a
subpanel. Out of the box, the Bug Tracker module does not include any
relationships to other modules that would cause a related record to be displayed in
the field listing. However, for example, a bug may be related to multiple cases.
This means that the cases will be displayed in a subpanel beneath the fields listing.

Users with administrator or developer access have the ability to change the fields
(e.g. Subject, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the bug, choose "Select" from the subpanel's
Action menu, then locate and select the desired record.
To relate a new record to the bug, choose "Create" from the subpanel's Action
menu, then complete the quick create form and click "Save".
To delete the bug's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.
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Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the bug report. Once the activities have taken place or are completed,
they will instead appear within the History subpanel. The History subpanel also
includes notes and emails associated with the bug record. For more information on
the history and activities subpanel, please refer to the User Interface
documentation.

 

Editing Bugs

Bugs may be edited at any time to update or add information to the record. You
can make changes to existing bug records via the Bug Tracker edit view and quick
create forms. Edit view is available within the Bugs module and includes all of the
Bug Tracker fields you should need.
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Quick create is available for editing bugs from outside the Bugs module and opens
as a pop-up without navigating away from your current page. It generally contains
fewer fields, but the Full Form button may be used to access the full edit view
should you need to edit additional fields.

 

Please note that your ability to edit bug reports in Sugar may be restricted by a
role. For more information on roles, please refer to the Roles documentation in the
Administration guide. Check with your system administrator if you do not see the
Edit options.

Administrators in Sugar may configure both the Bugs edit view and quick create
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.
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Editing Via Detail View

You can edit bugs via the detail view by clicking the Edit button on the upper left
of the page. Once the edit view layout is open, update the necessary fields, then
click "Save" to preserve the changes made.

 

Editing Via List View

You can edit bugs via the list view by clicking the Pencil icon to the left of each
bug's subject. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.

 

Editing Via Dashlets

You can edit bugs by clicking the pencil icon to the far right of any bugs-based
dashlet on your Sugar home page. For example, clicking the pencil icon within the
My Assigned Bugs dashlet will open a pop-up window with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve the changes. For more information on dashlets,
please refer to the Home documentation.
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Editing Via Reports

Sugar reports also allow you to edit a bug report by clicking on the pencil icon next
to a bug's subject. This opens a pop-up window with the quick create form which is
a shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes. Please note that you may only directly edit bugs
from Rows and Columns-type or Summation with Details-type reports as
Summation-type and Matrix-type reports do not include the pencil icon. For more
information on reports, please refer to the Reports documentation.

 

Deleting Bugs

If a bug report is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Bugs detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once. Deleting bug records will not delete the
related records and will only remove the relationship.

Please note that your ability to delete bugs in Sugar may be restricted by a role.
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For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a bug report via the detail view:

1. Navigate to a bug report's detail view.
2. Select "Delete" from the Actions menu. 

 

3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more bugs via the list view:

1. Navigate to the Bugs list view by clicking the Bug Tracker module tab.
2. Use the Basicor Advanced Searchto find the bugs you wish to delete.
3. Select the desired bug records individually or using the Checkbox

Dropdown'soptions.
4. Choose "Delete" from the Actions menu. 
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5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when
the application times out while deleting a large number of bug reports. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Bugs

Sugar's Export option allows users to download all fields for the selected bugs to
their computers as a .CSV (comma-separated values) file. This may be useful when
needing to use Bug Report data with other software such as Microsoft Excel or to
update existing records by exporting, making changes, then importing the altered
bugs back into Sugar. For more information on updating existing records via
import, please refer to the Import documentation. Due to PHP memory limitations
on the server, there may be occasions when the application times out while
exporting a large number of bug reports. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.

Bugs may be exported from the Bugs list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for bugs and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export bugs from Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Bugs

Mass Updating allows users to make the same change to multiple bug reports at
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once from the Bugs list view. Users with administrator or developer level access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of bug reports. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update bugs may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Mass Update option.

Use the following steps to mass update bug reports from the list view:

1. Navigate to the Bugs list view by clicking the Bug Tracker module tab.
2. Use the list view's Basicor Advanced Searchto identify bugs you wish to

modify.
3. Select the desired bugs individually or using theCheckbox Dropdown's

options.
4. Choose "Mass Update" from the Actions menu. 

 

5. Scroll to the Mass Update panel and set values for the fields you wish to alter.
Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments. 
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6. Click "Update" to save the changes to all of the currently selected bug
reports.

Finding Duplicate Bugs

Between multiple users working in Sugar, importing new records, and submitting
bugs via the Bug Portal, it is possible for duplicate bug reports to be accidentally
input to the system. Before creating a new bug report, a good practice is to first
check that the same issue does not already exist in Sugar. You can locate duplicate
records for cleanup using Basicand Advanced Search from the Bugs list view.
Searching for bugs with similar names, categories, or other information can turn
search a powerful, duplicates-finding tool. Sugar also provides a wizard for finding
potential duplicates that is available from the Bugs detail view and may be used as
shown below. If duplicate bug reports are detected, you can perform a merge per
the Merging Bugs section of this documentation.

Please note that your ability to use the Find Duplicate action may be restricted by
any role that prevents bug deletion. For more information on roles, please refer to
the Role Management documentation in the Administration guide.Check with your
system administrator if you do not see the Find Duplicates option.

Use the following steps to locate duplicate bugs using the Find Duplicates option
from the Bugs detail view:

1. Navigate to a bug report's detail view
2. Choose "Find Duplicates" from the Actions menu 
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3. Move any fields you wish to use in identifying duplicates to the list on the
right by selecting the field and clicking the arrow

 

4. Click "Next Step" to display a list of potential duplicate bug records which
match all of the specified filters

Once you determine which bugs of the resulting list are indeed duplicates of
your original record, select the duplicates by marking the checkboxes, then click
"Perform Merge" to begin a merge with the current record. Instructions for the
merge process that follows can be found in the Merging Via Detail View section of
this documentation.

Merging Bugs

When duplicate records are identified in Sugar, you have the option to merge two
or more bugs into a single record. Once the merge is complete, the duplicate bug
report(s) will be deleted, and the primary record will remain. Please note that all
relationships belonging to the duplicate bugs will be merged to the primary record
meaning that any cases, meetings, contacts, etc. related to the duplicate bug
report(s) will automatically be related to the resulting, merged bug report.

Merging Via Detail View

Use the following steps to merge bugs via the Bugs detail view:

 853 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Bugs/#Merging_Via_Detail_View


 

1. Navigate to a bug report's detail view.
2. Use the Find Duplicates option as shown in Finding Duplicate Bugs to identify

duplicate bugs.
3. Possible duplicates will be displayed in the results list. Select the duplicate

record(s). 

 

4. Click "Perform Merge" to display the Merge Bugs page. The primary record's
field values are displayed on the left while other records' values are in
columns to the right. Saving the merge will preserve only the leftmost values
for each field into a single bug record. 

 

5. To change which record is considered the primary, click the "Set as primary"
double arrows.

6. Review the field values in each column and use the associated double arrows
to move the best value for each field to the leftmost column.

7. Click "Save Merge" once the left column contains all fields you wish to appear
on the single, merged record.

8. A pop-up message will display confirming that the duplicate record(s) should
be deleted. Click "Ok" to proceed.

Merging Via List View
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Basic and Advanced Search may be used to identify duplicate bugs by, for
example, searching for bugs with similar names or categories. Once your search
has identified duplicate bug reports, you can merge them directly from the Bugs
list view.

Use the following steps to merge bugs via the list view:

1. Use the list view's Basicor Advanced Searchto identify duplicate bug reports.
2. Possible duplicates will be displayed in the list view. Select the duplicate

record(s) that you wish to merge. 

 

3. Select "Merge" from the Actions menu to display the Merge Bugs page. The
primary record's field values are displayed on the left while other record's
values are in columns to the right. Saving the merge will preserve only the
leftmost values for each field into a single bug record. 

 

4. To change which record is considered the primary, click the "Set as primary"
double arrows.

5. Review the field values in each column and use the associated double arrows
to move the best value for each field to the leftmost column.

6. Click "Save Merge" once the left column contains all fields you wish to appear
on the single, merged record.

7. A pop-up message will display confirming that the duplicate record(s) should
be deleted. Click "Ok" to proceed.
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Favoriting Bugs

Each Sugar user has the option to designate their own favorite bugs which are
important or will be viewed often so that they can easily be accessed via search or
from the Bug Tracker module tab. Once records are marked as favorites, use the
My Favorites checkbox in the Basic or Advanced Search to retrieve your favorites
or select from your most recent favorites directly from the Bug Tracker Module
Tab.

Favoriting Via List View

Use the following steps to mark records as favorites via the Bugs list view:

1. Navigate to the Bugs list view by clicking the Bug Tracker module tab.
2. Use the Basicor Advanced Searchto find the Bug reports you wish to mark as

favorites.
3. Mark the star icon on the left of each desired bug's row.
4. To remove the bug as a favorite, click the star again to revert it to white. 

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Bugs detail view:

1. Navigate to a bug report's detail view.
2. Click the star icon to the right of the bug's name in the upper left of the detail

view to designate it as a favorite.
3. To remove the bug as a favorite, click the star again to revert it to white. 
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Viewing Bugs Change Logs

Changes made to each bug record are tracked over time, and users are able to
view the history of changes via the change log in each bug's detail view. To view
the change log, navigate to a bug in detail view and select "View Change Log" from
the Actions menu. Please note that only fields marked as "Audit" in Admin > Studio
will be displayed in the change log. For more information on designating for audit,
please refer to the Studio documentation in the Administration guide.

 

Communicating Regarding Bugs

Sugar's Bug Portal enables users to communicate with customers regarding bugs
and to keep an archive of that correspondence.

The Bug Portal can be used to both view and submit bugs from a customer to
engineering or QA departments, but can also be used as a method of
communication regarding a bug. Both customers and Sugar users have the option
to add notes to bugs. Users can do this via the History subpanel. Customers have
this as an available option when viewing the details of a bug. For more information
on using the Bug Portal, please refer to the Portal Deployment User Guide . When
a customer adds a note to the portal, the note will be available for viewing inside
Sugar. In addition, when a user adds a note to a bug from Sugar, the note will be
available to be viewed in the Bug Portal assuming the Display in Portal field is
checked on the note. These notes are visible by anyone with access to the support

 857 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Developer_Tools/Studio
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Bugs/#Activities_and_History_Subpanels
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Portal_Deployment_User_Guide


 

portal.

Last Modified: 09/26/2015 06:25pm

Projects

Overview

Sugar's Projects module is used to track a variety of tasks in order for a project
manager to properly organize and complete a given project. Projects are tracked
using both a project grid and a Gantt chart. Resources (e.g. contacts and users)
can be allocated to the tasks of each project to helpe ensure your deadlines are
met.

Projects are also able to be associated to different accounts, contacts, 
opportunities, or other modules so that if a project is a direct result of one of these
modules, such as the project being performed that was purchased through an
opportunity, the relationship will show and alternate details be made available.

Note: This module is hidden by default. The administrator must enable it for your
use.

Project Fields

The Projects module contains the following fields which enable users to create and
properly organize projects.

Field Description
Assigned to Enter the name of the user who has

ownership of the project, which is
assigned to you by default

Date Created The date the project record was created
Date Modified The date the project record was last

modified
Description Enter a brief description of the project
End Date Click the Calendar icon and select the

project end date
Name Enter a name for the project
Priority Select the importance of the project
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from the dropdown list, such as Low,
Medium, or High

Start Date Click the Calendar icon and select the
project start date

Status Select a value from the dropdown list
such as Draft, In Review, or Published to
show the approval status of the project

Team The Sugar team(s) assigned to the
project

Projects Module Tab

The Projects module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Projects list view. You may also hover on
the tab to display the Actions and Recently Viewed menus. The Actions menu
allows you to perform important actions within the module. The Recently Viewed
menu displays the list of projects you last viewed in the module.

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Project Opens the edit view layout to create a

new project
Create Project Template Opens the edit view layout to create a

new project template
View Project List Opens the list view layout to search and

display projects
View Project Templates Opens the list view layout to display
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project templates
View Project Tasks Opens the list view layout to search and

display project tasks
View My Projects Dashboard Opens the Projects Dashboard
If you do not see the Projects module tab in Sugar, please check the following:

The top navigation bar may be filtered based on a specific tab grouping (e.g.
Activities, Reports, etc.) of which the Projects module is not a member. Click
the More tab (last tab on navigation bar) then hover on "Filter Menu By" to
check how the navigation bar is grouped. For more information on tab
grouping, please refer to the User Interface documentation.
The Projects module may be marked as hidden in your user preferences,
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Projects module in the Hide Modules
list, simply move it to the Display Modules list and save. For more information
on hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Projects module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Projects
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in the
Administration guide.

Creating Projects

The three methods for creating projects in Sugar are via the Projects module, via
Quick Create, and via Project Templates. The full edit view layout opens when
creating the project directly from the Projects menu and includes all of the
relevant fields for your organization's projects. The quick create form is a
shortened version of the projects edit view and can contain fewer fields. When
using quick create to make a project while viewing an existing record of another
module, Sugar automatically creates a relationship between both records. For
example, if you are viewing an account record (e.g. ABC Company) and create a
new project via the quick create form, the Accounts subpanel in the project record
will automatically populate with "ABC Company", thus creating the relationship.
Both the Edit View and Quick Create layouts can be configured by administrators
via Admin > Studio. For more information on configuring layouts, please refer to
the Studio documentation in the Administration guide.

Creating Via Projects Module
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One of the most common methods of project creation is via the Create Project
option in the Projects module tab. This opens up the edit view layout, which allows
you to enter in all the relevant information for the project.
Use the following steps to create a project via the Projects module:

1. Hover on the Projects module and select "Create Project".

 
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. Once the necessary information is entered, click "Save".

 

Creating Via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also easily create new records from any Projects
subpanel on related module records.

Use the following steps to create a project via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and select
"Create Project" or select "Create" on any Projects subpanel on a related
module's detail view.
From Quick Create:
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  From Subpanel:

 
2. Enter appropriate values in the fields in the quick create form. All required

fields are marked with a red asterisk and must be completed prior to saving.
3. If additional fields are desired, click the Full Form button to use edit view

instead.
4. Once the necessary information is entered, click "Save".

 

Creating Via Project Template

Project Templates are used when a similar project is going to be configured time
and time again. See Project Templates for more information. After you have a
template already created, you can use the template to create additional projects,
following these steps:

1. Hover on the Projects module and select "View Project Templates".
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2. While on the Project Template list view, click the name of your template to
open the template's detail view.

3. Select "Save as Project" from the Actions menu.

 

4. Change the name of your new project as need be and click "Save as New
Project", where you will be brought to the detail view of your new project.

Viewing Projects

There are various options available for viewing projects in Sugar including via
Projects list view, Projects detail view, Projects Recently Viewed menu, the Project
Dashboard, dashlets, and reports. Please note that you will only be able to see
projects records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the 
Teams and Roles documentation in the Administration guide.

Viewing Via List View

The Projects list view displays all project records meeting the current search
criteria. To access the list view, simply click the Projects module tab. While list
view shows key project fields, you can click the project's name to open the record
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in detail view. For more information on viewing project via list view, please refer to
the Projects List View section.

Viewing Via Detail View

The Projects detail view displays thorough projects information including all
project fields followed by subpanels of the project's related records belonging to
various modules. The detail view can be reached by clicking a project record's link
from anywhere in the application including from the Projects list view. For more
information on viewing projects via detail view, please refer to the Projects Detail
View section.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which projects and project templates you
have recently viewed. Hover on the Projects module tab to see a list of your most
recently viewed projects and click each name to open the project in detail view.

 

Viewing Via Project Dashboard

The Project Dashboard allows users to view upcoming and overdue project tasks,
as well as any support cases related to projects the user is assigned to. It also
allows an option for users to view any upcoming or overdue project tasks that are
assigned to the user. The Project Dashboard can be reached by clicking the
appropriate link in the Projects module tab.

The "My Projects Dashboard" panel shows four columns, showing projects that are
assigned to you, any overdue project tasks where the Finish Date is in the past,
any upcoming project tasks where the Start Date is within the next week, and any
cases that are open related to the project.

The "My Project Tasks" panel shows two columns, showing any overdue project
tasks assigned to you where the Start Date is in the past, any upcoming project
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tasks assigned to you where the Finish Date is within the next week.

All record references, for projects, project tasks, or cases, on either panel, are
clickable and will bring you to either the detail view for the specific record or the
Gantt chart of the parent project.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets, which allow users to get a
quick view of various records, activities, reports, etc. You can view project
information in project-based dashlets such as "My Project Tasks" as well as in
dashlets based on other modules such as "My Calls". Clicking a project's name
from any dashlet will open the project in detail view. For more information on
using dashlets and viewing project records via dashlets, please refer to the 
Modules section of the Home documentation.

 

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding projects and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
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filters to only display specific subsets of your records. Once the report is run, you
will be able to view the project record's detail view by clicking the project's name
in the report results. Please note that you can only directly access project detail
views with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Roles documentation in the
Administration guide. Check with your system administrator if you cannot access
the Reports module.

Searching Projects

The Projects list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Projects list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.
Note: Projects is hidden from Global Search by default. The administrator must 
enable it for your use.
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Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a project name, Sugar will only return projects with a
matching name that are assigned to you. Once the search is complete, the relevant
results will populate in the list view below the search panel. To see all projects to
which you have access, simply click "Clear" and then "Search" to perform a blank
search with no filters. Please note that you will only be able to see projects as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

Administrators can configure what fields appear on the Projects Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:
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Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Items" and enter in a project name to search, Sugar will only return projects with a
matching name that are assigned to you. When searching by a multiselect or
dropdown field (e.g. "Status"), however, Sugar will return records matching any of
these selections. Once the search completes, the relevant results will populate in
the list view below the search panel. To see all projects to which you have access,
simply click "Clear" and then "Search" to perform a blank search with no filters.
Please note that you will only be able to see projects as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Teams and Roles documentation in the
Administration guide.

Administrators can configure what fields appear on the Projects Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
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throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

 

To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Studio documentation as well as the Search section of the
System documentation in the Administration guide.

Projects List View

The Projects list view displays all projects meeting the current search criteria and
to which your user has access. You can view the basic details of each project
within the field columns. Please note that you will only be able to see projects as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Projects Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination
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List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on projects directly from the list view by first
selecting the desired records. To select individual projects on the Projects list
view, mark the checkbox on the left of each row. To select or deselect multiple
projects on the list view, use the options in the checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of project
results.
Select All : Selects all records in the current search results across all pages of
project results.
Deselect All : Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more projects at a time
Mass Update Mass update one or more projects at a

time
Export Export one or more projects to a CSV

file

More Information

Additional details for each project can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional project
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Description field by default. The list of fields
appearing here may only be configured through a code-level customization.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.
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Projects Detail View

The Projects detail view displays thorough project information including all project
fields, which are grouped by default into the Overview and Other panels. You can
also view a project's related records (Activities, Opportunities, Cases, etc.), which
appear in subpanels beneath the project fields. The detail view can be reached by
clicking a project's link from anywhere in the application including from the
Projects list view.

Please note that you will only be able to view a project record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Teams and Roles documentation in the
Administration guide. Users with administrator or developer access have the
ability to change the detail view by configuring the layout via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation in
the Administration guide.

Actions Menu

The Actions menu on the top left of each project's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this project
Delete Delete this project
View Gantt View the project's Gantt chart
Save As Template Save this project as a template for

future use
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Export To MS Project Export this project to an MPX file for
use with Microsoft Project

Next or Previous Record

On the upper right of the Projects detail view, there are two buttons that allow you
to page through each project in the Project list view's current search results.
Clicking the Previous button displays the previous project of the current search
results while clicking the Next button displays the next project of the current
search results. The text in between shows which project result you are currently
viewing within the total number of current results.

 

Subpanels

Beneath a project's fields are subpanels containing all of the users and contacts
that are working on the project, the project's tasks that need to be done, any
holidays or days off of the project so they will not be included in the date and time
calculations, and related records from various modules.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Resources Subpanel

The Resources subpanel is used to add specific Sugar users and contacts to the
project. When these users and contacts are added to the project, they will be
available to be added as resources on project tasks via the Gantt chart, meaning
they are the responsible party for the task. For more information on project
resources, please review the Project Resources section of this documentation.

The Resources subpanel allows the following operations to be performed:
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To view the details of a related user or contact, click the Users or Contacts
icon in the subpanel to open it in detail view.
To relate an existing user or contact to the project, choose the appropriate
"Select" option from the subpanel's Action menu, then locate and select the
desired record.
To remove the resource from the project, click "Unlink" from the dropdown on
the far right of the record's row. This removes the relationship, but does not
delete any actual records.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

 

Note: If you are not able to view this subpanel, the administrator may have
disabled the Projects subpanel for your entire Sugar instance. Reach out to your
Sugar administrator to have the subpanel displayed. For more information on
displaying and hiding subpanels throughout Sugar, please refer to the Developer
Tools documentation in the Administration guide.

Project Tasks Subpanel

The Project Tasks supbanel lists all of the project's Project Tasks and basic details
of each task. When a task is added to the project via the Gantt chart, the project
task will appear on this subpanel. The Project Tasks subpanel allows the following
operations to be performed:

To view the details of a project task, click the record's name in the subpanel
to open it in detail view.
To add additional tasks to the project, click the "View Gantt" button from the
subpanel's header and follow the information provided in Creating Project
Tasks section of this documentation.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
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subpanel's header.

Project Holidays Subpanel

The Project Holidays subpanel lists all of the resources' days that they will not be
working. The subpanel includes columns showing the resource's name, the date of
the holiday, and a description of the holiday. For more information on Project
Holidays, please refer to the Project Holidays section of this documentation. The
Project Holiday's subpanel allows the following operations to be performed:

To add additional holidays to the project, click the "Create" button from the
subpanel's header and fill in the necessary fields.
To remove the holiday from the project, click "Unlink" from the dropdown on
the far right of the record's row.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the project. Once the activities have taken place or are completed, they
will instead appear within the History subpanel. The History subpanel also
includes notes and emails associated with the project. For more information on the
history and activities subpanel, please refer to the User Interface documentation.

 

Related Record Subpanels

The most common type of subpanels displayed on a project's detail view contain
the project's related records belonging to various modules. The relationship type
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determines whether a related record will be displayed in the field listing or in a
subpanel. Out of the box, the Projects module does not include any relationships to
other modules that would cause a related record to be displayed in the field listing.
However, for example, a project may be related to multiple cases. This means that
the cases will be displayed in a subpanel beneath the fields listing.

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the project, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To edit the project's related record, choose "Edit" on the far right of the
record's row.
To delete the project's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the relationship,
but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

 

Editing Projects

Projects may be edited at any time to update or add information to the record. You
can make changes to existing project records via the Projects edit view and quick
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create forms. Edit view is available within the Projects module and includes all of
the Project fields you should need. To edit the Project Tasks related to this project,
please refer to the Editing Project Tasks section of this documentation

 

Quick create is available for editing projects from outside the Projects module and
opens as a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields.

 

Please note that your ability to edit projects in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure both the Projects edit view and quick
create via Admin > Studio. For more information on configuring layouts, please
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refer to the Studio documentation in the Administration guide.

Editing Via Detail View

You can edit projects via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve your changes.

 

Editing Via List View

You can edit projects via the list view by clicking the Pencil icon to the left of each
project's name. A pop-up window will open with the quick create form which is a
shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve your changes.

 

Editing Via Reports

Sugar reports also allow you to edit a project by clicking on the pencil icon next to
a project's name. This opens a pop-up window with the quick create form which is
a shortened version of the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes.
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Please note that you may only directly edit projects from Rows and Columns-type
or Summation with Details-type reports as Summation-type and Matrix-type
reports do not include the pencil icon. For more information on reports, please
refer to the Reports documentation.

Deleting Projects

If a project record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Projects detail view or list view.
Deleting via the detail view allows you to delete a single record while the list view
allows for mass deleting multiple records at once. Deleting projects will not delete
related records and will only remove the relationship, so you may wish to also
delete any related records to avoid orphaned records if necessary.

Please note that your ability to delete projects may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Delete options.

Deleting Via Detail View

Use the following steps to delete a project via the detail view:

1. Navigate to a project's detail view.
2. Select "Delete" from the Actions menu.
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3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more projects via the list view:

1. Navigate to the Projects list view by clicking the Projects module tab.
2. Use the Basic or Advanced Search to find the project records you wish to

delete.
3. Select the desired project records individually or using the Checkbox

Dropdown's options.
4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of project records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Projects

Sugar's Export option allows users to download all fields for the selected projects
to their computers as a .CSV (comma-separated values) file. This may be useful
when needing to use Project data with other software such as Microsoft Excel. Due
to PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of project records. If you
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encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Projects may be exported from the Projects list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for projects and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.

 

Please note that your ability to export projects from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Exporting to Microsoft Project

Sugar includes the functionality to export projects not just in CSV format, but also
in .MPX format. MPX is the standard format used by Microsoft Project. Upon
exporting this file, you will be able to open the file in Microsoft Project, which
allows people who are not Sugar users to be able to view this project information.

The following steps cover exporting a project to Microsoft Project:

1. Navigate to a project's detail view
2. Select "Export to MS Project" from the Actions menu

 

3. Open the downloaded file in Microsoft Project
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Mass Updating Projects

Mass Updating allows users to make the same change to multiple projects at once
from the Projects list view. Users with administrator or developer access can
control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of project records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update projects may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update projects from the list view:

1. Navigate to the Projects list view by clicking the Projects module tab.
2. Use the list view's Basic or Advanced Search to find projects you wish to

modify.
3. Select the desired project individually or using the Checkbox Dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

 
5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.
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6. Click "Update" to save the changes to all of the currently selected project.

Project Templates

Project Templates are used when a similar project is used multiple times. Project
Templates will save you from recreating the project each time. Instead, the
template can be used to create a new project which will have the same information
from the detail view and the same Project Tasks. Templates can be reused as often
as need be. They can be created using two different ways:

The module tab's Action Menu

 

Replicating an existing project using the Detail View's Action Menu

 
Choosing this option will bring you to a screen to define a new name for the
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template so that it can be made unique before saving the template and being
mixed with others.

When creating a project from a Project Template, the Project Tasks carry over
from the template to the new project. In addition, all of the fields within the
module carry over.

To see a list of all project templates, navigate to the Project Templates list view. To
access the list view, simply hover over the Projects module tab and select "View
Project Templates".

 

While list view shows key project template fields, you can click the project
template's name to open the record in detail view. For more information on the
Project Template's list view, please review the Projects List View section of this
documentation.

To create a project from a template, please review the Creating Via Project
Template section of this documentation.

Project Resources

Project Resources are a list of users and contacts that can be assigned Project
Tasks. On a project where you are the assigned user, you will see a subpanel on
the Projects detail view called "Resources". The subpanel will provide options to
Select User, Select Contact, or unlink an existing relationship. In addition any
related user or contact resource will have a corresponding icon allowing you to
view the user's detail view or contact's detail view.
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When a resource has been added to the project, the resource will show on the
Gantt chart as an available option for Project Tasks to be assigned. For more
information on the Gantt chart, please review the Project Tasks Gantt Chart
section of this documentation.
Note: If you are not able to view project resources, the administrator may have
disabled the Projects subpanel for your entire Sugar instance. Reach out to your
Sugar administrator to have the subpanel displayed. For more information on
displaying and hiding subpanels throughout Sugar, please refer to the Developer
Tools documentation in the Administration guide.

Project Resource Reports

From the Gantt chart, a resource report can be created showing a specific user's
or contact's assigned tasks across all projects and the user or contact's workload
for a given timeframe.

 
The report is filtered by each resource and filters for tasks starting or finishing
after a date, and before another given date. This allows an overall view of the
resource's time relative to all projects, not just one specific project.

 

This report shows the following information:

Daily Report : This section shows a daily breakdown of all weekday dates for
the report for the resource. The section also shows a "% Busy" section
showing what percentage of an 8 hour day is being taken up for this resource
by project tasks. If the resource has a Project Holiday scheduled, the % Busy
will show as "Holiday".
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Project Tasks : This section shows a list of all project tasks associated with the
resource in the given timeframe. This includes tasks across all projects, not
just the project from which the report was generated. This shows details for
each task so that you can see each task assigned to the user, as well as the
project that the task is for.

 
Holidays : This section shows a list of all of the resource's project holidays for
the given timeframe. This will show all holidays, regardless of which project
they are associated.

 

Project Holidays

The Project Holidays subpanel allows you to list any days that a user or contact
resource will not be working on a given project. This links with the project tasks to
ensure that timing of tasks is not affected by a resource taking a holiday. The
holidays are marked for specific days for specific project resources. Project
Holidays contain three fields:

Field Description
Description A brief description or reason for the

holiday.
Holiday Date The holiday or vacation date for this

resource on the project.
Resource Name The user or contact taking the holiday,

selected from a dependent dropdown
list.

Holidays created from this subpanel are specific to the project. Holiday records
can be deleted and removed from the project by clicking "Unlink" on the
corresponding line on the subpanel.
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Project Tasks

Project Tasks are a list of each task that needs to be performed to complete the
project. Project Tasks is a separate module than the Projects module, but it can
only be accessed via Projects. Each task can be tracked and monitored via the
Gantt chart. Each task can also be assigned a specific resource and is given a
planned start and finish date allowing the timing to be tracked and planned.

Project Task Fields

The Project Tasks module contains the following fields, which enable users to
properly organize and track each task.

Field Description
% Complete A numerical value to indicate what

percentage of the task has been
completed.

Actual Duration After the task is completed, enter a
numerical value for the actual duration
of the task.

Description Found only in the edit and detail views,
enter a brief description of the task and
any necessary details.

Duration Only editable from the Gantt chart,
enter a numerical value to indicate how
long it would take to complete the task
which can be specified in days or in
hours.

Note: Changes to this field will affect
the Finish Date as well.

Estimated Effort (hrs) Found only in the edit and detail views,
enter a numerical value for the
estimated amount of work needed for
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this task.
Finish Date Only editable from the Gantt chart, this

field will populate based on the Start
Date and Duration. Clicking on this field
on the Gantt chart will produce a
calendar popup to easily select a date.

Note: Changes to this field will affect
the Duration as well, and will be
affected by changes to the Start Date
and/or Duration fields.

Milestone Mark tasks as milestones if they are an
important and measureable landmark on
the way to completing the project. Tasks
can be marked with a checkbox on the
edit view or by clicking the task ID to
highlight the entire row and then right
clicking in the Gantt chart. Milestone
tasks will include an asterisk next to the
task ID on the Gantt chart.

Order The project task's detail view and edit
view display an Order field. This field,
which was used in the application prior
to version 5.0, has been replaced by the
Task ID field. If you are not using an
order number, you can safely remove
this field from the Project Task layouts
in Studio.

Predecessors If the completion of this task depends on
the completion of other tasks, enter the
Task ID in this column. This field must
be edited and viewed from the Gantt
chart.

Note: Multiple tasks can be
predecessors and the IDs can be
separated by commas.

Priority Choose a value of Low, Medium, or High
for the task which can be edited and
viewed from the edit and detail views.

Project The name of the parent project that can
be viewed from both the edit and detail
views. This value cannot be edited.
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Resource Select the individual who is assigned to
the task from the Resources dropdown
list.

Start Date Only editable from the Gantt chart, this
field will automatically populate with
today's date. Clicking on this field on the
Gantt chart will produce a calendar
popup to easily select a date.

Status Found only in the edit and detail view,
choose a value representing the current
stage of the task. This field also shows
on the Project Tasks subpanel.

Task ID When viewing the Gantt chart, the tasks
are ordered by Task ID. Task IDs cannot
be directly edited from the Gantt chart
or the edit and detail views. To move a
task to a different section of the list, and
therefore change its Task ID, click on
the existing ID to highlight the row,
then right click to "Cut" and then
"Paste" it in the new location.

Task Name Enter the name for the project task
here.

Task Number The project task's detail view and edit
view display a Task Number field. This
field, which was used in the application
prior to 5.0, has been replaced by the
Task ID field. If you are not using task
number, you can safely remove this field
from the Project Task layouts in Studio.

Teams The Sugar team(s) assigned to the task.
This is only viewable from the edit and
detail view.

Utilization (%) From the dropdown list, select the
percentage of a day that the resource
should dedicate their work hours
towards the assigned task. This field is
only found in the edit and detail views of
the project task.

Note: The value of this field is not
reflected in the Resource Report.
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Project Tasks Module Tab

The Project Tasks module tab is located on the navigation bar at the top of the
Project Task detail view, Project Task edit view, or Project Task list view. Click the
tab to access the Project Task list view. You may also hover on the tab to display
the Actions and Recently Viewed menus. The Actions menu allows you to perform
important actions within the module. The Recently Viewed menu displays the list
of project tasks you last viewed in the module.

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Project Opens the edit view layout to create a

new project
Project List Opens the list view layout to search and

display projects
Project Tasks Opens the list view layout to search and

display project tasks

Creating Project Tasks

Project Tasks can only be created from the Gantt chart's project grid. The tasks are
specific to each project, so they must be created directly from the project. When
creating a Project Task from the grid, you will be able to put in basic information
about the task. To add additional information later, please review the Editing
Project Tasks section of this documentation.

Use the following steps to create a project task via the Projects module:

1. Navigate to the detail view of the project where you would like to add tasks.
2. From the detail view, select "View Gantt" from the Project Tasks subpanel:
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Or select "View Gantt" from the Actions Menu:

 
3. Add a row to the grid next to the Gantt chart. This can be done using the icon

in the toolbar or by right clicking on the grid.

 
4. Fill in the grid columns on the new row that you created. When complete,

click the save icon the toolbar.

 

Viewing Project Tasks

There are various options available for viewing project tasks in Sugar including via
the grid and Gantt chart, the My Projects Dashboard, Project Tasks list view,
Project Tasks detail view, Project Tasks Recently Viewed menu, dashlets, and
reports.
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Viewing Project Tasks Via Gantt Chart

The Projects module includes a grid and Gantt chart, which allows you to view all
project tasks related to a specific project in one place. The grid, on the left of the
screen, outlines each task with pertinent information regarding each project task.
The Gantt chart, on the right, shows a timeline of each task and how they overlap.
For more information on the Gantt chart, please review the Project Tasks Gantt
Chart  section of this documentation.

 

Viewing Project Tasks Via My Projects Dashboard

The Project Dashboard allows for users to view any upcoming or overdue project
tasks that are assigned to the user, or are related to any projects for which the
user is the assigned user. The Project Dashboard can be reached by clicking the
appropriate link in the Projects module tab.

The "My Projects Dashboard" panel shows four columns, showing projects that are
assigned to you, any overdue project tasks where the Finish Date is in the past,
any upcoming project tasks where the Start Date is within the next week, and any
cases that are open related to the project.

The "My Project Tasks" panel shows two columns, showing any overdue project
tasks assigned to you where the Start Date is in the past, any upcoming project
tasks assigned to you where the Finish Date is within the next week.

Any project task link is clickable and will take you to the grid and Gantt chart for
the given project. Next to the task name, Sugar also displays the Finish Date for
the task.
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Viewing Project Tasks Via List View

The Project Tasks list view displays all project records meeting the current search
criteria. To access the list view, click the "View Project Tasks" option from the
Projects module tab. While list view shows key project fields, you can click the
project task's name to open the record in detail view. For more information on
viewing project via list view, please refer to the Project Tasks List View section.

Viewing Project Tasks Via Detail View

The Project Tasks detail view displays thorough project task information including
all project task fields followed by subpanels of the project task's related records
belonging to various modules. The detail view can be reached by clicking a project
task record's link from anywhere in the application including from the Projects
detail view. For more information on viewing project tasks via detail view, please
refer to the Project Tasks Detail View section.

Viewing Project Tasks Via Recently Viewed

As you work, Sugar will keep track of which project tasks you have recently
viewed. Hover on the Project Tasks module tab to see a list of your most recently
viewed project tasks and click each name to open the project task in detail view.

 

Viewing Project Tasks Via Dashlets

The Home page displays a collection of Sugar Dashlets, which allow users to get a
quick view of various records, activities, reports, etc. You can view project task
information in dashlets such as "My Project Tasks" as well as in dashlets based on
other modules such as "My Calls". Clicking a project task's name from any dashlet
will open the project in detail view. For more information on using dashlets and
viewing project records via dashlets, please refer to the Modules section of the
Home documentation.
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Viewing Project Tasks Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding projects and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the project task record's detail view by clicking the project's
name in the report results. Please note that you can only directly access project
task detail views with Rows and Columns-type and Summation with Details-type
reports as Summation-type and Matrix-type reports do not include hyperlinks in
their display columns. For more information on using reports, please refer to the 
documentation.

 

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Project Tasks

The Project Tasks list view includes a Basic and Advanced Search to help you
locate records easily and effectively in a module-specific manner. Once the search
is performed, the relevant results will be displayed in the Project Tasks list view
below. Global Search allows users to search for information across their entire
Sugar database as opposed to restricting search within a specific module. Please
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note that Sugar automatically appends the wildcard character (%) to the end of
your search phrase. This allows the system to retrieve all records that start with
the keyword entered in the search. If you would like to broaden the search, you
can use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "create" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.
Note: Project Tasks is hidden from Global Search by default. The administrator
must enable it for your use.

Project Tasks Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only records assigned to you.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a project task name, Sugar will only return project
tasks with a matching name that are assigned to you. Once the search is complete,
the relevant results will populate in the list view below the search panel. To see all
project tasks to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
projects as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Teams and 
Roles documentation in the Administration guide.

Administrators can configure what fields appear on the Project Tasks Basic Search
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via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Project Tasks Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select a Project
Name and enter in a project task name to search, Sugar will only return project
tasks with a matching name that related to that specific project. When searching
by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all project
tasks to which you have access, simply click "Clear" and then "Search" to perform
a blank search with no filters. Please note that you will only be able to see project
tasks as allowed by your team membership, user access type, and assigned roles.
For more information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.
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Administrators can configure what fields appear on the Projects Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Project Tasks List View

The Project Tasks list view displays all project tasks meeting the current search
criteria and to which your user has access. You can view the basic details of each
project task within the field columns. Please note that you will only be able to see
project tasks as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Teams and 
Roles documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Project Tasks Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Project Tasks Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Project Tasks Checkbox Selection

You can perform several actions on project task records directly from the list view
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by first selecting the desired records. To select individual project tasks on the
Project Tasks list view, mark the checkbox on the left of each row. To select or
deselect multiple project tasks on the list view, use the options in the checkbox
dropdown menu:

Select This Page : Selects all records shown on the current page of project
results.
Select All : Selects all records in the current search results across all pages of
project results.
Deselect All : Deselects all records that are currently selected.

 

Project Tasks Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more project tasks at a

time
Mass Update Mass update one or more project tasks

at a time
Export Export one or more project tasks to a

CSV file

Project Tasks More Information
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Additional details for each project task can be viewed by clicking the "i" icon to the
far right of each list view row. This provides users a quick view of additional
project task information in addition to what appears in the display column fields.
The resulting pop-up window will show the Description field by default. The list of
fields appearing here may only be configured through a code-level customization.

 

Project Tasks Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Project Tasks Detail View

The Project Tasks detail view displays thorough project task information including
all project task fields which are grouped by default into one panel. You can also
view a project task's related records (Activities, History, etc.), which appear in 
subpanels beneath the project task fields. The detail view can be reached by
clicking a project task's link from within Sugar including from the Project Tasks
list view.

Please note that you will only be able to view a project task record according to
your team membership, user type, and role restrictions. For more information on
teams and roles, please refer to the Teams and Roles documentation in the
Administration guide. Users with administrator or developer access have the
ability to change the detail view by configuring the layout via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation in
the Administration guide.

Project Tasks Actions Menu

The Actions menu on the top left of each project's detail view allows you to
perform two actions on the current record. Administrator users can change the
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action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this project task
Edit Task In Grid View the project task's parent project's

Grid and Gantt chart

Next or Previous Project Task Record

On the upper right of the Project task's detail view, there are two buttons that
allow you to page through each project in the Project Task list view's current
search results. Clicking the Previous button displays the previous project task of
the current search results while clicking the Next button displays the next project
task of the current search results. The text in between shows which project task
result you are currently viewing within the total number of current results.

 

Project Tasks Subpanels

Beneath a project task's fields are subpanels containing containing related records
from various modules, including different activities such as calls and meetings, as
well as a history of notes and emails.
Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
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Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Project Tasks Related Record Subpanels

Subpanels can be added to the Project Tasks module using relationships between
other modules and Project Tasks. Subpanels appear at the bottom of the detail
view. By default, Sugar does not include and any subpanels relating Project Tasks
to other modules. To add subpanels via relationships, please refer to the Studio
documentation in the Administration guide.

The most common type of subpanels displayed on a project task's detail view
contain the project task's related records belonging to various modules. The
relationship type determines whether a related record will be displayed in the field
listing or in a subpanel. For example, a project task may be related to only one
account but related to multiple contacts. This means that the related account will
be displayed amongst the project task's fields while contacts will be displayed in a
subpanel beneath the fields.

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in detail view.
To relate an existing record to the project, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the project, choose "Create" from the subpanel's
Action menu, then complete the quick create form and click "Save".
To edit the project task's related record, choose "Edit" on the far right of the
record's row.
To delete the project task's relationship to a record, choose "Remove" from
the dropdown on the far right of the record's row. This removes the
relationship, but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
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To move the subpanel to a new location on the detail view, drag and drop the
subpanel's header.

 

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Project Tasks Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the project task record. Once the activities have taken place or are
completed, they will instead appear within the History subpanel. The History
subpanel also includes notes and emails associated with the project task record.
For more information on the history and activities subpanel, please refer to the 
User Interface documentation.

 

Project Tasks Gantt Chart

The Projects module includes a grid and Gantt chart to allow you to visualize,
track, and easily make changes to your project tasks all in one place. This menu is
accessible from each project's detail view through the Actions Menu or the 
Project Tasks subpanel. The page consists of a grid which shows each project task,
as well as information on the timing, % complete, preceding tasks, and who is
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responsible for completing the task. Project tasks on the grid can be edited by
clicking on the specific cell and making in-line changes. Whole rows can be
selected by clicking the Task ID number in the ID column on the far left column.
The Gantt chart shows a timeline of each task represents which tasks are being
worked on at a given time.

 

Gantt Chart Toolbar

The Gantt Chart Toolbar allows you to make changes to both what tasks are
showing on the grid, but also how they are displayed. The icons and menus
perform the following actions, from left to right:

Toolbar Option Description
Add New Row Adds a new row to the end of the task

list, unless a row is selected, when the
button will add the row above the
selection

Indent Row When a row is selcted, this button will
make it a subordinate function of the
above row, causing any subordinate
tasks to be grouped under the parent
task

Outdent Row When a row is selcted and already
indented, this button will move it out
from being a subordinate function of the
above row and making it its own task

Copy Row When a row is selected, the Copy button
will allow the data in the row to be
placed in another row while keeping the
origional in tact

Cut Row When a row is selected, the Cut button
will delete the entire row, but allow it to
be pasted into another as an ensuing
action
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Paste Row Adds currently copied or cut row to the
end of the task list, unless a row is
selected, when the button will place the
row above the selection

Delete Row When a row is selected, the Delete
button will remove the entire row and
delete the project task

Expand All This button will affect the entire grid by
expanding all hidden rows created by
indenting to show all rows on the grid

Collapse All This button will affect the entire grid by
collapsing all visible indented rows on
the grid

Save Saves all changes to the grid and
updates the related project task records

Week View Changes the Gantt chart to show one
week of events at a time

2 Week View Changes the Gantt chart to show two
weeks of events at a time

Month View Changes the Gantt chart to show one
month of events at a time

View... Dropdown list to provide filters to
change which project tasks are showing
on the grid

Export to PDF Exports a PDF from Sugar containing
the information shown in the task grid

Resource Report Opens the Resource Report popup
Grid Changes the view of the page to only

show the task grid and releted toolbar
buttons

Gantt Changes the view of the page to only
show the Gantt chart and releted
toolbar buttons

Grid/Gantt Changes the view of the page to show
both the task grid and Gantt chart

Editing Project Tasks

Project Tasks may be edited at any time to update or add information to the
record. You can make changes to existing project task records via the Gantt chart,
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Project Tasks edit view, and Project Task quick create forms. Edit view is available
within the Project Tasks module and includes all of the Project Task fields you
should need.

 

Quick create is available for editing project tasks from outside the Project Tasks
module and opens as a pop-up without navigating away from your current page.
Unlike other Sugar modules, the quick create view of the Project Tasks module will
be exactly the same as the edit view. A full form option is available if you do not
want to view this layout as a popup.

 

Please note that your ability to edit project tasks in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure the Projects edit view via Admin > Studio.
For more information on configuring layouts, please refer to the Studio
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documentation in the Administration guide.

Editing Project Tasks Via Detail View

You can edit project tasks via the Detail View by clicking the Edit button on the
upper left of the page. Once the edit view layout is open, update the necessary
fields, then click "Save" to preserve your changes.

 

Editing Project Tasks Via Gantt Chart

Project Tasks can be edited one at a time via the task grid and Gantt Chart. The
Gantt chart can be accessed via the Projects detail view and Project Tasks detail
view. Project Task fields can be edited by clicking on the field, either if it is empty
or if it contains existing data, and edits can be made directly inline on the grid.
Selecting the entire row can be done by clicking the ID number for the row of each
project task. Multiple tasks can be selected by holding the Shift key on your
keyboard while clicking.

The following fields can be edited from the task grid and Gantt chart:

% Complete
Task Name
Duration
Start
Finish
Predecessors
Resource
Actual Duration

Editing Project Tasks Via List View

You can edit project tasks via the list view by clicking the Pencil icon to the left of
each project task's name. A pop-up window will open with the quick create form
which is a popup version of the edit view layout. Update the necessary fields, then
click "Save" to preserve your changes.
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Editing Project Tasks Via Dashlets

You can edit project tasks by clicking the pencil icon to the far right of any Project
Task-based dashlet on your Sugar home page. For example, clicking the pencil
icon within the My Project Tasks dashlet will open a pop-up window with the quick
create form containing the edit view layout. Update the necessary fields, then click
"Save" to preserve the changes. For more information on dashlets, please refer to
the Home documentation.

 

Editing Project Tasks Via Reports

Sugar reports also allow you to edit a project task by clicking on the pencil icon
next to a task's name. This opens a pop-up window with the quick create form
which is a pop-up version of the edit view layout. Update the necessary fields, then
click "Save" to preserve the changes.

 

Please note that you may only directly edit project tasks from Rows and
Columns-type or Summation with Details-type reports as Summation-type and
Matrix-type reports do not include the pencil icon. For more information on
reports, please refer to the Reports documentation.
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Deleting Project Tasks

If a project task is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the project's Gantt chart or the Project
Tasks list view. Deleting via the Gantt chart allows you to delete a single record
while the list view allows for mass deleting multiple records at once. Deleting
projects will not delete related records and will only remove the relationship, so
you may wish to also delete any related records to avoid orphaned records if
necessary.

Please note that your ability to delete project tasks may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Delete options.

Deleting Project Tasks Via Gantt Chart

Use the following steps to delete a project task via the Gantt chart:

1. Navigate to the project's Gantt chart
2. Select the project task's row by clicking on the ID number for the task

 
3. Right click on the selected row and select the "Delete" option from the action

menu, or click the "Delete" button from the Gantt toolbar
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4. Save the Gantt chart to confirm the change to the project.

Mass Deleting Project Tasks Via List View

Use the following steps to delete one or more project tasks via the list view:

1. Navigate to the Project Tasks list view by hovering over the Projects module
tab and selecting "View Project Tasks".

2. Use the Basic or Advanced Search to find the project task records you wish to
delete.

3. Select the desired project tasks individually or using the checkbox
dropdown's options.

4. Choose "Delete" from the Actions menu.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of project task records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Project Tasks

Sugar's Export option allows users to download all fields for the selected project
tasks to their computers as a .CSV (comma-separated values) file. This may be
useful when needing to use Project data with other software such as Microsoft
Excel. Due to PHP memory limitations on the server, there may be occasions when
the application times out while exporting a large number of project tasks. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Project tasks may be exported from the Project Tasks list view by selecting
"Export" from the Actions menu. Users with access to the Reports module also
have the option of creating or accessing reports containing specifically chosen
fields for project tasks and their related record(s). Please note that only Rows and
Columns-type reports have the ability to be exported. For more information on
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exporting records in Sugar, please refer to the Export documentation.

 
Please note that your ability to export projects from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Project Tasks

Mass Updating allows users to make the same change to multiple project tasks at
once from the Project Tasks list view. Users with administrator or developer access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of project tasks. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update project tasks may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update projects from the list view:

1. Navigate to the Project Tasks list view by hovering over the Projects module
tab and selecting "View Project Tasks".

2. Use the list view's Basic or Advanced Search to find project tasks you wish to
modify.

3. Select the desired project tasks individually or using the checkbox
dropdown's options.

4. Choose "Mass Update" from the Actions menu.
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5. Scroll to the Mass Update panel and set values for the fields you wish to alter.

Note: For the Teams field, use "Replace" to remove existing team assignments
before adding those specified here. Use "Add" to add the teams specified here
to any existing team assignments.

 
6. Click "Update" to save the changes to all of the currently selected project

tasks.

Last Modified: 09/26/2015 06:25pm

Reports

Overview

Sugar's Reports module allows users to build, generate, and manage reports for
modules such as Accounts, Contacts, Calls, etc. Reporting is a valuable tool in
Sugar as users can gather key data from various modules to generate vital
information for their organization. There are four types of reports (Rows and
Columns Report, Summation Report with Details, Summation Report, Matrix
Report) available in Sugar. This documentation cover how to use the Reports
module to build, generate, and manage reports as well as the various actions and
options available from within the module.

Reports Module Tab
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The Reports module tab is located on the navigation bar at the top of any Sugar
screen. Click the tab to access the Reports list view. You may also hover over the
tab to display the Actions, Recently Viewed, and Favorites menu. The Actions
menu allows you to perform important actions within the module. The Recently
Viewed menu displays the list of reports you last viewed in the module. The 
Favorites menu displays the list of reports you most recently marked as favorites in
the module.

 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Report Opens the report wizard to create a new

report
View Reports Opens the list view layout to search and

display reports
Manage Advanced Reports Opens the Advanced Reports tab to

create and view advanced reports

Report Types

There are four types of reports (Rows and Columns Report, Summation Report,
Summation Report with Details, Matrix Report) available for users to create in
Sugar. Please note that each report type provides users with key information for
records that meet the specified criteria, but each displays the report results in
different layouts.

Rows and Columns

The Rows and Columns report is the most basic report to create out of the four
report types. The report results display the data in a simple rows-and-columns
format displaying values for the selected display column fields for all records
meeting the specified criteria. Please note that only Rows and Columns-type
reports can be exported as a .CSV (comma-separated values) file in Sugar. For
more information on creating a Rows and Columns report, please refer to the 
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Rows and Columns Report section of this documentation.

Summation

The Summation Report provides computed data based on the selected fields for
records meeting the specified criteria. You can group the report based on one or
more fields from the target or related module. The report result will display the
data in groups, summarized using computed derivatives (e.g. SUM, AVG, MAX,
MIN) from numeric-type field values (e.g. opportunity amount, amount, etc.) as
well as weighted amounts. Summation Reports can be viewed in a chart format
and displayed as a Sugar Dashlet on your Home page as well.For more information
on creating a Summation Report, please refer to the Summation Report section of
this documentation.

Summation Report with Details

The Summation Report with Details is a combination of the Summation-type and
Rows and Columns-type report as you can group the data, get the total count of
records, and choose display columns (e.g. Contacts Name, Account Name, Email
Address, etc.) as well. You can group the report based on one or more fields from
the target or related module. You can view a Summation Report with Details in a
chart format and displayed as a Sugar Dashlet on your Home page. For more
information on creating a Summation Report with Details, please refer to the 
Summation Report with Details section of this documentation.

Matrix

The Matrix Report is also similar to the Summation-type report as it provides an
overview of the computed data and displays the total summary count. The report
results are displayed in a grid table with row and column headers. The numeric
field values for all display summaries will appear on the table along with the grand
total amounts for each row and column. Matrix Reports can be viewed in a chart
format and displayed as a Sugar Dashlet on your Home page. For more information
on creating a Matrix Report, please refer to the Matrix Report section of this
documentation.

Creating Reports

There are various types of reports (e.g. Rows and Columns Report, Summation
Report with Details, Summation Report, Matrix Report) you can create via the
Reports module. When you select "Create Report" from the Actions menu of the
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Reports module tab, the first step of the Report Wizard is to select the report type.
The report type you select determines the steps you will have to complete to create
the report. The following sections cover creating the four different report types via
the Reports module.

Rows and Columns Report

Out of the four report types, the Rows and Columns report is the most basic one to
create in Sugar. Users can simply define filters to determine which records the
report will include or exclude and then choose the fields (e.g. Name, Email
Address, etc.) they would like displayed in the report result. The Rows and
Columns report creates a tabular report containing the values of selected display
column fields for all records meeting the specified criteria.Please note that only
Rows and Columns-type reports have the ability to be exported to a CSV file in
Sugar.

The following steps cover creating a Rows and Columns report for calls with a
status of held as an example:

1. Navigate to the Reports module and select "Create Report".

 
2. Choose "Rows and Columns Report" as the report type and "Calls" as the

target module in the following step.

 
3. To filter on a field related to the target module, select it from the Available

Fields list on the bottom left, and it will be added to the list of filters. We will
select "Status" to filter the report based on call records already held. Click
"Next".

For more information on report filters, please refer to the Report Filters
section of this documentation.
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4. On the Choose Display Columns step, select the fields you would like included

on the report result from the Available Fields list and then click "Next". The
following fields will be added to the report: Subject, Status, Description, Date
Created, User Name, Contacts Name, and Account Name.

For more information on selecting display column fields, please refer to
the Report Display Columns section of this documentation.

5. Select "Subject", "Date Created", "Status", and "Description" in the Available
Fields > Calls list, as these are direct fields of the Calls module. By default,
the target module fields are displayed in the Available Fields list.

Note: You can designate the generated report to be sorted by a specific
display column field in either ascending or descending order. Simply
mark the radio button next to the field label then select "Ascending" or
"Descending" in the corresponding dropdown list.
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6. For the User Name field, click "Assigned to User" from the Related Modules

list at the top left then select "User Name" from the Available Fields :
Assigned to User list.

Note: User names are stored in their own table in the database and are
related to the modules in Sugar. So even though the assigned user field
appears in various module layouts, they are not direct fields of those
modules.

 
7. For the Contacts Name field, click "Contacts" from the Related Modules list

then select "Name" from the Available Fields : Contacts list.
By default, the label for the Name field will display "Name", but you can
override the label to "Contacts Name" to differentiate the field between
accounts and contacts. For more information on changing display column
labels, please refer to the Changing Display Column Labels section of
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this documentation.
8. For the Account Name field, click "Account" from the Related Modules list

then select "Name" from the Available Fields : Account list.
Change the label for the Name field to display "Account Name". For
more information on changing display column labels, please refer to the 

9. To place the fields in a different order on the report, drag and drop the field
rows within the display column list.

The first field (Subject) on the display columns list represents the first
column of the report, the second field (Date Created) is the second
column, and so forth. For more information on changing the display
column order, please refer to the Changing Display Column Order
section of this documentation.

10. Click "Next" once all appropriate fields have been added.
11. On the Report Details step, enter the report name and assign it to the

appropriate user and team.
Please note that if you want your report to include all held calls whether
or not they have an assigned user, related contact, or account, you will
need to mark the Optional Related Modules boxes. For more information
on marking related modules as optional, please refer to the Optional
Related Modules section of this documentation.

 
12. Once the report details are entered, click "Save and Run" to save and

generate the report immediately.
Clicking the Preview button allows you to preview the report prior to
saving.
Clicking the Save button will save the report, but not run it immediately.
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Summation Report

The Summation Report allows data to be grouped and provides computed data for
records that meet the specified criteria. You can choose an unlimited number of
group-by columns to group the data in the report and can define group-by data for
related modules as well.You can also drag and drop the group by fields to a
different order in the Define Group By step to change the layout in the report
results. Please note that the Summation Report does not provide detailed
information like Summation Report with Details and will not include display
columns in the report.

The following steps cover creating a Summation Report for total closed won
opportunities in 2012 by user as an example:

1. Navigate to the Reports module and select "Create Report".
2. Choose "Summation Report" as the report type and "Opportunities" as the

target module in the following step.

 
3. To filter on a field related to the target module (Opportunities), select it from

the Available Fields list on the bottom left and it will be added to the list of
filters. We will select "Expected Close Date" and "Sales Stage" to filter the
report based on closed won opportunities for 2012. Click "Next".

For more information on report filters, please refer to the Report Filters
section of this documentation.
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4. On the Define Group By step, select the field(s) you would like the records in

the report grouped by, then click "Next". We will add "User Name", which will
group the closed won opportunity records by assigned user.

Please note that you will have to click the related Assigned to User
module to select the User Name field as user names are not direct fields
of the Opportunities module.
Note: If you have multiple group-by fields, you can drag and drop the
displayed field paths in the Define Group By section to change the
ordering and layout in the report result.

 
5. On the Choose Display Summaries step, select how you would like the

opportunity amounts summarized on your report then click "Next". We will
select "SUM: Opportunity Amount", which will add all the closed won
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opportunity amounts in 2012 per user and display the total for each grouping.
Please note that the field(s) you selected in the Define Group By step is
automatically included in the Choose Display Summaries step.
Note: You can designate the generated report to be sorted by a specific
field column in either ascending or descending order. Simply mark the
radio button next to the field label then select "Ascending" or
"Descending" in the corresponding dropdown list.

 
6. On the Chart Options step, select the chart type you want to display in the

report as well as how the data will be summarized on the chart, then click
"Next". We will select "Vertical Bar" as the chart type, summarized by the
total opportunity amount per user.

For more information on setting up the chart options, please refer to the 
7. On the Report Details step, enter a name for the report and assign it to the

appropriate user and team.
Please note that if you want your report to include all closed won
opportunities whether or not it is assigned to a user, you will need to
mark the Optional Related Modules box. For more information on
marking related modules as optional, please refer to the Optional
Related Modules section of this documentation.

 
8. Once the report details are entered, click "Save and Run" to save and

generate the report immediately.
Clicking the Preview button allows you to preview the report prior to
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saving.
Clicking the Save button will save the report, but not run it immediately.

 

Summation Report with Details

The Summation Report with Details allows data to be grouped and summarized
with detailed information related to records in the report. You can group the
report based on one or more fields from the target or related module. Grouping the
report by particular fields allows the report results to display data in categories by
the specified field values. You can also drag and drop the group-by fields to a
different order in the Define Group By step to change the layout in the report
results.

The following steps cover creating a Summation Report with Details for closed won
opportunities in 2012 grouped by month as an example:

1. Navigate to the Reports module and select "Create Report".
2. Choose "Summation Report with Details" as the report type and

"Opportunities" as the target module in the following step.
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3. To filter on a field related to the target module (Opportunities), select it from

the Available Fields list on the bottom left, and it will be added to the list of
filters. We will select "Expected Close Date" and "Sales Stage" to filter the
report based on closed won opportunities for 2012. Click "Next".

For more information on report filters, please refer to the Report Filters
section of this documentation.

 
4. On the Define Group By step, select the field(s) you would like the records in

the report result grouped by then click "Next". We will add "Month: Expected
Close Date", which will group the opportunity records based on the month of
the expected close date.

Note: If you have multiple group-by fields, you can drag and drop the
displayed field paths in the Define Group By section to change the
ordering and layout in the report result.
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5. On the Choose Display Summaries step, select how you would like the

opportunity amounts summarized on your report then click "Next". We will
select "SUM: Opportunity Amount", which will add all the closed won
opportunity amounts in 2012 and display the total for each grouping.

Please note that the field(s) you selected in the Define Group By step is
automatically included in the Choose Display Summaries step.

 
6. On the Choose Display Columns step, select the fields you would like included

on the report from the Available Fields list on the bottom left then click
"Next". The following fields will be included in this report: Opportunity Name,
Opportunity Amount, Expected Close Date, Sales Stage, Account Name.

Refer to Steps 5-10 of creating Rows and Columns Report for
instructions on how to add fields as display columns.
For more information on selecting display column fields, please refer to
the Report Display Columns section of this documentation.
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7. On the Chart Options step, select the chart type you want displayed in the
report as well as how the data will be summarized on the chart then click
"Next". We will select "Vertical Bar" as the chart type, summarized by the
total opportunity amount per month.

For more information on setting up the chart options, please refer to the 
8. On the Report Details step, enter a name for the report and assign it to the

appropriate user and team.
Please note that if you want your report to include all closed won
opportunities whether or not they have a related account, you will need
to mark the Optional Related Modules box. For more information on
marking related modules as optional, please refer to the Optional
Related Modules section of this documentation.

 
9. Once the report details are entered, click "Save and Run" to save and

generate the report immediately.
Clicking the Preview button allows you to preview the report prior to
saving.
Clicking the Save button will save the report, but not run it immediately.
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Matrix Report

The Matrix Report provides an overview of the data and displays the total for
display summaries in a grid format. The numeric field values for all display
summaries will appear on the table along with the grand total amounts for each
row and column. You can choose a maximum of three group-by columns to group
the data in the report.

You can also choose specific layout options (e.g. 1x2 and 2x1) on the Report
Details step of the Report Wizard if you selected three group-by columns on the
Define Group By step. The 1x2 layout option displays the data for the first group-by
field in a row and displays the data for the other two group-by fields in columns.
The 2x1 layout option displays the data for the first two group-by fields in rows and
displays the data for the third group-by field in a column. If you only have two
group-by columns, you can manually change the report layout by dragging and
dropping the group-by fields to a different order on the Define Group By step.
Please note that the Matrix Report does not provide detailed information like
Summation Report with Details and will not include display columns in the report.

The following steps cover creating a Matrix Report for the number of "closed won"
opportunities in 2012 by month for each user as an example:
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1. Navigate to the Reports module and select "Create Report".
2. Choose "Matrix Report" as the report type and "Opportunities" as the target

module in the following step.

 
3. To filter on a field related to the target module (Opportunities), select it from

the Available Fields list on the bottom left, and it will be added to the list of
filters. We will select "Expected Close Date" and "Sales Stage" to filter the
report based on closed won opportunities for 2012. Click "Next".

For more information on report filters, please refer to the Report Filters
section of this documentation.

 
4. On the Define Group By step, select the field(s) you would like the records in

the report result grouped by then click "Next". We will add "User Name" and
"Month: Expected Close Date", which will group the opportunity records
based on the assigned user and month of expected closed date.

Please note that you will have to click the related Assigned to User
module to select the User Name field as user names are not direct fields
of the Opportunities module. Next, click "Opportunities" in the Related
Modules list to select "Month: Expected Close Date".
Note: The order of the Group By fields determine which fields constitute
the X and Y axis of the displayed report grid. For this example, the
assigned users will be listed in rows on the Y axis with the month of
expected close date displayed across columns on the X axis of the report
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grid. You can change the order of fields by dragging and dropping the
field within the Define Group By section.

 
5. On the Choose Display Summaries step, select how you would like the

opportunity amounts summarized on your report then click "Next". We will
select "SUM: Amount", which will add all closed won opportunities in 2012
and display the total amount of won opportunities by month by user as well as
the grand total per user and for all users.

Please note that the field(s) you selected in the Define Group By step is
automatically included in the Choose Display Summaries step.
Note: You can designate the generated report to be sorted by a specific
field column in either ascending or descending order. Simply mark the
radio button next to the field label then select "Ascending" or
"Descending" in the corresponding dropdown list.

 
6. On the Chart Options step, select the chart type you want displayed in the

report as well as how the data will be summarized on the chart then click
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"Next". We will select "Pie" as the chart type summarized by the total
opportunity amount.

For more information on setting up the chart options, please refer to the 
7. On the Report Details step, enter a name for the report and assign it to the

appropriate user and team.
Please note that if you want your report to include all closed won
opportunities whether or not it is assigned to a user, you will need to
mark the Optional Related Modules box. For more information on
marking related modules as optional, please refer to the Optional
Related Modules section of this documentation.
Note: The Layout Options dropdown list (1x2 and 2x1) will appear if you
selected three group-by columns on the Define Group By step. Select the
appropriate layout depending on how you want the data displayed on the
report grid.

 
8. Once the report details are entered, click "Save and Run" to save and

generate the report immediately.
Clicking the Preview button allows you to preview the report prior to
saving.
Clicking the Save button will save the report, but not run it immediately.

 928 / 1.013

http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Reports/#Optional_Related_Modules
http://support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Reports/#Optional_Related_Modules


 

 

Report Filters

The Define Filters step of the report wizard determines which records the report
includes or filters out. Filter groups and operators allow for additional levels of
complexity as you combine filters to get the precise result set you desire.

Target Module Filters

By default, the fields for the Target Module you are creating the report on will be
displayed in the Available Fields list. To filter on the field related to the target
module, select it from the Available Fields list on the bottom left, and it will be
added to the list of filters. Please note that only fields marked as "Reportable" in
Studio will display in the Available Fields list. For more information on marking
fields as reportable, please refer to the Studio documentation in the Administration
guide.
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You can also use the search feature above the Available Fields list to easily locate a
desired field. Simply enter in the appropriate keyword (e.g. billing, date, etc.) in
the search field and the relevant results will display in the Available Fields list.
Please note that Sugar automatically appends the wildcard character (%) to the
beginning and end of your search phrase. This allows the system to return all fields
that include the keyword entered in the search.

 

Related Module Filters

The Related Modules list shows all modules that have a relationship with the
target module. To filter on a field in a related module, choose the name of the
module (e.g. Documents) in the Related Modules list, and the Available Fields list
below will display fields belonging to the related module. You can select the
desired field(s) from the related module to add as a filter for your report. Please
note that only fields marked as "Reportable" in Studio will display in the Available
Fields list. For more information on marking fields as reportable, please refer to
the Studio documentation in the Administration guide.
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You can also use the search feature above the Available Fields list to easily locate a
desired field. Simply enter the appropriate keyword (e.g. billing, date, etc.) in the
search field and the relevant results will display in the Available Fields list. Please
note that Sugar automatically appends the wildcard character (%) to the beginning
and end of your search phrase. This allows the system to return all fields that
include the keyword entered in the search.

 

Filter Values

Once the filter has been created, you can specify what field values constitute a
match for the report in the Define Filters section. Select the appropriate value
from the corresponding dropdown list and enter the relevant value in the open text
box (if applicable).
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Please note that if the assigned user or a member of your team changes or adds a
new filter, the system alerts you that the report filters have been modified since
last run when you save and run the report.

 

Run-Time Filters

The run-time option in the Define Filters step allows you to make the filter(s)
available on the saved report, which enables you to quickly change your filter
values without having to edit the report. Simply mark the Run-time box for any
filter(s) you wish to view on the saved report.

 

Once the report is created and saved, the run-time filter (e.g. "Accounts > Date
Created") will appear on the generated report view. You can change the filter
values directly from the report view by selecting the new filter values from the
dropdown list and clicking "Apply" or "Run Report" at the top of the report's detail
view. Clicking the Reset button will reset the run-time filter back to the original
filter value you set.

 

Please note that the Report Wizard retains the original filter value(s) you set when
building the report regardless of the changes you or other users make on the
run-time filters on the report's detail view. If the report is shared by a team, then
each user can run the report with different run-time filter values to meet their
individual needs. The run-time filter values set by each user will be preserved for
future viewing until they change or reset the value.

Operators

 932 / 1.013



 

When building the report, you have the option to choose between two operators,
"AND" and "OR", using dropdowns within the Define Filters section. By default,
operators are set to "AND" which will cause the filters to work cumulatively. All
filters or groups of filters under an AND operator will need to be true for a record
in order for that record to appear in the report result. Changing an operator to
"OR" will mean that if any single filter under that "OR" is true for a record, the
record will be included on the report. The OR operator accepts records matching
any of the filters while the AND operator accepts records matching all filters.

 

Filter Groups

By default, all filters will be added to a single group. To split filters into multiple
groups, use the Add Filter Group button.

 

When you have more than one filter group and click a new filter field, Sugar will
prompt for which filter group the new field should belong.

 

Filter groups and operators can be combined to achieve complex filtering
situations. For example, if we need a report for documents belonging to accounts
created prior to the first quarter where the document is either new this week or
new this month if connected to a lead, we would use the following filter groups
with an OR operator joining the two together:
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Filters on Date and Datetime Fields

When creating reports in Sugar, specifying a range of time is a useful way to
isolate your desired results. Sugar provides a set of pre-defined options to help you
easily target the most common date ranges:

Date Range Filter Definition
On A specific day
Before Any value before the specified date
After Any value after the specified date
Is Between Any values after a specified start date

but before a specified end date
Not On Any values except the specified date
Is Empty No date set for the field
Is Not Empty Any date set for the field
Yesterday A value set to the prior day
Today A value set to the current day
Tomorrow A value set to the following day
Last # Days Any values within the last X days

including the current day
Next # Days Any values within the next X days

including the current day
Last 7 Days Any values within the last 7 days

including the current day (e.g. Running
on Monday includes the previous
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Tuesday morning through the end of the
current Monday)

Next 7 Days Any values within the next 7 days
including current day (e.g. Running on
Monday includes the the current
Monday morning through the end the
following Sunday)

Last Month Any values that fall within the prior
calendar month

This Month Any values that fall within the current
calendar month

Next Month Any values that fall within the next
calendar month

Last 30 Days Any values within the last 30 calendar
days including the current day

Next 30 Days Any values within the next 30 calendar
days including the current day

Last Quarter Any values within the prior quarter
defined by the calendar year (e.g.
January - March, April - June, etc.)

This Quarter Any values within the current quarter
defined by the calendar year (e.g.
January - March, April - June, etc.)

Next Quarter Any values within the upcoming quarter
defined by the calendar year (e.g.
January - March, April - June, etc.)

Last Year Any values within the prior calendar
year

This Year Any values within the current calendar
year

Next Year Any values within the upcoming
calendar year

Additionally, if your administrator has configured the Forecasts module via Admin
> Forecasts, additional options based on your organization's fiscal year will be
available. If your fiscal year follows a traditional calendar year, these options will
function in the same way as the corresponding options above:

Date Range Filter Definition
Previous Fiscal Year Any values within the prior fiscal year
Previous Fiscal Quarter Any values within the prior quarter
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defined by the fiscal year
Current Fiscal Year Any values within the current fiscal year
Current Fiscal Quarter Any values within the current quarter

defined by the fiscal year
Next Fiscal Year Any values within the upcoming fiscal

year
Next Fiscal Quarter Any values within the upcoming quarter

defined by the fiscal year
For more information about configuring the Forecasting module, please refer to
the Forecast Configuration documentation in the Administration guide.

Note: When generating reports with datetime filters, Sugar will always adjust the
results to ensure they are accurate according to the time zone settings of the user
accessing the report. For instance, a user on Eastern Standard Time (-5 GMT) may
see a different set of results for a report than a user on Pacific Standard Time (-8
GMT) because the date ranges are adjusted for the user's time zone.

Report Display Columns

The display columns step allows users to select which field(s) they would like
included when generating the report. The system will pull data specific to these
fields based on the report criteria for the associated module record. When you
select a field from the Available Fields list, they will be added to the right of the
list with the displayed path of the field (e.g. Contacts > Assigned to User > User
Name). The displayed field paths show users where the field is originating from to
retrieve the value for the report. For example, although "Email Address" appears
as a field in several modules (e.g. Accounts, Contacts, Leads, etc.), email addresses
are actually stored in their own table and are related to the modules where they
appear as opposed to being direct fields of those modules. So, the corresponding
displayed path will show the primary module record, then the related module
followed by the field name (e.g. Contacts > Email Address > Email Address) since
the email address field is a field of the related Email Address module.

To remove any unecessary fields from the display column list, simply click the "-"
sign to the far right of the displayed field path row.

Changing Display Column Labels

By default, the selected display column fields will display stock labels which can be
changed if you desire. To change the label, simply enter in the new label name in
the open text field then click outside of the text box to preserve the change.
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Changing Display Column Order

You can change the left-to-right order of the display columns by dragging and
dropping the displayed field paths in the Choose Display Columns section.

 

Defining Column Sort

You can also designate the generated report to be sorted by a specific field column
in either ascending or descending order. Simply mark the radio button next to the
field label then select "Ascending" or "Descending" in the corresponding dropdown
list. Please note that only one display column can be designated to sort by default
in the report.

 

Optional Related Modules

The Optional Related Modules option will appear on the Report Details step if you
add fields from related modules to the display column. Please note that if you want
your report to include records whether or not they have data in the fields, you will
need to mark the displayed module relationship(s) in the Optional Related Modules
section. For example, if you add the email address field as a display column for the
New Leads report, the Optional Related Modules section will display "Leads >
Email Address". Check the box for the Email Address relationship in order to
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include all applicable results even if the lead record does not contain an email
address. By default, Sugar treats all related modules in a report as mandatory
meaning that an email address will be required for a lead record to be included.

 

Leaving this box unchecked will exclude all lead records from your report that do
not have an email address associated with them.

This holds true for all related modules. You will need to check the box for any
relationship you do not wish to be treated as mandatory when Sugar is generating
your report.

Show Query

The Show Query option is only visible to system administrators and displays as a
checkbox on the Report Details step. If the Show Query box is checked and the
Preview button is clicked, the generated report will display all the SQL queries at
the bottom of the page for administrators to use and analyze how the specific data
was retrieved in the system.

 

Viewing Reports

There are various options available for viewing reports in Sugar including via the
Reports list view, Reports detail view, Reports Recently Viewed menu, and
dashlets. Please note that you will only be able to see reports as allowed by your
team membership, user access type, and assigned roles. For more information on
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teams and roles, please refer to the Team Management and Role Management
documentation in the Administration guide.

Viewing Via List View

The Reports list view displays all reports meeting the current search criteria. To
access the list view, simply click the Reports module tab. While list view shows
basic report information (e.g. report name, report type, target module for report,
etc.), you can click the report's name to view the data in the report's detail view.
For more information on viewing reports via list view, please refer to the Reports
List View section of this documentation.

Viewing Via Detail View

The Reports detail view displays key data specific to the report including the
display column fields, display summaries, charts, etc. The detail view can be
reached by clicking a report record's link from anywhere in the application
including from the Reports list view. For more information on viewing reports via
detail view, please refer to the Reports Detail View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which reports you have recently viewed.
Hover on the Reports module tab to see a list of your most recently viewed reports
and click each name to open the report in detail view.

 

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view reports in
report-based dashlets such as "My Favorite Reports" as well as view report charts
via Report Chart dashlets. The My Favorite Reports dashlet will display all reports
you have marked as favorites and you can click the report's name to open the
report in detail view. For more information on utilizing and viewing dashlets,
please refer to the Home section of the Home documentation.
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Please note that only report types (e.g. Summation with Details-type,
Summation-type, and Matrix-type reports) with charts can be added as dashlets on
your Home page. The Add Sugar Dashlets option allows you to add basic
out-of-the-box report charts as well as custom report charts from your favorite
reports, saved reports, team reports, and global team reports. For more
information on adding dashlets to your home page, please refer to the Adding
Dashlets section of the Home documentation. To view the report's detail view from
a Report Chart dashlet, simply click the Edit icon at the top of the dashlet menu
bar.

 

Searching Reports

The Reports list view includes a Basic and Advanced Search to help you locate
reports easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Reports list view below.
Please note that Sugar automatically appends the wildcard character (%) to the
end of your search phrase. This allows the system to retrieve all reports that start
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with the keyword entered in the search. If you would like to broaden the search,
you can use the wildcard at the beginning of your text as well (e.g. %accounts).
This will pull up any report that has the word "accounts" in the name, regardless of
how it starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons available in Basic Search panel have the following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.

 

Enter in the appropriate keyword in the basic search Title field then click the
Search button. Once the search is complete, the relevant results will populate in
the list view  below the search panel. To see all reports to which you have access,
simply click "Clear" and then "Search" to perform a blank search with no filters.
Please note that you will only be able to see reports as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management in the
Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
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following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
My Items : Select this box to return only reports assigned to you.
My Favorite Reports : Select this box to return only reports you have marked
as favorites.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorite Reports" and enter in a report title to search, Sugar will only return
reports with a matching name that you have marked as favorites. When searching
by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
reports matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all reports to
which you have access, simply click "Clear" and then "Search" to perform a blank
search with no filters.Please note that you will only be able to see reports as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

Reports List View
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The Reports list view displays all reports meeting the current search criteria and
to which your user has access. You can view the basic details of each report within
the field columns. Please note that you will only be able to see reports as allowed
by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Reports Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Checkbox Selection

You can perform several actions on report records directly from the list view by
first selecting the desired reports. To select individual report records on the
Reports list view, mark the checkbox on the left of each row. To select or deselect
multiple report records on the list view, use the options in the checkbox dropdown
menu:

Select This Page : Selects all reports shown on the current page of report
results.
Select All : Selects all reports in the current search results across all pages of
report results.
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Deselect All : Deselects all reports that are currently selected.

 

Delete Button

The Delete button to the right of the checkbox dropdown allows you to Delete one
or more reports at a time. Please note that your ability to delete reports in Sugar
may be restricted by a role. For more information on roles, please refer to the 
Role Management documentation in the Administration guide. Check with your
system administrator if you do not see the Delete button.

 

Favorite Designation

Users have the option to mark report records as favorites via the list view as well
as the detail view. This allows users to designate reports that are important or will
be viewed often so that they can easily be accessed via search or from the Reports
module tab. In the Reports list view, the star on the left of each report's row is
yellow once marked to indicate a favorite report. For more information on how to
mark records as favorites, please refer to the Favoriting Reports section of this
documentation.
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Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Reports Detail View

The Reports detail view displays thorough report information including display
column fields (if applicable), charts (if applicable), etc. The detail view can be
reached by clicking a report record's link from anywhere in the application
including from the Reports list view.

Please note that you will only be able to view a report according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management documentation
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in the Administration guide.

Actions Menu

The Actions menu on the top left of each report's detail view allows you to perform
various actions on the current report. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System  documentation in the Administration guide.

 

The options in the Actions menu allow you to perform the following operations:

Run Report Run this report to generate the result
Edit Edit this report
Duplicate Duplicate this report
Schedule Schedule this report to be delivered via

email
Print as PDF Print this report as a PDF file
Export Export this report result to a CSV file

Note: Only available for Rows and
Columns-type report

Delete Delete this report

Favorite Designation

Users have the option to mark reports as a favorite via the detail view as well as
the list view. This allows users to designate reports that are important or will be
viewed often so that they can easily be accessed via Advanced search or from the
Reports module tab. In the Reports detail view, the star on the right of the report's
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name is yellow once marked to indicate a favorite report. For more information on
how to mark reports as favorites, please refer to the Favoriting Reports section of
this documentation.

 

Run-time Filters

Run-time filters allow you to quickly change the filter values on the report without
having to edit the report. Please note that run-time filters only appear if filters are
set in the Define Filters step when building the report. The report will be filtered
based on the original filter value, but you can change the value via the Run-time
filter and click "Apply" or "Run Report" to re-generate the report result. For more
information on run-time filters, please refer to the Run-Time Filters section of this
documentation.

 

Report Details

By default the report details box will appear displaying the reports name, display
columns, report type, team(s) assigned to report, etc. To hide the report details,
simply click the Hide Details button on the upper left of the report's detail view.
Once the report details are hidden, the Show Details button will appear in place of
the Hide Details button. Click the Show Details button to display the report details
again.
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Report Chart

Users have the option to display the data as a chart in report results if desired. The
chart option is only available for Summation with Details-type, Summation-type,
and Matrix-type reports. You can choose the chart type (e.g. Pie, Horizontal Bar,
Vertical Bar, etc.) you want the report data displayed via the Chart Options step of
the Report Wizard. Please note that at least one of the calculated fields (e.g.
Count, AVG: Amount, SUM: Amount, etc.) in the Choose Display Summaries step
must be selected in order to be able to select a chart type in the Chart Options
step.

The report charts can also be added and displayed as a Sugar Dashlet on your
Home page. For more information on viewing charts via dashlets on your Home
Page, please refer to the Viewing Via Dashlets section of this documentation.Please
note that at least one Group By and one Display Summary column is required to
generate a chart.

The chart is displayed on the report by default, but you can hide the chart by
simply clicking the Hide Chart button on the upper left above the chart. Once the
report chart is hidden, the Show Chart button will appear in place of the Hide
Chart button. Click the Show Chart button to display the chart again.

 

Report Chart Options

The Chart Options step of the Report Wizard allows users to choose the chart type
they want displayed on the generated report as well as how the data will be
summarized within the chart. Please note that at least one of the calculated fields
(e.g. Count, AVG: Amount, SUM: Amount, etc.) in the Choose Display Summaries
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step must be selected in order to be able to select a chart type in the Chart
Options step.

The following options are available in the Chart Options step of the Report Wizard:

Chart Type : Select the chart type you want the data to be displayed on your
report.

No Chart : No chart will be generated for the report result.
Horizontal Bar : The report data will be displayed in horizontal bars.
Vertical Bar : The report data will be displayed in vertical bars.
Pie : The report data will be displayed as a pie chart.
Funnel : The report data will be displayed as a funnel chart.
Line : The report data will be displayed as a line chart.

 
Data Series : Select how you want the chart data to be summarized. The
field(s) you select in the Choose Display Summaries step will be available to
choose in this dropdown list.

 
Description : Enter in a brief description to label the chart if you wish.
Round Numbers Over 100000 : Check this box if you want numbers over
100,000 to be rounded in the report charts. For example, 150,000 will be
displayed as 150K.

Report Results

The report's detail view will display the report results with relevant data and
report chart (if applicable) for all records that meet the specified criteria. Please
note that each report type will display the report results differently and users
should consider how they would like to view the data prior to creating the report.

Rows and Columns Report Result

 949 / 1.013



 

The report results for this report type displays the data in a simple rows and
columns format. The display column field values for all records that meet the
specified criteria will appear on the report result. You may edit records via the
report by clicking the pencil icon next to the records name and view the record's
detail view by clicking the record name. You can also sort the report results by a
display column in either ascending or descending order. To sort by a field or
switch the sort direction, click the column header noting that the fields which
allow sorting will have a pair of arrows. Please note that the report may be sorted
by only one column at a time. To view an example Rows and Columns report result,
please refer to the creating Rows and Columns Report section of this
documentation.

 

Summation Report Result

The Summation Report provides an overview of the selected field data(s) grouped
by specific criteria(s). The report result displays the data in groups summarized
using computed derivatives (e.g. SUM, AVG, MAX, MIN) from numeric-type field
values (e.g. opportunity amount, amount, etc.) as well as weighted amounts. Each
field you select in the Define Group By and Choose Display Summaries will be
displayed as a column in the report result. The field(s) in the Define Group By list
determines how the data will be grouped on the report results table and the chart.
For example, if you group the opportunity report by "User Name" then "Month:
Expected Close Date" on the Define Group By list, the opportunity records will be
grouped by the user assigned to the opportunity and each user will be broken up
by month of the expected close date on the report result. The grand total of the
summarized field values will display at the bottom of the report results page.

You can sort the report results by a field column in either ascending or descending
order. To sort by a field or switch the sort direction, click the column header
noting that the fields which allow sorting will have a pair of arrows. Please note
that the report may be sorted by only one column at a time. To view an example
Summation report result, please refer to the Creating Summation Report section of
this documentation.

 

Summation Report with Details Result
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The Summation Report with Details groups the data and displays the total
summary count for records in the report result. Unlike the Summation Report, this
report type includes display columns for fields related to the target and related
module. The report result willgroup the data in different categories based on the
specified field values. If you choose to display the data as a chart, it will appear at
the top of the report results page. The field values for all records that meet the
specified criteria will be displayed in a rows and columns type table broken up into
grouped panels.You can sort the report results by a field column ineither
ascending or descending order. To sort by a field or switch the sort direction, click
the column header noting that the fields which allow sorting will have a pair of
arrows. Please note that the report may be sorted by only one column at a time.
You may also edit records via the report by clicking the pencil icon next to the
records name and view the record's detail view by clicking the record name.

Each panel header will display the grouped by field value(s) along with the total
summary count for the group. You can collapse the grouped panels individually by
clicking the double up arrow to the far left of the header or click "Collapse All" to
collapse all panels. Collapsed panels will display the header with the display
summaries for each group and you can click the double down arrow to open the
panels again. The grand total for the summarized field values will appear at the
bottom of the report results page. To view an example Summation with Details
report result, please refer to the Creating Summation Report with Details section
of this documentation.

 

Matrix Report Result

The Matrix report groups the fields based on the group by fields and displays the
summary for specific numeric-type field values that you select. The report result
displays the data in a grid table with row and column headers. If you selected
three group-by columns, then you will have the option to choose specific report
layout's (e.g. 1x2 and 2x1) on the Report Details step. The 1x2 layout option will
display the data for the first group-by field in a row and display the data for the
other two group-by fields in columns. The 2x1 layout option will display the data
for the first two group-by fields in rows and display the data for the third group-by
field in a column. The report results will show the grand total for each field row on
the table as well as for each column.To view an example Matrix report result,
please refer to the Creating Matrix Report section of this documentation.
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Viewing Currency Fields

When the user's profile has the Show Preferred Currency option selected, all
currency values will be displayed in reports using the user's preferred currency.
The values will use the current conversion rate set in Admin > Currencies at the
time the report is run. This means that the displayed value may not be historically
correct for closed business since the conversion rate of the user's preferred
currency may have changed since the purchase was completed.

When the user does not have this option selected, reports will display all currency
values in the system's default currency. To keep amounts historically accurate, the
conversion rate will only update on on currency fields when the business is still
open and under the following scenarios:

The record undergoes a save event (e.g. mass update, manual save, etc.) and
the record's currency has a different conversion rate defined in Admin >
Currencies than is currently saved.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all records saved
with that currency to the new rate.

For more information about currency exchange rates, please refer to the 
Currencies documentation in the Administration guide.

Running Reports

Once the reports are generated and saved in Sugar, you can view the report
results at any time. While viewing the report's detail view, there may be times
when you need to re-run the report to generate new report results. The Run Report
button on the upper left of the report's detail view allows you to refresh and run
the report to re-generate report results. For example, if you make a change to the
run-time filter on the report, you can click "Run Report" to generate the report
based on the new filter values. For more information on run-time filters, please
refer to the Run-Time Filters section of this documentation. You can also click "Run
Report" each time you want to re-generate the report to capture new records not
included in the current report results.
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Editing Reports

Reports may be edited at any time to update or add information to the report.
There are various methods of editing the report from the Reports detail view,
Reports list view, and dashlets. Regardless of where you initiate the edit from, you
will always go through the Report Wizard to make the necessary changes to your
report. You can edit the report by going through the Report Wizard step-by-step by
clicking the Back and Next button or clicking the link (e.g. Define Filters, Choose
Display Columns, Choose Display Summaries, etc.) at the top of the Report Wizard
to edit a specific step. Once the changes are complete, click "Save and Run" to
preserve the changes made and generate the report.

 

Please note that your ability to edit reports in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Editing Via Detail View

You can edit reports via the detail view by clicking "Edit" in the Actions menu on
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the upper left of the page. This will open the Report Wizard where you can make
the necessary updates to the various steps (e.g. Define Filters, Define Group By,
Choose Display Columns, Choose Display Summaries, etc.). Once the changes are
complete, click "Save and Run" to preserve the changes made and generate the
report.

 

Editing Via List View

You can edit reports via the list view by clicking the Pencil icon to the left of each
report's name. This will open the Report Wizard where you can make the
necessary updates to the various steps (e.g. Define Filters, Define Group By,
Choose Display Columns, Choose Display Summaries, etc.). Once the changes are
complete, click "Save and Run" to preserve the changes made and generate the
report.

 

Editing Via Dashlet

There are various ways to edit reports via the dashlets on the Home page. For the
My Favorite Reports dashlet you can click the reports name to open the reports
detail view then click "Edit" in the Actions menu to make the necessary changes.
Once the changes are complete, click "Save and Run" to preserve the changes
made and generate the report.
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For the Report Chart dashlets, you can click the Edit icon at the top of the dashlet
menu bar to open the reports detail view then click "Edit" in the Actions menu to
make the necessary changes. Once the changes are complete, click "Save and Run"
to preserve the changes made and generate the report.

 

Deleting Reports

If a report is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Reports detail view or list view.
Deleting via the detail view allows you to delete a single report while the list view
allows for mass deleting multiple reports at once.

Please note that your ability to delete reports in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a report via the detail view:

1. Navigate to a report's detail view.

 955 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management


 

2. Select "Delete" from the Actions menu.

 
3. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Mass Deleting Via List View

Use the following steps to delete one or more reports via the list view:

1. Navigate to the Reports list view by clicking the Reports module tab.
2. Use the Basicor Advanced Searchto find the reports you wish to delete.
3. Select the desired reports individually or using the checkbox dropdown's

options.
4. Click the Delete button.

 
5. A pop-up message will display asking for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of reports. If you encounter an
error when performing this action, we recommend selecting the reports in smaller
batches.

Exporting Reports

Sugar's Export option allows users to download the data in reports as a .CSV
(comma-separated values) file. Please note that only Rows and Columns-type
reports have the ability to be exported. For more information on exporting records
in Sugar, please refer to the Export documentation. This may be useful when
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needing to use the report data with other software such as Microsoft Excel or to
update existing records by creating a report (including Record ID's), exporting,
making changes, then importing the altered data back into Sugar. For more
information on updating existing records via import, please refer to the Import
documentation. Due to PHP memory limitations on the server, there may be
occasions when the application times out while exporting a report with a large
amount of data. If you encounter an error when performing this action, we
recommend breaking up the report in smaller batches.

 

Please note that your ability to export reports from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Duplicating Reports

You can create a new report by duplicating an existing report in Sugar. The
duplicate option is useful if the report you are creating has similar information to
an existing report, so there is less new data for you to enter. You have the option of
duplicating the report as the original report type that you are currently viewing or
any of the other three report types.

The following steps cover creating a report by duplicating an existing Rows and
Columns-type report as an example:

1. Navigate to a report's detail view.
2. Click the Actions menu and select "Duplicate".
3. Choose the report type you would like the duplicated report to be.

 957 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Application_Guide/Import
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Role_Management


 

 
4. Go through the Report Wizard to select and enter new data as necessary then

enter a new name for the report and save.
Please note that if you select a report type other than the original type,
there may be additional or less steps in the Report Wizard to complete
and you may need to edit the report as necessary to meet the specific
report type requirements.

Scheduling Reports

Reports in Sugar can be scheduled to be emailed to users periodically based on
specified date and time intervals. Please note that each individual user has to
schedule the report in their Sugar account in order for the reports to be delivered
to them. Sugar will run the report at the specified interval based on the set time
zone in user preferences and sends it as a PDF file to your email address on file.
Please note that the outbound mail server for the system as well as the user's
email settings must be configured properly in order for the reports to be delivered
successfully. For more information on setting up the system email settings, please
refer to the Email documentation in the Administration guide. For more
information on setting up your user preferences' email settings, please refer to the 

The Run Report Generation Scheduled Tasks scheduler in Sugar processes all
scheduled reports to be delivered to the user at the scheduled interval. By default,
the report scheduler is set as "Inactive" for new Sugar installations. Administrators
must check to make sure that the Run Report Generation Scheduled Tasks
scheduler is active and the settings (e.g. interval) are configured properly. F or
example, if the scheduler is set to trigger once per day and a user schedules a
report to be delivered every hour, the report will only be delivered once each day
due to the set interval in the scheduler. The administrator must change the
interval for the scheduler to run every 1 hour in order for the users report to be
processed and delivered per their scheduled interval.For more information on
configuring schedulers, please refer to the Schedulers section of the System
documentation.

Scheduling Via Detail View
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Use the following steps to schedule the report via the detail view:

1. Navigate to a report's detail view.
2. Select "Schedule" from the Actions menu.

 
3. Enter the start date/time and select the time interval for report delivery.

Check the Active checkbox and then click "Update Schedule" to schedule your
report.

Please note that you must mark the Active box in order to activate the
report schedule.

 

Once the report is scheduled successfully, the date and time for the scheduled
report will appear in the list view row for the specific report. If you do not see the
scheduled date and time under the Schedule Report column in the list view, then
check your scheduled report again to make sure it was set up properly.

 

Scheduling Via List View

Use the following steps to schedule the report via the list view:

1. Navigate to the Reports list view by clicking the Reports module tab.
2. Use the Basicor Advanced Search to find the reports you wish to schedule.
3. Go to the Schedule Report column for the specific report in the list view and

click on the --none-- link.
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4. Enter the start date/time and select the time interval for report delivery.

Check the Active checkbox and then click "Update Schedule" to schedule your
report.

Please note that you must mark the Active box in order to activate the
report schedule.

 

Once the report is scheduled successfully, the date and time for the scheduled
report will appear in the list view row for the specific report. If you do not see the
scheduled date and time under the Schedule Report column in the list view, then
check your scheduled report again to make sure it was set up properly.

 

Printing Reports as PDFs

Sugar's Print as PDF option in the Reports module allows users to download the
reports to PDF files and save on their local machine. This may be useful when
needing to email the file to other members of the team to share the report data or
to keep track of key historical data from the system. You can also view charts on
the downloaded PDF files for Report types (e.g. Summation Report with Details,
Summation Report, Matrix Report) with chart options.

Please note that your ability to print reports as PDF from Sugar may be restricted
by a role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Print as PDF option.

Use the following steps to print reports as PDF's via the Reports detail view:

1. Navigate to a report's detail view.
2. Select "Print as PDF" from the Actions menu.
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3. Open the downloaded PDF file to view the report and save to your local

machine if you wish.

Favoriting Reports

Each Sugar user has the option to designate their own favorite reports which are
important or will be viewed often so that they can easily be accessed via Advanced
search or from the Reports module tab. Once reports are marked as favorites, use
the My Favorite Reports checkbox in the Reports Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Reports
module tab.

Favoriting Via List View

Use the following steps to mark reports as favorites via the Reports list view:

1. Navigate to the Reports list view by clicking the Reports module tab.
2. Use the Basicor Advanced Search to find the Report records you wish to mark

as favorites.
3. Mark the star icon on the left of each desired report's row.
4. To remove the report as a favorite, click the star again to revert it to white.

 

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Reports detail view:
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1. Navigate to a report's detail view.
2. Click the star icon to the right of the report's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the report as a favorite, click the star again to revert it to white.

 

Adding Report Results to Target Lists

A target list consists of a group of individuals or organizations you wish to be
included or excluded on a mass marketing campaign. These targets are typically
identified based on a set of predetermined criteria such as being a prospect or
existing customer, age group, industry, etc. The Reports module gives users the
ability to add a large number of records (e.g. Contacts, Leads, Accounts, etc.) to a
target list at once instead of selecting them one-by-one. For example, if you need
to add all leads in the state of California to your target list, you can create a report
based on the Leads module filtered by the Primary Address State field (e.g. CA).
Once the report is created and saved, you can navigate to the Target Lists module
to add the report results to the specific target list. Go down to the Leads subpanel
in the Target List's detail view, click the Actions menu, then choose "Select from
Reports". Select the saved lead report from the pop-up window and all lead records
from the selected report will be added to the target list.

 

For more information on adding records to target lists, please refer to the Target
Lists documentation. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while adding the report to a target
list. If you encounter an error when performing this action, we recommend
breaking up the report in smaller batches.

Last Modified: 09/26/2015 06:25pm

Export
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Overview

There may be times in which users will want to access, review, or manipulate
information from their Sugar database in another format outside of Sugar. To
facilitate this process, users have two options on ways to export their data from
Sugar. Upon exporting data from Sugar, a CSV ("Comma Separated Value") format
file will be downloaded to the user's computer. This file can be reviewed in
Microsoft Excel, Notepad, or other spreadsheet tools and text editors.

Exporting restrictions can be controlled by a System Administrator via Admin >
Locale. For more information on the Locale menu, please refer to the Locale
section of the Administration guide. An administrator also has the option to create
a Role hindering regular users' access to the export functionality. Please refer to
the Role Management section of the Administration guide for more information on
setting roles for users.

Exporting From Module List Views

The first type of export that will be covered is exporting from the module list view.
When exporting this way, the downloaded file contains every field from the
database within the given module for the specified record or records. This export
will not include any information from records which are associated via
relationships to this module.

This export method is most useful when performing a type of data migration,
needing an excess of detail, or performing a comprehensive import and update of
the data, since this method exports all fields within a module. It is recommended
the Export From Reports functionality be used for any other export use case to
isolate the specific information needed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of records. If you encounter
an error when performing this action, we recommend selecting the records in
smaller batches.

Use the following steps to export from list view:

1. Navigate to the list view of the module by clicking on the module tab.
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2. Use the Basic or Advanced Search functionality find the records you would

like to export.
3. Select the desired records individually or by using the checkbox dropdown's

options.

 
4. Choose "Export" from the Actions menu.

 
5. The CSV file will be downloaded to your local computer to a location defined

by your browser settings. The file can then be read and manipulated
depending as needed.

Exported Files From List View

When data is exported from Sugar, the file that is produced is a CSV, or "Comma
Separated Value" file. When viewed in a plain text editor, a CSV file looks like a
long string of text with groupings of text separated with quotation marks and
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commas (e.g. "First Name","Last Name","Title"). The file first lists out all columns
that are in the file, and then the corresponding rows follow, also separated by
quotation marks and commas (e.g. "Dusty","Connor","IT Developer").

However, most spreadsheet software, such as Microsoft Excel, will read this file
and convert the quotation marks and commas into rows and columns. This makes
your data much easier to read and turns it into a useful format that can be
manipulated and repurposed as need be.

 

The records that appear in your spreadsheet are dependent on what type of
search, if any, you did prior to your export.

When exporting from list view, the user is left with every part of the module
database information, which is often not all readable by the user. This file will only
contain information specific to the module where the export was performed. This
exported data will comprise of all stock and custom fields from the module. No
data that would normally be found in a subpanel will appear on this export.

Exporting From Reports

In addition to exporting from a list view, users also have the option to export data
from a report. Using a Rows and Columns report, users can select the specific
fields they would like to see on the export file and filter the module data however
they would like. The advantage to using reports is that users will only be presented
with the data that they need, and no excess data. In addition, users can also export
data from related modules using reports, which is not possible when Exporting
From Module List Views . Finally, because the reports are much more focused and
specific, there is a higher threshold of the quantity of records that can be exported
before encountering a timeout or any other such issues.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of contact records. If you
encounter an error when performing this action, we recommend filtering the
records in smaller batches.

For more information on creating your report, please refer to the Reports
documentation.

Use the following steps to complete an export from a report:
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1. Select an existing Rows and Columns report from the Report module's
listview, or create a new one based on the information that you would like to
export.

2. Click on the actions menu of the report details and select "Export".

 
3. The CSV file will be downloaded to your computer to a location defined by

your browser settings. The file can then be read and manipulated at will.

When exporting from a report, the data is more well-rounded for a user to review.
The user is allowed to determine what fields should be included on the export. This
means that while reviewing it in a spreadsheet, the information appears exactly as
it does in Sugar. This makes for a more positive user experience and a more
focused export file. In addition, the user is able to utilize modules related to the
reported-on module. This makes the report more useful in a business sense for
individual users.

Exported Files From Reports

When data is exported from Sugar, the file that is produced is a CSV, or "Comma
Separated Value" file. When viewed in a plain text editor, a CSV file looks like a
long string of text with groupings of text separated with quotation marks and
commas (e.g. "First Name","Last Name","Title"). The file first lists out all columns
that are in the file, and then the corresponding rows follow, also separated by
quotation marks and commas (e.g. "Dusty","Connor","IT Developer").

However, most spreadsheet software, such as Microsoft Excel, will read this file
and convert the quotation marks and commas into rows and columns. This makes
your data much easier to read and turns it into a useful format that can be
manipulated and repurposed as need be.

 

The information that appears in your spreadsheet is dependent on what filters you
added to your report and which display columns exist. Only the information that
shows in the display columns when you view your final report is what will be
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included in your CSV export.

Last Modified: 09/26/2015 06:25pm

Import

Overview

Sugar provides all users with access to import functionality for most modules.
Using this functionality, users can add large amounts of database records at one
time to Sugar. Importing is available for the following modules:

Accounts
Bugs
Calls
Cases
Contacts
Contracts
Custom modules (if applicable)
Leads
Meetings
Notes
Opportunities
Products modules (Manufacturers, Products, Product Catalog, Product
Category, Product Types, Tax Rates)
Targets
Tasks
Users (Requires Admin role)

When importing through any of the above modules, Sugar presents users with a
wizard to help guide users through the process of creating and updating records.

Importing can be useful to enter historical or existing data, migrating from your
previous CRM system, adding a list of new customers or leads, or updating a large
amount of records at once.

Import Guidelines

Importing is a very important process for users brand new to using Sugar or to
those who have been using Sugar for years. Depending on your business, you may
run imports anywhere from multiple times per week, to only a few times or less per
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year. Regardless of the import frequency, all users will have to follow the same
type of process and follow the same guidelines.

File Delimitation : Sugar accepts files that are delimited by a given separator,
such as commas or tabs. The most common type of import will be using a CSV
(Comma Separate Value) file, but Sugar will accept other file types as long as
it recognizes the delimiter.
Imposed Limitations : Sugar, by default, does not impose any type of import
imitations. However, System Administrators can impose a limit on the amount
of rows or records that can be imported at one time. This limitation is found in
Admin > System Settings > Advanced > Import - Maximum Number of Rows.
Administrators can also limit what modules users are allowed to import into
through the use of Roles.
Scrub Data Before Import : It is strongly recommended that all data is
reviewed and scrubbed before importing. It is much easier to see if you are
importing good data or that you have removed all duplicates before importing
than finding them after they are already in Sugar and are already in use by
other users. In addition, you want to ensure standardized fields such as dates,
phone numbers, etc. adhere to a common format so that the import will run as
smooth as possible.
Parent Records First : When importing any records that use a relationship to
another module, such as the Account - Contact relationship, it is best to try
importing the parent, or higher level, records first. This is demonstrated with
a one-to-many relationship between the two modules. In this case, it is best to
import accounts first and then contacts, which rely on account records.

Importing New Records

The first type of import that will be covered is importing new records. Whether you
are just starting a migration from another CRM to Sugar or if you are adding a
new list of records that you have received, such as a new list of leads or accounts,
this process will help to get the data into Sugar without having to manually enter
each record. After you have your import file that is scrubbed and ready to be
imported, follow these steps to import this list into Sugar.

1. Navigate to the module tab for the module that you are importing into and
select the import option. This will open the Import Wizard and bring you to
the"Upload Import File" screen.
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2. If you would like to review the Import File Template, you can download it

from this page. This will give you a template of the format Sugar is going to
be using to import your data. For more information on the template, please
review the Import File Template section of this documentation.

3. Select the import file that you are going to use to import by clicking the
Choose File button. When prompted, select the file from your computer and it
will appear in this box.

 
4. Ensure that "Create new records only" is selected.
5. If you have preformed imports before and have previously saved your import

settings, you can select your setting at the bottom of the page using the "To
use pre-set import settings, select from below" option. If you do not have any
saved import settings, this section will not appear. For more information on
saving mapping, please review the Saving Field Mappings section of this
documentation.

 
6. Click "Next" to access the "Confirm Import File Properties" screen.
7. This screen will show you the first two rows that Sugar is going to try to

import as an example to let you know that your file was read properly by
Sugar.

8. The Import Wizard automatically detects the properties of the file that has
been uploaded to ensure the best import possible. If you notice any mistakes
or need to set up any advanced configuration, click "View Import File
Properties". These changes are specific to the import and do not affect your
standard user preferences.
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9. If the file was exported from either Salesforce.com or Microsoft Outlook,

select the corresponding option under "If the import file data was exported
from any of the following sources, select which one". If not, leave this as
"None". This option will set up your mapping properly on the next screen.

10. Click "Next" to access the Confirm Field Mappings screen.
11. Click the View Notes button for any relevant information, specific to this

module, to the import that you are performing.

 
12. This screen presents you with four columns:

 
Header Row : This is the column header from your import file. This column
will let you reference your file to make sure your column mapping is correct.
If your import file does not have a header row, this column will not show.
Module Field : This column contains a dropdown list of all importable fields
for the module. The Import Wizard tries to match the Header Row with the
corresponding Sugar field. If the suggested mapping is incorrect, use the
dropdown list to change the mapping. Required fields are marked with an
asterisk (*).
Row 1 : This column contains the values from the first row of data in your
import file. This is another aid to help ensure you have your mapping correct,
so that you can see the mapping using real data and not just the headers. If
your import file does not have column headers, there will be an additional
column for Row 2.
Default Value : This column is hidden by default, but can be expanded if
needed. When expanded, you have the option to fill in a value that will
populate all records where a value for that field does not exist. For example, if
you do not have anything populated in the Accounts Industry field, but you
know this is a list of Technology companies, you can populate all blank values
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in the Industry field with the value of "Technology". 
13. Click "Add Field" if any data needs to be added to the import that is not on

your import file. This can be used if you would like to assign a value to a
record when the column is not on your import file. This is used in conjunction
with the Default Value column. For example, if you are importing these
accounts, but would like to assign them all to another user, John Smith, you
would click the Add Field button, select the field from the Module Field
column, and populate the desired value in the Default Value column. Now, all
records will be assigned to John Smith upon import.

 
14. Click "Next" to access the Check for Possible Duplicates screen.
15. This menu allows users to check if there are duplicated values on the import

to records that already exist in Sugar. This menu will vary depending on what
module you are importing into as the fields will be specific to this module. The
fields available to the Import Wizard are determined based off the
system-defined indexes. This is why you will not see all fields shown on this
list, but only a subset of fields from the module. If you would like to cross
reference existing Sugar records against what is being imported, simply drag
and drop the field name from the right column, "Available Fields", to the left
column, "Fields to Check". For more information on duplicate checking,
please review the Detecting Duplicates section of this documentation.

 
16. If the import configuration that you have set up is going to be used again in

the future for additional imports, add a name at the button of the page so that
it can be referenced later. For more information on saved field mappings,
please review the Saving Field Mappings section of this documentation.
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17. When your duplicate checking settings are complete, click "Import Now" to

begin the import.
18. After the import completes, you are brought to the "View Import Results"

page. Here, you are provided with a summary of the import.

 
19. The summary will tell you how many records were created, how many were

not created due to an error, and how many were found as duplicates.
20. There are three buttons below the Summary:

Undo Import : If there was a mistake in the import that you realized after
importing, you can check this button. All records that were created via the
import will be deleted. This button cannot be re-accessed for this import. As
soon as you navigate away from this page, the import is considered complete.
Import Again : Click this button if you would like to go back to the first step of
the Import Wizard and perform additional imports. Clicking this button will
consider the import to be complete.
Exit : This button will also consider the import to be complete, but will bring
you back to the module's list view to be able to further review or search your
records.

21. There are also three tabs on the summary page under the action buttons:
Created Records : This tab will show you a list view of all of the records that
were properly imported on this import.
Duplicates : This tab will present you with any records that were not imported
due to the Import Wizard finding duplicates from Step 15. There is an option
to download a list of the duplicates, which produces a new CSV file. You have
the option to download this list, make any changes, and import again
following this same process.

 
Errors : This tab will show you any records that were not imported due to an
error during the import process. This is usually seen when there is a problem
with data that is on one of the records or rows in the CSV file. For instance, if
you are missing a value for a required field, or a field is formatted incorrectly.
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Similar to the option to download duplicate records, you also have the option
to download the list of errors using the two links provided.

 
The "Download list of errors" option will produce a new CSV file with columns
showing (from left to right) the error, the field affected, the value, and the
line on your original import file where the error occurred.

 
The "Download list of rows that were not imported" option will download a
new CSV file with the same format of your original one, containing only the
rows that were not imported so that you can clean them up and then
re-import.

 
22. Once you have downloaded the desired lists and reviewed the import, the

buttons mentioned in Step 20 can be used to complete your import.

Importing Updates to Existing Records

In addition to importing new records, Sugar's Import Wizard also has the
functionality to use an import file to update existing Sugar records. The process
runs very similar to the new record import process described above.

The most important aspect to importing updates to existing records is that Sugar
will only update records where there is a matching ID in the import file. Every
Sugar record, regardless of what module it is in, is defined with an alphanumeric
ID field. This field is typically a 36-character alphanumeric value but may be less if
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imported from a previous CRM. This field is the only way that the Import Wizard
will know which record to update.

Note: All other fields (name, email address, etc.) are not considered unique and
can have duplicates, so only the ID field will work to differentiate records for an
update from import.

The ID field is not usually shown within Sugar and must be found either by running
a report or an export within the module.

During the import, if there are any other records without ID fields and they are on
the import file, they will create new records, which will create duplicates in your
database.

To import updates, follow the steps below.

1. You will have to get the ID numbers for all of the records that you are going
to be updating to prepare your import file. The most common methods are
either by exporting a list of records from the module list view, or by running a
report and exporting the results. For more information on exporting, please
review the Export documentation.
Export from List View : This option will include the record ID field, but it is
recommended that you open the file in a spreadsheet editor (Microsoft Excel)
and delete any columns that you are not updating. Be sure to leave the ID
field and any required fields, such as Name, as the import will not complete
without these.
Export from Report : If you choose to run a report, be sure to include the ID
field in your display columns so that the records can be matched up. You will
also want to include any required fields, such as Name, as the import will not
complete without these. Please note that only Rows and Columns reports can
be used for exports.
After you have your file ready for import, you can proceed with working
through the Import Wizard.

2. Navigate to the module tab for the module that you are updating and select
the import option. This will open the Import Wizard and bring you to the "
Upload Import File" screen.
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3. If you would like to review the Import File Template, you can download it

from this page. This will give you a template of the format Sugar is going to
be using to import your data. For more information on the template, please
review the Import File Template section of this documentation.

4. Select the import file that you are going to use to import by clicking the
"Choose File" button. When prompted, select the file from your computer and
it will appear in this box.

 
5. Select the option "Create new records and update existing records".
6. If you have performed imports before and have previously saved your import

settings, you can select your setting at the bottom of the page using the "To
use pre-set import settings, select from below" option. If you do not have any
saved import settings, this section will not appear. If your CSV file was
exported from Sugar, this is likely not a necessary step. For more information
on saving mapping, please review the Saving Field Mappings section of this
documentation.

 
7. Click "Next" to access the "Confirm Import File Properties" screen. Before the

"Confirm Import File Properties" screen opens, you will be prompted with an
alert informing you that updates made to existing records cannot be undone.
Read, and then click "OK" to proceed.

8. This screen will show you the first two rows that Sugar is going to try to
import as an example to let you know that your file was read properly by
Sugar.

9. The Import Wizard automatically detects the properties of the file that has
been uploaded to ensure the best import possible. If you notice any mistakes
or need to set up any advanced configuration, click "View Import File
Properties". These changes are specific to the import and do not affect your
standard user preferences.
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10. If the file was exported from either Salesforce.com or Microsoft Outlook,

select the corresponding option under "If the import file data was exported
from any of the following sources, select which one". If not, leave this as
"None". This option will set up your mapping properly on the next screen. If
this file was exported from Sugar, keep it set to "None".

11. Click "Next" to access theConfirm Field Mappingsscreen.
12. Click the View Notes button for any relevant information, specific to this

module, to the import that you are performing.

 
13. This screen presents you with four columns:

 
Header Row : This is the column header from your import file. This column
will let you reference your file to make sure your column mapping is correct.
If your import file does not have a header row, this column will not show.
Module Field : This column contains a dropdown list for each row that
contains the name of a field in Sugar. The Import Wizard tries to match the
Header Row with the corresponding Sugar field. If the suggested mapping is
incorrect, use the dropdown list to change the mapping. Required fields are
marked with an asterisk (*).
Row 1 : This column contains the values from the first row of data in your
import file. This is another aid to help ensure you have your mapping correct,
so that you can see the mapping using real data and not just the headers. If
your import file does not have column headers, there will be an additional
column for Row 2.
Default Value : This column is hidden by default, but can be expanded if
needed. When expanded, you have the option to fill in a value that will
populate all records where a value for that field does not exist. For example, if
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you do not have anything populated in the Accounts Industry field, but you
know this is a list of Technology companies, you can populate all blank values
in the Industry field with the value of "Technology".

14. Click "Add Field" if any data needs to be added to the import that is not on
your import file. This can be used if you would like to assign a value to a
record when the column is not on your import file. This is used in conjunction
with the Default Value column. For example, if you are importing these
accounts, but would like to assign them all to another user, John Smith, you
would click Add Field button, select the field from the Module Field column,
and populate the desired value in the Default Value column. Now, all records
will be assigned to John Smith upon import.

 
15. Click "Next" to access the Check for Possible Duplicates screen.
16. This menu allows users to check if there are duplicated values on the import

to records that already exist in Sugar. Duplicate checking will only apply to
new records created by the import. For more information on detecting
duplicates, please review the Detecting Duplicates section of this
documentation.

17. If the import configuration that you have set up is going to be used again in
the future, add a name at the button of the page so that it can be referenced
later. For more information on saving mapping, please review the Saving
Field Mappings section of this documentation.

 
18. Click "Import Now" to begin the import.
19. After the import completes, you are brought to the "View Import Results"

page. Here, you are provided with a summary of the import.
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20. The summary will tell you how many records were updated, how many were

created, how many were not created due to an error, and how many were
found as duplicates, as applicable.

21. There are three buttons below the Summary:
Undo Import : If there was a mistake in the import of any new records that
you realized after importing, you can check this button. All new records that
were created via the import will be deleted. After updating, no changes to
updated records can be reverted. This button cannot be re-accessed for this
import. As soon as you navigate away from this page, the import is considered
complete. This button will not show if there were no new records created.
Import Again : Click this button if you would like to go back to the first step of
the Import Wizard and perform additional imports. Clicking this button will
consider the import to be complete.
Exit : This button will also consider the import to be complete, but will bring
you back to the module's list view to be able to further review or search your
records.

22. There are also three tabs on the summary page under the action buttons:
Created Records : This tab will show you a list view of all of the records that
were properly imported on this import. If this was only an update, there will
not be any records showing on this tab as it does not show updated records.
Duplicates : This tab will present you with any records that were not imported
due to the Import Wizard finding duplicates from Step 16. There is an option
to download a list of the duplicates, which produces a new CSV file. You have
the option to download this list, make any changes, and import again
following this same process. If you did not use any duplicate settings, this tab
will be empty.

 
Errors : This tab will show you any records that were not imported due to an
error during the import process. This is usually seen when there is a problem
with data that is on one of the records or rows in the import file. For instance,
if you are missing a value for a required field, or a field is formatted
incorrectly.
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Similar to the option to download duplicate records, you also have the option
to download the list of errors using the two links provided.

 
The "Download list of errors" option will produce a new CSV file with columns
showing (from left to right) the error, the field affected, the value, and the
line on your original import file where the error occurred.

 
The "Download list of rows that were not imported" option will download a
new CSV file with the same format of your original one, containing only the
rows that were not imported so that you can correct the errors and then
re-import.

 
23. Once you have downloaded the desired lists and reviewed the import, the

buttons mentioned in Step 21 can be used to complete your import.

Importing Relationships

There are many situations where imports need to forge a relationship between two
modules. A common example of this would be how importing contacts without an
account name would leave the contacts orphaned and not linked to any parent
account. To solve this problem, Sugar allows one-to-many and one-to-one
relationships to be imported during the standard import process. The available
fields will vary depending on the module being imported and will show on the 
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Import Template.

When importing a relationship, Sugar will need the related record's unique ID, or,
in some cases, will accept the record's Name field. Examples of the fields that
relate one module to another are explained below.

Module Module Related To Field(s) Used For
Relationship

Instructions For
Import

Accounts Accounts Member Of On the import file,
add a column for

"Member Of". You
can use either the
Sugar record ID or
the exact name of

the parent account.
This will cause the
imported record to
be related to the

parent account on
the "Member Of"

field.

Using an account
name that Sugar

does not recognize
will create an
additional new
account record.

Note: If you are
using the account
name, it must be

exactly as it shows
in Sugar. For

example, if your
account in Sugar is
"SugarCRM", but
your import file
contains "Sugar

CRM" or
"SugarCRN", the
account will not
relate properly.

Parent Account Id On the import
template, there is a
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column for "Parent
Account". Use the

existing Sugar
record ID of the

parent account. The
dropdown option
for this is Parent
Account Id. This

will cause the
imported record to
be related to the

parent account on
the "Member Of"

field.
Campaigns Campaign Use the existing

Sugar campaign
name or campaign
record ID to relate
the account to the
campaign record.

Note: If you are
using the campaign

name, it must be
exactly as it shows

in Sugar. For
example, if your

campaign in Sugar
is "End of Year

Newsletter", but
your import file
contains "End of

Year News" or "End
of Year Promotion",
the account will not

relate properly.
Campaign ID Use the existing

Sugar campaign
record ID number

to connect the
campaign name

into the new
account record.

Calls Contacts Contact ID Use the existing
Sugar contact
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record ID number
to connect the

contact name into
the new call record.

Flex Relate Related To Module

Related To ID

On the import
template, there are
columns for both

"Related To
Module" and

"Related To ID".
Both need to be
used to form the

proper relationship.

Related To Module:

Related To ID: The
ID for the record
you are relating.

Cases Accounts Account ID Use the existing
Sugar account

record ID to relate
the case to the
account record.

Account Name Use the existing
Sugar account

name or record ID
to relate the

contact to the
account record.

Note: If you are
using the account
name, it must be

exactly as it shows
in Sugar. For

example, if your
account in Sugar is
"SugarCRM", but
your import file
contains "Sugar

CRM" or
"SugarCRN", the
account will not
relate properly.
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Contacts Accounts Account ID Use the existing
Sugar account

record ID to relate
the contact to the
account record.

Account Name Use the existing
Sugar account

name or record ID
to relate the

contact to the
account record.

Using an account
name that Sugar

does not recognize
will create a new

account record with
a relationship to the

contact. 

Note: If you are
using the account
name, it must be

exactly as it shows
in Sugar. For

example, if your
account in Sugar is
"SugarCRM", but
your import file
contains "Sugar

CRM" or
"SugarCRN", the
account will not
relate properly.

Campaigns Campaign Use the existing
Sugar campaign

name or campaign
record ID to relate
the contact to the
campaign record.

Note: If you are
using the campaign

name, it must be
exactly as it shows
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in Sugar. For
example, if your

campaign in Sugar
is "End of Year

Newsletter", but
your import file
contains "End of

Year News" or "End
of Year Promotion",
the contact will not

relate properly.
Campaign ID Use the existing

Sugar campaign
record ID number

to connect the
campaign name

into the new
contact record.

Contacts Reports To Use the existing
Sugar contact

record ID number
to connect the new

contact and the
existing one.

Emails Email Address Importing an
existing email

address into Sugar
will cause all

related emails to
that email address
to be associated to
the contact record.
The email address
must be exact for
the relationship to

form properly.
Leads Accounts Account ID Use the existing

Sugar account
record ID to relate

the lead to an
existing account

record. This is not a
relationship that

can be forged from
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the Leads module
in Sugar. This can
be created from an

Account record
though. This

relationship is
usually formed

through the Lead
Conversion process.

Account Name In Leads, this is just
a text field. This

will not create any
relationships. Upon

conversion an
Account can be

created. For more
information on

converting leads,
please review the 

documentation.
Campaigns Campaign Use the existing

Sugar campaign
name or campaign
record ID to relate

the lead to the
campaign record.

Note: If you are
using the campaign

name, it must be
exactly as it shows

in Sugar. For
example, if your

campaign in Sugar
is "End of Year

Newsletter", but
your import file
contains "End of

Year News" or "End
of Year Promotion",

the lead will not
relate properly.

Campaign ID Use the existing
Sugar campaign

record ID number
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to connect the
campaign name

into the new lead
record.

Contacts Contact ID Use the existing
Sugar contact

record ID to relate
the lead to an

existing contact
record. This is not a

relationship that
can be forged from
the Leads module
in Sugar. This can
be created from a

contact record
though. This

relationship is
usually formed

through the Lead
Conversion process.

For more
information on

converting leads,
please review the 

documentation.
Opportunities Opportunity ID Use the existing

Sugar opportunity
record ID to relate

the lead to an
existing opportunity
record. This is not a

relationship that
can be forged from
the Leads module
in Sugar. This can
be created from an
opportunity record

though. This
relationship is
usually formed

through the Lead
Conversion process.

For more
information on
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converting leads,
please review the 

documentation.
Opportunity Name In Leads, this is just

a text field. This
will not create any
relationships. Upon

conversion an
opportunity can be
created. For more

information on
converting leads,
please review the 

documentation.
Emails Email Address Importing an

existing email
address into Sugar

will cause all
related emails to

that email address
to be associated to

the lead record.
The email address
must be exact for
the relationship to

form properly.
Meetings Contacts Contact ID

Use the existing
Sugar contact

record ID number
to connect the

contact name into
the new meeting

record.
Flex Relate Related To Module

Related To ID

On the import
template, there are
columns for both

"Related To
Module" and

"Related To ID".
Both need to be
used to form the

proper relationship.
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Related To Module: 

Related To ID: The
ID for the record
you are relating.

Notes Contacts Contact ID Use the existing
Sugar contact

record ID number
to connect the

contact name into
the new note

record.
Flex Relate Related To Module

Related To ID

On the import
template, there are
columns for both

"Related To
Module" and

"Related To ID".
Both need to be
used to form the

proper relationship.

Related To: The
Sugar module's

plural name for the
record that you are

going to relate
(Accounts,

Contacts, etc.).

Related To ID: The
ID for the record
you are relating.

Opportunities Accounts Account ID Use the existing
Sugar account

record ID to relate
the opportunity to

the account record.
Account Name Use the existing

Sugar account
name or record ID

to relate the
opportunity to the
account record.
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Using an account
name that Sugar

does not recognize
will create a new

account record with
a relationship to the

opportunity. 

Note: If you are
using the account
name, it must be

exactly as it shows
in Sugar. For

example, if your
account in Sugar is
"SugarCRM", but
your import file
contains "Sugar

CRM" or
"SugarCRN", the
account will not
relate properly.

Campaigns Campaign Use the existing
Sugar campaign

name or campaign
record ID to relate
the opportunity to

the campaign
record. 

Note: If you are
using the campaign

name, it must be
exactly as it shows

in Sugar. For
example, if your

campaign in Sugar
is "End of Year

Newsletter", but
your import file
contains "End of

Year News" or "End
of Year Promotion",
the opportunity will
not relate properly.
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Campaign ID Use the existing
Sugar campaign

record ID number
to connect the

campaign name
into the new

opportunity record.
Targets Accounts Account Name In Targets, this is

just a text field.
This will not create
any relationships.

Campaigns Campaign ID Use the existing
Sugar campaign

record ID number
to connect the

campaign name
into the new target

record.
Leads Lead ID Use the existing

Sugar lead record
ID to relate the

target to an
existing lead

record. This is not a
relationship that

can be forged from
either module in

Sugar. This
relationship is
usually formed

through the target
conversion process.

For more
information on

converting targets,
please review the 

documentation.
Tasks Contacts Contact ID

Use the existing
Sugar contact

record ID number
to connect the

contact name into
the new Task
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record.
Flex Relate Related To ID

Related To Module

On the import
template, there are
columns for both

"Related To ID" and
"Related To

Module". Both need
to be used to form

the proper
relationship.

Related To ID: The
ID for the record
you are relating.

Related To Module:

Import File Template

The Import File Template is a very useful tool for building your import file from
another source or from scratch. The template for any module can be found on the
Upload Import File page, which is either the first or second page of the wizard,
depending on the module.

The purpose of this file is to let you know what format Sugar is going to be looking
for when you perform your import. The file contains all fields for a given module,
regardless of if they show on any of your layouts. The file is also properly
formatted and all settings are ready for the import. Upon opening the template,
you will see a few example lines of either actual records from your instance, or,
"demo data" if you have not yet performed an import. The template also contains
instructions on how it is used.

It is best to use the format supplied in this template whenever possible to make
your import process as seamless as possible.

Saving Field Mappings

When importing data, there can be times where you will be using the same import
file format. If this file was not exported from Sugar, that likely means that you
have to re-map most of the fields on the Confirm Field Mappings screen of the
Import Wizard. To save time in the future, you can use the Import Wizard's pre-set
import settings.

 991 / 1.013



 

 

On the "Check for Possible Duplicates" page of the wizard, which is the last page
before performing your import, there is a text box where you can name the import
settings that you have used on this import.

 

Once you click "Import Now", this mapping will be saved and available for your use
in future imports.

This mapping is now saved for your user and will appear on the Upload Import File
page of the Import Wizard. This will include two buttons for "Publish" and "Delete".

 

Publish : Clicking this option will make your mapping available to all users. The
Publish button will change to "Un-Publish" so that you can stop other users from
using the templated mapping. When it is published, it will appear as an option in
the same section for other users when they perform an import.

Delete : This button will remove the pre-set import mapping for all users. This
action cannot be undone.

Detecting Duplicates

During an Import, Sugar's Import Wizard includes the functionality to check for
duplicate records. When enabled, Sugar will check to see if a record already exists
in Sugar with the given criteria. When checking for duplicates, Sugar will mark
any record as a duplicate if it cross references against any of the duplicate fields.
For example, when importing Contacts, if you select Last Name and Email Address
as your duplicate check fields, any record that has a matching last name and/or a
matching email address to an existing contact in Sugar will be marked as a
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duplicate.

 

The duplicate check fields used in each module differ depending on what fields are
available to the module. Not all fields are used or available in the duplicate check
and are pre-determined based off of system-defined indexes.

If your import file has any duplicate records based off the fields you elect to verify
against, the first record will be imported, and then all subsequent records in the
file matching the duplicate criteria will be flagged.

Any duplicates will show as such on the final page of the import. You will also have
an option to download the duplicates so that they can be manually cross
referenced to verify if they are actually duplicates. If they are not, simply re-run
the import process without selecting any fields on the "Check for Possible
Duplicates" page.

External Data Sources

When importing data to Sugar, there are other options than importing a data file
exported from another source. Sugar offers an option to directly connect to an
outside application or service though the Import Wizard and have Sugar pull the
information directly from the source. This functionality is currently only available
for Google Contacts.

The import process is very similar to what is described above, but with some
differences to speed up the process for users who would like to import all contact
data into Sugar

Importing Data From Google

1. Navigate to the module tab for the person-type module that you are importing
into and select the import option. This will open the Import Wizard and bring
you to the "Select Data Source" screen.
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2. On the Select Data Source screen, navigate to the "My data is in:" section and

choose the option for "an external application or service". This will activate a
"Sign In" button for you to sign in to your Google account.

 
3. Fill in your user name and password for the Google account you would like to

connect to and click "Connect".

 
4. Upon connecting, you will be brought to your user profile, on the "External

Accounts" tab. Navigate back to the import screen, repeating steps 1 and 2
above. Click "Next" this time, instead of Sign In.

 
5. This will direct you to the "Confirm External Source Properties" page, which

is very similar to the mapping screen from a data import from a file on your
computer. Change any mapping necessary specific to your Google account
and your Sugar instance. Any field in the Module Field column marked with
an asterisk (*) is a required field and must be imported.
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6. There is no duplicate check for this type of import, but names and email
addresses are automatically checked for duplicates.

7. Click "Import Now" after you have completed your mapping.
8. On the "View Import Results" screen, you will see that all of your Google

contacts have been successfully imported into Sugar.
9. Any records that were not imported due to error can be exported from Sugar

and then re-imported if need be using the "Download list of rows that were
not imported" link

 
10. To review the standard import process to re-import any additional records

please review the Importing New Records section of this documentation.

Admin Import Wizard

Administrators have special functionality available in Sugar that may not be
available for all other users. One of these is access to the Admin Import Wizard. In
the "Admin" menu, under the "System" panel, there is a link for "Import Wizard".

 

Clicking this option will bring you to the Import Wizard, similar to the one for
specific modules. However, the first step here is for "Select Data Source", where
you will need to select the module you wish to import data. The dropdown provided
includes options for all importable modules in one convenient location. Once you
select the module from the list, click "Next" and you will be directed to the
standard import wizard where you can import new records or update existing
ones.

Last Modified: 09/26/2015 06:25pm

Employees
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Overview

Sugar's Employees module consists of individual people within your organization.
The Employees module allows you to see a list of all employees, their contact
information, and their employment status in one convenient location. Employee
records are typically created when a user record is created, but users with
administrative access can also add non-user employees. This means that, typically,
all users will be listed as employees, but not all employees are necessarily Sugar
users.

For more information on having administrators create employee records in Sugar,
please refer to the Employee Management documentation in the Administration
guide.

For more information on having administrators create user records in Sugar,
please refer to the User Management documentation in the Administration guide.

To access the Employees module, click on your user name in the top right corner
of any page in Sugar and click on the Employees menu option.

 

Employee Fields

The Employees module contains a number of stock fields which come
out-of-the-box with Sugar. The below definitions are suggested meanings for the
fields, but the fields can be leveraged differently to best meet your organization's
needs. Users with administrator or developer access have the ability to alter, add,
or remove fields via Admin > Studio. For more information on configuring fields,
please refer to the Fields documentation in the Administration guide.

Field Description
City The city of the employee's address
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Country The country of the employee's address
Department The department where this employee

works
Email Address The employee's email address
Employee Status The employee's employment status in

the organization, either: Active,
Terminated, or Leave of Absence

Fax The employee's fax number
First Name The employee's first name
Home Phone The employee's home phone number
IM Name The employee's instant message screen

name
IM Type The employee's instant message client

type
Last Name The employee's last name
Mobile The employee's mobile phone number
Notes A description or other information about

this employee
Office Phone The employee's office phone number

and extension
Other An additional phone number for the

employee
Picture A picture, headshot, or identifying

image of the employee
Primary Address The number and street of the

employee's address
Postal Code The postal code of the employee's

address
Reports to This field list's the employee's manager,

if the manager is a Sugar user
State The state of the employee's address
Title The employee's job title

Employees Module Tab

The Employees module tab is located on the dropdown bar accessed by clicking
your user name in the top right of any Sugar screen. Click the Employees option to
access the Employees list view and have the Employees module tab appear. Once
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displayed, you may hover on the tab to display the action for View Employees and
the Recently Viewed menu. The View Employees option will take you to the
Employees list view . The Recently Viewed menu displays the list of employees you
last viewed in the module.

 

Viewing Employees

There are various options available for viewing employee records in Sugar
including via Employees list view, Employees detail view, and the Employees
Recently Viewed menu. Please note that you will only be able to access these views
by first clicking on the Employees button after clicking on your user name in the
top right side of Sugar.

Viewing Via List View

The Employees list view displays all employee records meeting the current search
criteria. To access the list view, simply click the Employees option under your user
name on the module tab bar. While list view shows key employee fields, you can
click the employee's name to open the record in detail view. For more information
on viewing employees via list view, please refer to the Employees List View section
of this documentation.

Viewing Via Detail View

The Employees detail view displays thorough employee information by showing all
employee fields. The detail view can be reached by clicking an employee record's
link from the Employees list view. For more information on viewing employees via
detail view, please refer to the Employees Detail View section of this
documentation.

Viewing Via Recently Viewed
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As you work, Sugar will keep track of which employees you have recently viewed.
Hover on the Employees module tab to see a list of your most recently viewed
employees and click each name to open the employees in detail view .

 

Searching Employees

The Employees list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Employees list view below.
Please note that Sugar automatically appends the wildcard character (%) to the
end of your search phrase. This allows the system to retrieve all records that start
with the keyword entered in the search. If you would like to broaden the search,
you can use the wildcard at the beginning of your text as well (e.g. %services). This
will pull up any record that has the word "services" in the name, regardless of how
it starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:
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Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.
Active Employees : Select this box to return only records where Employee
Status is Active.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "Active Employees" and enter an employee's name, Sugar will only return
employee records with a matching name that are active. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all employee records, simply click "Clear" and then "Search" to perform a
blank search with no filters.

Administrators can configure what fields appear on the Employees Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to perform
the search.
Clear : Click the Clear button to clear all criteria from the searchable fields.
Active Employees: Select this box to return only records where Employee
Status is Active.
Layout Options : Use the expandable Layout Options section to configure your
list view. For more information, please refer to the Layout Options section of
the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.
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When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "Active Employees" and enter an employee's name, Sugar will only return
employee records with a matching name that are active. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all employee records, simply click "Clear" and then "Search" to perform a
blank search with no filters.

Administrators can configure what fields appear o n the Employees Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Employees List View

The Employees list view displays all employee records meeting the current search
criteria. You can view the basic details of each employee within the field columns.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Employees Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
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and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

 

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header, noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Employees Detail View

The Employees detail view displays thorough employee information by way of all
employee fields grouped into one page.

Users with administrator or developer access have the ability to change the detail
view by configuring the layout via Admin > Studio. For more information on
editing layouts, please refer to the Studio documentation in the Administration
guide.

Next or Previous Record

On the upper right of the Employees detail view, there are two buttons that allow
you to page through each employee in the Employees list view's current search
results. Clicking the Previous button displays the previous employee of the current
search results while clicking the Next button displays the next employee of the
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current search results. The text in between shows which employee result you are
currently viewing within the total number of current results.

 

Last Modified: 09/26/2015 06:25pm

Mobile Browser

Overview

Sugar mobile browser enables users to access the HTML view of their Sugar
instance via mobile devices (e.g. iPhone, Android, etc.) to perform various actions
and manage their records. Similar to the desktop Sugar application, you will be
able to access all records that are assigned to you, your teams, and your direct
reports for various modules (e.g. Accounts, Contacts, Calls, etc.). Please note that
the Calendar, Emails, Forecasts, Reports, and Target Lists module are not
available for the mobile browser. This documentation will cover how to access,
navigate, and utilize your Sugar instance via the mobile browser.

Accessing Sugar Via Mobile Browser

Users can access their Sugar instance via the mobile browser from their mobile
device. To access your Sugar account, enter your instance URL (e.g.
https://example.sugarondemand.com) in your mobile browser to load Sugar's login
screen. Please note that if you are unable to access Sugar via the mobile browser
using your instance URL, append "&mobile=1" to the end of your URL then try
reloading the page.

Once the login page loads, enter the same login credentials (username and
password) you normally use to access your Sugar instance in a desktop browser
then click "Login".
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Mobile Dashboard

The Mobile dashboard allows users to navigate to various modules (e.g. Contacts,
Accounts, Leads, etc.), view currently scheduled activities, as well as access their
recently viewed records. To navigate to a modules page, simply select the specific
module from the Select a module dropdown list then click "Go".Currently
scheduled activities will appear under the Today's Activities section and you can
access the records detail view by clicking the records name. The Recently Viewed
section displays the list of records you last viewed in Sugar. You can access the
records detail view by clicking the records name in the Recently Viewed list. The
dashboard also provides direct access to the Employees page by clicking the
Employees link at the bottom left of the page. To log out of Sugar, simply click
"Log Out" from either the upper right or bottom left of the dashboard.

 

Please note that you can easily navigate back to the dashboard by clicking the
Dashboard link on the bottom left of any Sugar page you are currently on.

 1.004 / 1.013



 

 

Creating Via Mobile Browser

Users can create new records via the mobile browser by navigating to the specific
module's page then clicking the Create button. This opens up the edit view layout
which allows you to enter in all the relevant information for the new record. Please
note that administrators can configure the Edit View layout via Admin > Studio
from the desktop Sugar application. For more information on configuring mobile
layouts, please refer to the Studio documentation in the Administration guide.

The following steps cover creating a new contact via the mobile browser as an
example:

1. Navigate to the Contacts module by selecting "Contacts" in the Select a
module dropdown list then clicking "Go".

 
2. Click the Create button beneath the Search form.
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3. Enter appropriate values for the fields in the Edit View layout. All required

fields are marked with a red asterisk and must be completed prior to saving.
4. Once the necessary information is entered, click "Save".

 

Viewing Via Mobile Browser

There are various options available for viewing records via the mobile browser
including via the Mobile list view, Mobile detail view, and Mobile dashboard. As
you view records within the mobile browser, you can go back to previously viewed
records by clicking the Back link on the bottom left of any Sugar page or the Back
button on your browser. Please keep in mind that you will only be able to see
records as allowed by your team membership. For more information on teams,
please refer to the Team Managementdocumentation in the Administration guide.

Viewing Via List View

The Mobile list view displays all records for the specific module you are viewing
which meet the current search criteria. To access the list view, you will first need
to select the module (e.g. Contacts, Leads, etc.) from the Select a module
dropdown list at the top of the page then click "Go". Once in the module's page,
the search form will display allowing you to enter in a keyword in the searchable
field (e.g. name, subject, etc.) to pull up records matching the criteria. Please note
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that administrators can configure what fields appear on the search form via Admin
> Studio from the desktop Sugar application. For more information on editing
mobile search layouts, please refer to the Studio documentation in the
Administration guide.To see all records to which you have access to in the module,
simply click "Search" without entering any search criteria(s). While list view shows
key record fields, you can click the specific record's name to open the record in
detail view. For more information on viewing records via list view, please refer to
the Mobile List View section of this documentation.

Viewing Via Detail View

The Mobile detail view displays thorough information regarding the record
including all the fields followed by the Related Information subpanel, which
displays the related records belonging to various modules. Please note that
administratorscan configure what fields appear on the detail view layout via Admin
> Studio from the desktop Sugar application. For more information on editing
mobile layouts, please refer to the Studio documentation in the Administration
guide.The detail view can be reached by clicking the module record's link from the
mobile list view or from anywhere in the mobile browser where you see the
record's name as a hyperlink. For more information on viewing record's via detail
view, please refer to the Mobile Detail Viewsection of this documentation.

Viewing Via Dashboard

The Mobile dashboard displays a list of your currently scheduled activities as well
as recently viewed records in Sugar. You can click each record's name in the
Today's Activities and Recently Viewed list to access the record's detail view. For
more information on the Mobile dashboard, please refer to the Mobile Dashboard
section of this documentation.
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Searching Via Mobile Browser

When you navigate to a module's page (e.g. Accounts, Contacts, etc.) within the
mobile browser, the Search form will display first. Mobile search helps you to
locate records easily and effectively in a module-specific manner. Once the search
is performed, the relevant results will be displayed in the list view. Please note that
Sugar automatically appends the wildcard character (%) to the end of your search
phrase. This allows the system to retrieve all records that start with the keyword
entered in the search. Users also have the option to search only records assigned
to them by selecting the My Items checkbox that appears below the search field(s).

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a contact name, Sugar will only return contact records
with a matching name that are assigned to you. To see all records to which you
have access, simply clear any values in the search form then click "Search" to
perform a blank search with no filters. Please note that you will only be able to see
records as allowed by your team membership. For more information on teams,
please refer to the Team Managementdocumentation in the Administration guide.

Administrators have the ability to configure what fields appear on the search form

 1.008 / 1.013

http://http//support.sugarcrm.com/Documentation/Sugar_Versions/6.7/Ent/Administration_Guide/Team_Management


 

via Admin > Studio from the desktop Sugar application. For more information on
editing mobile search layouts, please refer to the Studiodocumentation in the
Administration guide.

Mobile List View

The Mobile list view displays all records meeting the current search criteria and to
which you have access. You can view the basic details of each record within the
field columns of the list view. Please note that you will only be able to see records
as allowed by your team membership. For more information on teams, please refer
to the Team Management documentation in the Administration guide.

Users with administrator or developer access have the ability to change what fields
are visible in the list view via Admin > Studio from the desktop Sugar application.
For more information on editing mobile layouts, please refer to the Studio
documentation in the Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially hundreds of rows at once. To the right
just below the list view you can see which records of the total results set are
currently being displayed. The Next and Previous links can be used to scroll
through the records page-by-page.

By default, the Mobile list view displays 10 records per page, but administrators
can change the number of records displayed via Admin > Mobile from the desktop
Sugar application. For more information on changing the number of displayed
records, please refer to the System documentation in the Administration guide.

 

Mobile Detail View

The Mobile detail view displays thorough information regarding the module record
including all the fields. Please note that administrators can configure what fields
appear on the detail view layout via Admin > Studio from the desktop Sugar
application. For more information on configuring fields for the mobile layout,
please refer to the Studio documentation in the Administration guide. You can also
view the related records (Accounts, Opportunities, etc.) via subpanels under the
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Related Information section. Please note that subpanels will only appear on the
detail view if there is a related record. The detail view can be reached by clicking
the record's link from the mobile list view, mobile dashboard, or anywhere in the
mobile browser where you see the record's name as a hyperlink.

To access a specific module record, you will need to select the module (e.g.
Accounts, Contacts, etc.) from the Select a module dropdown list on the upper left
of Sugar then click "Go". Once in the modules page, you can either perform a
search for a specific record or click "Search" with no search filters entered to
return all records to which you have access. Once the search is complete, the list
view will display the relevant results and you can click the record name to access
the detail view.

Please note that you will only be able to view a record according to your team
membership. For more information on teams, please refer to the Team
Management documentation in the Administration guide. Users with administrator
or developer access have the ability to change the detail view by configuring the
layout via Admin > Studio from the desktop Sugar application. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

 

Related Information

The Related Information section of the Mobile detail view displays related records
belonging to various modules. Relationships between records allow you to connect
relevant records together. You can viewthe details of a related record by clicking
the record's name in the specific module's subpanel. Please note that
administrators have the ability to disable modules via Admin > Mobile from the
desktop Sugar application. Please reach out to your administrator if you do not see
a related module record appear in detail view. For more information on disabling
modules for the mobile browser, please refer to the System documentation.
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Add Related Information

Users can also create related module records (e.g. calls, meetings, etc.) via a
record's detail view under the Add Related Information section.

The following steps cover creating a new call record in the Contacts detail view as
an example:

1. Navigate to a contact record's detail view .

 
2. Scroll to the Add Related Information section at the bottom of the detail view

page.
Select "Calls" from the dropdown list then click "Add".

 
3. Enter appropriate values for the fields in the edit view layout then click

"Save".

 

The newly created record will appear within the Calls subpanel of the Related
Information section.

 

Editing Via Mobile Browser
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Records may be edited at any time to update or add information to the specific
record. You can make changes to existing records via the Edit View layout from the
mobile browser. Edit view is available within each module and includes all of the
fields you should need to edit the record.

Administrators in Sugar may configure the edit view layout via Admin > Studio
from the desktop Sugar application. For more information on configuring mobile
layouts, please refer to the Studio documentation in the Administration guide.

The following steps cover editing a contact via the mobile browser as an example:

1. Navigate to a contact record's detail view .

 
2. Click the Edit button below the detail view fields.

 
3. Update the necessary fields then click "Save" to preserve your changes.
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